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Getting Started with General Administration 
Guide 

Within our documentation, some content might be specific for cloud deployments while other 
content is relevant for on-premises deployments. Any content that applies to only one of these 
deployments is labeled accordingly. 

The Unifier General Administration Guide explains how the Company Administrator should use 
the general options that are available in the Admin mode of operation.  

Depending on permissions, among other tasks, the Company Administrators can: 

 Create or modify projects and programs 

 Create data definitions for custom attributes on BP forms 

 Activate business process schemas 

 Define record numbering schemas 

 Create users and groups and grant their permissions 

 Set up templates 

 Add currencies 

For more detail about Company Administrator, see Administrators in Unifier (on page 23). 

Access to Oracle Primavera Unifier functionality is granted through permissions.  

A Company Administrator can set permission from the following modules: 

 Access Control

 Company User

 User Administration > Groups

 Standards & Libraries > Permissions

The ability to utilize a specific function in Unifier depends on permissions settings granted by the 
Company Administrator, set in Admin mode. 

Unifier has two modes of operation: 

 Admin (Administration) mode

Company Administrator work in Admin mode to set up, for example, company, program, and 
project or shell properties, user permissions, templates for major features, data structures, 
and configure and set up business process (BP) workflows. 

 User mode

Users spend most of their time in the User mode. The User mode allows users perform the 
day-to-day activities, collaborate through business processes and Mailbox, maintain, for 
example, the Cost Manager, Schedule Manager, and Document Manager, and run reports. 

The Unifier User Help explains how to use the options that are available in the User mode of 
operation. 

You can switch between modes using the mode icons ( User mode and Admin mode). 
These options are not available for the Home workspace. 
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Security Considerations 

For any company that deals with sensitive data, keeping it secure is crucial to success. While 
hosting Unifier data on the Oracle Cloud provides security measures, it cannot do everything. 
For example, it cannot prevent phishing attempts or other attacks that exploit gaps in its users' 
security awareness. That is why it is important for everyone who works with Oracle Primavera 
Unifier, whether hosted on-premises or on the Oracle Cloud, to understand what they can do to 
keep data secure.  

Who this information is for 

This guide (the Unifier Administration Guide) and the Unifier Integration Interface Guide contain 
comprehensive information on administrative features, including those related to security. 

This section is for anyone who uses, manages, or is just interested in the system. If you are a 
security expert or administrator, this is a good place to start. It should help you see the big 
security picture and understand the most important guidelines related to security in Unifier.  

For further information on configuring your on-premises Unifier environment securely, refer to 
the Unifier Security Guide for On-Premises.  

Some Security Basics 

We use the term administrator to refer to anyone who is responsible for managing a company's 
data and who can access that data. For our purposes, administrators includes a wide variety of 
IT professionals, from those who define roles in the Primavera Unifier application to those who 
manage company servers. 

An end user is anyone who uses Primavera Unifier to do their job. This includes project 
managers, subcontractors, general contractors, and everyone else who logs into Primavera 
Unifier from an office or jobsite to get their work done. 

Administrators

 Set up Single Sign-On (SSO) and enable multi-factor authentication to minimize the number 
of passwords that users have to remember and to consolidate risk. 

 Educate users on how they can avoid unwittingly helping hackers. One of the best ways 
application administrators and security advocates can help users is by helping them to 
prevent security breaches. 

 Use a VPN to encrypt data being sent over the internet. 

 Stay up-to-date about security trends and best practices. 

End users

 Follow security guidelines created by their companies and the administrators of any network 
applications they use. 

 Use strong passwords. The more random-looking the better, and avoid reusing passwords. 
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 Learn to recognize phishing. Phishing is when someone disguises an email or some other 
transmission as a legitimate message in an attempt to get a user to reveal sensitive 
information. For example, a hacker may send you an email disguised to look like an email 
from your employer requesting login information. These attacks are becoming more 
sophisticated, but you can still protect yourself by making sure any emails you receive or 
websites you visit are legitimate before using them to share sensitive information. 

In This Section 

Authentication: How Users Sign On ......................................................................... 16 
Authorization: What Users Can Access ................................................................... 16 
Endpoint Security .................................................................................................... 17 
Confidentiality .......................................................................................................... 18 
Integration with Other Applications .......................................................................... 18 
Security for Developers - API Security ..................................................................... 18 
Establishing Security Contacts ................................................................................ 18 

Authentication: How Users Sign On 

Authentication refers to the way users sign on. 

If possible, Administrators should implement Single Sign-on (SSO).  

SSO reduces the number of passwords the users must remember. It can also be used to enable 
multi-factor login, which is when users are asked to provide some verification in addition to their 
passwords, like a code that they receive via text or email. 

Note: For Unifier On-Premises customers, the system only supports 
integration with the Oracle Identity Manager.  

To learn how to change the authentication settings, refer to the "Authentication Options for 
Primavera Unifier" section of the Unifier Security Guide for On-Premises.  

Authorization: What Users Can Access 

Authorization refers to what users can access. The authorization to use the system is based on 
permissions. Permissions are managed by the administrator. The administrators must grant 
permissions to all appropriate users, carefully.  

Administrators: There are different types or levels of administrators, and they have various 
responsibilities, including (but not limited to) the end-to-end administration of Unifier. 
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Permissions: Unifier offers a flexible yet powerful permission-based security system, as 
opposed to role-based security. Role-based security by definition limits the user to a fixed set of 
functions or tasks. With permission-based security, access to all modules, functions, and tasks 
are controlled by granting each user any combination of permissions. These permissions consist 
of the ability to access specific tasks, and to perform specific actions within those tasks, such as 
create, modify, and view. 

Permissions are granted to Users, or to Groups, to allow them access to features or 
functionalities. 

Users: Individuals who use a functionality, if they have the permission granted to them to do 
so, by the administrator. 

Groups: The Groups option makes it easier for the administrators to assign permission sets 
to multiple users (a group of users) at the same time. The administrators can use Groups to 
group users who will be using the same functionality, and assign the same permissions to all 
users in the group. Anytime a new person comes onto the project or shell, the administrator 
can assign the new person to a group, and the new person's permissions will be set 
automatically. 

Specific permission settings are described in the Unifier Data Reference Guide. 

Endpoint Security 

From laptops to cellphones, organizations have to keep track of data on more devices than ever, 
and more devices means more risk. It is important to implement Enterprise Mobility Management 
(EMM) tools and policies.  

Inherent Risks and Practical Policies 

No automated security system or protocol can make a system fully secure if those with 
legitimate access exploit it for illegitimate purposes or if a device falls into the wrong hands. Here 
are some general "common sense" guidelines you should follow when it comes to endpoint 
security: 

Use good mobile device management (MDM) software.

MDM systems can help your organization secure the devices where its sensitive data might 
end up. 

Grant security permission conservatively.

Do not give everyone permission to everything just to avoid perceived complexity. 
Remember, one breach can be many times more costly and time consuming than setting 
and following standard security protocols. 

Organize permission sets and credentials so they can be edited quickly.

Keep user groups and their permissions organized and easy to manage. Use descriptive 
names for permission sets, and organize them logically to make it easier for you or anyone 
else to manage them quickly and confidently. 

Keep up with organizational changes.
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If a user no longer needs access to a part of the app, for whatever reason, update that user's 
permissions accordingly. 

Use timeout settings.

Administrators can limit how long mobile applications and APIs remain connected to the 
server after a user signs in. See the Unifier Mobile Application (on page 337) topic in this 
guide for more details. 

Confidentiality 

Confidentiality ensures that only the authorized users see the stored and transmitted 
information. In addition to the documentation included with other applications and hardware 
components, follow the Unifier-specific guidance below. 

 For data in transit, use SSL/TLS to protect network connections among modules. If you use 
SSO authentication, ensure that you use LDAP to connect to the directory server. 

 For data at rest, refer to the documentation included with the database server for instructions 
on securing the database. 

Integration with Other Applications 

The ability to connect and exchange information with other apps is powerful, but it also presents 
some potential security issues that administrators must manage. It is important to understand 
which data flows between applications to ensure compliance with policies and regulations 
related to security and privacy. 

For more information on integration, refer to the Unifier Integration Interface Guide. 

Security for Developers - API Security 

With APIs, developers can use some of the data and functionality of Unifier outside of the 
limitations—and relative safety—of the Unifier environment. This opens many possibilities. But 
as with any situation where data can move in potentially unpredictable ways, it presents risk. For 
more information on integration, refer to the Unifier Integration Interface Guide. 

Establishing Security Contacts 

While the apps used by your organization may have some security features of their own, most 
security issues ultimately come down to the people who use them. When your company 
establishes its security procedures, it's important to also establish in-house security experts to 
whom other members can turn when they have security questions. Security points of contact 
should be continuously learning about security trends and how they can educate users to keep 
their data and network secure. Security contacts should also routinely update and maintain 
protocols that suit the security needs of their organizations. 
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Base Currency Confirmation 

The Base Currency is the default currency used by the company. The Base Currency is set by 
Oracle when Primavera Unifier is first provisioned. Because the type of currency plays a large 
role in nearly all financial functions of Unifier, the base currency cannot be changed after data 
has been entered into the application or data issues may arise.  

When an administrator logs into the application for the first time, a confirmation alert is displayed 
on screen with the following message: 

"The Base Currency of your company is <Currency Name> (<Currency Code>). This currency 
cannot be changed. If you want to change this currency, you must contact your Oracle team 
immediately before creating any data." 





21

Companies 

The following is a list, and description of, company types in Unifier:  

 Owner Company (also referred to as the Sponsor Company) 

 Partner Company 

 Member Company 

The following explains each company type in detail. 

Owner Company (Sponsor Company) 

The entity that engages in business and has complete control (or ownership) of the application. 
An Owner Company (Sponsor Company), commissions projects or shells. Projects and shells 
are created under the Owner Company. 

Note: Projects and shells are a collaboration space allowing users to 
collaborate and coordinate efforts during the execution of a project. 

A Sponsor Company may have one, many, or no partners. 

Partner Company 

A Partner Company is a consultant, a contractor, or a vendor company which is associated with 
a Sponsor Company. A Partner Company may work with the Sponsor Company on all, or only 
some, of the Sponsor Company projects or shells. 

Member Company 

When a Partner Company participates in a project or shell, the Partner Company becomes a 
Member Company, and the Partner Company users that are added to the project or shell 
become the Member Company users.  

Note: Project and shell access is limited to the users (including Sponsor 
Company users or Member Company users) who are chosen for the 
project or shell and permissions are configurable for each company. 

The application allows adding Partner Company or Member Company to enable project users to 
collaborate on (and coordinate) the execution of a project. 
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Administrators 

Note: The following information is based on the default settings and 
typical use of Unifier. 

There are different types, or levels, of administrators in Unifier and they include: 

 Site Administrator (also referred to as the System Administrator) 

 Company Administrator 

 Project or Shell Administrator  

The following explains each administrator type in detail. 

Site Administrator (also referred to as the System Administrator) 

A Site Administrator is responsible for the end-to-end administration. 

Note: For cloud customers, the Oracle Primavera Technical Team 
performs the Site Administrator function. For on-premises customers, the 
customer performs the Site Administrator function.  

The Site Administrator's tasks include: 

 Loading modules. 

 Loading certain system reports. 

 Managing the License Manager. 

 Performing basic system administration tasks, including unlocking locked user accounts. 

 Performing Company Administrator and Project/Shell Administrator functions, if requested. 

 Changing the Authentication Key.  

Company Administrator 

Generally, a Company Administrator administers the Owner Company (Sponsor Company) 
functions. For more information about Owner Company see User Administration (on page 95). 

The Company Administrator can perform user tasks, also. 

Note: Except where noted, the Company Administrator cannot perform 
tasks designated for the Site Administrator. 

A Company Administrator typically performs the following tasks, depending on the permission: 

 Creating multiple partner companies in the Owner Company. 

 Creating users for each partner companies in the Owner Company. 

 Modifying the company properties, including Company Workspace 

 Managing company details such as contact information. 

 Managing company-level users, groups, and granting permissions. 

 Managing Partner Company (or Member Company) status. 
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 Managing Partner Company (or Member Company) users. 

 Creating cross-project or cross-Shell reports. 

 Creating, and maintaining, Data Definitions (DDs) and Data Elements (DEs). 

 Activating a Business Process schema. 

 Defining record numbering scheme. 

 Defining the company exchange rate and currencies. 

 Creating programs, projects, and shells. 

 Managing project organization (categories) and shell organization (types). 

 Setting up templates. 

 Setting up and managing data structure. 

 Configuring the User mode Navigator (the setup of the left-hand Navigator in User mode: 
Company Workspace > Admin mode > Configuration > User Mode Navigator). 

In Unifier, you can have multiple company administrators. 

The Company Administrator group, which can contain multiple company administrators, is 
automatically created when the Owner Company (Sponsor Company) is created in Unifier. 

This Company Administrator group has preset permissions. These permissions can be changed 
as needed. 

Examples 

 If new business processes are added. 

 If new modules are added. 

 If the Company Administrator assists in administration of other modules such as projects 
or shells. 

Project Administrator or Shell Administrator (Project/Shell Administrator) 

Project/Shell Administrators manage project-level or shell-level administration tasks, and may 
also administer programs for projects. A project or shell administrator will add existing Unifier 
users to projects and/or project/shell groups, restrict access within specific projects, set up the 
project or shell cost/funding/Schedule of Value (SOV)/schedule sheets, and set up business 
processes. Project or Shell Administrators typically: 

 Administer projects or shells they are a member of 

 Add Project or Shell Users, create Groups and grant Permissions 

 Create and modify the Cost Sheet 

 Create Business Process Setups and define workflows 

 May also manage programs as a Program Administrator (for projects only) 

To access company administration functions see Company Workspace Landing Page (Admin). 
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Permission-Based Security 

Unifier offers a flexible yet powerful permission-based security system, as opposed to role-based 
security. Role-based security by definition limits the user to a fixed set of functions or tasks. With 
permission-based security, access to all modules, functions and tasks in Unifier are controlled by 
granting each user any combination of permissions. 

For ease of use, permissions can be set for both individuals and for groups of users. You can 
even copy permissions from one user to another, and then make modifications. 

A user may belong to any (or all) of the administration groups and perform functions as a 
company, program, or project or shell administrator. Company Administrators generally have 
program and project or shell permissions, and may or may not work within the specific projects 
or shells. You may want a project, shell, or program administrator to have the ability to perform 
some company administrator functions, such as creating a project or shell. Creating different 
types of user permission templates will help you to more easily grant access to different staff 
members, whether they are administrative staff, engineers or architects, managers, vendors or 
subcontractors, IT personnel, etc. 

Use default permissions as a guideline, but your users' actual permission settings will depend on 
your organizations needs. 
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Company Workspace Landing Page (Admin) 

When you go to your company workspace tab, you will see the company landing page, as 
shown below: 

As shown, the company landing page has a heading which displays the Oracle Primavera 
Unifier logo and enables you to access the following: 

 Announcements icon (  ): Displays a log of recent announcements. 

 Bookmarks icon ( ): Displays all bookmarked locations in Unifier. 

 View Help menu icon (  ): Displays a list of tabs that lead to additional support resources. 

 User control panel icon (Image and the user's name): Contains your user preferences and 
login details. 

Below the heading, the tab row enables you go to the Analytics tab ( ) (depending on your 

permissions), Home tab (Home workspace) (  ), Company Workspace tab, and shell tabs. You 
can close all the tabs except the Home tab (Home workspace). You can click the New tab icon ( 

 ) to open a window that enables you to search for company or shells by: 

a) Opening all locations and searching, for example, in all projects, all properties, or buildings. 

b) Opening the company or shells that are displayed (categorized under: Recent Locations, 
Key Locations, and Bookmarks). 

Below the tabs row is the mode row, which enables you switch the mode of operation, from the 

User mode to the Admin mode or reverse ( User mode and Admin mode). 
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Below the mode row is the menu options row, which provides access to the following menu 
options: 

 File

 New: Creates a new Company Workspace. A company can only have one Company 
Workspace. This node is read-only. 

 Open: Opens the Edit Company window, which provides access to company properties 
through the following tabs: 

 General: Enables you to manage multiple company features, such as 
company name and description. 

 Address: Enables you to enter multiple company addresses, including one for 
the company headquarters. 

 Security: Enables you to configure policies for multiple items, including file 
security and account logins. 

 Contact: Enables you to provide contact information that can be used when 
users need support and training. 

 E-Signatures: Enables you to configure account settings for DocuSign and 
Adobe Acrobat Sign and select a default system for e-signatures. 

 Outgoing E-mails: Enables you to manage the size of attachments that can 
be included on an outgoing email. 

See Access Company Details (Edit Company Window) (on page 69) for details about 
the tabs. 

 Edit

 Delete: Removes a Company Workspace. This node is read-only. 

 View

 All: Displays a list of all Company Workspaces. This node is read-only. 

 Find: Enables you to search for a specific Company Workspace. This node is read-only. 

 Audit Log: Opens the Audit Log window, which displays a history of all actions that 
have been taken on the Company Workspace, including changes to the hyperlink 
security policy. The following are captured in the Audit Log window: 

 Date

 Event

 Action

 Field

 Old Value

 New Value

 User Name

 Proxy User 

 Attachment

 Help

 User Help: Accesses the Unifier User Help web page. 

 Admin Help: Accesses the Unifier Administrator Help web page. 

 uDesigner Help: Accesses the Unifier uDesigner Help web page. 
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 Unifier Library: Accesses the Unifier Administrator Help web page. 

 User Productivity Kit: Accesses the portfolio type training. 

Below the menu options row, the toolbar options row enables you to open the Edit Company
window. For more information, see the File > Open > <option> descriptions provided earlier. 
The New and Find options on this row are not available. 

Below the toolbar options row is the area that displays more details about the company such as 
the: 

 Description of the company 

 Administrator information 

 Home Page URL of the company 

 Help URL for the company 

 Company Addresses

 Partner Companies

On the left side of the company landing page, the following navigation (left Navigation) grouping 
nodes and functional nodes are displayed: 

Note: You can click a grouping node to expand it and access the 
functional nodes that are associated with that grouping node. In some 
instances, some of the items under the grouping nodes are considered 
sub-grouping nodes which have their respective functional nodes, as 
shown in the following lists (the indented bullets). 

The following topics explain each grouping and functional nodes, in the Company Workspace 
landing page (Admin mode). 

In This Section 

User Administration ................................................................................................. 29 
General Administration ............................................................................................ 30 
Data Structure Setup ............................................................................................... 31 
uDesigner ................................................................................................................ 32 
Configuration ........................................................................................................... 34 
Integrations ............................................................................................................. 36 
Standards & Libraries .............................................................................................. 37 
Configuration Package Management ....................................................................... 38 
System Information ................................................................................................. 39 
Templates ............................................................................................................... 40 
Company Workspace .............................................................................................. 41 
Programs................................................................................................................. 42 
Company Sponsored Projects (Standard) ............................................................... 42 
Company Sponsored Shells .................................................................................... 42 

User Administration 

The User Administration grouping node contains the following functional nodes: 
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Partner Companies 

A sponsor company might work with one or more partner companies (for example, 
subcontractors, vendors, and so on) to work on projects, shells, or company-level activities. Use 
this functional node to grant Partner company users access to specific company-level and 
project-level or shell-level features. 

Company Users 

Company users are the main users that will have access to Unifier and your company's 
functions. Use this functional node to grant Company users access to specific company-level 
and project-level or shell-level features. 

Partner Users 

Partner users are members of partner companies that can be given permission to access Unifier 
and specific company functions. Use this functional node to grant Partner users access to 
specific company-level and project-level or shell-level features. 

Groups 

Use this functional node to create and manage groups, such as Project Administrators. You can 
also specify the applicable Permissions for the group, and manage the group membership. 

Task Reassignment 

Lets you reassign tasks to another active user. The assignments are divided in the following 
categories, which have their own log: 

 Active User Tasks

 Inactive User Tasks

Integration Users 

Integration users can perform integration, using external programs to import data into Unifier. 
Use this functional node to grant Integration users access to run requests related to 
Representational State Transfer (REST)ful services. 

Access Control 

Use this option to see the users and groups who have access to each module (access range is 
from the Admin mode to the User mode, including the individual modules or managers), to see 
the permission settings, and to make changes to the permissions. 

General Administration 

The General Administration grouping node contains the following functional nodes: 

Announcements 

Lets you create announcements and indicate who should see the announcement -- users, 
bidders, or both. 
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License Manager 

Displays the number of licenses allocated to each user type, such as Standard, as well as the 
current number of active users. Also provides access to the License Terms option in which you 
can enable alerts regarding the level of consumption. 

Consent Notice 

The Consent Notice contains the following functional nodes: 

User Consent

Lets you create and enable consent notices that require each user to accept or reject 
acknowledgment of the notice on the first login occurrence. 

Consent Status

Lets you track the status of each recipient's response. 

Bidder Consent

Lets you create and enable consent notices that require each bidder to accept or reject 
acknowledgment of the notice on the first login occurrence. 

Consent Status

Lets you track the status of each recipient's response. 

Customer Support Logins 

Lets you view the name and contact information for those identified as customer support. You 
can also see when each customer support person last logged in and out. 

Data Structure Setup 

The Data Structure Setup grouping node contains the following functional nodes: 

System Modules 

Lists the various modules (grouping nodes and functional nodes) that provide Unifier 
functionality. 

Data Cube Definitions 

Lets you view and create queries for extracting data and displaying it on dashboards. 

Data Definitions 

Lets you view and update the values and labels assigned to the following categories of data. 
Additional information might include the data type, data size, data source, how it is entered, and 
so on. 

 Basic

 Cost Codes

 Data Picker
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Data Elements 

Lists the Data Elements defined for your environment. A Data Element is a field, and it is defined 
by using a Data Definition. A Data Element consists of a name and label, and it might be a text 
box, a menu, a checkbox, and so on. 

Data Indexes 

Lets you create user-defined indexes that speed up the performance of large data sets. 

Data Views 

Lets you create and deploy SQL data views that can be used as a data source for custom 
reports, user-defined reports (UDRs), and Data Cube Definitions. 

Dynamic Data Sets 

Lets you view and update a list of data sets that control what other data elements display or how 
they behave. For example, you can use a data set to control how checkboxes behave when a 
user has multiple-choice options. 

Reports 

Lets you view a list of the following types of reports that were loaded by your Site Administrator. 

 Custom

 System

Statuses 

Lets you view a list of the following types of status that were loaded by your Site Administrator. 
The status indicates the state of a line item or record, such as approved or pending, at any point 
in the business process. 

 Asset Statuses

 Line Item Statuses

 Record Statuses

 Tags

ER Views 

The Entity Reference (ER) Views functional node provides a list of modules and a corresponding 
tabular view of the Data Elements and Data Definitions for each. 

uDesigner 

The uDesigner grouping node contains the following functional nodes: 

Business Processes 

Displays a list of the Business Process templates. 
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Activity Manager 

Displays a list of activity, OBS, and  WBS sheets (the activity manager components). 

Asset Manager 

Displays a list of assets, based on the asset type. 

The Asset Manager is where users can enter company assets into Unifier, set up depreciation 
schedules for them, and classify them into categories to make managing them more efficient. 
Ultimately, they can gather these assets onto a sheet to track asset depreciation in monthly, 
quarterly, or yearly increments. 

The Asset Manager uses the three most common depreciation methods— straight line, double 
decline, or sum of year digits—as well as manual depreciation. 

Configurable Modules 

Displays a list of configurable managers, including their description, type, and other related 
information. 

A configurable manager is a manager that has been especially created for your company. Up to 
25 managers can be created to consolidate and monitor any entities you want. Configurable 
managers differ from the managers that are shipped with Unifier in that configurable managers 
can roll up not only currency amounts, but also quantity amounts. 

You can design two kinds of managers: Code and Records-based and Code-based. 

    A Code and Records-based manager employs both codes to create a tracking sheet and 
records of individual items. 

    A Code-based manager employs only a sheet to keep track of the values it is monitoring. 

From a Code and Records-based manager, you can drill down from the sheet to individual 
items; from a Code-based manager, you cannot. 

Cost Manager 

Displays a list of the cost-related attributes. 

Document Manager 

Displays a list of the folder- and document-related attributes. 

Planning Manager 

The Planning Manager is where Unifier users can plan for new projects and proposals and 
create forecasts for those projects that are already running in Unifier. They cannot administer 
planned projects the way they administer real projects in Unifier; however, they can manage the 
planning phases for these projects as business processes in Unifier using the same functions 
used by other business processes. 

Resource Manager 

Displays a list of resources, their owners, status, level, type, and other related information. 
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The Resource Manager is where Unifier users can set up and manage a company’s personnel 
resources. These resources are always maintained at the company level, to be distributed 
among the company’s projects. 

The Resource Manager classifies job functions into roles that can then be allocated to projects. 
These roles are used to define billable rates, which are used in budgeting, and can also be used 
in planning for resource demands across projects. Roles are associated with personnel 
resources—the people who can perform these roles in a project. The Resource Manager is 
where users assign personnel to roles and projects. 

The Resource Manager manages time sheets, and also hard and soft resource bookings using 
a calendar that shows what projects a resource has been booked for, as well as the resource’s 
availability. 

Schedule Manager 

Displays a list of schedules, their owners, status, level, type, and other related information. 

The Schedule Manager is where Unifier users can create and manage schedules at both the 
project/shell and program level. They can create a schedule sheet that is customized to a 
project's or shell’s needs. Once these sheets are created, users can then use them to create 
project/shell activities and tasks, assign resources to tasks, create relationships between 
activities, track schedule progress and variables, and calculate the schedule’s critical path. 

Space Manager 

Displays a list of space-related items, their owners, status, level, type, and other related 
information. 

A space is an entity—such as a cubicle, office, or conference room—that resides on a level in 
the Space Manager. 

Shell Manager 

The Shell Manager is where uDesigner users create the shell types that will be used in Unifier. 
In Unifier, administrators group shells into hierarchies, create shell “instances,” and specify what 
functions and features will be included in the shell, such as a cost manager (standard or 
generic), Document Manager, Schedule Manager, etc. 

User Administration 

Displays a list of the user attributes, including logs and pickers, their owners, status, level, type, 
and other related information. 

Configuration 

The Configuration grouping node contains the following functional nodes: 

Business Process 

Displays a log of the Business Processes that have been imported and lets you update their 
configuration settings. 
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Document Manager 

Lets you configure views for the Folder and Document Attributes log. 

Planning Manager 

The Planning Manager is where Unifier users can plan for new projects and proposals and 
create forecasts for those projects that are already running in Unifier. They cannot administer 
planned projects the way they administer real projects in Unifier; however, they can manage the 
planning phases for these projects as business processes in Unifier using the same functions 
used by other business processes. 

Portfolio Manager 

Lets you configure the scenarios that should be analyzed by each portfolio component. 

Resource Manager 

The Resource Manager is where Unifier users can set up and manage a company’s personnel 
resources. These resources are always maintained at the company level, to be distributed 
among the company’s projects. 

The Resource Manager classifies job functions into roles that can then be allocated to projects. 
These roles are used to define billable rates, which are used in budgeting, and can also be used 
in planning for resource demands across projects. Roles are associated with personnel 
resources—the people who can perform these roles in a project. The Resource Manager is 
where users assign personnel to roles and projects. 

The Resource Manager manages time sheets, and also hard and soft resource bookings using a 
calendar that shows what projects a resource has been booked for, as well as the resource’s 
availability. 

Shell Manager 

Lets you update configuration settings for shell types, such as project number, cost codes, and 
status. 

Space Manager 

Displays a list of configured space items, their level, status, and ID. 

Custom Templates 

Lets you create and update Oracle Analytics Publisher-based Custom Reports and Custom 
Prints. 

Navigation Tabs 

Lets you view the order in which the tabs for the Company Workspace and each shell are 
displayed in the tabs row. Also lets you rename the Company Workspace tab and the 
Organization and Test shells. 
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User Mode Navigator 

Lets you update the appearance and organization of the modules and business processes that 
are available in the left Navigator for all company users. 

Landing Page 

Displays the available landing pages, their type, status, and other related information. 

Internationalization 

Lets you view a list of translated content for customized strings and rename data element labels 
and other system strings by updating the English column. In addition to the translated items 
provided with Unifier, you can provide users and groups with translation privileges with the 
option of viewing translations or configuring them. 

Stamps 

Displays a list of available stamps along with their description. 

Material Inventory Manager 

Displays an inventory list of the materials at the project or shell level. 

The Material Inventory Manager is a Project/Shell level Code and Record-based type manager. 

If you are using a Code and Records-based configurable manager, there are sheets and classes 
(for example, Sheets and Material Inventory Manager). 

 To access a sheet, click the Sheets node, and select a sheet from the log. 

 To access a class, select a class. The log for the class opens. 

If you are using a code-based configurable manager, there is just one sheet, which is listed 
under the log (for example Parts Manager). 

Integrations 

The Integrations grouping node contains the following functional nodes: 

Analytics 

Use this node to define data mapping between Unifier data sources and Primavera Analytics 
subject areas. See Unifier and Primavera Analytics (on page 343) for more details. 

Bluebeam 

If Bluebeam is enabled for your environment, use this node to configure the information that is 
tracked throughout review sessions. Refer to the Bluebeam User Guide for more details. 

Event Notifications 

Use this node to view events triggered by steps reached within Business Processes. See Event 
Notifications (on page 89) for more details. 
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Gateway 

Use this node to view information about specific objects within Unifier and whether 
communication with other objects has been enabled.See Unifier and Primavera Gateway (on 
page 388) for more details. 

Business Objects

Use this node to view a list of the objects that are available in your environment. See 
Business Objects Node in Unifier (on page 396) for more details. 

Standards & Libraries 

The Standards & Libraries grouping node contains the following functional nodes: 

Calendars

Lets you create multiple calendars, which supports using a library of calendars that can be 
selected for use at the company, shell, and project levels and accounts for holidays and other 
non-working days in a range of locales. 

Cash Flow 

The Cash Flow node consists of the following functional nodes: 

The Cash Flow feature is a way to view a time-based record of income and expenditures, which 
can be presented in tabular or graphical format. It enables users to create a baseline for project 
expenditures, track actual costs, and calculate future expenditures based on a known forecast or 
calculate from trends compared to “Baseline” curves. 

Data Sources

Lets you define budget sources and curve types, and customize the display and order for 
graphical elements. 

Distribution Profiles

Lets you create and manage profiles that can be used for the display of cash-flow graphics. 

Templates

Lets you create and manage templates used in the display of cash-flow graphics. 

Currencies 

Use this node to create and manage different currencies to suit business requirements. 

Exchange Rates 

Use this node to create and manage the exchange rates for different currencies. 

Permission Templates 

Lets you create templates for permission sets that you can subsequently apply to individual 
users or to group. 
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User Preference Templates 

Lets you create templates for a default set of user-based preferences that you can subsequently 
apply to existing users and to new users. 

Approved Email List 

In addition to the dedicated company email address that was originally specified for your 
company, use this node to create and manage project/shell-specific identifiers that are used in 
conjunction with the company email. You can also specify additional email addresses that are 
approved for use within your organization. 

Period Structure 

Use this node to define and manage time periods that support cost calculation for budgets used 
in cash flow and portfolio management. The default setting is monthly, but you can define 
alternate periods such as different fiscal years, quarterly periods, twice yearly periods, and so 
on. 

Seasonal Dates 

Supports work-order management for preventive maintenance. 

P6 Data Sources 

Displays a list of P6 data sources. 

The P6 Data Sources enables you to access the following information, based on your 
permissions:  

Data source

Captured from P6 Summary Sheets, for use in Cost Sheets or Cost Sheets Templates. 

Examples of P6 Data Sources: Current Schedule Summary, Original Baseline Summary, 
Sanctioned Baseline Summary 

Dataset for the attribute "Type" for P6 Summary Sheets

Note: Unifier allows a maximum of 12 P6 Data Sources to be integrated, 
with "Current Schedule" as one of the 12 P6 Data Sources must be 
named. 

Configuration Package Management 

You can manage the configuration package creation and import through the Configuration 
Package Management grouping node in the left-hand Navigator. The Configuration Package 
Management grouping node contains the following functional nodes: 

Component Lists 

Displays a list of all components in a configuration package. 
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Add-on Component Lists 

 Displays a list of add-on components and enables you to create an add-on component list in 
order to create a configuration package that can be imported in to a different development 
environment. 

Note: The Add-on Component Lists functional node, when included 
with the Component Lists functional node, is available in the 
development servers, only. 

The Add-on Component Lists functional node is available for the users who have "Enable" 
permission for the Configuration Package Management grouping node. 

The Add-on Component Lists and the Add-on Configuration Packages (below) follow the 
same naming convention as regular Component Lists and Configuration Packages, for package 
names. Similar to the component lists, the add-on component lists can be saved with or without 
performing error check. 

Configuration Packages 

Displays a list of component packages and enables you to create and import newly created or 
existing component packages. 

Add-on Configuration Packages 

Lists all of the added configuration packages existing in the Development environment and is is 
available for the users who have "Enable" permission for the Configuration Package 
Management grouping node. 

System Information 

The System Information grouping node contains the following functional nodes: 

Auto Creation Audit Log 

Use this node to view the auto creation events across the company. You need to have the View 
permission for "Auto Creation Audit Log" functional node.  

Autopublish Log 

Use this node to view the status—successful or failed—of all auto-publish events. 

Background Jobs 

Use this node to view the status of tasks, such as reports, that are running or waiting to run. 

Background Jobs History 

Use this node to view a log of background jobs that have already occurred. 

Event Audit Log 

This functional node tracks all action events across the company that are initiated by a click. 
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Rest Services Audit Log 

This functional node tracks all action events that occur through REST Services. 

System Reports 

Lets you run any set of predefined reports, and output the information to different formats. 

Templates 

The Templates grouping node contains the following functional nodes: 

Shells 

Enables you to create and maintain templates of the following shell types. Shell templates are 
used to create new or update existing shells. 

 Buildings

 Linear Assets

 Projects

Commitment Summaries 

Displays a list of summaries for all the Commit Cost Business Processes. 

Configurable Modules  

The Configurable Modules consists of the following sub-nodes: 

 FCA Manager

The Facility Condition Assessment (FCA) manager is a Project/Shell level Code-based type 
manager with the following components: 

 Detail Form

 Picker

 Generic Cost Manager

 Material Inventory Manager

 Parts Manager

Cost Sheets 

Enables you to create and manage Cost Templates that can help you track and manage cost in 
projects, shells, programs, and across the company. 

Folder Structures 

Enables you to create and manage templates for the folder and subfolder structure used in a 
shell document manager. 

Funding 

The Funding node consists of the following functional nodes: 
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 Funding Sheets: Enables you to create and manage one template for a company funding 
sheet and multiple templates for shell/project funding sheets. 

 Commitment Funding Sheets

 Region/District 

 Site/Campus

General Spends SOV 

Use this node to define the required columns and formulas that are used to validate summary 
commitments. 

Reports 

Enables you to create and manage user-defined reports (UDRs) that can be added to a shell or 
shell template. 

Rules 

Enables you to create and manage the requirements that are used to validate the steps taken 
for business process records. 

Schedule Sheets 

Enables you to create and manage schedules of activities within the company. 

Company Workspace 

The Company Workspace node contains the following functional nodes: 

Business Process Setup 

Enables you to configure how a business process deployed at the Company level will function. 

Business Process Updates 

Enables you to update Preventive Maintenance (PM) Books for PM functionality at the Company 
level. 

Planning Manager 

Provides sponsoring companies the ability to create, organize, manage, and update all company 
or project/shell planning initiatives from conception to completion. 

Resource Manager 

Enables you to create and manage personnel resources and assign roles to each resource.  

 Roles

 Resources
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Rules 

Enables you to create and manage rules that govern transactions on the Company level cost 
sheet. 

Auto-update Status Setup 

Enables you to configure automatic updates of project statuses for active projects. 

Programs 

The Programs functional node displays a list of Programs, their names and status. 

Company Sponsored Projects (Standard) 

The Company Sponsored Projects (Standard) grouping node contains the following functional 
node: 

All 

This functional node lists all of the Projects (Standard) that are company sponsored. 

Company Sponsored Shells 

The Company Sponsored Shells node enables you to configure and manage multiple aspects, 
such as access, user administration, and rules, of the following types of shells: 

 All Projects

 All Properties

 Buildings

 Enterprises

 Land

 Linear Assets

 Projects

 Regions

 Sites
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Program Landing Page (Admin) 

To access your program landing page (Admin):  

1) Click your program tab to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, on the very top, click your program name. 

The program landing page has the following elements: 

 Left-hand pane (Navigator) which contains the following nodes (modules): 

 Program name 

 Summary 

 Other nodes (such as Cost Manager, Schedule Manager, etc.) 

 Reports 

 Right-hand pane which contains: 

 On the top: 

 Tab name 

 Menu options (File, Edit, View, and Help) 

 Toolbar options (New, Open, and Find) 

 Below the top, on the left, program general information: 

 Program name 

 Program Number 

 Location 

 Email Address 

 Description 

 Below the top, on the right: 

 Links 
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Shell Landing Page (Admin) 

Once you create a shell, it is available for use. To access your shell landing page:  

1) Click the shell tab to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, click your shell name on top. 

The top section of the landing page contains the Shell Dashboard. 

By default, the shell dashboard contains the following blocks: 

 Tasks

 Notifications

 Mail

 Image

 Details

 Links

By default, the following two tabs are displayed. 

 Summary

 Workspaces

You can change the layout of the tabs in My Dashboard. 

Example 

Block Length: 2 units 

Block Height: 2 units 

The following explains the various informational blocks in the Summary tab:  

 Tasks

This block lists the total number of tasks belonging to the shell. In User mode, when you click 
on Tasks you go to the Task log directly. 

 Notifications

This block lists the total number of notifications belonging to the shell. In User mode, when 
you click on Notifications you go to the Notifications log directly. 

 Mail

This block lists the total number of e-mails belonging to the shell. In User mode, when you 
click on Mail, you go to the Inbox log directly. 

Note: Accessing the Tasks, Notifications, and Inbox logs by clicking their 
respective tabs is not supported in Admin mode.

 Image

This block displays an image, if available; otherwise, the block will be blank. 

 Details
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This block is displayed with either custom fields or default fields based on the configuration of 
the details block that is designed in uDesigner, shell manager. In the latest version of Unifier, 
the shell home landing page displays the custom fields; otherwise, the shell home landing 
page displays the default fields, only. 

You can edit the details block by clicking My Dashboard > Edit Dashboard and using the 
pen icon that appears when hovering over the block. This capability applies to block 
information, or to the fields that must be displayed in the block. 

 Links

If links have been added to the shell details, then those links are displayed in this block. 

Important Information

The Tasks, Notification, and Mail are grouped together in a standard block called "Items 
Requiring your Attention" that can be added or removed. Individual tiles cannot be added or 
removed. 

You can add this block by navigating to the Add Block button (the plus button with a down 
arrow), clicking Standard, and selecting Data Type as "Items Requiring Your Attention." When 
you save the Standard Block, the block will be added automatically to the dashboard. 

The following explains the various informational blocks in the Workspaces tab: 

The Workspaces tab is available when geo-code server details are configured in Unifier, only. 

 If there is no geo-location present in the sub-shells, Unifier displays a map without location 
markers. 

 If there is a geo-location present in the sub-shells, Unifier displays a map with location 
markers. 

When you hover over the location markers on the map, you can see the details for the location 
marker based on available information. 

When you right-click on the location marker, you can open the shell (for that location) in a new 
tab, in Unifier. 

The left pane of the workspaces tab displays a log of all sub-shells that have been created under 
the currently selected shell. You can access sub-shell dashboards by clicking the gear menu 
and clicking Open. If you would like to navigate backwards to parent shells, you can use the 
breadcrumb links listed above the Workspaces tab. 

The user-created dashboards support all of the existing functionalities, except the sub-shell log. 

You can show or hide this tab in the Edit Dashboard window. 

You cannot delete the Workspaces tab in any Dashboard. 

The My Dashboard sub-menu (the three dots) enables you to: 

 Access additional dashboards for the shell, if available. 

 Edit Dashboard 

To open the editing mode of the current dashboard. 

 Details 

To view the shell details, as overlay. The details include: Shell Name, Shell Number, and the 
following tabs: 
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 General 

 Currency 

 Options 

 Images 

 Links 

 Calendar 

 Custom Print Template 

 Gateway Integration 

 Print 

To print the information on this page. 

 Audit Log 

To open the Audit Log as an overlay. 

The Workspaces tab Sub-shell log has the following toolbar options: 

 View 

For example, Buildings, Land, Projects, Regions. 

 Group By 

Select, Hierarchy. 

 Actions 

 Get Activity Sheet Data 

All Shells 

Selected Shells 

Filtered Shells 

History 

 Send Activity Sheet Data 

All Shells 

Selected Shells 

Filtered Shells 

History 

 Search 

 Find on page 

 Expand All Groups 

The columns in the Workspaces tab sub-shell log are not hard-coded. The fields defined in Shell 
Detail form (in uDesigner) are added as columns in the Sub-shell log. 

 Name 

 Shell Number 

 Shell Name 

 Description 

 Status 

 Administrator 
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 Location 

 User-Defined Text  

The right-hand pane displays the map that shows the regions. 
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Project Landing Page (Admin) 

To access your project landing page (Admin):  

1) Click your project tab to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, on the very top, click your project name. 

The project landing page has the following elements: 

 Left Navigator contains the following nodes (modules): 

 Project name 

 Member Companies 

 Access Control 

 User Administration 

 Setup 

 Rules 

 Right-hand pane which contains: 

 On the top: 

 Tab name: Company Workspace 

 Menu options (File, Edit, View, and Help) 

 Toolbar options (New, Open, and Find) 

 Below the top, on the left, project general information: 

 Project name 

 Description 

 Number 

 Address 

 City 

 State 

 Country 

 Phone 

 Fax 

 Email Address 

 Below the top, on the right: 

 Progress 

 Links 





51

Queries 

You will be using queries to extract data from the database for reports and data pickers, and to 
set up auto-creation with creator elements.  

A query is a data mining tool—a method for retrieving information from a database. A query 
filters the information returned from the database according to restrictions or conditions you 
specify. The Unifier queries can: 

 Filter or narrow the data being retrieved for use in reports and manager sheets 

 Set up conditions or triggers to make something happen automatically in Unifier 

 Filter or narrow the data being retrieved for use in a data picker element 

In This Section 

How Queries Work .................................................................................................. 51 
Using Formulas or Conditions in Queries................................................................. 52 
Assignee Filter Query Condition .............................................................................. 56 
Query Based Data Element (QBDE) ........................................................................ 57 
Defining the Format of the Currency for QBDE ........................................................ 59 

How Queries Work 

The way queries work in Unifier is as follows: 

 You mine down to the information you want by choosing an element (field) in the database 
on which to base the query. 

 You test the data against conditions and values you specify. 

A condition is a state or restriction the value in the data element (field) must meet. A 
condition of the value might be that it must be equal to a certain number (maybe 10) or that it 
must contain a certain string of letters (such as "due date of"). 
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 When (or if) the data meets the condition you specify, Unifier retrieves it from the database 
for use in a report, manager sheet, auto-creation, data picker, etc. 

Using Formulas or Conditions in Queries 

For queries, you can evaluate the data before retrieving it from the database to determine 
whether or not to include the value in the report, manager sheet, or data picker, or to spawn an 
auto-creation. To evaluate the data, you can use a formula or a condition. 

In formulas, multiple fields can be calculated to arrive at a certain value that the data must meet 
before it will be used. The value can be one that you enter, or a value from another field. 

You can include formulas in conditions. 

In the Condition field, select the condition the value in the field must meet.  

The following explains the formulas you can use in a query. 
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Field Value Comparison 

The formula for field value comparison produces data that meets a field value (string or numeric) 
from the form of a business process or a shell in a hierarchy, or a constant. This is then used to 
populate a data picker.  

Date Plus or Minus 

The formula for date adds or subtracts a value to or from a date.  



Unifier General Administration Guide

54

Date Difference 

The formula for date difference subtracts one date from another to give you the number of days 
between the dates.  

Compare Date Fields 

You can also compare date fields as part of a query.  
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Dynamic Date Value 

You can compare a date field value with a date field from the form of a business process or a 
shell in a hierarchy, a specific date, or today's date, and also add or subtract days to the result. 
This is then used to populate a data picker.  



Unifier General Administration Guide

56

Between Dates 

You can compare a date field value to see if it falls between two dates. This is then used to 
populate a data picker.  

Assignee Filter Query Condition 

When you are setting up a business process, you can filter the condition for the assignee 
according to: 

 Contains 

 Does not contain 

 Exists in 

 Does not exist in 

 Equals 

 Does not equal 

 is empty 

 is not empty 

The following is an example of query evaluation. The workflow setup follows these policies for 
selecting users. 

Assignee Query Field (Role as defined in the User Attribute Form) 

A Approver 
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Assignee Query Field (Role as defined in the User Attribute Form) 

B Reviewer 

C Controller-Approver 

D Controller 

E Reviewer-Submitter 

F Submitter 

G Approver 

The following shows examples with condition/operator: 

Condition/Operator Business Process Form (Field value)

Example of the data source used. 

Filtered List of 
Assignees 

exists in Controller-Approver A, C, D, G 

Reviewer B 

does not exist in Controller A, B, C, E, F, G 

Note: If the workflow setup has any of the new operators, the list of 
assignees that the user sees at runtime retains the stated query 
parameters. 

The following shows examples with value, condition/operator, and result:  

Value 1 Condition/Operator Value 2 Result 

ABC exists in ABC, BCD, CDE True 

XYZ exists in ABC, BCD, CDE False 

ABC does not exist in ABC, BCD, CDE False 

XYZ does not exist in ABC, BCD, CDE True 

ABC, BCD, CDE contains ABC True 

ABC, BCD, CDE contains XYZ False 

ABC, BCD, CDE does not contain ABC False 

ABC, BCD, CDE does not contain XYZ True 

Query Based Data Element (QBDE) 

In Unifier, a Query Based Data Element (QBDE) enables you to view data from the Upper Form 
or Detail form of a Business Process. QBDE also enables you to view data from: 
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 Other Business Processes 

 Sheets 

 Cash Flow 

The QBDEs are based on the “SYS Numeric Query Based” Data Definition (DD), and the query 
for these QBDEs is set in the Business Process Configuration setup. See the "Configure a 
Query for a Query Based Data Element on a BP" for additional details. 

In addition to the Web interface (Unifier Application in the browser), the system evaluates QBDE 
in the following areas: 

 CSV import for record creation 

 CSV import for Line Item creation 

 Web Service methods for record creation along with Line items 

 Web Service methods for Line Item creation 

 Web Service methods for record updates 

 Bulk Edit 

 Bulk Update 

 Creating BP records using BP Template 

Evaluating Query Setups of Data Picker Data Elements 

Unifier supports many types of Data Picker DEs. The Administrator can set up Query conditions 
on these Data Picker DEs to filter the results. When a Data Picker DE is launched in the Web 
interface (Unifier Application in the browser), the system runs the query and displays the records 
based on the queries defined in uDesigner. The system evaluates the data picker query 
conditions in the following areas, as well: 

 CSV import for record creation 

 CSV import for Line Item creation 

 Web Service methods for record creation along with Line items 

 Web Service methods for Line Item creation 

 Web Service methods for record updates 

The following is a list of the supported Data Pickers: 

 BP Data Picker 

 Shell Data Picker 

 User Data Picker 

 CM Data Picker 

 Role Data Picker 

See the "Importing Configuration Packages" section for more information about importing data. 

Creating a Record from the Query Based Tab  

When creating a record from the Query Based tab of another BP (that auto-populates data to the 
record being created), the Data Element (DE) of type “SYS Numeric Query Based” Data 
Definition (any DE of this type) is not updated, unless the user manually changes the trigger 
element. 
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Defining the Format of the Currency for QBDE 

You can use the QBDE to get the count of records. As a result, you can format the DEs that are 
query-based to hide the currency symbol. That is to say, you have the option to hide the 
currency symbol, at the data element level. As a result, when viewing the value in a query-based 
DE, Unifier displays the correct format so that the number makes meaningful sense.  

Example 

A Budget Change BP may have the 'Count of Change orders' QBDE (defined as a DE of 
SYS Numeric Query type) associated with the BP. On the same BP, there may be another 
QBDE 'Sum of All Change Orders' which needs the formatting of a Currency DE. You can 
choose whether or not to display the currency symbol for these DEs at runtime. 

In the Admin mode, you define the Data Element (DE) that is query-based, add it to the BP 
form, and set up the query. In the User mode, you can see the results in the run-time (for 
example, displaying or not displaying the currency symbol). 

The Data Element properties tab of SYS Numeric Query Based Data definition contains a 
checkbox option for hiding currency symbol in Cost type BP. By default, this option will be 
unchecked. 

Note: When the same DE is placed in non-Cost BPs, this option will be 
ignored since these BPs do not display currency symbol for data 
definition with Input type of Currency Amount at runtime. 

Go to: Company Workspace (Admin mode) > Data Structure Setup > Data Elements to find 
the DEs that are query-based. 

Click Find and enter "qbde" in the Search for field box to find the DEs. 

When you open a query-based DE (Modify Data Element window), you have the option to 
select, or deselect, the Hide Currency Symbol in Cost type Business Process option. 

Depending on your selection, Unifier displays, or hides, the currency symbol for the query-based 
DE. 

Configuration Package

The format set in the DE must be included in the bundle. 
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Dashboards in Unifier 

Similar to other software applications, the dashboard in Unifier is a user interface that provides a 
view of important performance indicators and data related to the shell, organization, or company.  

The shell dashboard is a general view of a specific shell's data, and it is not specific to any one 
user view of data; therefore, the administrators can create multiple shell instance dashboards 
per shell. 

Administrators can configure the dashboard from the Dashboards sub-node, under the Setup 
node: <shell> (Admin mode) > Setup > Dashboards. 

The Dashboards log contains a list of existing dashboards, and the details are listed in the 
following columns: 

 Name

 Description

 Last Modified By

 Last Modified Date

Use the gear menu located next to each item on the log to conduct the following on each 
dashboard listed: 

 Open

 Copy

 Mark as Default (Unmark as Default) 

 Delete

Depending on the setup, this option will change. If the Mark as Default option is available, 
the selected dashboard name will replace the label: My Dashboard on the shell landing 
page. If the Unmark as Default option is available, the label My Dashboard will replace the 
selected dashboard name on the shell landing page. 

The Dashboards log also lets an administrator: 

 Create, delete, or find dashboards by using the following toolbar options: 

 Create

 Delete

 Find on Page

 Change the dashboard properties and set permissions within the following tabs on the 
right-hand pane: 

 Properties tab 

 Change the dashboard name (Name) 

 Provide a description for the dashboard (Description) 

 Permissions tab 

 Displays the Selected Users/Groups

 Enables you to Add User

 Enables you to Delete User
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If a user has the View permission, the user can only view an existing dashboard: <shell> (User 
mode) > My Dashboard > <dashboard>, as shown below. 

Figure 1: My Dashboard - View only 

If a user has the Edit permission, the user can edit My Dashboard: <shell> (User mode) > My 
Dashboard > Edit Dashboard, as shown below.  

Figure 2: My Dashboard Edit 

A user who creates a shell can create a dashboard for that shell. 
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Self-Service Portal 

The Self-Service Portal enables users to sign in and work with specifically-enabled business 
processes. For example, Oracle Primavera customers use Unifier for corrective work order 
management. These work requests are usually generated from project participants who do not 
use Unifier. These participants can use the Self-Service Portal, which allows request submittals 
through a web-based tool. Users can use the Self-Service Portal to submit requests and to view 
the status of these requests, and to collaborate on submitted requests. 

In uDesigner, you can enable certain business processes to be accessed through the 
Self-Service Portal. The business processes that you can enable to be accessed through the 
Self-Service Portal must have the following characteristics: 

 Simple 

 Company level 

 Non-workflow 

 Multi-record 

The actions users can take through the Self-Service Portal are: 

 Create a business process 

 Modify a business process 

 Add or remove business process attachments 

 Add General Comments to a business process 

Before you begin, design the Landing Page in terms of the text and graphics that you want it to 
contain. Then: 

Step 1: Set Landing Page permission. 

Step 2: Configure and activate the Landing Page. 

Step 3: Specify users that receive portal-specific notifications. For more information see "Setting 
up a Non-Workflow Business Process" in the Unifier Modules Setup Administration Guide. 

Setting Up a Self-Service Portal Landing Page 

Note: You must have Configure permission to be able to configure a 
Portal Landing page. 

To set Landing Page permissions: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Open the User Administration grouping node and click Access Control in the left 
Navigator. 

3) On the right pane, select Administration Mode Access > Configuration > All > Landing 
Page. 

4) Set the permission as needed: Configure: Administrators can configure Self-Service Portal 
Landing Pages. 
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Configuring and Activating a Portal Landing page 

If you have the Configure permission for the Self-Service Portal Landing Page, then you can use 
an HTML editor to set up a Landing Page. After you configure and activate the Portal Landing 
Page, users signing in to the Self-Service Portal will see this landing page. You can configure 
one Landing Page, and activate this page for use. 

Note: If the Landing Page is not configured, then the user who signs in 
to the Self-Service Portal will see the Announcement page. 

To configure and activate a Portal Landing page: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Configuration > Landing Page in the left Navigator. 

3) Click New. 

4) Enter the Setup Name of the Landing Page, and an optional Description of the page. The 
default initial status of the page is Inactive. You can change this status after you complete 
the page. 

5) Click the Layout tab. 

6) Use the HTML editor to add text, and perform other editing functions. 

7) Click the Insert Image button (second button from the right in the toolbar) to insert an image 
into your Landing Page. Browse for the image, and click OK, and Close after the upload is 
complete. 

8) Click OK. 

To activate a Portal Landing page: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Configuration > Landing Page in the left Navigator. 

3) Select the Landing Page in the log. 

4) Choose Status > Active. You can inactivate the Landing Page by choosing Status > 
Inactive. When a Landing Page is inactive, the user who signs in the Self-Service Portal 
sees the Unifier Announcement page. If no active Landing Page is set up, the portal user 
sees a default Landing Page. 
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Access Control and AutoVue Stamps 

The following permissions are available:  

 Create 

The user will be able to perform all the operations on a stamp (Import, Download, Create, 
Delete, and Edit) along with changing the Stamp data elements selection. 

 Modify or Delete 

The user will not be able to create or import stamps into Unifier, but the user will be able to 
perform the rest of the operations on the stamp. 

 View 

The user will not be able to edit or delete stamps, but the user will be able to open and 
download the stamp. 
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Adding & Managing Partner Companies 

A sponsor company may work with one or many partner companies (for example, 
subcontractors, vendors, etc.) to work on projects, shells, or company level activities. Company 
Administrators can manage partner companies and users. The Site Administrator will first add 
the potential partner company to the list of available companies, from which you can select the 
companies to activate. Partner company users can be granted access to specific company level 
and project-level or shell-level features. 

Note: Contact your Site Administrator to add a company to the list of 
available companies. 

To access partner companies 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration grouping node to expand. 

3) Click the Partner Companies functional node in the left Navigator. The Partner Companies 
log opens. The log will display any current partner companies. 

In This Section 

Add a Partner Company .......................................................................................... 67 
Remove a Partner Company ................................................................................... 68 
View Partner Company Profile ................................................................................. 68 

Add a Partner Company 

Adding a partner company to the list allows you to work with partner company users within the 
system.  

To add a partner company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration grouping node to expand. 

3) Click Partner Companies in the left Navigator. The Partner Companies log opens. 

4) Click the New button. The New Company window opens to display the following tabs: 

 General: To input identifying information about the company, such as the company name 
and home page URL. 

 Address: To input the company address information. 

 Security: To set up the password and login policy for the users from the company.  
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 Contact: To add contact information for support resources. 

5) In the General tab, set the status to Active to enable users from the company to be added 
to company, project, or shell functions.  

6) Once all the information is added, click OK to save. 

7) To search for a particular company, click the Find button. The Find box opens at the top of 
the window. Click the Search By drop down and choose Company Name or Contact Name. 
Enter the search criteria in the Search for field and click the Search button. 

Remove a Partner Company 

If you no longer want users in a partner company to participate in your company, project, or shell 
areas, you can set the company status to Inactive.  

 The partner company users that have been added as users either under your company 
(Partner Users node) or in any projects or shells will be deactivated automatically. 

 If the partner company being deactivated has previously been added to a project or shell as 
a project or shell "member company," the company will remain in the Partner Companies 
log, but users will be deactivated. 

 These deactivated users cannot be reactivated unless the partner company status is set 
back to Active. 

To remove a partner company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration grouping node to expand. 

3) Click Partner Companies in the left Navigator. The Partner Companies log opens. 

4) Select a partner company from the list and click Open (or double click). 

5) In the General tab, set the Status to Inactive.  

View Partner Company Profile 

Partner company details are managed by the company administrator for the company, or the 
Site Administrator. You can view the details. 

To view the company profile of a partner company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration grouping node to expand. 

3) Click Partner Companies in the left Navigator. The Partner Companies log opens. 

4) Select a partner company from the list and click Open (or double-click). The Company 
Profile window opens. The information in this window is read-only, and is maintained by the 
partner company's administrator. 
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Access Company Details (Edit Company 
Window) 

Company detail information is managed in the Edit Company window (also known as company 
properties window). To access the company properties window:  

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, from the toolbar, click File and then click Open. The Edit Company
window opens. The Edit Company window has the following tabs: 

 General: In this tab, you can manage several company features. See the table in the 
following topic for details. The fields with red asterisks are required. 

 Address: You can enter up to seven company addresses. There must be at least one 
address entered for the company headquarters. 

 Security: In this tab, you can set up file security policy and password/login policy that 
your users must follow after they signed in to the system.  

 Contact: Maintains support contact and e-Learning access information for your users. 
The information entered here appears in the Support window (Contact tab). To access 
the Support window, click Help, from the upper right-corner of the Unifier window, and 
select Contact Support from the menu. 

 E-Signatures: In this tab you can manage the default e-signature type, DocuSign setup, 
and Adobe Acrobat Sign (Adobe Sign) setup, to use these digital E-signature solutions 
within Unifier documents. 

 Outgoing E-mails: In this tab, you will be able to determine the size of the attachment in 
each outgoing email, in MB. 

In This Section 

Edit Company (General Tab) ................................................................................... 69 
Edit Company (Address Tab) .................................................................................. 73 
Edit Company (Security Tab) ................................................................................... 75 
Edit Company (Contact Tab) ................................................................................... 80 
Edit Company (E-Signatures Tab) ........................................................................... 82 
Edit Company (Outgoing E-mails Tab) .................................................................... 84 

Edit Company (General Tab) 

To complete the General tab: 
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In this field: Do this: 

Name 
Enter a company name, up to 64 characters. It can include 
alphanumeric characters, spaces, and punctuation. 

Short Name 

Enter a one-word short name, up to 60 characters. The Short Name
is a unique, one-word abbreviated form of your company name, and 
is used throughout the system in place of the company name. (For 
example, uDesigner-created business processes and on logs that 
identify partner companies.)  

Description 
Enter a company description. This is displayed on the Administration 
Mode home page. This can be especially useful for identifying 
partner companies, such as subcontractors or vendors. 

Contact Name 

Click Select, then select a user from the User/Group picker. This 
name is displayed on the Company Home Page in Administration 
and User Modes. The list is generated from the list of active users in 
the Company Users log. 

DUNS 
Enter the nine-digit Dunn & Bradstreet business identification 
number. 

Home Page 
URL 

Enter the URL of your company's web site, displayed on the 
Company Home Page as a hyperlink. 

Help URL 

Enter an additional URL to point to internal documentation regarding 
company policies or practices, an intranet site, or other internal 
information that you choose. This is displayed on the Company 
Home Page as a hyperlink. 

Status 
(read-only) 

Company status is controlled by the Site Administrator. 

Image 
Similar to the Image field in the Shell properties, this field allows you 
to include a picture that represents the company. 

Authentication 
Key 

or 

Re-Enter 
Authentication 
Key 

Note: This field 
is available for 
the Site 
Administrator, 
only, and the 
Site 
Administrator is 
the only person 

The Authentication Key provides a means of gaining access to the 
company that you are signing in to. This key was set up at the time 
the company was configured. 

For Unifier Cloud customers, the Cloud Administrators will need to 
enter a unique key to manage the cloud administration services. The 
current key is stored in an encrypted format and can be changed as 
needed. 

If a key has already been assigned to the company, it will not be 
displayed in the field; the field will appear blank. 

Re-enter the key in the following field to confirm it. 

This field is not available on the General tab, for the company 
administrator. The company administrator must access the 
Integration Users sub-node to access the authentication key. Read 
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In this field: Do this: 

who can change 
the value. 

"Changing the Authentication Key" below for more details. 

Bid 
Management 
Account 

Enter the account name of the user who will be managing the bids 
that your company receives. 

This is the account that will contain the bidder's preferences you 
specify when you create the bid management account. Refer to the 
Unifier Administration Help for more details. 

Owner 

Selecting this option allows a company to sponsor projects or shells, 
and is controlled by the Site Administrator. The checkbox will not be 
selected if the company is a partner company that is not authorized 
to sponsor projects or shells. 

Maximum Limit 
for UDR records

The company administrator will be able to set the maximum number 
of records to be retrieved for the company. By default the maximum 
number will be set to 1 million. The company administrator will have 
multiple options to choose from and then can set the maximum limit. 

Display element 
for Project/Shell 

By default, the "Name" option is selected. Based on the setting in this 
field, the labels change in the following areas: 

Top navigation tabs 

Breadcrumbs 

The first (top) left menu node (Home node) for the Shell/Project 

Bookmarks: Add new bookmark (editable label of bookmark) 

If the user selects the "Name" option to display the Shell name, the 
default string will appear as "{Shell Name} - {Location}" when adding 
a new bookmark. 

If the user selects the "Number" option to display the Shell number, 
the default string will appear as "{Shell Number} - {Location}" when 
adding a new bookmark. 

The tool-tips will be seen in format: {Shell Number} - {Shell Name} 

Hide Tabs in 
Company 
Dashboard 

When checked: 

 No tabs will be displayed on the company dashboard and only 
the company workspace information is displayed. 

 The Summary and other tabs created will be hidden and only the 
General tab will be visible. There will be no General tab heading, 
since there is only one (1) tab on the dashboard. The user will 
only see the General tab along with the logged in user's 
information. 

 The Edit Dashboard option will be hidden. 

By default, this option will be unchecked. So all users will be able to 
view and modify the Summary tab of the dashboard, and the Edit 
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In this field: Do this: 

Dashboard option is enabled. 

Base Currency 

The Base Currency is the default currency used by the company. 
The Base Currency is set by Oracle when Unifier is first provisioned. 
Because the type of currency plays a large role in nearly all financial 
functions of the system, the base currency cannot be changed after 
data has been entered into the system or data issues may arise. 

When an administrator logs into the system the first time, a 
confirmation alert is displayed on screen with the following message: 

"The Base Currency of your company is <Currency Name> 
(<Currency Code>). This currency cannot be changed. If you want to 
change this currency, you must contact your Oracle team 
immediately before creating any data." 

Source for 
Activity Sheet 
data 

Users who have the edit permissions to company properties should 
be able to modify or add the P6 and Oracle Primavera Cloud URLs. 

This block enables you to provide a link to a source (for Activity 
Sheet) application, P6 or Oracle Primavera Cloud: 

 P6 URL (format: https://site_url/p6/...) 

 Primavera Cloud URL (format: https://site_url/web/...)

By default, the URL fields will be empty with a place holder text to 
show the format. There will be no link shown in a project activity 
sheet when a user does not enter any URL in company properties. 

Changing the Authentication Key 

For integration users, the company administrator can access the authentication key value by 
way of the Integration Users sub-node (Company Workspace > Admin mode > User 
Administration node > Integration Users). 

For users who are using Unifier 19.x:
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You (the company administrator) need to create a new integration user in order to change 
the authentication key. 

You need to use the following format to create the integration user: 

User Name - $${shortname} 

Password - {Desired authentication Key} 

If you have upgraded to version 19.7, the system will not create $${shortname} integration, 
by default. In such case, Oracle recommends that you use new token-based REST APIs, 
instead of legacy SOAP and old REST APIs. 

If you have not upgraded to version 19.7, but you have upgraded to version 19.6, the system 
creates $${companyshortname} automatically, by way of the migration process, with the 
password that is the same as the original authentication code. 

To access the authentication value: 

1. In the Integration Users log click on a customer row to open the Update User page. 

2. In the Update User page, scroll to see the Security block. 

3. In the Security block, the value in the User Name field shows the company name (for 
example: $$company short name). 

4. In the Security block, the value in the Password field shows the existing authentication 
key. 

Note: The Site Administrator can change the authentication key, also. 

For users who are upgrading to version 19.x:

As a part of upgrading process, the system will automatically create an integration user by: 

Using the company short name as the integration user. 

Using the existing authentication key as the password. 

That is to state: 

User Name - $${shortname} 

First Name - $${shortname} 

Last Name - $${shortname} 

Time Zone - Company timezone as seen in the Background Jobs 

Language - Company language as seen in the Internationalization node 

If a company does not have an authentication key, then the integration user will not be 
created. 

If a customer already has an integration user $${shortname}, the system will leave it 
unchanged. 

The legacy SOAP and old REST APIs do not access the integration permissions. 

For this created integration user, all legacy permissions will be checked. 

Edit Company (Address Tab) 

Enter the company address information in the following fields. All fields with a red asterisk are 
required:  
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 Address Type: Select from the list. 

 Headquarters 

 Main 

 Branch Office 

 Billing 

 Shipping 

 Billing and Shipping 

 Satellite Office 

 Attention

 Address 1, 2, 3

 City

 State/Province

 Zip/Postal Code

 Country/Region

 Phone

 Fax

For more information, see Manage Company Addresses (Address Tab) (on page 75). 
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Manage Company Addresses (Address Tab) 

At a minimum, a Headquarters address must be entered in the Edit Company window. The 
Headquarters address will be the default company address. The default address displays on the 
Company Home page and is used to generate an online company location map. You can add up 
to six additional company addresses. 

To manage company addresses 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, click Open. The Edit Company window opens. 

3) Click the Address tab. 

4) Complete all fields marked as mandatory (red asterisk *). To enter additional addresses, 
click Address Type and choose another address to enter. See the table below for details. 

5) Click Apply to save changes, or OK to save and close the Edit Company window. 

In this field: Do this: 

Address Type 

Click the field and select from the drop-down list. At a 
minimum, an address for Headquarters is required, 
which is used as the default company address in the 
system. You can enter up to seven company 
addresses (for example, billing). 

Attention 
Click the Select button and select a user from the 
picker. 

Address and phone fields 

These are text fields. No validation will be performed 
on these fields. All fields with a red asterisk are 
required. Select the Country/Region from the 
drop-down list. 

Edit Company (Security Tab) 

The Security tab has the following blocks:  

 File Security Policy

 File Upload Restrictions

 Hyperlink Picker Security Policy

 URI Restrictions

 Cost Sheet Restrictions Policy

 User Attributes Policy

 IP Filtering Policy

 Partner User Proxy Login Policy

 Password/Login Policy
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To complete the Security tab: 

In this block: In this field: Do this 

File Security 
Policy

Size Limit per 
File in MB:

Enter a size limit number 

File Security 
Policy

File Upload 
Restrictions

Allow File Extensions:

Enter the file extensions separated with comma.

Example 

 Allow File Extensions: Selected 

 Allow: .png, .pdf, .jpg 

 Block: Blank 

 Files that the user can upload: .png, .pdf, 
.jpg 

Or 

 Allow File Extensions: Selected 

 Allow: Blank 

 Block: Blank 

 Files that the user can upload: No file can 
be uploaded as nothing specified in Allow. 

Block File Extensions

 Block File Extensions : Selected 

 Allow: Blank 

 Block: .mov 

 Files that the user can upload: All file types 
except .exe and .mov 

Or 

 Block File Extensions: Selected 

 Allow: Blank 

 Block: Blank 

 Files that the user can upload: No 
restrictions, but the user cannot upload .exe 
files since the system prevents it. 

Hyperlink 
Picker Security 
Policy

URI Restrictions

To allow custom Uniform Resource Identifiers 
(URIs) specified by your company. Valid URIs 
must start with a letter, but can contain numbers 
and certain symbols, including "+", "-", and ".".  

Note: When a company chooses to use URI 
Restrictions, by allowing additional URIs, the 
system will relax the current validations that are 
in place for URL standards. However, 
validations will still be applicable to HTTP and 
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In this block: In this field: Do this 

HTTPS URIs.  

Cost Sheet 
Restrictions 
Policy

Override column 
restrictions

View or edit a cost sheet column if any of the 
restricted groups, or the individual user, is 
allowed to view or edit the column. 

By default, this option is not selected. 

User Attributes 
Policy

Hide User Profile
Select this box to hide the basic information of 
the user associated with the field. 

IP Filtering 
Policy

Allow IP 
Addresses for 
REST 
WebServices

Enter IP addresses to allow in the IPv4 or IPv6 
fields by using separators ‘,' (comma) or ‘;' 
(semicolon). 

You may enter IP addresses in CIDR notation 
to allow IPs in a particular range. The maximum 
number of characters allowed for the IPv4 or 
IPv6 fields is 1000, and duplicate IP addresses 
will be removed. This Allow IP list filtering can 
be bypassed if ‘EXTERNAL_REQUEST' header 
parameter is not provided in the request or 
‘EXTERNAL_REQUEST' header parameter is 
set to false. 

Partner User 
Proxy Login 
Policy

Allow Partner 
Users to grand 
Proxy login 
access to Owner 
Company Users

Select this box to allow a Partner User to add 
Owner Company Users as Proxy users. 
Administrators can also add themselves as 
Proxy Users of Partner Users. 

Password/Login 
Policy

Password/Login 
Policy

Select the necessary options and enter values. 
See Manage Company Password Policy 
(Security tab) for details on each field.  
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Manage Company Password Policy (Security tab) 

Sponsor company administrators can specify password security policies in the Security tab of 
the Edit Company window. By default, the minimum password requirement is set at one (1) 
character, meaning that the user is required to create a password with a minimum of one 
character. If a value is not entered in a field, the option is ignored. These settings apply to 
Sponsor/Owner company users only. These will not apply to Partner Company users. For the 
Partner Company users, the default settings apply.  

To manage user password criteria 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, click the Open button. The Edit Company window opens. 

3) Open the Edit Company window and click the Security tab. 

4) Select the password criteria that you want to configure, then enter the value in the text box. 
See the following table for details on each option. 

5) Click Apply to save changes, or OK to save and exit the Edit Company window. 

Select this option: To specify: 

Minimum overall character(s) 
Minimum number of characters that a 
password must contain; default is one (1) 

Maximum overall character(s) 
Maximum number of characters that a 
password must contain 

Minimum numeric character(s) 
Password must contain a minimum amount 
of numbers 

Minimum alphabetic character(s) 
Password must contain a minimum amount 
of letters 

Minimum special character(s) 
Special characters are 
[{~!@#$%^&*()-_=+;:'",<.>/?]} 

Password cannot be same as user 
name 

Users cannot use their user name as their 
password 

Password cannot be same as first or last 
name 

Users cannot use their name as their 
password 

Password cannot be same as last 
A newly changed password must be different 
from previously used ones (indicated the 
number here) 

Password expiration 
If password expires, users will be prompted 
to change it when attempting to log on  

Inform user before expiration 
Upon signing in, users are warned that their 
passwords are about to expire and given the 
option of changing it 

Maximum login attempts If user does not successfully log on after this 
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Select this option: To specify: 

number of attempts, the account will become 
locked 

Suspend inactive user after 
Sets the number of days of inactivity before a 
user's account is locked 

Password recovery secret questions 
required 

If selected, users will be prompted to set up 
security questions for password reset upon 
first login. Existing users will be prompted to 
set up security questions upon the next login.

Note: This option is available for Owner, 
Partner, and Hosting companies. When 
selected, it makes it mandatory for users to 
set up the password recovery secret 
questions. This is applicable to all users in 
the respective companies including 
Company Administrators and site 
Administrator. 

Apply Password Policy for Bidders 
Select if you would like the same settings to 
apply to Bidders logging into Unifier. 

Edit Company (Contact Tab) 

The Contact tab has the following blocks: 

 Support Contact Info

Enter values in each field. 

 eLearning Access

Enter values in each field. 

For more details, see Manage Support and eLearning Contact Information (Contact Tab)
(on page 81) 
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Manage Support and eLearning Contact Information (Contact Tab) 

In the Contact tab of the Edit Company window, you can provide your users with an email 
address and/or phone number of your internal support staff. This information will be displayed in 
error messages users may encounter if their accounts become locked, on the Support window 
Contact tab, and at the bottom of email notifications. The information included for email 
notification can contain a hyperlink to your local support. For information about translating Email 
Notifications, see the Internationalization (Email Notifications) section. 

In addition, if your company is part of the eLearning suite of interactive tutorials, you can provide 
access information to your users in this tab. This space can also be used for any location (such 
as an internal website) where you have provided Unifier training materials. 

To manage user support contact information 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, click the Open button. The Edit Company window opens. 

3) Open the Edit Company window and click the Contact tab. 

4) Under Support Contact Info and eLearning Access, you can add or modify the contact 
information as needed. See the following table for details. 

5) Click Apply to save changes, or OK to save and exit the Edit Company window. 

To complete this section: Enter this information: 

Support Contact Info 

Email: Email address for company internal support. 

Phone: Phone number for company internal support. 

Instructions: Information that appears in the Support window 
Contact tab, as well as the Email and Phone from above. 
This provides information to your users on how to use the 
support information. 

Email Notifications: Information that appears at the bottom of 
email notifications. This field supports simple html formatting, 
and can include a hyperlink. For example: 

<p>For YourCompany support, contact <a 
href="mailto:support@yourcompany.com">support@your
company.com</a> or 1-800-555-1212. </p> 

which will display in the bottom of record email 
notifications as: 

For YourCompany support, contact 
support@yourcompany or 1-800-555-1212. 

eLearning Access 

URL: Enter the URL for eLearning access. It is best to 
include the entire address 

Label: This is the label for the URL above. The label can 
display the actual URL, or you can a different label. This will 
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appear as a hyperlink to users. 

Contact email: Enter an email address that you would like 
users to use if they need to contact someone. Enter a valid 
email format, e.g., elearn@yourcompany.com. 

Instructions: You can enter instructions or other information 
such as a contact phone number. This field does not support 
html formatting. 

Edit Company (E-Signatures Tab) 

The E-Signatures tab contains the following field and blocks: 

 Default E-Signature Type

 DocuSign

 Adobe Sign

The following provides details: 

Default 
E-Signature 
Type

(Mandatory field) To select the default technology that provides a 
electronic signature solution for the company. 

DocuSign This block contains the following fields and options: 

 Url

The API URL which the customer or Oracle attains after acquiring 
the license. 

 Account Id

The ID for the DocuSign account 

 Client ID

To enter the user identification needed to log into Adobe Acrobat 
Sign. 

 Client Secret

This field is needed to set up integration between the system and 
DocuSign. 

 Token

This field is needed to set up integration between the system and 
DocuSign. 

 Status

Inactive by default. When you click Active, the system tests the 
connection. If the connection is successful, then you will be able to 
lock the status as Active. If the connection is not successful, then 
you will be receiving pertinent messages, and the status will 
remain as Inactive. If you successfully change the Status as 
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Active and then change any of the fields, the Status changes to 
Inactive, and you must select Active to run the test connection. 

 Generate Token

 Test Connection

To establish a connection between the system and DocuSign: 

1. Click Generate Token. The system inspects the integrator key 
and the client secret and directs the end-user to DocuSign 
URL to enable them to log in to their Demo or Production 
DocuSign account. 

2. After the end-user logs in to their DocuSign account, the token 
will be generated automatically in the Token field. 

3. Click Test Connection to ensure that the connection has been 
made successfully. This option is available after you 
successfully entered in, and selected values for, all the fields. 
If the testing the connection fails, the system displays the error 
message: Integrator key / Client Secret / Token combination is 
not correct. 

4. Follow the prompts to complete the work. 

Adobe Sign This block contains the following fields and options: 

 Url

The API URL which the customer or Oracle attains after acquiring 
the license. 

 Client ID

To enter the user identification needed to log into Adobe Acrobat 
Sign. 

 Client Secret

This field is needed to set up integration between the system and 
Adobe Acrobat Sign. 

 Token

This field is needed to set up integration between the system and 
Adobe Acrobat Sign. 

 Status

Inactive by default. When you click Active, the system tests the 
connection. If the connection is successful, then you will be able to 
lock the status as Active. If the connection is not successful, then 
you will be receiving pertinent messages, and the status will 
remain as Inactive. If you successfully change the Status as 
Active and then change any of the fields, the Status changes to 
Inactive, and you must select Active to run the test connection. 

 Generate Token

 Test Connection

To establish a connection between the system and Adobe Sign: 
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1) Click Generate Token. The token will be generated automatically 
in the Token field. 

2) Click Test Connection to ensure that the connection has been 
made successfully. This option is available after you successfully 
entered in, and selected values for, all the fields. 

3) Follow the prompts. 

OK Click when you are finished. 

Cancel Click to exit the tab. 

Edit Company (Outgoing E-mails Tab) 

The Outgoing E-mails tab enables you to set the maximum file size for each of your outgoing 
emails, in megabytes (MB), by entering a numeric value in the Total Size of Attachments in 
Each Outgoing E-mail field. 

To set the maximum file size for each of your outgoing emails to your system default 
specification, either click the Set to System Default option or enter zero (0) in the Total Size of 
Attachments in Each Outgoing E-mail field.  

If the size of your email is larger than the limit set for the recipient's server, the system truncates 
all the attachments in the email body to reduce the email size.  The system also appends a 
custom-defined text in the email body informing the recipient that the email attachments have 
been deleted, informing the recipient to sign in to the system to view the email. 
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Background Jobs 

The system uses jobs to perform various: 

 Operations (such as auto creation) 

 Scheduled jobs (such as UDR runs) 

 Record creations (from WF templates) 

 Analytics data pushes (to staging table) 

The node called "Background Jobs" (Company Workspace > Admin mode > System 
Information > Background Jobs) enables certain users and groups (Company Administrators) 
to access jobs data and set the time zone for recurring jobs. 

The visibility of, and access to, the Background Jobs node is controlled by permissions set in 
the Access Control node. The following shows how to determine access by way of the Access 
Control node. 

Go to Company Workspace > Admin mode > User Administration > Access Control > 
Administration Mode Access > Background Jobs to set the permissions. The permission 
settings contain the "Modify" and "View" options, and permissions can be assigned to both 
Users and Groups. Users/Groups with View permission are able to view the log without having 
the ability to edit the time zone. Users/Groups with Modify permission are able to view the log 
content and edit the time zone. 

The Background Jobs node log page has the following toolbar options: 

 Reload (  ): Enables the user to reload the contents of the page. When the action is 
complete, the list may vary from before reload. 

 Find on Page (  ): Enables the user to conduct a quick find (on the contents of the page) 
for any of the log columns. 

 On the far right-corner of the log page, the field labeled "Time Zone for Recurring Job:" is 

displayed. By default, this field shows the "(Default) <Time Zone Name>". The Edit icon ( 
), next to the field, is displayed if the user has Modify permission, only. 

The system uses the set time zone to calculate the next start time for time-based jobs. 

The Background Jobs node log page content: 

 High Priority Jobs: Example - Auto Creation job 

 Background Jobs

The lower-end of the page displays the total count of the jobs and log pagination number. 

The Background Jobs node log page has the following columns: 

 Name

The name of the job. Examples - system:collect action emails, alert:Hourly Trigger etc. 

 Status

The possible values are: Running and Waiting.  

Refer to the Unifier Data Reference Guide for the default time zones and the possible values. 
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 Next Start Time

The time that the scheduler runs the job. The value seen here will be per User Preferences. 
Example: If the User preference is set, then the format of the next run will be according to 
this time. 

 Type

The possible values are: Simple and Recurring. Simple is a type of job that was done once, 
at a specific time. Recurring is a type of job that is done based on a calendar schedule. 

 Priority

The job priority. Only high priority jobs will have this column populated with the value of 
"High." The values for other jobs will be blank. 

 Workspace

Displays the name or number of the shell for the job (listed under the Name column). 

 Time Zone

Displays the time zone for the job. 

All current jobs (scheduled UDR, scheduled refresh of the attach flow, BP record creation using 
templates) across the shells are run based on the time zone that you set up in the company 
Background Jobs module (company-level time zone). 

In cases where the project time zone is different from the company time zone (for example 
facilities based on a certain geographical location), you can go to the shell details (Details > 
Options tab) and from the Time Zone for Background Jobs drop-down list select the desired 
time zone for all shells in the log. After saving your changes, all the jobs within the shell will use 
your selected time zone. 

Event Audit Log 

The Event Audit Log functional node tracks all action events across the company that are 
initiated by a click, particularly when a user clicks a hyperlink within Unifier. All clicks on 
hyperlinks are tracked from all users, regardless of their roles. The log tracks the following 
details:  

 Event Date: Lists when the event occurred. 

 Action: Lists the action taken, or the hyperlink that was clicked. 

 User Name: Lists the user that clicked the hyperlink, or initiated the action. 

 Origin: Lists the shell that contains the hyperlink or action within Unifier. If the hyperlink or 
action occurs at the company level, then the value in this field will be the name of the 
Company Workspace tab. 

 Source Name: Lists the business process that contains the clicked item. 

 Source Number: Lists the number of the record that contains the clicked item. If the record 
was not yet created at the time of the event, the value in this field will be "New Record." This 
field will be blank if the event occurred in one of the following locations: 

 Cost Sheet 

 Funding Sheet 

 Generic Cost Manager 
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 Configurable Manager Sheet 

 Planning Manager Sheet 

 Portfolio Manager Sheet 

 Company Properties 

 Field: The name of the hyperlink picker from where the click was made.  

 Proxy User: If the link was clicked by a proxy user, their user name will appear here. 

 Source Type: Lists the type of business process that contains the clicked item. The possible 
values are: 

 Business Process 

 User Attributes 

 Document Manager  

 Cost Sheet 

 Funding Sheet 

 Generic Cost Manager 

 Configurable Manager 

 Planning Manager 

 Portfolio Manager 

 Company Properties 

The toolbar of the Event Audit Log contains the following options: 

 Refresh: Allows you to refresh the log. 

 Print: Allows you to print the log through the following options: 

 Print

 Export To CSV

 Export To Excel

 Search: Allows you to search for log items based on the source type, source name, user 
name, or event date.  

 Find on Page: Allows you to filter the log based on specified values for each column. 
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Event Notifications 

The event notifications are meant for the external applications that integrate with Unifier. When 
data in Unifier changes (based on certain triggers), the event notifications (notification records) 
are generated that can be used by the external applications to pull data from Unifier. 

The Event Notifications node has been set up by Oracle. The event notifications have already 
been incorporated within the design of the business processes (BPs) forms. 

To access the Event Notifications functional node: 

1) Go to your Company Workspace and switch to the Admin mode. 

2) From the left Navigator, click the Integrations grouping node to expand it. 

3) Click Event Notifications. The Event Notifications log or window displays. 

The Event Notifications log displays events that happen within the Workflow or Non-workflow 
BPs. 

When a BP record reaches a status that is meant to generate event notifications, then an entry 
gets listed in the Event Notifications log. This applies to both Workflow and Non-workflow BPs. 

The Event Notifications log or window has the following toolbar options: 

 View

This drop-down list allows you to select the system-defined views that are available to 
users who have access to view the Event Notifications log. It also allows you to create 
and manage the log views. The options are: 

 All Notifications

This is the default view for the log. By default, all rows in this log (sorted by Event 
Date and in descending order) are visible to the users. 

 Group by Object Name

This means grouping the rows in the grid by the "Object Name" parameter. The 
user has the ability to create a new view and manage views. Any view created by 
any user who has permissions to this log will be available to all other users who 
have permissions to this log. Similarly, any view edited or deleted by one user will 
be edited or deleted for all other users using this log. 

 Create New View...

Use this option to create a custom view. Custom views appear in the View list. 

 Manage Views...

Use this option to reorder, show or hide views, and delete the custom views. 

 Edit View

Enables you to select which columns to be displayed or remain hidden, apply filters, 
group and sort by available fields and to save custom views. 

 Refresh

To update the information displayed on the screen. 

 Print
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To print the information displayed on the screen. Your options are: 

 Print

 Export To CSV

 Export To Excel

 Search

To open a screen and search for a record by applying value operators in columns. 

 Find on Page

To open a row on top of the rows within the log and enter values in each column to start a 
search for a specific item in the log. 

The Event Notifications log or window has the following columns: 

Column 
Name 

Description Applies to 
WF BPs 

Applies to 
Non-WF 
BPs 

Shell 
Number 

Populates with the project or shell number 
where the event was triggered. 

Yes Yes 

Shell Name Populates with the name of the project or shell 
where the event was triggered 

Yes Yes 

Object 
Type 

Populated as "Business Process." Yes Yes 

Object 
Sub-Type 

When the Object Type = Business Process, 
then the Object Sub-Type is populated as 
Workflow or Non-workflow, based on the type 
of the BP. 

No Yes 

Object 
Name 

Populated with the name of the Business 
Process in which the event was triggered 

Yes Yes 

Record 
Number 

Populated with the "record_no" value of the 
BP record that triggered the event. 

Yes Yes 

Event Date Populates with the date and time, when the 
event was triggered. The content of this 
column is in descending order, which is the 
default sort format.  

Yes Yes 

WF Step 
From 

Populates when the event notification is for a 
WF BP. This column is populated with the 
name of the starting step of the record that 
have triggered the notification generation. 

No Yes 

WF Step 
To 

Populates when the event notification is for a 
Non-WF BP. This column is populated with the 
name of the final step of the record that have 
triggered the notification generation. 

No Yes 

WF Action Populates with the WF action name that was No Yes 
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Column 
Name 

Description Applies to 
WF BPs 

Applies to 
Non-WF 
BPs 

Name taken for the BP record that triggered the 
notification. 

Note: The same BP could go through several 
events which trigger the notification 
generation. Each such event inserts a 
corresponding row in this log. 

Old Status The original status of the BP record (before 
the event got triggered). 

Yes Yes 

New Status The final status of the BP record which 
satisfies the event trigger condition. 

Yes Yes 

The Event Notifications log or window Workflow BPs and Non-Workflow BPs: 

Workflow BPs Non-Workflow BPs 

For the Workflow BPs, the grid displays a 
record of all of the workflow actions that 
are taken within the BP records, and 
which are set with the Generate event 
notification option as checked, in 
uDesigner. 

A Workflow BP step completion policy 
does not impact the creation of the 
notification row. 

Regardless of the completion policy, if an 
action (which is setup to generate an 
event notification) is taken in the 
Workflow BP record, then the notification 
row is inserted in the log. 

If there are multiple assignees on a step, 
then the final action on the Workflow BP 
record, which moves the record to the 
next step, determines what will be 
included as an event notification row in 
the grid, not each action taken by an 
assignee. 

If a task is reassigned and the new 
assignee takes an action that moves the 
record to the next step, and the record is 
configured to generate a notification, then 
Unifier inserts an event notification row in 
the grid, also. 

For the Non-workflow BPs, the notification 
records are generated when the BP record 
reaches the status that has been designed 
to trigger event notification. Upon reaching 
the status, Unifier inserts a notification row 
in the grid. 

If you click Edit on a Non-workflow BP 
record and proceed to click Finish Edits
with making any changes, but the status 
change is set to generate notifications per 
the design, then Unifier inserts a notification 
row in the grid. 
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Setting up Permissions for the Event Notifications 

The visibility of Event Notifications log is driven by permissions. 

To set the Event Notifications functional node permissions: 

1) Go to your Company Workspace and switch to the Admin mode. 

2) From the left Navigator, click the User Administration grouping node to expand it. 

3) Click Access Control. The Access Control log or window displays. 

4) On the right pane, click Administration Mode Access to expand. 

5) Click Integrations to expand. 

6) Click Event Notifications to open the Module Permission Settings window. 

7) Set the View permission to users and groups as needed. 

Under the Permission Settings for: Event Notifications block you can select users or 
groups and either modify (Modify...) or remove (Remove) the existing permission. 

To add a new user and add permissions, click Add to open the Permission/Access Control
window. From the Permissions Settings for: Event Notifications Select Users/Groups
block click Add Users/Groups to add users or groups. From Permission Settings block, 
click View to select and click OK to grant this permission to the users or groups that you 
have selected. 

When finished, click Apply and then click OK to close the window. To discard your changes 
or close the window click Cancel. 

Users or groups with the View permission have the ability to: 

a. See the Event Notifications node in the left Navigator. 

b. Take actions using available options in the log toolbar. 

c. View all notifications records within the log. 
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uDesigner Overview 

uDesigner is a functional module of Unifier and is enabled automatically when Unifier is installed.  

The uDesigner module is used to create: 

 Business Process (BP) 

 Managers (Asset - Cost - Document - Planning - Portfolio - Resource - Schedule - Space - 
Shell) 

 Configurable Modules 

 Attribute Forms (Users, Shells, Document Manager, Cost) 

Collapse by Default Option in Block Properties 

In the Block Properties window of both a BP form and a manager attribute form, there is a new 
checkbox called Collapse by Default. If the checkbox is checked, the block is collapsed by 
default. If the checkbox is unchecked, the block is expanded by default. 

With the Collapse by Default option, you can avoid scrolling through irrelevant information. 

Under the Collapse by Default checkbox, the following note is displayed: “The block will be 
collapsed in User Mode, only if the block has a label and the Show Border and Show Label 
options are checked. This option is applicable only for Standard View of forms.” 

Collapse by Default is applicable to the following forms: Action form, View form, Detail form, 
and various attribute forms. 

Additional uDesigner Options  

You can use the uDesigner module to: 

 Create a design in the Development environment. 

 Configure, setup, and test your designs in both the Development environment and Test 
environment.  

After this point you can import your designs to the Production environment by way of 
Configuration Package.  

Oracle recommends that you: 

 Create your Configuration Package in the Development environment and import your 
Configuration Package to the Test environment for additional testing. 

 Import your Configuration Package from the Development environment onto the 
Production environment for use. 

You can select the Unifier environment in the Unifier Configurator. 

 The Unifier Development environment is a Unifier server deployed by selecting the server 
type as "Development" in the the Unifier Configurator. 

 The Unifier Test environment is a Unifier server deployed by selecting the server type as 
"Test" in the Unifier Configurator. 
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 The Unifier Production environment is a Unifier server deployed by selecting the server type 
as "Production" in the the Unifier Configurator. 

The Development/Test environment is an environment that replicates the Unifier Production
environment. 

An object (for example a BP) can be deployed multiple times in the Development environment, 
only. 

Note: In Development environment, all uDesigner functionalities are 
available, but in the Test/Production environment the uDesigner 
functionalities are not available. 

In the Test environment, you can:  

Import an unpublished Configuration Package. 

In the Test environment, you cannot: 

Publish your Configuration Package. You can only publish your Configuration Package from 
the Development environment. 

The Test server is equipped with usable uDesigner and Data Structure Setup nodes so users 
can create or modify BP designs and include them in configuration packages and export them to 
another Test or Development server. 

When deploying your designs using Design Bundles, it is important to note the version numbers: 

 A deployed version indicates that the design has been tested in the Development/Test 
environment. 

 A published version indicates that the design has been imported, or the design has been 
imported into the Production environment for the first time. 
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User Administration 

This section covers adding, managing, related permission settings, and related access control 
for:  

 Company Users (sponsor company and partner company users) 

 Partner Users (partner users) 

 Groups (user groups) 

 Task Reassignment (access control) 

 Integration Users

In This Section 

Owner Company or Sponsor Company ................................................................... 95 
Partner Company or Member Company .................................................................. 96 
Assigning Application Access (Cloud Only) ............................................................. 97 
Editing User Permissions at Company, Shell, and Project Levels ............................ 97 
Importing User Attribute Form .................................................................................. 98 
Adding and Managing Company Users ................................................................... 98 
Creating Partner Companies, Users, and Permission Settings (On-Premises Only)118 
Creating Partner Companies and Users (Cloud Only) ........................................... 121 
Adding and Managing Partner Company Users ..................................................... 121 
Adding and Managing Groups ............................................................................... 128 
Integration Users ................................................................................................... 131 
Managing Users in Bulk ......................................................................................... 137 
Creating and Managing User Preference Templates ............................................. 139 
Creating an Approved Email List for Project/Shell Mailboxes ................................. 141 
Editing, Deleting, and Finding Email Addresses..................................................... 143 
Importing and Exporting Email Addresses ............................................................. 144 
Managing Permissions and Access Control ........................................................... 146 
Announcements Node ........................................................................................... 149 
Working with the License Manager ........................................................................ 152 
Running System Usage Reports ............................................................................ 157 
Setting Permissions for Inbox ................................................................................ 171 
Setting Permissions for Unpublished Attachments ................................................. 172 
Task Reassignment (Company and Project) .......................................................... 172 

Owner Company or Sponsor Company 

The entity that engages in business and has the complete control (or ownership) of Unifier with 
all its rights and privileges. 
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Partner Company or Member Company 

The consultants, contractors, and vendors that have been invited to participate in a project by 
the Owner Company/Sponsor Company. The system lets you add a Partner Company/ Member 
Company to enable project users to collaborate on (and coordinate) the execution of a project. 

Note: A Member Company is a Partner Company. When a Partner 
Company is added to a shell or project, the Partner Company becomes 
a Member Company. That is to state: When a Partner Company
participates in a project or shell, the Partner Company becomes a 
Member Company in that project or shell, and the Partner Company
users that are added to the project or shell become the Member 
Company users. 

To access the User Administration node, go to Company Workspace tab > Admin mode > 
User Administration. The following explains each sub-node in details. 

Generally, the values of the user attributes are specified under the General tab of the members 
in Company Users or Partner Users: 

1. Go to your Company Workspace tab in Admin mode. 

2. From the left-hand Navigator click the User Administration node to expand it. 

3. Click the Company Users, or Partner Users, sub-node to open the log. 

4. Select a member from the log and click Open. The Edit User window for the user that 
you selected opens, and the General tab is displayed by default showing the values of 
the user attributes. 

The same values of the user attributes that are specified under the General tab of the members 
in Company Users or Partner Users are also displayed (read-only) in the shells, within the 
Users or Groups sub-nodes: 

1. Go to your <shell> tab in Admin mode. 

2. From the left-hand Navigator click the User Administration node to expand it. 

3. Click the Users, or Groups, sub-node to open the log. 

4. Select a member from the log and click Open. The Edit Projects User window for the 
user that you selected opens, and the General tab is displayed (read-only) by default 
showing the values of the user attributes. 

Note: You can edit the user attribute fields that are relevant to each 
project or shell, only. 

Within a shell, the General tab (of the members in Users or Groups) you can click the Copy 
Attributes from Company Workspace option to fetch all of the company-level user attribute 
values from the company (Company Workspace tab) and populate the user attributes values 
the General tab. 

1. Go to your Company Workspace tab in Admin mode. 

2. From the left-hand Navigator click the User Administration node to expand it. 

3. Click the Company Users, or Partner Users, sub-node to open the log. 

4. Select a member from the log and click Open. 



User Administration

97

5. In the Edit User window for the user that you selected (General tab) enter the user 
attributes. 

6. Click Apply to save your changes and then click OK to close the window. 

7. Go to your <shell> tab in Admin mode. 

8. From the left-hand Navigator click the User Administration node to expand it. 

9. Click the Users, or Groups, sub-node to open the log. 

10. Select the member from the log and click Open. 

11. In the Edit User window for the user that you selected (General tab) click Copy 
Attributes from Company Workspace. 

12. Follow the prompts so that the system can fetch all of the company-level user attribute 
values from the company (Company Workspace tab) and populate the user attributes 
values the General tab. 

Note: If a user attribute value changes at the company-level, the system 
will not update the corresponding value at the shell-level. 

When finished, click Apply to save your changes and then click OK to close the window. 

Click Cancel to discard your changes and close the window. 

Assigning Application Access (Cloud Only) 

To assign application access to Unifier: 

1) Log in to Primavera Administration and do the following: 

a. Add a user. 

b. Assign application access for that user to Primavera Unifier Production. 

Note: For details on using Primavera Administration, see the Primavera 
Administration Identity Management Guide. 

2) Log in to Unifier as a company administrator. 

3) Assign the users permissions that are specific to module access, functions, and tasks that 
they will use. 

4) Repeat these steps for each user account that requires access to Unifier. 

Editing User Permissions at Company, Shell, and Project Levels 

The following user permission setting applies to editing a user permissions both at 
company-level, shell-level, and project-level: 

When a user has the Create permission, all of the fields on the User Properties window are 
editable. The Apply and OK options are displayed. 

A user with Create permission at the company-level will be able to create users and modify all 
the properties of the users, including the status and permissions. 



Unifier General Administration Guide

98

When a user has Modify Status permission only, the Status option is enabled. The Apply and 
OK options are displayed and enabled. All of the other fields are not editable. A user who only 
has the Modify Status permission will be able to modify the status of users both from the User 
Properties window and the log. 

Note: The ability to update the status from the log is not available at the 
shell, or project, level. 

When a user has the Modify Properties permission only, the Status option is not enabled 
(disabled). In this case, the user needs the Modify Status permission in order to be able to edit 
the Status field. The Apply and OK options are displayed and enabled. All of the other fields are 
editable. 

A user who has the Modify Properties permission without the Modify Status permission can 
modify the properties of the user. A user who has the Modify Properties permission without the 
Modify Status permission cannot modify the status of the users. 

Importing User Attribute Form 

For company user administration, the system displays a default log, General tab (used when 
creating a user with the Company or Partner detail form), and User/Group picker, unless you 
design and import your own user administration attribute form. 

You can add additional data elements to the User Attribute form, configure Company User and 
Partner User logs, add additional attributes to the View User Profile form, and a User/Group 
picker. The additional data elements appear as user properties on the General tab for Company 
and Partner users, as well as on the user View Profile form. For example, the additional user 
properties can include a user's department and location, or other details. 

Refer to the user administration of the Unifier uDesigner User Guide for more details. 

Note: The new attribute will be available only for Company Users log 
and Partner Users log and will not be available as part of custom 
attributes in other module designs. 

All designs, including user attribute forms, are designed in uDesigner and deployed to Unifier. 
See Importing Configuration Packages. 

Adding and Managing Company Users 

Company Administrators can add new users to the sponsor company. Each new user creates a 
new user record. These are known as company users. Company users can be entered manually 
one at a time, or multiple user records can be imported into Unifier from a CSV file. 
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Note: For information about the columns, such as timezone, user type, 
and language, see the Unifier Integration Interface Guide. 

To ensure compliance with company standards and restrict access, Oracle recommends that the 
responsibility for user administration (at the company level) be delegated to one person, or a 
small group of people.  

To access the Company Users log 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. To open an existing 
user record, select a user from the log and click Open. 

Note: If a User Attribute form has been imported, the columns that 
appear in the Users Log can vary. If designed in uDesigner, the log can 
include navigation in the left pane. This navigation allows you to filter the 
display of users listed in the log. If you decide that you want a standard 
log to display, you can remove the navigation from the log in uDesigner. 
Also, the search criteria in the Find window and sort order can also vary 
depending on what was added to the User log design in the User 
Attribute form. 

User Type 

As part of the log attributes, the User Type column in the Company Workspace log page 
identifies the type of user, available in Unifier, per following: 

 SYS User Type/Standard

The SYS User Type/Standard, which refers to both Company and Partner users, can have 
access to all Unifier modules, except the Earned Value Management. If the Earned Value 
Management component is checked for a Standard User, the Earned Value Management will 
be available to the Standard User. 

Note: For information specific to the Earned Value Management module, 
see the Unifier Earned Value Management User Guide. 

 SYS User Type/Portal

The SYS User Type/Portal, which refers to Portal users, can have access to self-service 
portal login, only. 

The Company Workspace log page (for Company Users node) has the following menu 
options: 

 File

 New

Manual

Import

 Open

 Export
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All

Selection

Export Structure

 Send e-mail

 Status

Active

Inactive

On-Hold

 Edit

 Bulk Edit

 Delete

 Update User Type

To Portal

To Standard

 View

 All

 Find...

 Audit Log...

 Help

 User Help

 Admin Help

 uDesigner Help

 Unifier Library

 User Productivity Kit

The Company Workspace log page (for Company Users node) has the following toolbar
options: 

 New

 Open

 Find

 Send e-mail

 Status

 Active

 Inactive

 On-Hold

 Update User Type

 To Portal

 To Standard
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The Update User Type (To Portal and To Standard) option, collectively, work as a bulk action 
on one or more selected user rows by enabling you to update the type of user. For example, you 
can select one row, or multiple rows, click Update User Type, and change the user type to 
portal, or standard, by clicking To Portal, or To Standard. 

If user assignment results in the number of users exceeding the licenses allocated, Unifier 
displays a notification. 

If the user type attribute is not mentioned when creating the user, the user type for that user will 
be set to Standard user type by default. 

When you are creating a user, the User Type drop-down list is defaulted to Standard user, but 
you can change the User type to Portal. 

The Attribute "Earned Value Management" displayed is unchecked by default. If the user checks 
this option, then the user will be granted access to the Earned Value Management module. This 
checkbox will be disabled for Portal type of users. 

Note: The checkbox for Earned Value Management users will be seen 
only when the Earned Value Management module is loaded. 

In the License Manager, the Company user and Partner user are considered Standard users in 
terms of license count and combined count for License Terms and Current Usage. The License 
Manager landing page will generate and update a gauge chart for all the following license types: 

 Standard Users 

 Portal Users 

 Collaborator Users 

 Earned Value Management Users 

A new count for Portal users and Earned Value Management (EVM) users are shown for 
License Terms and Current Usage. This count will depend on: 

 Whether a particular Company user is marked as Portal user, and 

 The Earned Value Management user in User Administration. 

The excess or surplus (overage) is calculated in the same way as the Standard users. 

The Site Administrator can edit the license terms and view the audit log for the users by clicking 
the Settings icon. 

When editing the user count, the Site Administrator will have to put a combined number for 
active named users. 

The Site Administrator will also be able to edit the Portal users and EVM users count by using 
the following tabs on the License Terms window: 

 General tab 

 Notifications tab 

For users other than the Site Administrator, only the Notification tab will be available to be 
edited. 
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Note: Unifier considers the existing Company users and all users added 
by way of import (File > New > Import) as Standard users. 

The User Type column will be seen by default in the standard user data picker. For the custom 
user data picker, if the user has added the column, then the user will be seen in User Type
column. 

In addition to the standard user (a user with access to all Unifier functionalities) and the portal 
user (a user with access to limited Unifier functionalities), Unifier supports the Collaborator User. 

Notes: 

 The Collaborator User is a Partner User. Any user can be declared as 
a Collaborator User, but a Collaborator User will have limited access 
to unifier functionalities. The Collaborator User status must be 
granted to external users such as vendors. 

 A Collaborator User will also have access to Mailbox module and its 
sub-modules. 

License terms for a company (customer) can only be changed by the Site Administrator (for 
the cloud customers this will be the Oracle Cloud Administrator). As a result, to allow a 
Company Administrator to add a Collaborator User, the Site Administrator must first add 
licenses for the Collaborator User. See Collaborator User (on page 104) for more details. 

Add a New Company User 

This section describes how to manually add a new user record to your company. For information 
about importing multiple user records from a CSV file, see Import company users (add users 
or update users). 

If you have created a User Preference template (in Standards & Libraries > User Preference 
Templates), the active template will automatically be used to generate the new user's user 
preferences. If there is no active template present, then the system default settings will be used 
for the user preferences.  

To add a new company user 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. 

3) Click New from the toolbar to open the Edit User window and complete the form. 

4) In the Edit User window, complete the fields of the General tab as discussed in the following 
table. 

5) Click the Security tab. You must also add a login user name before saving the record. See 
Manage User Login Information (Security Tab) (on page 111) for details. 

6) At this point, you can activate the user, save the record, or complete the rest of the tabs: 
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 Groups: You can add the user to existing groups. The default groups are Company 
Administrators, Project Administrators, Shell Administrators, and Support. The user 
automatically inherits group permissions. See Manage a user's group membership 
(Groups tab) for details. 

 Permissions: You can configure individual permission settings for the user in this tab. 
See Edit User Permissions (Permissions Tab) (on page 112) for details. Alternatively, 
you can assign the user to a group (the user will automatically inherit group permissions), 
or assign permission through Access Control. 

 Projects/Shells: This tab lists the projects and shells to which the user has been added 
and is view-only. See View User's Project, Program, and Shell Membership 
(Project/Shell/Program Tabs) (on page 112).  

 Programs: This tab lists the programs to which the user has been added and is 
view-only. See View User's Project, Program, and Shell Membership 
(Project/Shell/Program Tabs) (on page 112). 

 Proxy: You can add or view the user's proxy users in this tab. See Designate a Proxy 
User (Proxy Tab) (on page 113). 

7) Click Apply to save changes, or OK to save and exit the window. 

In this field: Do this: 

First Name, 
Last Name 

Enter the first and last name of the user. These are required fields. 

Title Enter an optional company title for the user. 

Email 
Enter the user's email address, which will be used to send system 
notifications to the user, and will display in the user's contact information. 
This is a required field. 

Work Phone Enter the user's work telephone number. 

Mobile 
Phone 

Enter the user's mobile telephone number. 

Home Phone Enter the user's home telephone number. 

Pager Enter the user's page number. 

Fax Enter the user's fax number. 

Address 
Click the Select button to add a company address to the user profile 
(From Edit Company, Address Tab) 

Time Zone 
Choose the default time zone for the user. This can be changed in the 
User Preferences window. 

Language 

Select a language from the drop-down list. 

Note: The languages listed are the active languages selected in the 
Configuration - Internationalization log window, by the administrator. 

Date Format 
This setting controls the display of dates on reports, business process 
forms, etc. This can be changed in the User Preferences window. 
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In this field: Do this: 

User Type 

Select Standard or Portal. The Standard User has access to all 
modules, except the Earned Value Management. (If the Earned Value 
Management component is selected for a Standard User, the Earned 
Value Management is available to the Standard User.) The Portal User 
only has access to the self-service portal login. 

Earned 
Value 
Management

The Attribute "Earned Value Management" displayed is unchecked by 
default. If the user checks this option, then the user will be granted 
access to the Earned Value Management module. This checkbox will be 
disabled for Portal type of users. 

Status 

New users are Active by default. Status can be Active, Inactive or 
On-hold. Neither Inactive nor On-Hold users can sign in: 

 Active: User is listed in Project or Shell Directory, in User/Group 
Picker, User can sign in and participate in project or shell. 

 Inactive: User's name does not appear anywhere for selection on 
any project-or shell-related functions or User Picker. User cannot 
sign in but they can be given permissions and added to groups. 

 On-hold: User can be added to a project or shell and assigned as a 
participant in a business process workflow but cannot sign in. 
Normally used to pre-assign users to a new project or shell before 
activating it. 

Active and On Hold users will be counted against your user license 
terms; Inactive users will not. 

Collaborator User 

The Company Administrator can: 

 Create a user of the type "collaborator" in in the Partner Users sub-module, only (Company 
Workspace tab > Admin mode > User Administration module). 

 Bulk update the user type to "Collaborator." 

Note: All license constraints will be in place. 

If you make a user a Contractor by assigning the Contractor User Type in Primavera 
Administration, the user will consume a Collaborator license in the system. Any other user 
classification (Employee, Intern, Temp, External, Service, Generic) will consume a Standard 
license.  

Attention Unifier Cloud Administrator 

When you are provisioning users in the Cloud Administration tool:  
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a) While setting up users of Collaborator license type, you must select the user type as 
“Contractor” in the Cloud admin tool. The user type of “Contractor” is reserved for the 
"Collaborator" user type of Unifier. You must not use the user type “Contractor” for any other 
user type that may count towards Standard license. 

b) If you want to create users with Standard license type, then you can choose the user type to 
be any of the other values such as Generic, Intern, and so forth. 

Impact on the Audit Log 

Changes made to the Collaborator User license terms will also get captured in the Audit Log
tab. 

A Collaborator User license type can only be added as a Partner User (Company Workspace > 
User Administration node), manually. 

1) Go to the Company Workspace tab and switch to the Admin mode. 

2) From the left Navigator click User Administration node to expand. 

3) Click Partner Users sub-node to open the log. 

4) Click to select the company you want to add the Collaborator User to and open it. The Edit 
User window opens. 

5) In the Edit User window, General tab, enter the user information, click the User Type
drop-down list, and select Collaborator. 

The Update User Type toolbar option lets you use the sub-menu option of To Collaborator. 
The same option will be available in Edit in the Menu. 

The following table outlines the behavior of various options: 

Selection Update License Type Usage 

When one or more users 
are selected 

Update to Standard For all the selected users, the user 
type will be updated to Standard. 

When one or more users 
are selected 

Update to 
Collaborator 

For selected users, the user type if 
not Collaborator will be changed to 
Collaborator. 

When one or more 
Standard partner users 
are selected 

Update to Portal For the selected Standard Partner 
users, the user type will be changed 
from Standard to Portal. 

When one or more 
Standard partner users 
are selected 

Update to 
Collaborator 

For the selected Standard Partner 
users, the user type will be changed 
from Standard to Collaborator. 

When one or more portal 
users are selected 

Update to Portal For selected users, the user type if 
not Portal will be changed to Portal. 

When a mix of Standard, 
Portal & Collaborator 

Update to 
Collaborator 

For selected users, the type if not 
Collaborator will be changed to the 
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Selection Update License Type Usage 

users are selected Collaborator. 

When a mix of Standard 
and portal users are 
selected 

Update to Portal For selected users, the type if not 
Portal will be changed to Portal. 

You can add Collaborator User of the new license type in User Administration for Partner Users 
through CSV. If the license count is exceeded, the system displays the message: License limits 
for Standard/Portal/Collaborator Active Named Users and Overage have been reached. {total 
number of users} user(s) cannot be added/updated. Contact your Site Administrator. 

For the identity management domain or Primavera Administration Application, to create a 
Collaborator User a new attribute for the user type must be created, when creating a user.  

Navigational nodes seen (Home): 

 Home

 Tasks

 E-Signatures

 Notifications

 Inbox

 Drafts

 Sent items

Note: The Master log is not displayed. 

The Standard Projects would still be accessible to Collaborator User. 

Navigational nodes seen (Shell): 

 Tasks

 E-Signatures

 Drafts

 Mailbox

 Drafts

 Inbox

 Notifications

 Sent Items

 Delete Items

 Document Manager, with all the sub-nodes (based on logged-in user permissions). 

 Logs, with all of the business processes (that the logged-in user has navigational-level 
access to). 

Because Project Mailbox is not available to the Collaborator User, the same option is also not 
available under "Linked Mail" of a BP. If there are any existing emails from the Project Mailbox in 
the linked mail of the particular BP, the emails would still be visible and accessible. 
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The Collaborator User will not have access to any non-BP type object, in the left Navigation. If 
there are references on the BP forms, the Collaborator User will be able to access them. Also, 
any records that can be opened by way of a hyperlink in a non-BP type picker will be accessible 
to user. 

Note: A user who does not have permissions for any shells can click on 
any shell picker on the BP forms and add or reference a shell in a BP; 
the system does not restrict this based on the permissions. The same 
rule applies to a Collaborator User. 

Here is a list of some of the pickers that are non-BP type: 

 Space Manager 

 Planning Items 

 Code or Record Based Managers 

 Shell Manager 

A Collaborator User can have other users (Standard user or Portal user) who can act as proxies 
and can act as a proxy for other users. A Collaborator User can view this list in the My Proxy
tab. All sub-options seen in the Preferences window will be the same as other Standard users, 
including the Email Subscription options. 

Note: The system does not prevent the Company Administrator from 
setting Collaborator user types as Proxy users; however, at runtime 
these type of users will not see the option to proxy on behalf of someone 
else. 

The User Type "Collaborator User" is not available in the Bulk Edit log, and the license count 
will not be checked when updates are made through bulk edit. 

A Collaborator User has access to the following options in the top pane: 

 Announcements

 Bookmarks

 Help

 Recent Locations

 Key Locations

Delete a User 

Company Administrators can delete an existing user from the shell template. This section 
describes how to manually delete a user from a shell.  

Note: You can delete a user from a specific shell template but not from 
other Projects/Shells that have been created using the template. 

To delete an existing company user: 
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1) Go to Company Workspace tab and switch to Admin mode. 

2) In the left navigation pane, click Templates > Shells > {Shell Type} > {Shell Templates} >
User Administration > Users. 

3) Select a user from the log. 

4) Click Delete. 

Note: System prompts the user asking to confirm deletion of the user. 

5) Click Yes to remove the membership from the shell template. 

Import Company Users (Add Users or Update Users) 

If you have a large number of users to add or update, you may want to import the records, so 
you do not have to manually open and update each user record. You can import multiple users 
with a CSV file by doing the following:  

 Export a copy of the CSV file structure. 

 Populate the CSV file with user information. 

 Import the CSV file into the system. 

To export a copy of the CSV file structure 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. 

3) Click the File menu and choose Export > Export Structure.  

Depending on your browser, the CSV file will be automatically downloaded or you will be 
prompted to download it manually.  

To export existing users for update 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. 

3) Choose File > Export > All, or select users in the log and choose File > Export > 
Selection. 

Depending on your browser, the CSV file will be automatically downloaded or you will be 
prompted to download it manually.  

To populate the CSV file with user information 

1) Open Microsoft® Excel (or other program compatible with CSV format), and open the CSV 
file you just saved. 

2) Enter or modify user information in the spreadsheet. The fields are discussed in the following 
table. Ensure that you review the notes after the table. 

3) Save in CSV format. 
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In this column: Do this: 

First Name* Enter user's first name. 

Last Name* Enter user's last name. 

Title Enter user's company title. 

Email* Enter user's email address. 

Work Phone Enter user's work phone number. 

Mobile Phone Enter user's cell phone number. 

Home Phone Enter user's home phone number. 

Pager Enter user's pager number. 

Fax Enter user's fax number. 

Login Username* 
Enter a unique username that the user will use to log 
in the system. 

Password 
Enter a password that will allow the user to log in for 
the first time. The user can change the password 
after signing in. 

Time Zone* 

Enter the code for the Time Zone (refer to the Unifier 
Data Reference Guide for the list of codes). This is a 
required field, even if you are entering a User 
Preferences Template Name (if the time zone 
specified in the template is different from this cell, 
the template selection will take precedence). 

Date Format* 

Enter the code for the Date Format (refer to the 
Unifier Data Reference Guide for the list of codes). 
This is a required field, even if you are entering a 
User Preferences Template Name (if the date format 
specified in the template is different from this cell, 
the template selection will take precedence). 

Address 
Enter the code for the company address to use with 
this user. (Refer to the Unifier Data Reference Guide
for the list of codes) 

Template Name 
If you have created User Preferences Templates, 
enter the name of the template to use for this user. 

Status* 
Enter a status code for this user: Active=1, 
On-Hold=2, Inactive=0 

* = mandatory column  

Note the following: 

 Do not delete or change the order of the columns; this will make the file invalid. 
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 Valid information must be entered into columns corresponding to required fields. An asterisk 
in the column header indicates required fields. (Expand the columns to see the asterisks if 
necessary.) 

 For non-text-entry fields (Time Zone, Date Format, Address), enter the corresponding code. 
Valid codes are found in the Unifier Data Reference Guide. 

 Non-required fields (column heading does not have an asterisk) are optional. You may enter 
information or leave these fields blank. 

 The length of "Username" cannot exceed 64 characters and cannot include the following: 

 Space 

 Non-printable characters 

To import the CSV file into the system 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. 

3) Choose New > Import to import the completed CSV file. 

4) Click Browse and navigate to where you saved the file. 

5) Click OK to import. New users are created and existing users are updated. 

6) Open the User record and set up the Groups, Permissions, Projects/Shells, Programs, and 
Proxy tabs as needed. 

If any rows contain errors, no rows are imported. Error messages are listed in the CSV file. 

To fix import errors 

If you receive the Confirmation message: 

Import could not be completed. Do you want to download a file with errors 
shown?

1) Click Yes to open the CSV file. 

2) Fix the rows that contain errors. 

3) Re-import the file. 

Export User Records 

You can export a CSV file with current user information. 

To export a CSV file containing all user records 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. 

3) Click the File menu and choose Export > All.  

Depending on your browser, the CSV file will be automatically downloaded or you will be 
prompted to download it manually.  

To export a CSV file containing selected user records 

1) In the Company Users log, select one or more users to export (press the Ctrl or Shift keys to 
select multiple users). 
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2) Click the File menu and choose Export > Selection.  

Depending on your browser, the CSV file will be automatically downloaded or you will be 
prompted to download it manually.  

Manage User Login Information (Security Tab) 

Before you activate a new user, you must enter a Login Username. To allow the user to sign in 
to the system, you must also add an initial password. You can also change the user's password 
here, for example if the user has forgotten their password. 

Users can change their password later in the User Preferences window.  

To add or manage user login information 

1) In the User Administration log, select a user and click Open. The Edit User window opens. 

2) Click the Security tab. 

3) Complete the fields as shown in the following table. 

4) Click Apply to save changes, or OK to save and exit. 

In this field: Do this: 

Login Username 
Enter the Users Sign In ID (required). This value can be 
changed by the System or Company Administrator but not 
by the User. 

Password 
Enter the value the user will use as their Sign In ID. 
Passwords must match the company Security/Password 
policy, if one is in force. 

Confirm Password Confirm password by re-entering. 

View Password Policy 

Click this link to verify the password is conforming to your 
company's Security/Password policy (Edit Company 
window, Security tab). A password that does not comply will 
generate a warning message.  

Note: The Security tab is not available if Unifier is integrated with SSO 
(LDAP, OAM). 

Manage a User's Group Membership (Groups Tab) 

You can manage a user's group membership from the Groups tab of the Edit User window. This 
tab displays all the groups the user is a member of, and allows you to quickly add or remove 
groups. The default groups are Company Administrators, Project Administrators, Shell 
Administrators, and Support. For information about adding or managing groups, see Adding 
and Managing Groups (on page 128). 
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Note: If you are using OIM to add users to your company, you will still 
have to use these instructions to add users to groups. 

To add a user to a group 

1) In the User Administration log, select a user and click Open. The Edit User window opens. 

2) Select the Groups tab. 

3) Click Add. The User/Group Picker opens. 

4) Select the Group and click Add. The group will appear in the Selected Groups window. Click 
OK to save. 

To remove a user from a group 

On the Groups tab, select a group and click Remove. 

Edit User Permissions (Permissions Tab) 

This procedure allows you to grant or remove specific user permissions. This is useful if a user 
needs special permissions that are not likely to be repeated with other users, or is not part of a 
group. You can also specify permissions for groups (if you add the user to the group, the user 
will automatically inherit all group permissions, or control permissions through Access Control. 

To edit a user's permission settings 

1) In the User Administration log, select a user and click Open. The Edit User window opens. 

2) Select the Permissions tab. 

3) Click a plus sign to expand the choices. Scroll up or down as needed. 

4) Select the Permission module in which to grant permissions. Choose the Permission level in 
the bottom window. Permissions are described in the Unifier Data Reference Guide. 

5) Click OK to save. 

To copy permissions from a template 

1) In the Permissions tab, click the Copy Permissions button. 

2) Select the template and click OK. All permissions settings in the user record will be 
overwritten and replaced with the permission settings from the template. 

View User's Project, Program, and Shell Membership (Project/Shell/Program Tabs) 

Users can be added to projects, programs, and shells giving them access to participate in them. 
You can view a user's project membership in the Projects/Shells tab, and program membership 
in the Program tab. 
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To view a user's project/shell membership 

1) In the User Administration log, select a user and click Open. The Edit User window opens. 

2) Select the Projects/Shells tab. This tab displays the list of programs of which the user is a 
member. Users cannot be added or removed from Programs here. 

To view a user's program membership 

1) In the User Administration log, select a user and click Open. The Edit User window opens. 

2) Select the Programs tab. This tab displays the list of programs of which the user is a 
member. Users cannot be added or removed from Programs here. 

Designate a Proxy User (Proxy Tab) 

A Site/Company Administrator can designate a user to be a proxy user for another user.  

 Proxy users can be granted permission to access another user's account and perform 
various functions on that person's behalf if that person is unavailable, such as on vacation. 

 Proxy users who are active (Status: Active) receive email notification of tasks to perform as 
proxy. This applies during the specified time period, using the Start Date/Time and End 
Date/Time. 

 Proxy users have access to all of the records, settings and functions of the original user. A 
proxy user signed in to another's account cannot change Preference settings. The Audit logs 
reflect the actions taken by a proxy user as "on behalf of" the original user. 

Note: If the specified proxy user has Send notifications in a single daily 
digest selected on the Options tab of their User Preferences, it will 
impact when they receive notification of the task they must perform as 
proxy. Ensure that the Send notifications in a single daily digest 
checkbox is deselected for the proxy user if that user must receive the 
task notifications immediately. 

To designate a proxy user follow these steps: 

Note: The following applies to Company Users, Partner Users, and 
Groups. 

1) Launch the system > Company Workspace tab > Admin mode > User Administration > 
Company Users.

2) Select a user from the Users log and click open to open the Edit User window 

3) Click Proxy tab. 

4) Set the options per following descriptions. 

Do not allow Proxies 

The Site/Company Administrators, Company users, and Partner users) are permitted to select 
the Do not allow Proxies option. 
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Note: This option is read-only in the user's User Preferences window. 

Users are able to add proxy users in their User Preferences window only if the Site/Company 
Administrator has not checked the Do not allow Proxies option in the Proxy tab of Edit User 
window. 

Users who can act as my Proxy 

This section of the Proxy tab lists the users who can act as proxy and allows you to add, adjust 
the settings, remove proxies, and view the proxy login history. 

Note: You can select/designate more than one proxy user. 

Add

The Company Administrator can assign other users to act as proxies to your account. if you are 
unable to do so. 

To add a proxy: 

1) Click Add to open the Proxy User Settings window. 

2) Click Select to open the Users/Group Picker window. 

3) Select users, click Add, and then click OK to go back to the Proxy User Settings window. 

4) Enter the Start Date/Time and End Date/Time values. 

5) Select the Status (Active) and click OK. 

If enabled by the Administrator, Partner Users can add Owner Company Users as proxy users. 

1) Launch the system > Company Workspace tab > Admin mode > User Administration > 
Partner Users. 

2) Select a user from the Users log and click open to open the Edit User window 

3) Click Proxy tab. 

4) Click Add to open the Proxy User Settings window. 

5) Click Select to open the Users/Group Picker window. 

6) Select the desired company from the List Names from dropdown list. 

7) Select users, click Add, and then click OK to go back to the Proxy User Settings window. 

8) Enter the Start Date/Time and End Date/Time values. 

9) Select the Status (Active) and click OK. 

Settings

Use this option to select an existing proxy and change the user settings of the proxy, such as 
start and end date/time. To change the user settings of the proxy, click Settings and follow the 
prompts. 

The system sets the values in the time-related fields based on the user's preferred data and time 
formats. 
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Note: If you do not specify a start or end date, the proxy user can access 
your account immediately and their access privileges will not expire. 

You can select Active to activate proxy's access. To disable proxy's access, select Inactive. 

Remove

You can use this option to remove a selected proxy. To remove a user as a proxy, click to select 
the proxy from the list and click Remove. 

Proxy Login History

Use this option to view the following information about the proxies: 

 Name 

 Login Date 

 Logout Date 

The last login information appears on top. 

Note: The Sign Out link at the upper-right portion of the Unifier window 
allows a proxy's session to end. 

Send Email to a Company User 

This is available for company users only, and is not available for partner company users. 

To send an email to a company user 

1) Navigate to the Company Users log. 

2) Select one or more names in the log, then click Send email on the button bar. Your email 
client window opens, where you can then send an email to the user(s) you selected. 

Unlock a Locked User Account 

A user account can be locked if the user exceeds the maximum sign in attempts, or if the user 
has not signed in after a specified number of days. The users who are locked out of the system 
will receive a message stating the condition that needs to be corrected. 

The password criteria are configured on the Security tab of the Edit Company window.  

To unlock a locked user account: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users or User Administration > Partner Users in 
the left Navigator. 

3) Select the user from the log. 

4) Click Open, and click the Security tab. When a user's account is locked, the Unlock account 
checkbox appears selected. This checkbox is provided only if the user's account is locked. 
Otherwise, it does not appear on the user's Security tab. 

5) Deselect the Unlock account checkbox. 
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6) Click Apply to save or OK to save and exit. 

Change the Status of Multiple Company Users 

If you want to change the status of multiple users at the same time you can select the users from 
the log and change the status for all of those users. This eliminates the need for you to open 
each user record to modify the user status. 

The License Manager controls the number of active users within a system. If the new users will 
exceed your license terms, you will receive an error message. 

To change the status of multiple company users 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users in the left Navigator. 

3) Select the users whose status you want to change. 

4) Choose Status and one of the available statuses (Active, Inactive, On-Hold). 

View or Print User Audit Log 

To view the Audit Log for a user record: 

1) Select a user from the Users log. 

2) Click the View menu and choose Audit Log. The Audit Log window opens, listing each 
event associated with the user. 

3) From the Audit Log window, you can double-click a listed event to view the audit record 
detail, which details the action taken. The details also include for reference the current time 
zone of the user viewing the audit log. 

To print the audit log: 

1) From the Audit Log window, click the Print button. A PDF file of the audit log is created. 

Depending on your browser, the file will be downloaded automatically to your system, or you will 
be prompted to download it manually.  

Reactivating Users 

When a Partner Company participates in a project or shell, the Partner Company becomes a 
Member Company in that project or shell, and the Partner Company users that are added to the 
project or shell become the Member Company users.  
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Notes: 

 Project and shell access is limited to users (including Sponsor 
Company users or Member Company users) who are chosen for the 
project or shell and permissions are configurable for each company. 

 These processes apply to the proxy users. 

Go to the Company Workspace tab (Admin mode). From the left Navigator, click User 
Administration > Partner Users, and open a user to open the Edit User window. In this 
window: 

 If you (the administrator) deactivate a Partner Company user from a project or shell that the 
Partner company was associated with and later decide to reactivate the Partner Company 
user for that project or shell, the status of that Partner Company user changes to what it was 
prior to the deactivation of that Partner Company user. 

 If you (the administrator) remove a Partner Company from a project or shell and later 
decided to re-add the Partner Company to that project or shell, the status of the Partner 
Company users changes to what it was prior to the removal of the Partner Company. In this 
scenario, the administrator has to manually activate the Partner Company user at the 
company level (global), and the system automatically changes the status of the Partner 
Company user to what it was prior to the removal, or deactivation. 

Important Information about Reactivating Users

When you deactivate the Partner Company users who are active in a project or shell and later 
activate the same users, the system reverts the status of the users to "Active" or whatever the 
user's status was prior to the deactivation. 

When you deactivate a Partner Company, in Company Workspace, the system removes the 
Partner Company that exists as a Member Company (in a project or shell). If you deactivate a 
Member Company from the list of Partner Company, in the Company Workspace, the system 
removes the Member Company from all associated projects or shells and sets all Member 
Company users as "Inactive." When you reactivate the Member Company, at the company level, 
the system adds the Member Company to all previously associated projects and shells. 

If a Partner Company is a member of a project or shell, but the Partner Company users are all 
set as "Inactive" in that project or shell, when you (the administrator) decide to reactivate the 
Partner Company users at the company level, the status of the Partner Company users at the 
shell level will remain as "Inactive." 

When there are limited licenses available in the system, you need to deactivate the Member 
Company users at company-level. In this case, the Partner Company users are deactivated 
automatically. 

You can reactivate a deactivated Member Company at company-level (Company Workspace 
tab). 

Exceeding License Limit

Example 

If you have three licenses, but you have added or activated five users, the system assigns 
the three licenses that you had to the first three users (most recent users) that you added or 
activated. 
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Creating Partner Companies, Users, and Permission Settings (On-Premises Only) 

Creating Partner Companies 

A Company Administrator of an Owner Company (Sponsor Company) can create multiple 
partner companies. 

To create multiple partner companies go to Company Workspace tab > Admin mode > 
Partner Companies > New. 

In the New Company window, enter information in fields of the following tabs: 

 General

 Address

 Security

 Contact

The Partner Companies log toolbar allows you to add (New), open (Open), and find (Find) 
partner companies. 

The Partner Companies log page allows you to see a list of partner companies (Company 
Name), the name of the contact for the partner company (Contact Name), phone (Phone), and 
the partner company standing such as active or inactive (Status). 

The Partner Users node has the following menu options:  

 File

 New

 Open

 Send e-mail

 Status

Active

Inactive

On-Hold

 Edit

 Bulk Edit

 Delete

 Update User Type

To Portal

To Standard

 View

 All

 Find...

 Audit Log...

 Help

 Unifier Help

 Unifier Library
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 User Productivity Kit

 About Unifier

The Company Workspace log page (for Partner Users node) has the following toolbar options: 

 New

 Open

 Find

 Status

 Active

 Inactive

 On-Hold

 Update User Type

 To Portal

 To Standard

The Update User Type (To Portal and To Standard) option, collectively, work as a bulk action 
on one or more selected user rows by enabling you to update the type of user. For example, you 
can select one row, or multiple rows, click Update User Type, and change the user type to 
portal, or standard, by clicking To Portal, or To Standard. 

Creating Users for the Partner Company 

To add users to a Partner Company go to Company Workspace tab > Admin mode > User 
Administration > Partner Users > New. 

When the Edit User window opens, you can see the following tabs. Enter data in the fields 
within each tab. 

 General

1. Enter the name of the Partner Company (the system conducts a search and displays a 
filtered list of partner companies) 

2. Alternatively, you (Company Administrator) can select the name of the Partner Company 
from the list by clicking the arrow. 

3. Fill out the fields under "Contact Information as in Company Directory." 

4. Select the Status, and click OK. 

 Security

To enter the password for the user. 

 Groups

To add the user to an existing group. 

 Permissions

To assign permissions to various modules in Unifier. 

 Projects/Shells

The content in this tab is blank when creating a user, and any existing content varies based 
on the Projects/Shells that the user has access to. 

 Programs
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The content in this tab is blank when creating a user, and any existing content varies based 
on the Programs that the user has access to. 

 Proxy

To manage Proxy settings. 

If user assignment results in the number of users exceeding the licenses allocated, Unifier 
displays a notification. 

If the user type attribute is not mentioned when creating the user, the user type for that user will 
be set to Standard user type by default. 

When you are creating a user, the User Type drop-down list is defaulted to Standard user, but 
you can change the User type to Portal. 

The Attribute "Earned Value Management" displayed is unchecked by default. If the user checks 
this option, then the user will be granted access to the Earned Value Management module. This 
checkbox will be disabled for Portal type of users.  

Note: The checkbox for Earned Value Management users will be seen 
only when the Earned Value Management module is loaded. 

In the License Manager, the Company user and Partner user are considered Standard users in 
terms of license count and combined count for License Terms and Current Usage. The License 
Manager landing page will define Gauge chart for all the following license types: 

 Standard Users 

 Portal Users 

 Earned Value Management Users 

In addition, a new count for Portal users and Earned Value Management (EVM) users are 
shown for License Terms and Current Usage. This count will depend on: 

 Whether a particular Company user is marked as Portal user, and 

 The Earned Value Management user in User Administration. 

The excess or surplus (overage) is calculated in the same way as the Standard users. 

The Site Administrator can edit the license terms and view the audit log for the users by clicking 
the Settings icon. 

When editing the user count, the Site Administrator will have to put a combined number for 
active named users. 

The Site Administrator will also be able to edit the Portal users and EVM users count by using 
the following tabs on the License Terms window: 

 General tab 

 Notifications tab 

For users other than the Site Administrator, only the Notification tab will be available to be 
edited. 

Notes: 

 Any user who has not yet been added to the existing partner 
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companies will be added to the Partner Users log of the Owner 
Company as Inactive user. 

 Partner user creation through CSV is not supported. 

Permission Settings for Partner Companies 

To set permissions for partner companies go to Company Workspace tab > Admin mode > 
User Administration > Access Control > Administration Mode Access > User 
Administration > Partner Companies. 

In the Module Permission Settings window, determine the level of permission for each user (in 
the Partner Company) that is listed. You can click Add (to add a new name), Modify (to change 
the permission setting for a user, by way of Permission/Access Control window), or Remove
(to delete a name) in this window. 

If you (Company Administrator) create a Partner Company and select Inactive for the Partner 
Company Status, then the users that you add for that Partner Company will be inactive. When 
the contract with a Partner Company ends, you can select Inactive for the Partner Company 
Status and inactivate the contract. 

Creating Partner Companies and Users (Cloud Only) 

A partner company is a consultant, contractor, or vendor company that is associated with a 
owner company. A partner company may work on some or all of the projects or shells that the 
owner company commissions. 

Creating partner companies and users requires you to perform a series of tasks in both 
Primavera Unifier and Primavera Administration. 

For the prerequisites and tasks to create partner companies and users, see the Primavera 
Administration Identity Management Guide.

Adding and Managing Partner Company Users 

Adding a partner company user enables you to grant them access to your company features in 
the company workspace, programs, projects, or shells. You can manage their status, group 
membership, and permissions. Users can have access to self-service portal login, only. 

User Type 

As part of the log attributes, the column, "User Type" in the Company Workspace log page 
(Partner Users node Company Workspace > Admin mode > User Administration > Partner 
Users) identifies the type of user per following: 

 SYS User Type/Standard

The SYS User Type/Standard, which refers to both Company and Partner users, can have 
access to all modules, except Earned Value Management. If the Earned Value Management 
component is checked for a Standard User, the Earned Value Management will be available 
to the Standard User. 
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 SYS User Type/Portal

The SYS User Type/Portal, which refers to Portal 

Adding a Partner Company User 

Partner company user details are managed by the Site Administrator or the company 
administrator for the partner company. As the company administrator for the your company, you 
can add partner company users to your own company at the company, program, project, or shell 
level, and control their status and permissions within your company. 

If a partner company user is added to a project or shell, the user will be added to the Partner 
Company Users log automatically. 

The License Manager (Company Workspace tab > Admin mode > User Administration > 
Access Control > Administration Mode Access) controls the number of active partner 
company users within a system. If the new users will exceed your license terms, you will receive 
an error message. 

By default, new users will have a status of Active. You can change the status or other user 
detail information selecting the user from the list and clicking Open. 

To access the Partner Users log 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Partner Users in the left Navigator. To open an existing user 
record, select a user from the log and click Open. 

Note: If a User Attribute form has been imported, the columns that 
appear in the Users Log can vary. If designed in uDesigner, the log can 
include navigation in the left pane. This navigation allows you to filter the 
display of users listed in the log. If you decide that you want a standard 
log to display, you can remove the navigation from the log in uDesigner. 
Also, the search criteria in the Find window and sort order can also vary 
depending on what was added to the User log design in the User 
Attribute form. 

To add a new partner company user 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Partner Users in the left Navigator. 

3) Click New from the toolbar to open the Edit User window and complete the form. 

4) In the Edit User window, complete the fields of the General tab as discussed in the following 
table. 
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5) Click the Security tab. You must also add a login user name before saving the record. See 
Manage User Login Information (Security Tab) (on page 111) for details. 

6) At this point, you can activate the user, save the record, or complete the rest of the tabs: 

 Groups: You can add the user to existing groups. The default groups are Company 
Administrators, Project Administrators, Shell Administrators, and Support. The user 
automatically inherits group permissions. See Manage a user's group membership 
(Groups tab) for details. 

 Permissions: You can configure individual permission settings for the user in this tab. 
See Edit User Permissions (Permissions Tab) (on page 112) for details. Alternatively, 
you can assign the user to a group (the user will automatically inherit group permissions), 
or assign permission through Access Control. 

 Projects/Shells: This tab lists the projects and shells to which the user has been added 
and is view-only. See View User's Project, Program, and Shell Membership 
(Project/Shell/Program Tabs) (on page 112).  

 Programs: This tab lists the programs to which the user has been added and is 
view-only. See View User's Project, Program, and Shell Membership 
(Project/Shell/Program Tabs) (on page 112). 

 Proxy: You can add or view the user's proxy users in this tab. See Designate a Proxy 
User (Proxy Tab) (on page 113). 

7) Click Apply to save changes, or OK to save and exit the window. 

In this field: Do this: 

First Name, 
Last Name 

Enter the first and last name of the user. These are required fields. 

Title Enter an optional company title for the user. 

Email 
Enter the user's email address, which will be used to send system 
notifications to the user, and will display in the user's contact information. 
This is a required field. 

Work Phone Enter the user's work telephone number. 

Mobile 
Phone 

Enter the user's mobile telephone number. 

Home Phone Enter the user's home telephone number. 

Pager Enter the user's page number. 

Fax Enter the user's fax number. 

Address 
Click the Select button to add a company address to the user profile 
(From Edit Company, Address Tab) 

Time Zone 
Choose the default time zone for the user. This can be changed in the 
User Preferences window. 

Language 

Select a language from the drop-down list. 

Note: The languages listed are the active languages selected in the 
Configuration - Internationalization log window, by the administrator. 
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In this field: Do this: 

Date Format 
This setting controls the display of dates on reports, business process 
forms, etc. This can be changed in the User Preferences window. 

User Type 

Select Standard or Portal. The Standard User has access to all 
modules, except the Earned Value Management. (If the Earned Value 
Management component is selected for a Standard User, the Earned 
Value Management is available to the Standard User.) The Portal User 
only has access to the self-service portal login. 

Earned 
Value 
Management

The Attribute "Earned Value Management" displayed is unchecked by 
default. If the user checks this option, then the user will be granted 
access to the Earned Value Management module. This checkbox will be 
disabled for Portal type of users. 

Status 

New users are Active by default. Status can be Active, Inactive or 
On-hold. Neither Inactive nor On-Hold users can sign in: 

 Active: User is listed in Project or Shell Directory, in User/Group 
Picker, User can sign in and participate in project or shell. 

 Inactive: User's name does not appear anywhere for selection on 
any project-or shell-related functions or User Picker. User cannot 
sign in but they can be given permissions and added to groups. 

 On-hold: User can be added to a project or shell and assigned as a 
participant in a business process workflow but cannot sign in. 
Normally used to pre-assign users to a new project or shell before 
activating it. 

Active and On Hold users will be counted against your user license 
terms; Inactive users will not. 

Managing Partner Company User: Status, Groups, and Permissions 

User details such as contact information are managed for individual users by the company 
administrator for the partner company. 

Note: Partner company users can be granted Company Administrator 
permissions if you add them to the Company Administrators group. See 
Manage a User's Group Membership (Groups Tab) (on page 111) for 
details on adding users to groups. 

You can manage the following information for partner company users: 

Status: You can change the partner company user to Active, Inactive, or On-Hold. 

 Active users are eligible to participate in company or project- or shell-level activities to 
which they have permissions. 
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 On-Hold users appear on user pickers, and can be added to business process set ups, 
project or shell user lists. However, the user cannot log onto the system until they are 
activated. 

 Inactive users will not appear in user pickers. If you inactivate partner company users, 
they will automatically become inactive throughout the system, including in any projects 
or shells to which they belong. After inactivating, if you then change the status back to 
Active, their status in projects or shells will not automatically change back to Active; you 
will need to reactivate them at the project or shell level. 

Groups: You can add a partner company user to a company or project- or shell-level group as 
needed. 

Permissions: You control permission access for partner company users within your company. 

To edit a partner company user's details 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Partner Users in the left Navigator. The Users log opens. 

3) Select a partner company user and click Open. The Partner Company Edit User window 
opens. 

Note: If a User Administration design has been imported, the data 
elements that appear in the General tab of the User Properties can vary. 

4) Do any of the following: 

 To change the status of the partner company user, click the General tab and change the 
Status field. 

 To manage a partner company user's group membership, click the Groups tab. Click 
Add or Remove. 

 To manage a partner company user's permissions, click the Permissions tab. Grant 
permissions to the user as needed. (In addition, when using Access Control, both partner 
company users and sponsor company users can be added to a module.) 

5) Click OK to save and exit. 

Changing the Status for Multiple Partner Users 

If you want to change the status of multiple users at the same time you can select the users from 
the log and change the status for all of those users. This eliminates the need for you to open 
each user record to modify the user status. 

Note: The License Manager controls the number of active users within 
a system. If the new users will exceed your license terms, you will 
receive an error message. 

To change the status of multiple partner users 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Partner Users in the left Navigator. 

3) Select the users whose status you want to change. 
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4) Choose Status and one of the available statuses (Active, Inactive, On-Hold). 

Importing and Exporting Company and Partner Users 

Importing and Exporting for Company Users 

When the direction for the Data Element (DE) "uuu_user_company" is set to Input/Both, then 
the DE "Company" will be available in the CSV when the user performs Export Structure. 

When the direction for the DE "uuu_user_company" is set to Output , then the CSV retrieved 
through the Export Structure action will not have the DE "Company". In this scenario, the CSV 
can be used to create Company Users. 

If the DE "Company" is present in the CSV, the user must include the Owner Company name to 
complete the CSV import. The system will not validate because the value in the DE "Company" 
is ignored. 

Importing and Exporting for Partner Users 

When the User Attribute Form is present, the following conditions apply:

The Partner Users log enables you to export and import, similar to Company Users log. 

Go to the Company Workspace tab (Admin mode). 

From the menu bar, click File. Click Export to see the following sub-options: 

 All

To export the list of partner users to a CSV file. 

 Selection

To export a list of selected partner users to a CSV file. 

 Export Structure

To export the structure for partner users to a CSV file based on the DEs set in the 
Integration node of Partner Users. 

If the Direction is set to Output, in uDesigner, then:  

 The CSV file generated using All and Selection will export data, but it will not contain the 
company attribute in the CSV file. 

 The CSV file generated using Export Structure will not include company attribute. Such 
CSV file, when used to create user by way of the Import option, will return the error, 
"Company is required" indicating that a partner user cannot be created without a company 
attribute. 

Similarly, the Import option will be available as a sub-option of the New option in toolbar and 
menu options (File > New > Manual or Import). The Import option, in this case, enables you to 
perform a bulk import by way of a CSV file. The functionality is similar to the Import option on 
the Company Users log. 
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The user can import partner users through a CSV file only when the company attribute is 
present. In this scenario, the Direction (for Integration) must be set to Input or Both in 
uDesigner in order for the user to be able to create partner users by way of the Import option.   

Note: The company attribute is a mandatory field when creating Partner 
Users by way of the Import option. 

When the User Attribute Form is not present, the options to import or export will be available the 
same ways as when a User Attribute Form is present. 

If the User Attribute Form is not defined, and the user clicks Export Structure for Partner Users, 
then the DE "Company" is displayed by default in the exported CSV file. 

Reactivating Users 

When a Partner Company participates in a project or shell, the Partner Company becomes a 
Member Company in that project or shell, and the Partner Company users that are added to the 
project or shell become the Member Company users.  

Notes: 

 Project and shell access is limited to users (including Sponsor 
Company users or Member Company users) who are chosen for the 
project or shell and permissions are configurable for each company. 

 These processes apply to the proxy users. 

Go to the Company Workspace tab (Admin mode). From the left Navigator, click User 
Administration > Partner Users, and open a user to open the Edit User window. In this 
window: 

 If you (the administrator) deactivate a Partner Company user from a project or shell that the 
Partner company was associated with and later decide to reactivate the Partner Company 
user for that project or shell, the status of that Partner Company user changes to what it was 
prior to the deactivation of that Partner Company user. 

 If you (the administrator) remove a Partner Company from a project or shell and later 
decided to re-add the Partner Company to that project or shell, the status of the Partner 
Company users changes to what it was prior to the removal of the Partner Company. In this 
scenario, the administrator has to manually activate the Partner Company user at the 
company level (global), and the system automatically changes the status of the Partner 
Company user to what it was prior to the removal, or deactivation. 

Important Information about Reactivating Users

When you deactivate the Partner Company users who are active in a project or shell and later 
activate the same users, the system reverts the status of the users to "Active" or whatever the 
user's status was prior to the deactivation. 



Unifier General Administration Guide

128

When you deactivate a Partner Company, in Company Workspace, the system removes the 
Partner Company that exists as a Member Company (in a project or shell). If you deactivate a 
Member Company from the list of Partner Company, in the Company Workspace, the system 
removes the Member Company from all associated projects or shells and sets all Member 
Company users as "Inactive." When you reactivate the Member Company, at the company level, 
the system adds the Member Company to all previously associated projects and shells. 

If a Partner Company is a member of a project or shell, but the Partner Company users are all 
set as "Inactive" in that project or shell, when you (the administrator) decide to reactivate the 
Partner Company users at the company level, the status of the Partner Company users at the 
shell level will remain as "Inactive." 

When there are limited licenses available in the system, you need to deactivate the Member 
Company users at company-level. In this case, the Partner Company users are deactivated 
automatically. 

You can reactivate a deactivated Member Company at company-level (Company Workspace 
tab). 

Exceeding License Limit

Example 

If you have three licenses, but you have added or activated five users, the system assigns 
the three licenses that you had to the first three users (most recent users) that you added or 
activated. 

Adding and Managing Groups 

Company-level user groups can be used to group users who will be using the same functionality 
in the system and assigned the same Permissions. Anytime a new person comes onto the 
project or shell you can assign them to the appropriate groups and their permissions will be set 
automatically. 

There are three default groups created for new companies: Company Administrators, Project 
Administrators, and Support. You can edit group information and permissions as necessary, and 
create new groups as needed. 

For example, you may want to create a "Finance Admin" group and give them permission to 
create and modify Cost Sheet Templates. Another "Finance User" group may have permission 
to access and work with project- and shell-level cost sheets, but not the templates. These users 
may require access to only those modules and reports dealing with finances, but not other areas 
of the company, project or shell. 

To access user groups 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Groups in the left Navigator. 

Create a New Group 

The following discusses how to create a new group. 
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To create a new group 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Groups in the left Navigator. The Groups log opens. 

3) Click the New button. The Groups window opens. 

4) Complete the General tab as outlined in the following table. 

5) At this point you can also complete the other two tabs: 

 Add user to the groups in the Members tab. 

 Add group permissions in the Permissions tab. 

6) Click OK to add the new Group. 

In this field: Do this: 

Group Name Enter a name for the group. 

Group Manager 
Click Select and select the person responsible for administering 
the group. This person automatically becomes a member of the 
Group. 

Group Description 
Enter a description, such as the group's function or permission 
level. 

Add Users to a Group (Members Tab) 

This section discusses how to add and manage a group's membership. You can add company 
users or partner company users to a group. You can also manage a user's group membership in 
the Groups tab of the Edit User window of both company and partner users. 

To add a user to a group 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Groups in the left Navigator. The Groups log opens. 

3) Select a group and click Open. The Groups window opens. 

4) Click the Members tab, and click Add. The User/Group Picker opens. The User/Group 
Picker displays all Active or On-Hold users from the sponsor company and all Partner 
Companies. The company affiliation is noted in the Company column on the picker. 

Note: If a User Administration design has been imported, the content of 
the User/Group picker (in User view) can vary. The Find window and sort 
order can also vary depending on the optional design. 

5) Select the user(s) to add to the group. (Press the Ctrl or Shift keys to select more than one 
user name.) 

6) Click Add. Users will appear in the Selected Users box. 

7) Click OK, then click OK to close the Groups window. 
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To remove a user from a group 

From the Groups window, Members tab, select the user on the list and click Remove. 

Edit Group Permissions (Permissions Tab) 

The permissions assigned here will be applied to all members of the group. Users within the 
group inherit permissions from the group. If a user is in more than one group, then the highest 
level of permissions granted in any group for a module will prevail. 

Note: Permissions are described in the Unifier Data Reference Guide. 

To assign permissions 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Groups in the left Navigator. The Groups log opens. 

3) Select a group and click Open. The Groups window opens. 

4) Click the Permissions tab. 

5) You may click on the plus sign next to a module to expand the options. Scroll up or down, 
as needed. 

6) Select a module in the upper portion of the window. Choose the Permission level for that 
module in the lower portion. 

7) Click OK to save. 

To copy permissions from a template 

1) In the Permissions tab, click the Copy Permissions button. 

2) Select the template and click OK. All permissions settings in the user record will be 
overwritten and replaced with the permission settings from the template. 

Delete a Group 

Company Administrators can delete an existing user group from the shell. This section describes 
how to manually delete a user group from a shell.  

Note: You can delete a user group from a specific shell template but not 
from other Projects/Shells that have been created using the template. 

To delete an existing user group: 

1) Click Company Workspace tab and switch to Admin mode. 

2) Open the project or shell and in the left navigation pane, click Templates > Shells > {Shell 
Type} > {Shell Templates} > User Administration > Groups. 

3) Select a user group from the log. 

4) Click Delete. 
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Note: System prompts the user asking to confirm deletion of the user 
group. 

5) Click Yes to delete the user group. 

Integration Users 

Integration user refers to a user who is performing integration, using the SOAP and REST 
services. 

You (Administrator) can use the Integration Users sub-node (under User Administration
node) to view the list of integrated users, create new integrated users, and assign or edit 
permissions for Document Manager and access protocol (Legacy). 

To access the Integration Users sub-node: 

1) Go to Company Workspace tab and switch to Admin mode. 

2) Click User Administration node to expand. 

3) Click Integration Users sub-node log. 

The Integration Users sub-node log contains the following elements: 

Toolbar options

 Create

 Refresh

 Print

 Find on Page

Columns

 First Name

 Last Name

 User Name

 Status

 Description

 Auth Type

 Timezone

When you select a user, a right-hand pane displays the general details for the user that you 
selected. 

The following explains each element in details. 

Creating Integration Users 

To create a new integration user: 

1) Go to the Integration Users log. 

2) Click Create to open the Create User window. 

3) Fill out the form. 
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4) Click Done. 

The following explains each block and field in the Create User window: 

General block 

It provides general information about the integration user. The General block has the following 
fields:  

 First Name

 Last Name

 Status

 Active

 Inactive

 Email

 Language (system default language) 

 Description

 Time Zone (system default time zone) 

 Date Format 

Security block 

It provides the ability to add "username" and "password" for a user. The Security block has the 
following fields: 

 Username

 Password

 Confirm Password

 Expiry Duration

 Expiry Units

Permissions block 

It provides the ability to determine the permissions that the user has (for modules in the system). 
The Permissions block has the following fields: 

Administration

 Company Administration 

 Full Access: This permission will provide full access to the system. 

 Create: This permission will provide access to all the POST services. 

 Update: This permission will provide access to all the PUT services. 

 Get: This permission will provide access to all the PUT services. 

 User Administration 

 Full Access: This permission will provide access to adding and maintaining user-level 
access. 

 Create: This permission will provide access to all the POST services. 
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 Update: This permission will provide access to all the PUT services. 

 Get: This permission will provide access to all the PUT services. 

Business Process

 Business Process Service 

 Full Access: This permission will provide full access to services related to business 
processes (BPs). 

 Create: This permission will provide access to all the POST services related to BPs. 

 Update: This permission will provide access to all the PUT services related to BPs. 

 Get: This permission will provide access to all the PUT services related to BPs. 

 Non-Workflow Business Process Permission 

 Update: This permission will provide access for maintaining non-workflow BPs. 

 Get: This permission will provide access to all the PUT services related to non-workflow 
BPs. 

Document Manager

 Document Services 

 Full Access: This permission will provide full access to services related to Documents.

 Create: This permission will provide access to all the POST services for Documents, 
which includes: 

Create Documents by Path 

Create Documents by Parent Folder ID 

 Update: This permission will provide access to all the PUT services for Documents, which 
includes: 

Update Documents Metadata by Path 

Update Document Metadata by Document ID 

 Get: This permission will provide access to all the PUT services for Documents, which 
includes: 

Get Documents by Path 

Get Documents by Parent Folder ID 

Get Document by File ID 

 Folder Services 

 Full Access: This permission will provide full access to services related to Folders.

 Create: This permission will provide access to all the POST services for Folders, which 
includes: 

Create Folder by Path 

Create Folder by Parent Folder ID 

 Update: This permission will provide access to all the PUT services for Folders, which 
includes: 

Update Folders Metadata by Path 

Update Folder Metadata by Folder ID 
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 Get: This permission will provide access to all the PUT services for Folders, which 
includes: 

Get Folders, or Documents, Metadata by Path. 

Get Folders, or Documents, Metadata by Parent Folder ID 

Reporting 

 User Defined Reports 

 Get: This permission will provide access to all the PUT services for user-defined reports 
(UDRs). 

Legacy block 

Legacy SOAP services 

 The Full Access permission will be supported for all the Legacy SOAP services. 

 The check-boxes will be checked by default when clicked on Full Access. 

Cost 

 CBS Services 

 Full Access: This permission will provide full access to services related to Work/Cost 
Breakdown Structure (WBS/CBS). 

 Create: This permission will provide access to all the POST services related to CBS 
Services. 

 Update: This permission will provide access to all the PUT services related to CBS 
Services. 

 Get: This permission will provide access to all the PUT services related to CBS Services. 

 CashFlow Services 

 Full Access: This permission will provide full access to services related to CashFlow 
Services. 

 Create: This permission will provide access to all the POST services related to CashFlow 
Services. 

 Update: This permission will provide access to all the PUT services related to CashFlow 
Services. 

 Get: This permission will provide access to all the PUT services related to CashFlow 
Services. 

 CashFlow Permissions 

 Update: This permission will provide access for maintaining permission levels for 
CashFlow Services. 

 Get: This permission will provide access to all the PUT services related to CashFlow 
Services. 

Fund 

 Fund Services 

 Full Access: This permission will provide full access to services related to Fund Services. 
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 Create: This permission will provide access to all the POST services related to Fund 
Services. 

 Update: This permission will provide access to all the PUT services related to Fund 
Services. 

 Get: This permission will provide access to all the PUT services related to Fund Services. 

ScheduleSheet 

 Schedule Sheet Services 

 Full Access: This permission will provide full access to services related to Schedule 
Sheet Services. 

 Create: This permission will provide access to all the POST services related to Schedule 
Sheet Services. 

 Update: This permission will provide access to all the PUT services related to Schedule 
Sheet Services. 

 Get: This permission will provide access to all the PUT services related to Schedule 
Sheet Services. 

Activity Manager 

 WBS Services 

 Full Access: This permission will provide full access to services related to Work/Cost 
Breakdown Structure (WBS/CBS). 

 Create: This permission will provide access to all the POST services related to WBS 
Services. 

 Update: This permission will provide access to all the PUT services related to WBS 
Services. 

 Get: This permission will provide access to all the PUT services related to WBS Services. 

ExchangeRates 

 Exchange Rates Services 

 Update: This permission will provide access to all the PUT services related to Exchange 
Rates Services. 

 Get: This permission will provide access to all the PUT services related to Exchange 
Rates Services. 

Space Manager 

 Space Manager Services 

 Full Access: This permission will provide full access to services related to Space 
Manager Services. 

 Create: This permission will provide access to all the POST services related to Space 
Manager. 

 Update: This permission will provide access to all the PUT services related to Space 
Manager. 

 Get: This permission will provide access to all the PUT services related to Space 
Manager. 
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Updating Permissions for Integration Users 

To update the permissions for an integration user: 

1) Go to the Integration Users log. 

2) Double-click the name of the applicable user to open the Update User window. 

3) Click Permissions to expand the form. 

4) Set the integration user permission for the applicable areas: 

 Administration

 Business Process

 Document Manager

 Reporting

 Legacy

 Cost

 Fund

 ScheduleSheet

 Activity Manager

 ExchangeRates

 Space Manager

5) Click Done. 

Printing and Exporting Integration Users 

To print a list of the integration users: 

1) Go to the Integration Users log. 

2) Click the Print drop-down. 

3) Select Print and follow the prompts. 

To export the integration users to CSV: 

1) Go to the Integration Users log. 

2) Click the Print drop-down. 

3) Select Export to CSV and follow the prompts. 
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To export the integration users to Excel: 

1) Go to the Integration Users log. 

2) Click the Print drop-down. 

3) Select Export to Excel and follow the prompts. 

Access Control for Integration Users 

To set permissions for Integration Users: 

1) Go to Company Workspace tab, Admin mode. 

2) Open the User Administration grouping node and click Access Control node to open the 
Access Control log. 

3) Click Administration Mode Access to expand. 

4) Click User Administration to expand. 

5) Click Integration Users. 

You can assign the following permissions: 

Permission Expected Behavior When Checked 

Create When you check this option, the system selects the 
following permissions: 

 Modify 

 View 

A user with the "Create" permission can add users, 
modify the user status, and view the user details. 

Modify When you check this option, the system selects the 
"View" permission. 

A user with the "Modify Status" permission can modify 
the user status and view the user details. 

View A user with the "View" permission can view the user 
details. 

Managing Users in Bulk 

You can use bulk processing to manage users across a large number of projects or shells. Bulk 
processing means that you can perform the same action on a large number of user records 
without having to navigate to each record and perform the same action repeatedly. You can 
perform this bulk processing at the shell or project level.  



Unifier General Administration Guide

138

Note: For cases where users have the same first and last name, the 
combination of first name, last name, company, and email address is 
used to uniquely identify a user. The email address is required on all 
imported rows. 

You can use bulk processing to:  

 Add or remove user group assignments 

 Add new users 

 Change the status of existing users 

 Update multiple users in the User logs for Company or Partner users 

Change User Group Assignments or Add New Users in Bulk 

To add or remove user group assignments in bulk 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Company Sponsored Projects (Standard) > All or 
CompanySponsored Shells > shell log (for the shells that you have configured). 

3) Open the project or shell from the log. 

4) Click the User Administration grouping node and select the Groups functional node. 

5) Double click to open a group from the log that you would like to assign users to. 

6) Select the Members tab and click Add to open the User/Group picker window. 

7) Select the user(s) to add to the group and click Add to move users to the Selected 
Users/Groups list. Use ctrl and shift to select multiple users at a time.  

8) Click OK when finished. 

To add new users to a project/shell in bulk 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Company Sponsored Projects (Standard) > All or 
CompanySponsored Shells > shell log (for the shells that you have configured). 

3) Open the project or shell from the log. 

4) Click the User Administration grouping node and select the Users functional node. 

5) Click New to open the User/Group picker window. 

6) The Users/Groups are listed based on the company selected in the List Names From
dropdown at the top of the window.  

7) Select the user(s) to add to the group and click Add to move users to the Selected 
Users/Groups list. Use ctrl and shift to select multiple users at a time.  

8) Click OK when finished. 
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Update Multiple Company or Partner Users 

Bulk edit of Company or Partner users relies on fields defined in Integration and is available only 
if the User Attribute form has been imported. For Partner users, the only additional attributes that 
are available for bulk edit are those that were added by importing the User Attribute form. 

Note: Bulk update of status is available through the Status button in the 
Users log toolbar. 

To update multiple users in the Users log 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Company Users or User Administration > Partner Users in 
the left Navigator. 

3) From the log, select users to modify. 

4) Choose Edit > Bulk Edit. 

5) Modify the Bulk Edit form as needed. 

6) Select the Update checkbox for the fields you want to update. The checkbox is automatically 
selected when you type into or modify a field. You can deselect it if you do not want to 
modify the field at this time. 

7) Click Update. This launches the bulk update of the selected records. 

The Bulk Actions Status window displays after you click Update. This window allows you to 
monitor the progress of the bulk update. Click OK after all records have processed. Click 
Cancel if you want to cancel the bulk update in progress. 

Creating and Managing User Preference Templates 

User Preference templates can be used to configure the default user preference settings for new 
users. It can also be used to update existing users' user preferences by "pushing" the 
preference options. In this way, you can establish a standard for your users' preference settings.  

Create a User Preferences Template 

You can create any number of user preferences templates. 

To create a new User Preferences Template: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries and then User Preference Templates in the left Navigator. 
The Preference Templates log opens. 

3) Click New. The User Preferences Template window opens. 

4) On the General tab, enter a name for the template. Each template must have a unique 
name. Enter an optional description. 
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5) For Status, choose Active or Inactive. You can create any number of templates, but only 
one can be active at a time. 

The Active template will be used as the default user preference settings when adding new 
company users. The other templates can be used to update ("push") preference settings to 
existing users. 

6) Click the Preference tab. The Preferences tab appears exactly like the Options tab of a 
user's User Preference window. Complete the fields in the window as described earlier in the 
Preferences section of this guide. 

7) Click the Region Format tab. Select the following: Language, Time Zone, Date Format, and 
Number and Currency Formats. 

Note: The languages listed are the active languages selected in the 
Configuration - Internationalization log window, by the administrator. 

8) Click Apply to save changes, or OK to save and close the window. 

Update Users with the User Preferences Template 

You can create multiple user preference templates. The Active template will be used as the 
default template when creating new users. The other templates can be used to update ("push") 
preference settings to existing users. 

The Update Users process runs in the background. Depending on the number of records and 
projects or shells you are updating, it can take a considerable amount of time to complete. The 
process is complete when the End Date column in the Update History window shows the 
complete date. 

To apply the user preferences template to selected users 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > User Preference Templates in the left Navigator. The 
Preference Templates log opens. 

3) Select any template in the log. 

4) Click the Update Users button and choose Users. The User Picker opens. The picker lists 
Company Users. 

5) Select the users to update and click Add. Click OK to close the picker window. 

6) Select preferences to update. Only selected options are updated. Email subscription choices 
are not selectable; they are determined by the template. 

7) Click OK. 

8) Click Yes to confirm. The user preferences of the selected user(s) will be updated with the 
template settings. 

To apply the user preferences template to all users 

1) In the Preference Templates log, select a template. 

2) Click the Update Users button and choose All Users. This includes Company Users. 

Users are identified by their unique User ID. 
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3) Select preferences to update. Only selected options are updated. Email subscription choices 
are not selectable; they are determined by the template. 

4) Click OK. 

5) Click Yes to confirm. 

View Update Users History 

You can view details about previous Update User runs. 

To view Update Users History 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > User Preference Templates in the left Navigator. The 
Preference Templates log opens. 

3) Click the Update Users button and choose History. The Update Users: History window 
opens. It lists the following: 

 Requestor: User who initiated the update process 

 Users: Either user selected or all users 

 Submit date: When the update request was submitted 

 Start date: When the update process started 

 End date: When the update process ended 

 Status: Status of the request 

4) Select an instance from the list and click Open (or double-click to open). The History Details 
window opens, displaying which users were updated by the request. 

Cancel a User Update Request 

You can cancel an update request that has not yet started, that is, the status is not In Process
or Finished. 

To cancel a user update request 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > User Preference Templates in the left Navigator. The 
Preference Templates log opens. 

3) Click the Update Projects or Update Shells button and choose History. The Update 
Projects or Shells: History window opens. 

4) Select an update that has not yet started. 

5) Click Cancel Request. 

Creating an Approved Email List for Project/Shell Mailboxes 

Emails are important tools for communication, and they need to be included in the Project/Shell. 
Emails can come from: 

 Project/Shell members who send emails from outside the system. 

 External Users who do not use the system. 
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The system collects emails, and their attachments, in a central repository, called a Mailbox. This 
repository lets users use emails to manage and document a Project/Shell. 

Note: Emails can also be linked to business process records. 

After an email resides in the Project/Shell Mailbox, a user can forward the email to appropriate 
members, flag the email for review, or reply to the email. 

When the system is installed for your environment, a dedicated email domain for your company 
is specified. When you create a Project/Shell, the system assigns a unique identifier to the 
Project/Shell. To create a dedicated mailbox as the communication repository for the 
Project/Shell, the system combines your company email address (domain) and the Project/Shell 
identifier. 

The system considers email addresses used by any company or partner user as "approved" and 
automatically whitelists the email addresses. To work with other External Users, such as 
vendors, you (the Administrator) must create a list of approved domains or email addresses, or 
both, that should be accepted by the Project/Shell Mailbox. This helps prevent spam and virus 
attacks from infiltrating your system, by way of external emails. You can add the approved 
domains and email addresses for all the users (Unifier users and External Users) by using the 
Approved Email List feature. By adding a domain, you do not have to enter individual email 
addresses. You can also use the Approved Email List feature to import names and email 
addresses from a CSV file. 

Note: The system accepts up to 1,000 emails from any single address 
per day. The system ignores, as spam, any number of emails beyond 
1,000. 

To create an approved email list (email address of an individual) 

1) Go to the Company Workspace tab, and switch to Admin mode. 

2) Click Standards & Libraries > Approved Email List in the left Navigator. 

3) Click New to open the Add address or domain window. 

4) In the Email/Domain field, enter the email address of the individual, for example: 
someone@example.com

5) (Optional) In the First Name and Last Name fields, enter the name of the user. 

6) If you want to add another email address, click Apply; otherwise, click OK to close the 
window. 

To create an approved email list (Internet domain name) 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > Approved Email List in the left Navigator. 

3) Click New to open the Add address or domain window. 

4) In the Email/Domain field, enter the Internet domain name, for example: @example.com

Notes: 

 Domain names have to start with the "at" (@) symbol. 

 Names can include letters (abc), numbers (123), period (.), and 
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dashes or hyphens (- - -). 

 Names cannot include any other special characters or spaces. 

 Names cannot begin or end with a dash or hyphen. 

 If the system detects a domain name, the system disables the First 
Name and Last Name fields. 

5) Click Apply and then OK. 

Editing, Deleting, and Finding Email Addresses 

After the system is installed, a dedicated email address is specified for the company. When a 
Project/Shell is created, the system assigns a unique identifier to the Project/Shell. The system 
combines the dedicated email address and the Project/Shell identifier and creates the Project 
Mailbox. The Project/Shell email address appears on the Options tab of the Project/Shell details 
page. 

The Administrator can define the project email address in order to create a more meaningful 
name that is related to the project. 

The existing format for an email address in Prefix pattern is: <PID>-<Configurator 
email>@<Domain>. 

The existing format for an email address in Suffix pattern is: <Configurator 
email>@<Domain>+<PID>@<Domain>.

The string that you enter in the Email Address field is prefixed/suffixed to the project email 
address based on the Configurator settings. By default, the system generates the "<PID>" and 
places it as the first part of the project email address. 

You can change the project email address at any time; however, the system retains the emails 
belonging to a previous mailbox of the Project/Shell in the new mailbox. 

The following explains the rules for naming an email address: 

 Must be alpha numeric. 

 Can include non-ISO characters. 

 Cannot contain more than 170 characters. 

 Cannot include the at (@), plus (+), or dash (-), symbols. 

The following characters are not acceptable for the <PID>: / \( ) ~ ! @ # $ % ^ & * { | , ; " < > ' } + 
- : ? space characters = [ ]. 

Note: For an existing Project/Shell, the input box for Email address 
cannot contain zero (0) because internally the system uses zero (0), at 
the time of creating the Project/Shell, to populate the Project ID 
(<PID>_). As a result, zero (0) is not a valid input for the Email Address 
field. 

To edit an email address 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > Approved Email List in the left Navigator. 
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3) In the log click to select the email address that you want to edit and double-click the email 
address to open. The Add/Edit Approved Emails opens. 

4) Edit the information and click OK. 

To delete an email address 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > Approved Email List in the left Navigator. 

3) In the log click to select the email address you want to delete and click Delete. 

To find a specific email address 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > Approved Email List in the left Navigator. 

3) In the log click Find to open the Find window. 

The Find window shows fields from the list, which you can use to narrow the list of items you 
see on the list. These fields show an operator, such as "contains" or "equals," which you can 
use to specify more precisely which items you want to search for. 

4) Click the operator beside the field and choose the operator you want to use on the field, such 
as "equals," "does not contain," or "is empty". 

5) Enter the value the field should contain. 

You can enter a partial name or address. 

6) Click Search (or press Enter). 

The system will display the address(es) or name(s) that match the criteria you entered. It will 
also identify the criteria by which you have searched the list in the "Current View: filtered 
by" line above the list. If you choose to, you can cancel the find action by clicking [Cancel 
Filter]. The system will restore the list to its unfiltered state. 

Importing and Exporting Email Addresses 

If the user and email address information is stored in another software application, such as 
Microsoft Excel, you can import the information from the software application into the Approved 
Email List. You can also export the information from the Approved Email List to another software 
application, if necessary. 

The Export option, on the toolbar, enables you to export: 

 All 

 Selected Rows 

 Structure 

Note: If you choose the Export > All option, you do not need to create a 
template structure. 

The Import option, on the toolbar, enables you to open the File Upload window and select files. 

To import and export email addresses, you (the Administrator) need to create a template 
structure, to use for both the import and export actions, first. 
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To create a template structure 

1) On the Approved Email List log, click Export and select Structure. 

2) At the prompt, click Open. 

The system opens a CSV file (for example: unifier_approved_emails.csv) showing 
the user information in the columns for: 

 Email / Domain* 

 First Name 

 Last Name 

3) Save the CSV file. 

This CSV file becomes the template for importing and exporting Approved Email List data. 

In the CSV file, you can enter the email address information. If an email, or Internet domain 
name, is already in use and you try to add it again, then the system notifies you about the 
duplicate record. 

Notes: 

 Do not change column structure. Columns marked with asterisk (*) 
contain mandatory/required information. 

 Upon importing, if the email, or Internet domain name, is not present 
in the Approved Email List log, then the system creates a new 
record. 

 Upon importing, if the email is present in the Approved Email List log, 
then the system updates the First and Last Name information for that 
associated record. 

 Upon importing, if the Internet domain name is present in the 
Approved Email List log, then the system ignores the First and Last 
Name information for that associated record. 

Example 

Email / Domain* First Name Last Name 

user1@example.com User1 Partner 

user2@oracle.com User2 Contractor 

To import approved email addresses 

1) On the Approved Email List log, click Import. The File Upload window opens. 

2) Use Browse to navigate to the CSV file you want to import. 

3) Click OK to upload the file into the Approved Email List. 

To export all approved email addresses 

1) On the Approved Email List log, click Export and select All. 

2) Select the CSV file and click OK to begin export. 

The system exports all the email addresses on the approved list to the CSV file and open the 
file. 
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You can edit the file and import it back into the system, or you can save the file for later 
updates. 

To export specific approved email addresses 

1) On the Approved Email List log, select the email addresses that you want to export. 

2) Click Export and select Selected Rows. 

The system exports all the email addresses that you selected to the CSV file and open the 
file. 

You can edit the file and import it back into the system, or you can save the file for later 
updates. 

Managing Permissions and Access Control 

Permissions can be set at different levels in the system (the company level or project and shell 
level). 

The permission settings can be done in these functional nodes: 

 Access Control 

 Company User 

 User Administration > Groups 

 Standards & Libraries > Permissions 

A user can be granted permissions individually or can inherit them from the groups to which the 
user belongs. 

If a user is in more than one group, the highest level of permissions granted in any group for a 
module will prevail. 

Users can be granted individual permissions in addition to group permissions. If the user-level 
and group-level permissions are different for a module, the highest level will be granted to the 
user. 

Note: If you grant permissions to project- or shell-level (User mode) 
features from the company-level, the new permission settings will take 
effect on future projects or shells the user is assigned to, but not on 
current projects or shells. To grant permissions to a user for a current 
project, be sure to change the permissions from the project or shell level 
user record. 

Permissions in a project or shell template from which the project or shell is created override the 
company-level permissions. 

Permission Tab versus Access Control 

You can use the following methods to control permissions and access to features and records: 

 Access Control 
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 Permissions tab 

Both of these will allow you to manage permissions. See below to help you decide which to use. 

Access Control 

Access Control displays the permissions granted to all users and groups per module. It allows 
you to quickly see which users and groups have access to each module and at what permission 
setting. 

You can add, remove or adjust permissions for multiple users or groups at once, rather than 
editing the properties for each user or group individually. For example, if you need to grant 
access permissions to a newly set up business process, or want to verify that all team members 
have access to a new feature, it may be easier to do this in Access Control rather than opening 
each individual group or user record. 

You can also generate and print an Access Information table summarizing permission settings. 

Permissions Tab 

You can manage individual user or group permissions in the Permissions tab, which is part of 
the Properties window for the user or group record. Use the Permissions tab to quickly view or 
adjust permission settings for a particular user or group. 

The Permissions tab also enables access to permission templates. You can copy a permission 
template to quickly set up the permissions for a new user or group; you can also save an 
existing user or group's permission settings as a new template for later use. 

See Edit User Permissions (Permissions Tab) (on page 112) or Edit Group Permissions 
(Permissions Tab) (on page 130). 

Edit User or Group Permissions using Access Control 

To adjust permission settings using Access Control 

1) Do one of the following: 

 To open company level access control, go to the Company Workspace tab and switch 
to Admin mode. Open the User Administration grouping node and click Access 
Control in the left Navigator. The Access Control window opens in the right pane of the 
Unifier window. The window displays a copy of the Navigator. 

 To open access control for a program, go to the Company Workspace tab and switch to 
Admin mode. Open the User Administration grouping node and click Access Control
in the left Navigator. The Access Control window opens in the right pane of the Unifier 
window. The window displays a copy of the Navigator. 

 To open access control for a project, open the project and click Access Control in the 
left Navigator. The Access Control window opens in the right pane of the Unifier window. 
The window displays a copy of the Navigator. 

 To open access control for a shell, open the shell and click Access Control in the left 
Navigator. The Access Control window opens in the right pane of the Unifier window. The 
window displays a copy of the Navigator. 
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2) Select a module in the Access Control window. The Module Permission Settings window 
opens. It lists the user(s) and group(s) which currently have access to the selected module 
and their permission settings. 

You can Add, Modify, or Remove users or groups, and grant permission levels. See the 
following procedures. 

To add user and group access to a module 

1) From the Module Permission Settings window, click Add. The Permission/Access Control 
window opens. 

2) Click Add Users/Groups. The User/Group Picker opens. 

3) Select users and/or groups from the list, click Add to add them to the Selected Users/Groups 
list, and click OK. 

4) In the Permission Settings window, select the level of permissions you want to assign to 
the Users/Groups. Click OK. 

To remove a user/group and their related module permissions 

In the Module Permission Settings window, select the checkbox next to the user or group and 
then click the Remove button. 

To modify permission settings 

In the Module Permission Settings window, select the checkbox next to the user or group and 
then click the Modify button. Make changes to permission settings as needed and click OK. 

Create or Edit a Permission Template 

Permission templates are sets of permissions that can be applied to users or groups of users as 
a whole. This is often an easier alternative to setting individual access permissions, especially 
when setting up groups and working with large project or shell teams. You can apply the 
template to a user or group to set basic permissions, then modify the permissions for individuals 
or groups if needed. 

Any project or shell level permission granted at the company level and then applied to a specific 
user or group of users is inherited at project or shell creation time. The user permissions can 
then be modified at the project or shell level if further modifications are necessary. 

By design, when you create a new Permission-based UDR report at the template level:  

 The company level BPs, and the company level Document Manager, data sources will not 
be available in the Data Type pulldown (drop-down) field. 

 The shell level BPs, and the shell level Document Manager, data sources will be available in 
the Data Type pulldown (drop-down) field. 

To create a new permission template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Standards & Libraries > Permission Templates in the left Navigator. The Permission 
Templates log opens. 

3) Click the New button. The Edit Permission Template window opens. 
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4) Add a name and description of the template in the General tab. 

5) Click the Permissions tab. This window is the same as the Permissions tab for an individual 
user or group record. 

6) Configure the permissions settings and click OK. 

To edit a permission template 

1) Select the template from the Permission Template log and click the Open button. The Edit 
Permission Template window opens. 

2) You can edit the name or description in the General tab. 

3) Click the Permissions tab and adjust permission settings as needed. 

4) Click OK. 

To create a new permission template from existing permission settings 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click User Administration > Groups in the left Navigator. 

3) Select a group and click Open. 

4) Click the Permissions tab. 

5) Click the Save as Template button. Enter a template name and click OK. 

Generate and Print an Access Information Report 

You can generate and print an Access Information summary report of user and group permission 
settings. The report will display all user and group permissions. 

To generate the Access Information report 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Go to the User Administration grouping node in the left navigator and click Access 
Control. 

3) Click the Access Information button. The Access Information window opens. It may take 
several moments to generate the report. 

To print the Access Information report 

1) Generate the Access Information report. When the report is complete, the Print button 
becomes available on the toolbar. 

2) Click the Print button. Select the printer and click OK. 

Announcements Node 

In addition to the Site (or System) Administrator, a Company Administrator will be able to create 
Announcements. Also, A Company Administrator will be able to define whether a particular 
announcement should be displayed to: 

 Users. 

 Bidders. 

 Users and bidders. 
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Note: Announcements are displayed to all the users of the owner 
company and all partner users. Bidders are also able to view all 
announcements by the Owner Company, in the Bidder Portal 

To access the Announcements module: 

1) Go to the Company Workspace tab. 

2) Switch to the Admin mode. 

3) From the left-hand Navigator, open the General Administration grouping node and click the 
Announcements node to open both the Announcements log, and the Announcement 
properties page (the right-hand pane). 

The Announcements log (toolbar options) enables you to: 

 Create a new announcement (+ Create icon). 

 Delete or change the status of an existing announcement (Actions drop-down menu). 

 Refresh the log items (Refresh icon). 

 Print, or export, the contents of the log (Print icon). 

 Find items on the log (Find on Page icon). If the you decide to cancel the find for an entire 
row, then you must click the Find on Page icon, again. 

The Announcements log contains the following columns: 

 Title

 Status

 Last Modified By

 Last Modified Date

When the log page is displayed, the default sort order is descending date of records (Last 
Modified Date). 

When you select an announcement record, or you hover over an announcement record, a gear 
menu will be displayed. The gear menu enables you to delete the selected announcement or 
change the announcement status. 

The Announcement properties page (the right-hand pane) also enables you to see, or change, 
the details of an existing announcement. You must click to select an announcement on the 
Announcements log, first. The Announcement properties page (the right-hand pane) also 
enables you to: 

 Enter a title for your new announcement (Title). You must click the create a new 
announcement (+ Create icon) option, first. 

 Enter the text for a new announcement (Announcement Text). Maximum of 4000 
characters, including formatting and HTML tags. 

 Assign a status for your new announcement (Status). Active announcements cannot be 
deleted. 

 Determine the audience (Make an Announcement for). The default is "Both" the Users and 
Bidders. 
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Announcement Properties 

When you create a new announcement record which is unread, a red bubble count-indicator 
icon appears on top of the grey announcement icon (the megaphone icon). In the bubble icon, 
the number of unread announcements is displayed. 

When there are no unread announcements, the bubble count-indicator disappears. 

When you click the announcement icon (the megaphone icon), a grid appears that displays all of 
the unread announcements, highlighted in red. All the announcements are displayed in 
descending order, according to the date. 

After an announcement record has been read by a user, the title of the record is displayed in 
black. When you click the announcement hyperlink, the announcement grid appears. 

In the announcement grid, the active (Status = Active) announcement records are displayed, 
only. The Title, Last Modified By, and Last Modified Date (for both company and system 
announcements) fields are also displayed. 

For the system announcements created by the Site Administrator, the sign-in name of the Site 
Administrator is displayed in the Last Modified By field. 

For company announcements, the full name (First + Last Name) of the user who created (Last 
Modified By) the record, is displayed in the Last Modified By field. 

Access Control for the Announcements Node 

To assign access: 

1) Go to the Company Workspace tab. 

2) Switch to the Admin mode. 

3) From the left-hand Navigator, open the User Administration grouping node and click the 
Access Control node to open the Access Control log. 

4) Click to expand the Administration Mode Access. 

5) Open General Administration and click the Announcements sub-node to open the 
Module Permission Settings window (Permission Settings for: Announcements). 

6) Click Add, click Add Users/Groups, click and select user, group, or both, and click Add. 

7) Assign permission: Create or View. 

Create: Users/Groups with Create announcements permission will be able to create, modify, 
and view all announcements. 

View: Users/Groups with View permission will be able to view the existing announcements, 
without the ability to modify them. 

Site Administrator Announcements Log 

A Site Administrator can access announcements under Customer Support node: 

1) Sign in as Site Administrator. 

2) On the left-hand Navigator click to expand Customer Support node 

3) Click Announcements sub-node. 
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A Site Administrator can create announcements in the same way that a Company Administrator 
creates announcements. 

Announcements created by a Site Administrator are displayed to all users. 

Note: "The Make an Announcement for" option is not available for the 
Site Administrator. 

For a Site Administrator, the following columns are displayed in the Announcements log: 

 Title

The title from the announcement displayed in the log. 

 Status

The current status of the announcement record is displayed in this column. 

 Last Modified Date

The date on which the announcement record was created or last modified. This an 
auto-populated field. The date is displayed in the format selected by the user, in the user 
Preferences window. When a field in an announcement record is modified, and the 
modification is saved, then the Last Modified Date is updated. 

Note: The Announcements log does not display the Last Modified By 
column for Site Administrator. 

Working with the License Manager 

The License Manager (Company Workspace tab > Admin mode > General Administration > 
License Manager) controls the number of active users (Standard Users, Portal Users, 
Collaborator Users, and Earned Value Management Users) allowed in the system based on 
agreed license terms.  

Note: Standard Users refer to both Company and Partner users. 

The license terms (that is, the number of allowed users) used for License Manager are 
maintained by the Site Administrator, and cannot be edited by the Company Administrator. 

You can click the Settings icon to define the notification threshold for license terms and overage 
thresholds. 

The Earned Value Management block in License Manager is seen only when the module is 
loaded. When licenses are provided for the Earned Value Management module, an additional 
Earned Value Management check box is available in the Edit User dialog for standard users. 
Select the check box to designate users as Earned Value Management module users, within 
license terms. 
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Your Company Administrator can access the License Manager to: 

 View the current named users and user record limits. 

 View the usage charts. 

 Print usage reports. 

Your Company Administrator can set up the License Manager to: 

 Notify the Company Administrator (or other designated user) automatically when the number 
of users is approaching the limit. 

 Allow for an overage (that is, a certain number of users that are over the limit, as determined 
by the terms of the license agreement). 

If the number of users exceeds the number of available licenses, the system sends notifications 
to the following: 

 Users specified in the configurator (Unifier Configurator WebLogic). 

 Users who have Notify permission in the License Manager, which was set in Access 
Control. 

The License Manager counts users with status of Active or On-Hold. The term "active named 
user" refers to any user in the system who has an Active or an On-hold status. 

A user with the Inactive status is not counted against the license terms, and you can add/import 
any number of Inactive users. 

View License Manager Terms and Usage 

The License Manager console provides easy access for viewing license terms and usage. 

To view the License Manager console 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click General Administration > License Manager.  

The License Manager console opens in the right pane. The License Manager displays the 
following blocks: 

 Standard Users: This block is always displayed and provides the total license count for 
Company and Partner users. 

 Portal Users: This block is displayed when the environment has license-count of portal 
users greater than zero. 

 Collaborator Users: This block is displayed when the environment has license-count of 
collaborator users greater than zero.  

 Earned Value Management Users: This block is displayed when the module is loaded. 

Each block has the following information: 

 License Terms: Displays the number of Active Named Users — that is, any user with a 
specific user name and password — in the sponsor company and all partner companies. 
("Active" refers to users with a status of Active or On-Hold.) It also displays any Overage
limits, which allow companies to exceed their active named user limits by an agreed upon 
amount. 
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 Current Usage: Displays the current number of Active Named Users (users with status 
Active or On Hold for your company and partner companies, and whether the Overage is 
being used. Usage refers to user records only, regardless of whether the users are 
currently signed in, or not. (Current Usage also displays the "as of" date and time of the 
last update.) 

To view the License Terms window 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click General Administration > License Manager.   

The License Manager console displays in the right pane. 

The Site Administrator will be able to edit the license terms and view the audit log for the 
users by clicking the Settings icon (gear menu). 

The Site Administrator when editing the user count will have to put a combined number for 
active named users. The Site Administrator will also be able to edit the Portal Users and 
Earned Value Management Users counts. 

 The General tab displays your company's current license terms. This tab is read-only, 
and managed by the Site Administrator. 

 The Notifications tab lets you schedule regular usage checks and configure thresholds 
for notifying you when you are getting close to license term limits. 

Notes: If you exceed license limits while adding or importing users, then: 

 While adding company or partner company users, if license limits 
have been reached, a warning message will appear. You may 
receive this warning message if: 

 The license limit for active named users has been reached, but not 
the overage limits. Any new users will be counted against the 
overage limits. 

 The license limits for both active named users and overage have 
been reached. You will be able to add new user records, but will not 
be able to activate them without adjusting your current license limits, 
or deactivating other users. 

 If you are adding partner company users to the company workspace 
or a project or shell, you can add the users, but will not be able to 
activate them. 

 If you are importing users (via XML or CSV), and the license limits are 
reached, any user records that would exceed the limit will not be 
created, and you will receive an error message informing you of the 
number of user records that could not be created. 

 In addition, if your license limits have been reached, you will not be 
able to activate any currently inactive users. 
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Set Up License Manager Scheduled Runs and Notifications 

You can set up the License Manager to notify you when the number of active users in your 
company or partner companies is approaching the established license limits.  

Note: Notifications will only be sent if a scheduled run is set up and 
enabled. Notifications will only be sent to users or groups who have 
been given explicit Modify or Notify Permissions. 

To set up notification and threshold limits 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click General Administration > License Manager. 

The License Manager console appears in the right pane. 

3) Click the Settings icon, and select License Terms. 

4) On the Notifications dialog box, complete the fields as described in the following table, and 
click Apply. 

In this field: Do this: 

Enable 
Notifications 

To enable notifications regarding License Term thresholds, select this 
checkbox. These email notifications will be sent to users or groups 
who explicitly have Modify or Notify permissions. Notifications are sent 
only after scheduled runs. 

Notification 
Thresholds 

 Standard 
Users 

 Portal 
Users 

 Collaborato
r Users 

 Earned 
Value 
Users 

For each type of user, enter the threshold values for active named 
users in your company and partner company. For example, if you 
want to be notified when the number of active named users in the 
system reaches 80% of your license terms, enter 80 in the applicable 
field. 

Note: The threshold value calculates against the number of allowed 
active users in the license terms, and does not count overage 
amounts. After the threshold limit has been reached, users will 
continue to receive notifications during every scheduled run. 

Scheduled 
Runs 
Frequency 

To generate notifications, you must schedule usage runs. These runs 
check for currently active named users in your company and partner 
company. You will receive notification of these runs only if threshold 
values have been reached. Choose frequency: 

Weekly, End of day: Select the day of the week. 

Monthly: Select the day of the month. 
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Print License Manager Information 

You can print a copy of the current license manager console view.  

To print license manager terms and usage 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click General Administration > License Manager. 

The License Manager console appears in the right pane. 

3) In the upper-right corner, click the Print icon. 

The information appears in a printable HTML format in a separate browser window. 

View or Print the License Manager Audit Log 

The audit log captures changes made to license terms. You can view the audit log, search for 
specific changes, print a copy, or save a PDF copy of the audit log to your local drive.  

To view a license manager audit log 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click General Administration > License Manager. 

The License Manager console appears in the right pane. 

3) Click the Settings icon, and select Audit Log. 

The Audit Log window opens. You can scroll through the list of events, sort the list by clicking 
the applicable heading, or click the Find on Page button to search for a specific entry. 

4) From the Audit Log window, you can double-click a listed event to view the audit record 
detail, which includes for reference the current time zone of the user viewing the audit log. 

To print the audit log 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click General Administration > License Manager. 

The License Manager console appears in the right pane. 

3) Click the Settings icon, and select Audit Log. 

4) In the Audit Log window, click the Print button. 

A PDF file is created. 

5) Do one of the following: 

 Click Open to open the file in Adobe Acrobat Reader. From the Reader window, you can 
view, save, or print the file. 

 Click Save. In the Save As window, navigate to the location in which you want to save 
the PDF file. Open the file in Adobe Acrobat Reader and choose File > Print to print. 
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Running System Usage Reports 

You can track current system usage using the predefined system usage reports. These reports 
provide an accurate and efficient way to track and manage licenses and system usage. Usage 
reports can be run based on company workspace or individual projects or shells, and can track 
both sponsor company users and partner company users. 

The available reports are: 

 Usage Detail By Company 

 Usage Summary By Company 

 Usage Detail By Project/Shell 

 Usage Summary By Project/Shell 

 Usage Detail By Company Workspace 

 Usage Summary By Company Workspace 

 Usage Detail By User 

 Usage Summary By User 

 User Account Details 

 User Account Summary 

 User Session Detail 

 Last Login 

 Current Login 

 Proxy Login 

The reports are described in the following sections. 

Run a System Usage Report 

The following is the general procedure for running a system usage report. The availability for the 
reports is based on permissions. 

To run a system usage report 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click System Information > System Reports in the left Navigator. 

3) Select a report from the log and click Open (or double-click the selected report). The query 
window for the report opens. The query window will differ depending on the report selected. 

4) Use the table below to complete the Query fields. You can leave the fields blank to return all 
records without filtering. 

5) Choose a report format. The User Account Details include Programs as a source, and allows 
you to choose a program name for the report. The options are: 

 HTML: Displays the report in the standard format in a browser window. You may print a 
copy of the report from the browser window. (Click the File menu and select Print or Print 
Preview.) 
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 CSV: Formats the report in an exportable CSV format, usually in Microsoft Excel, or other 
software application you have set up for this format. You will be prompted to save the file 
or open it. 

 Excel: The report displays in Microsoft Excel format in the browser window. You can 
save an Excel formatted copy of the report or print from the window. (Click the File menu 
and select Save As or Print.) 

 PDF: Opens Adobe Acrobat Reader and displays the report in PDF format. You can save 
a copy of the report and/or print it from the PDF window. (Click the File menu and select 
Save or Print.) 

 XML: Generates the output in XML format. Before the results are generated, a 
confirmation window will open, giving you the option to save the XML file to your local 
machine (click Save), or display the results in a popup browser window (click Open). 

6) Click Run to run the report. The report results are generated in the format you chose. 

For this query parameter: Do this: 

Owner Company (The field displays the owner company.) 

Source 

Select one of the following options to see where users' 
time was spent: 

All: All areas of the system 

Company Workspace 

Project: If you select Project, the Project picker is 
activated. 

Shell: If you select Shell, the Shell picker is activated. 

Other: Other areas of the system that are not part of a 
project or shell or the company workspace, such as the 
Asset Manager, Administration Mode, program 
features, user home page, etc.  

Project/Shell 

If you chose Project /Shell or All as the source, the 
Project /Shell picker is activated. Click Select to select 
a specific project. If you do not select a project or shell, 
the default is all projects or shells. 

Partner Company 
Click Select to select a specific partner, or leave blank 
to include all partner companies (in addition to the 
owner company results). 

Date Range From 
Click the calendar icon to enter a start date for the 
report. If you leave it blank, the report will start at the 
company activation date. 

Date Range To 
Click the calendar icon to enter a start date for the 
report. If you leave it blank, the report will include 
results up to the current date. 
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System Usage Report Types 

The following describes details for running the predefined system usage reports. 

Usage Detail By Company 

This report allows you to view usage times across a company and all of its partner users 
grouped by Company /Partner name. This report uses the login time to track usage, and shows 
usage per day (not per session). 

The report results are sorted as follows: 

 Company name in alphabetical order. 

 For each company, the list of user names: first name, last name 

 For each user, lists the source alphabetically 

 When source = Project, then project names are listed alphabetically 

Report Query Parameters: 

 Owner Company: Read-only 

 Source: All, Company Workspace, Project/ Shell or Other 

 Project/Shell: Select a Project/Shell or leave blank 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This column: Shows: 

Company 
Name 

The name of the company for which the report is being generated. 
Depending on filter condition, this report can be generated for a 
particular company or all. 

User Name 
The user names that are involved either in Projects or Shells or directly 
at Company Level. 

User ID 
The user ids that are involved either in Projects or Shells or directly at 
Company Level 

Source Company Workspace, Project, Shell, or Other 

Name 

The names of projects or shells that have users assigned to it either 
from Company or Partner levels. If user does not participate in any 
Projects or Shells the Project or Shell Name and number columns is 
empty. 

Number The number that corresponds to the Project or Shell Name 

Date Date when user signed in 

Usage (Min) Time taken by User in minutes between sign in and sign out 

Usage (Hrs) Time taken by User in hours between sign in and sign out 

Total Total time taken by all users per company login level and per Company 
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This column: Shows: 

Partner level 

Grand Total 
Total time taken by all users at a company level as well as Company 
Partner level 

Usage Summary By Company 

This report allows you to view summarized usage times across the sponsor company and 
partner companies. These are usage times logged by users, after they sign in, independent of 
whether they are working for their own company or other companies. The report results are 
sorted alphabetically by company name. 

Report Query Parameters: 

 Source: All, Company Workspace, Project/Shell or Other 

 Project: Select a project or leave blank for all projects 

 Shell: Select a shell or leave blank for all shells 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This column: Shows: 

Company Name
The company name. Depending on filter condition, this report can be 
generated for a particular company or all companies. 

Usage (Min) 
Total Time taken by all Company Users in minutes at "Source" level 
between sign in and sign out in the specified date ranges 

Usage (Hrs) 
Total Time taken by all Company Users in hours at "Source" level 
between sign in and sign out in the specified date ranges 

Usage Detail By Project/Shell 

The Usage Detail By Project/Shell report shows usage details per project or shells across a 
company and its partners grouped by project or shell name. Results are sorted by: 

 Project/Shell names alphabetically for all projects belonging to user company 

 For each project or shell, lists users belonging to owner company first followed by partner 
company sorted alphabetically 

 Within a company, users are sorted alphabetically by first name, last name 

Report Query Parameters: 

 Source: defaults to Project/Shell 

 Project/Shell: Select a Project/Shell or leave blank 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 
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This column: Shows: 

Name 
The names of projects or shells that have users assigned to it 
either from Company or Partner levels. 

Number The corresponding Project or Shell Numbers. 

Company Name 

Name of the owner company. Depending on filter condition, this 
report can be generated for a particular Sponsoring company. 

If no users from current company are assigned to the Project, the 
row will start with Partner name. 

User Name The user names that are involved in Projects/Shells 

User ID The user ids that are involved either in Projects/Shells 

Date Date when user signed in 

Usage (Min) 
Time taken by User in minutes between sign in and sign out 
working on that Project/Shell 

Usage (Hrs) 
Time taken by User in hours between sign in and sign out working 
on that Project/Shell 

Total 
Total time taken by sponsor company or partner company users for 
a given project or shell 

Grand Total 
Total time taken by sponsor company or partner company users 
across Projects/Shells. 

Usage Summary By Project/Shell 

This report displays summarized usage times per project or shell across a company and partner 
users grouped by project name. 

Report Query Parameters: 

 Source: defaults to Project/Shell 

 Project/Shell: Select a Project/Shell or leave blank 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This column: Shows: 

Name 
The names of projects or shells that have users assigned to it 
either from Company or Partner levels 

Number The corresponding Project/Shell Numbers 

Company Name 
Either the Sponsoring Company Name or Partner Company 
Name. Distribution across Owner Company and Partner users in a 
given Project 

Usage (Min) Total Time taken by all Users in minutes between sign in and sign 
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This column: Shows: 

out per Project/Shell 

Usage (Hrs) 
Total Time taken by all Users in hours between sign in and sign 
out per Project/Shell 

Total 
Total time taken by users at a company level as well as Company 
Partner level for across all company projects or shells 

Usage Detail By Company Workspace 

This report displays usage times for company and partner users working in the owner company's 
Company Workspace. 

Report Query Parameters: 

 Source: defaults to Company Workspace 

 Project/Shell: Not applicable 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This column: Shows: 

Company Name 

The company name. Depending on filter condition this report can 
be generated for a particular Sponsoring company. 

If no users from current company are assigned to work in the 
Company Workspace the row will start with Partner name. 

User Name The user names that are involved at Company Level 

User ID The user ids that are involved at Company Level 

Date Date when user signed in 

Usage (Min) 
Time taken by User in minutes between sign in and sign out 
working at the Company Workspace 

Usage (Hrs) 
Time taken by User in hours between sign in and sign out 
working at the Company Workspace 

Total 
Total time taken by users at a company level as well as Company 
Partner level at Company level 

Grand Total 
Total time taken by users at a company level as well as Company 
Partner level across Company and its Partners. 

Usage Summary By Company Workspace 

This report summarizes usage times for company and partner users working in the owner 
company's Company Workspace. 

Report Query Parameters: 
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 Source: defaults to Company Workspace 

 Project/Shell: Not applicable 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This 
column: 

Shows: 

Company Name of the Sponsoring Company or Partner 

Usage 
(Min) 

Total Time taken by all Users in minutes between sign in and sign out in 
Company Workspace per Company/Partner 

Usage 
(Hrs) 

Total Time taken by all Users in hours between sign in and sign out in 
Company Workspace per Company/Partner 

Total 
Total time taken by users at the owner company level as well as Company 
Partner level in the Owner Company Workspace 

Usage Detail By User 

This report details usage across a company and all of its partner users grouped by user name. 
The results sort by user's first name and last name independent of whether user belongs to the 
owner company or a partner company. 

Report Query Parameters: 

 Source: All, Company Workspace, Project/Shell or Other 

 Project/Shell: Select a Project/Shell or leave blank 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This column: Shows: 

User Name 
The user names that are involved either in Projects or directly at 
Company Level 

User ID 
The user ids that are involved either in Projects or directly at Company 
Level 

Company 
Name 

Company Name of the User 

Source Either Company Workspace/Project/ Other 

Name 
The names of projects or shells that have users assigned to it either from 
Company or Partner levels. This column is empty if Source is Company 
Workspace or Other. 

Number 
The corresponding Project/Shell Numbers. This column is empty if 
Source is Company Workspace or Other 
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This column: Shows: 

Date Date when user signed in 

Usage (Min) Time taken by User in minutes between sign in and sign out 

Usage (Hrs) Time taken by User in hours between sign in and sign out 

Total 
Total time taken by a particular user at a company level as well as 
Company Partner level across Source criteria 

Grand Total 
Total time taken by all users at a co. level as well as Company Partner 
level across Source criteria 

Usage Summary By User 

This report displays summarized usage times per user. The report is sorted alphabetically by 
user first name, last name. 

Report Query Parameters: 

 Source: All, Company Workspace, Project/Shell or Other 

 Project/Shell: Select a Project/Shell or leave blank for all projects or shells 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

This column: Shows: 

User Name All user names for sponsor company and partner companies 

User ID The corresponding User IDs 

Company 
Name 

Each user's company 

Usage (Min) 
Total Time taken by a user in minutes between sign in and sign out 
summed up in the date ranges 

Usage (Hrs) 
Total Time taken by a User in hours between sign in and sign out 
summed up in the date ranges 

User Account Details 

This report displays account status details across a company and partners grouped first by 
Company User Names and then Partner User Names. 

Report Query Parameters: 

 Source: All, Company Workspace, Programs or Projects/Shells 

 Source Name: Active if Programs or Projects/Shells is the source. Click Select and select 
the Program or Project/Shell name from the list. 

 Partner Company: Select a partner or leave blank for all partners 



User Administration

165

This column: Shows: 

Company 
Name 

The Sponsor Company Name, followed by the Partner Names 

User Name 
All user Names from a company and partner users assigned to 
Sponsoring Company Projects 

User ID The corresponding User IDs 

Source The Project/Shell Name the user is a part of 

Source Name The name of the project or shell 

Date Added 
The date that this user was added to the company. This column is 
empty for Partner users 

User Status 
The Status of the User at the project or shell level whether 
(Active/Inactive) 

Status Effective 
Date 

The date the Status of the user changed at the project Level. 

User Account Summary 

This report summarizes account status details across a company and partners grouped first by 
Company User Names and then Partner User Names. 

Report Query Parameters: 

 Partner Company: Select a partner or leave blank for all partners 

This column: Shows: 

Company Name The Sponsoring Company or Partner 

Company Short 
Name 

The short name for the Company 

Total Users 
Total number of users at Owner Company/Partner working on Owner 
Company Workspace or Owner Company Projects 

Current Active 
Users 

Total number of active users at Owner Company/Partner working on 
Owner Company Workspace or Owner Company Projects 

Current Inactive 
Users 

Total number of inactive users at Owner Company/Partner working 
on Owner Company Workspace or Owner Company Projects 

Current On Hold 
Users 

Total number of inactive users at Owner Company/Partner working 
on Owner Company Workspace or Owner Company Projects 

User Session Detail 

This report displays user sign in session details. 

Report Query Parameters: 

 Owner Company 
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 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 

 Platform 

 Website 

 Mobile App 

 Website & Mobile App 

This column: Shows: 

User Name All user Names from an Owner Company 

User ID The corresponding User IDs 

Company 
Name 

The Sponsoring Company or Partner 

Login Date Date user signed in 

Logout Date Date user signed out. (Dates will displayed in Server Time zone) 

Session End 
Type 

Timeout or Logout 

Usage (Min) Usage between sign in and sign out in minutes 

Usage (Hrs) Usage between sign in and sign out in Hours 

Total Total time taken 

The following shows the columns according to the platform: 

This column: Shows: 

Website As is. 

Mobile App Output for User Session Detail Report: 

The header of the Report will have the fields of Owner Company, 
Partner Company, Report Run by, and the date that the report was run 
on. 

Columns displayed in the report output: 

 User Name 

 User ID 

 User Type 

 Company Name 

 Operating System 

 Device 

 Login Date 

 Logout Date 
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This column: Shows: 

 Session End Type 

 Usage (Min) 

 Usage (Hrs) 

Website & 
Mobile App 

Output for User Session Detail Report: 

The header of the Report will have the fields of Owner Company, 
Partner Company, Report Run by, and the date that the report was run 
on. 

Columns displayed in the report output: 

 User Name 

 User ID 

 User Type 

 Company Name 

 Operating System 

 Device 

 Login Date 

 Logout Date 

 Session End Type 

 Usage (Min) 

 Usage (Hrs) 

About Platform 

Unifier can be accessed through various platforms (website, mobile app, or both), and you have 
the option to track the users when they sign in through these platforms. This is to enable you to 
to capture information such as number of sign-ins, device type, and so forth. 

When you select the platform, the report output, will have the following columns: 

This column: Shows: 

Operating 
System 

The version of the device operating system. 

Device The device model. For example, Apple iPhone 7 plus. 

The following shows the columns according to the platform: 

This column: Shows: 

Website As is. 

Mobile App Output for Last Login Report: 

The header of the Report will have the fields of Owner Company, 
Partner Company, Report Run by, and the date that the report was run 
on. 

Columns displayed in the report output: 
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This column: Shows: 

 User Name 

 User ID 

 User Type 

 Company Name 

 User Status 

 Operating System 

 Device 

 Last Login Date 

 Days Since Last Login 

Website & 
Mobile App 

Output for Last Login Report: 

The header of the Report will have the fields of Owner Company, 
Partner Company, Report Run by, and the date that the report was run 
on. 

Columns displayed in the report output: 

 User Name 

 User ID 

 User Type 

 Company Name 

 User Status 

 Operating System 

 Device 

 Last Login Date 

 Days Since Last Login 

The information above applies to the following reports (Company Workspace tab > Admin 
mode > System Reports): 

 User Session Detail 

 Last Login 

 Current Login 

The available report formats are: 

 HTML 

 CSV 

 Excel 

 PDF 

 XML 

Last Login 

This report displays last sign in details for a user. It lists the users that have signed in, not all 
user accounts. If a user has never signed in, that user will not be listed on the Last Login Report. 

Report Query Parameters: 
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 Partner Company: Select a partner or leave blank for all partners 

 Platform: Select a platform to monitor. 

This column: Shows: 

User Name All user Names from an Owner Company 

User ID The corresponding User IDs 

Company Name The Sponsoring Company or Partner 

User Status The status of the user 

Last Login Date 
Date when Company User last signed in. For a partner user, this date 
should be the last date the user signed in to Partner Company 
Workspace. 

Days Since Last 
Login 

Number of days since the user last signed in. Calculated as 
difference between last sign in date and the date on which the report 
is run. 

Current Login 

The Current Login Report displays currently logged in users. 

Report Query Parameters: 

 Source: All, Company Workspace, Programs or Projects 

 Source Name: Active if Programs or Projects is the source. Click Select and select the 
program or Project name from the list. 

 Partner Company: Select a partner or leave blank for all partners 

 Platform: Select a platform to monitor. 

This column: Shows: 

Company Sponsor company 

User Name All user names from an Owner Company 

User ID The corresponding User IDs 

Source The source 

Source Name The source name 

Source 
Number 

Corresponding number 

Login Time Login time for the current session 

Remote 
Address 

The IP address of the computer from which the user is logged on 

The following shows the columns according to the platform: 
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This column: Shows: 

Website As is. 

Mobile App Output for Current Login Report: 

The header of the Report will have the fields of Owner Company, 
Partner Company, Source, Source Name, Report Run by, and the date 
that the report was run on. 

Columns displayed in the report output: 

 Company Name 

 User Name 

 User ID 

 User Type 

 Operating System 

 Device 

 Source 

 Source Number 

 Login Time 

 Remote Address 

Website & 
Mobile App 

Output for Current Login Report: 

The header of the Report will have the fields of Owner Company, 
Partner Company, Source, Source Name, Report Run by, and the date 
that the report was run on. 

Columns displayed in the report output: 

 Company Name 

 User Name 

 User ID 

 User Type 

 Platform 

 Operating System 

 Device 

 Source 

 Source Number 

 Login Time 

 Remote Address 

Proxy Login 

This report displays user sign in proxy details. 

Report Query Parameters: 

 Partner Company: Select a partner or leave blank for all partners 

 Date Range From 

 Date Range To 
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This column: Shows: 

First Name The Proxy first name 

Last Name The Proxy last name 

Login User 
Name 

The user who logged in 

Company 
Short Name 

The Company name of the Proxy user 

Proxy User 
Name 

Then name of the Proxy 

Login Date The date the user logged in 

Setting Permissions for Inbox 

To set Inbox permissions for Company Workspace, Shell Instances, and Standard Project 
Instances: 

1) Go to Company Workspace tab (Admin mode). 

2) Open the User Administration grouping node and click Access Control to open the log. 

3) Click User Mode Access to expand it. 

4) Click Projects/Shells to expand it. 

5) Click Project Mailbox to expand it. 

6) Click Inbox to open the Permissions Setting for: Inbox window. 

7) Click Add or Modify and grant the following permissions: 

 Delete 

To delete messages. 

 Reply 

To reply to messages. 

 View 

To view messages. 

 Create/Manage Folders 

To create, rename, and move folders under Inbox. 

8) Click Apply when finished. 

Note: You cannot grant permissions at Project Mailbox level. All 
Project Mailbox permissions must be granted at Inbox level. 

For Permission Templates: 

1) Go to Company Workspace tab (Admin mode). 

2) Open the User Administration grouping node and click Access Control to open the log. 
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3) Click Administration Mode Access to expand it. 

4) Click Standards & Libraries to expand it. 

5) Click Permission Templates to open the Permission Settings for: Permission Templates
window. 

6) Click New. 

7) Click Permissions. 

8) Go to User Mode Access and expand it. 

9) Click Mailbox to expand it. 

10) Click Project Mailbox to expand it. 

Setting Permissions for Unpublished Attachments 

Whenever a mail is received through the Project Mailbox, the attachment associated with the 
email will be captured within the Document Manager (DM). A new folder will be available under 
Project Mailbox node in which all unpublished mail attachments will be available for publishing to 
Shell DM. 

To set Unpublished Attachments permissions for Shell Instances and Standard Project 
Instances: 

1) Go to your project or shell mailbox. 

2) Open the User Administration grouping node and click Access Control to open the log. 

3) Click User Mode Access to expand. 

4) Click Projects/Shells to expand. 

5) Click Mailbox to expand. 

6) Click Project Mailbox to expand. 

7) Click Unpublished Attachments to open the Unpublished Attachments window. 

8) Click Add or Modify and grant the following permissions: 

 Publish 

To allow publishing into the DM. 

 Download 

 Open 

 View 

9) Click Apply when finished. 

Task Reassignment (Company and Project) 

When a user with assigned tasks is removed from a project, you (Company Administrator, 
Project Administrator, or Administrator user) can reassign the removed user's tasks to an active 
user. 



User Administration

173

Note: In this scenario, you can only reassign tasks that have not been 
started, or tasks that are in progress. 

In the case of a dynamic assignment (when a workflow is routed back to the previous step, and 
the task on that step was assigned to the removed user), the system lets you send the task to 
the new active user. This also applies in a situation in which a record must be sent back for 
review. 

To reassign a task from a removed user to an active user: 

1) Go to Company Workspace tab (Admin mode). 

2) Click to expand User Administration. 

3) Click to expand Task Reassignment. 

There are two sub-nodes under the Task Reassignment node: 

 Active User Tasks

 Inactive User Tasks

The following explains each sub-node in details. 

Active User Tasks 

The Active User Tasks log will house the following tasks: 

 Tasks for all active users existing at the company level. 

 Company level - This includes users from both owner and all partner companies 

 Project level - This includes users from both owner and the member companies. 

 Tasks where the active user is an assignee and the record has not yet reached the terminal 
step. 

This means that the previous user would no longer be seeing the task in the log but because 
of a previous action taken by the previous user the task would still appear in the log. The 
reasons for this appearing in the log are as follows: 

- To account for Dynamic step assignment. For example, the Workflow setup might have 
"Match <step>" in a subsequent step. 

- To account for step revisits. 

Active User Tasks log (toolbar options)

Option Description 

Reassign To open the Select New Assignee window and select the following 
information about the assignee: 

 Name

 Company

Select one or more tasks and click Reassign to open the user 
picker-window. 

View This option enables you to view the following pre-defined views: 
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Option Description 

 All Tasks

 Group by Assignee

 Group by Origin

 Group by Business Process

 Reassignment History (See the "Reassignment History" section below 
for important details) 

 Create New View

 Manage Views

The Create New View option can be used to define user specific views. 

Refresh 



To refresh the items listed in the log. 

Print  To print the items listed in the log, based on the current view of the log. 

Edit View 



To view and edit the settings of items listed in the log. 

Use the View Name field to enter a name for your new view. 

Use the Columns tab to: 

- Determine which columns to display: Available Columns

- Select the columns: Selected Columns

- Lock the columns in place: Lock after selected Column

Use the Filters tab to: 

- Determine the field for your filter: Field

- Indicate the operator for your filter: Operator

- Include any values: Value

- Determine the number of records that you want to be displayed: Number 
of Records

Use the Group By tab to: 

- Group the list based on the options available from the drop-down list. 

- Adjust the order of your list: Order

Use the Sort By tab to sort items according to: 

- Previous assignee 

- New assignee 

- Origin 

- Business Process 

- Record Number 

- Reassigned on 

Click Cancel to discard your changes and return to the log. 

Click Apply to apply your changes to the view. 

Click Save As to save an existing view with another name. 
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Option Description 

Search / 
Find on 
Page

To filter the log for specific results 

Active User Tasks log (columns)

Column 
Heading 

Description 

Reassign
ment 
Status 



The (X symbol)    signifies that the task cannot be reassigned. 

Assignee Name of the inactive user assignee. 

Company Company name of the inactive user. 

Origin The source. The source can be project, shell, or company tab name. 

Business 
Process

Name of the business process. 

Record 
Number

The record number 

Title The title. 

Record 
Due

The due date for the record. 

Creation 
Date

The creation date for the task. 

Workflow 
Name

The workflow name. 

Inactive User Tasks 

The Inactive User Tasks log lists records that are in progress (workflow has not yet been 
completed) for inactive users. 

For the inactive users at the company, the Inactive User Tasks log lists all the tasks for inactive 
users. 

 At the Company level, the tasks included may belong to owner company users or all partner 
company users. 
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 At the Project level, the tasks included may belong to owner company users or member 
company users. 

Note: A Member Company is a Partner Company. When a Partner 
Company is added to a shell or project, the Partner Company becomes 
a Member Company. 

The Inactive User Tasks log also lists the records that an inactive user is an assignee and the 
record has not yet reached the terminal step. This means that the inactive user would no longer 
be seeing the task in the log but because of a previous action taken by the inactive user the task 
would still appear in the log. This display allows to account for both Dynamic step assignment 
and step revisits for in-flight records. 

Example 

Workflow setup might have "Match <step>" in a subsequent step. 

The Task Reassignment log has the following columns: 

Note: The following information applies to both the Company-level and 
Project-level unless it is noted otherwise. 

Column 
Heading 

Description 

Reassign
ment 
Status 



The (X symbol)    signifies that the task cannot be reassigned. 

Assignee Name of the inactive user assignee. 

Company Company name of the inactive user. 

Origin The source. The source can be project, shell, or company tab name. 

Business 
Process

Name of the business process. 

Record 
Number

The record number 

Title The title. 

Record 
Due

The due date for the record. 

Creation 
Date

The creation date for the task. 
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Column 
Heading 

Description 

Workflow 
Name

The workflow name. 
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Reassigning Tasks (Workflow) 

The following chart describes the workflow for reassigning tasks. The following topics explain 
each step in details. 
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Reassigning Tasks (Scenarios) 

In the following cases, the company administrator is a user who has permissions to reassign the 
tasks. 

Case 1: Selected new assignee is a CC user

1) Business Process record R1 currently has been assigned to user A and has been CC'd to 
user B 

2) User A has been inactivated 

3) Company Administrator has now reassigned this task to user B 

4) User B will receive the task reassignment notification in addition to seeing the task in the 
Tasks log. 

5) In addition to this, the notification for this task which the User B had received because of 
being a CC'd user, will be removed from the Notifications log. 

Case 2: Selected new assignee is not in the Workflow (WF) setup

In the event that the selected assignee is not in the WF setup, the user will still get the 
reassigned task. This means that the task will be seen in the Tasks log. 

Note: By means of Tasks reassignment, the system will not add the user 
to the Workflow setup. This action has to be performed by the 
administrator who is setting up the workflow setup. Similarly the user will 
not have navigation level permissions to the Business Process log that 
the task belongs to. This action again has to be performed by the 
administrator. 

Case 3: Selected new assignee had previously declined the task

If the selected new assignee had previously declined the task, then post reassignment, the task 
will be seen in the Tasks log. 

Assumption: The workflow setup allows declining of the task. 

Case 4: Single Completion policy - Non participating assignee has been inactivated

A non participating assignee is one who has not acted on a task. When such a user is 
inactivated, the in-flight records which had this user in one of the steps will not be seen in the 
Tasks reassignment log. 

Case 5: Completion Policy - All Consensus

1) Business Process record R1 currently has been assigned to users A, B and C 

2) User A accepts the Task routes the record to step A 

3) User B declines the task 

4) User C has been inactivated 

5) Company Administrator reassigns the Task of User C from the Tasks Reassignment log to 
user D 

6) User D accepts the Task and routes the record to step B 



User Administration

181

7) The record will get routed to the resolving action since the users have taken different actions 

Case 6: Completion Policy - All Majority

1) Business Process record R1, currently has been assigned to users A, B and C 

2) User A accepts the Task and routes the record to step A 

3) User B accepts the Task and routes the record to step B 

4) User C has been inactivated 

5) Company Administrator reassigns the Task of User C to user D 

6) User D accepts the task and routes the record to step B 

7) The record will get routed to Step B since the majority of the users took the action of routing 
it to Step B 

Views 

You can use the views to sort or group tasks based on various attributes. The following displays 
the views and their definitions: 

View Definition 

All Tasks Columns are in the following order. 

 Assignee 

 Company 

 Origin 

 Business Process 

 Record Number 

 Title 

 Record Due 

 Creation Date 

 Workflow Name 

Other definitions are the same as in the Tasks log. 

Group by Assignee The Group By element will be Assignee. 

Columns are in the following order. 

 Assignee 

 Company 

 Origin 

 Business Process 

 Record Number 

 Title 

 Record Due 

 Creation Date 

 Workflow Name 

Other view attributes are the same as in the All Tasks. 
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View Definition 

Group by Origin The Group By element will be Origin. 

Columns are in the following order. 

 Assignee 

 Company 

 Origin 

 Business Process 

 Record Number 

 Title 

 Received 

 Creation Date 

 Workflow Name 

Other view attributes are the same as in the Group by Origin in 
the Tasks log. 

Group by Business 
Process 

The Group By element will be Business Process. 

Columns are in the following order. 

 Assignee 

 Company 

 Origin 

 Business Process 

 Record Number 

 Title 

 Received 

 Creation Date 

 Workflow Name 

Other view attributes are the same as in the Group by Business 
Process in the Tasks log. 

Reassignment 
History - log 

It is important to maintain the reassignment history of tasks. The 
view Reassignment History will enable administrators to view all 
the past reassignments. When this view is active: 

Toolbar option of Reassign will not be seen. All other toolbar 
options will remain as is. 

Log columns will be Previous assignee, New assignee, Origin, 
Business Process, Record Number and Reassigned on. 

The date column of Reassigned on will retain user preferences. 
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View Definition 

Reassignment 
History - View 
settings 

Columns 

    Previous assignee 

    New assignee 

    Origin 

    Business Process 

    Record Number 

    Reassigned on 

Filter fields 

    Previous assignee 

    New assignee 

    Origin 

    Business Process 

    Record Number 

    Reassigned on 

The operators available will be dependent on the data type. In 
addition to the filter fields, the view definition will also have 
Number of Records. 

Group By 

    String fields 

View buttons 

The view settings will only have Cancel and Apply. There can be 
only one view of this type and this is already provided by the 
system. Any changes made to the view cannot be saved. 

Workflow of Reassigning Tasks (Company) 

 The administrator user selects tasks. 

Tasks may or may not be from the same Origin. For example, the Tasks may belong to two 
different projects P1 and P2. 

 The administrator user clicks Reassign. 

 The user picker window opens that displays the list of users as follows: 

 All active owner company users from P1 and P2. 

 All active member company users from P1 and P2. 

 Users belonging to either of the two projects. 

 The administrator user selects a new assignee. 

 The system assigns all selected tasks to the new assignee. 

 If user exists in the project, then the task will get reassigned and an email notification will be 
sent to the new assignee. See the "New Assignee Email Notifications" for details. 
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 If user does not exist in the project, then the task will not get reassigned and will continue to 
remain in the log. 

Workflow of Reassigning Tasks (Project) 

 The administrator user selects tasks. 

Tasks belong to the same project. 

 The administrator user clicks Reassign. 

 The user picker window opens that displays the list of users as follows: 

 All active owner company users. 

 All active member company users. 

 The administrator user selects a new assignee. 

 The system assigns all selected tasks to the new assignee. 

 If reassignment is successful, then the task will get reassigned and an email notification will 
be sent to the new assignee. See the "New Assignee Email Notifications" for details. 

 If reassignment is no successful, then the task will not get reassigned and will continue to 
remain in the log. 

Reassigning Tasks Access Control 

Access to the Tasks Reassignment node is by permissions. To grant permission: 

1) Go to the Access Control node. 

2) Click Administration Mode Access. 

3) Click User Administration. 

4) Click Tasks Reassignments. 

5) Select users, or groups, and set permissions. 

The "Enable" permission enables the user to: 

 View the task 

 Reassign the task 

You can assign the permissions to either an individual user or a group. 

The permission changes are applicable to all modules, where the permissions can be set, for 
example: 

 User > Permissions 

 Group > Permissions 

 Permission template 

New Assignee Email Notifications 

The Subject line of the new assignee email notification states how many tasks have been 
assigned and by whom. 

The body of the new assignee email notification contains the following information: 
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 Project name 

 Record number of the business process 

 Title of the business process 

 Unifier login link 
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Program Administration 

The following section describes how to create and manage programs. 

In This Section 

Creating and Managing Programs ......................................................................... 187 
Creating a Project .................................................................................................. 187 
Creating a Program ............................................................................................... 191 
Defining Program Properties ................................................................................. 191 
Program User Administration................................................................................. 194 

Creating and Managing Programs 

Programs are a way to group like projects or CBS shells together (or projects and shells in 
combination). Programs allow consolidation of financial, schedule and status data across 
projects or shells. They are created at the company level in Admin mode. An administrator 
typically grants permissions to other project or shell team members who will modify an existing 
program and generate specific project or shell data. For example, a project or shell team 
member may modify a program to produce high-level forecasting data or to generate program 
reports based on a project's cost, schedule, and status data. 

Although the Company Administrator creates the program, rights are typically granted to project 
or shell members who will then modify the existing program and generate specific project or 
shell data. 

For example, a project or shell team member may modify a program to produce high-level 
forecasting data or to generate program reports based on the project cost, schedule and status 
data for one project or shell or across several projects or shells. 

Creating a Project 

The follow discusses creating a project by copying from a project template, by copying from 
another existing project, or by creating manually.  

Grant Permission to Administer Projects or Project Templates 

In order for a Project Administrator to be able to create and setup a Project, the administrator 
must have the permission setting to "Administer All" (or "Administer Project Category") at the 
Company Sponsored Projects, Project Properties level.  

To grant permissions to Project Administrator User or Group 

1) Go to the Company Workspace tab and switch to Admin mode. 
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2) In the left Navigator, click User Administration > Company Users or Partner Users (to 
grant permissions to individual users) or Groups (to grant permission to a project 
administration group). 

3) Select the user or group and click Open. Click the Permissions tab. 

4) Scroll to Company Sponsored Projects (Standard) and select. 

5) Select Administer All (for non-categorized projects), and/or Administer Project Category. 

Create a Project by Copying a Template or Project 

You can create projects using the project templates you created. You can also create projects 
by copying from existing projects. 

You can verify the project properties, make changes as necessary, update status, or activate as 
necessary. 

Tip: Because you can only have one cost sheet per project (and once a Cost Sheet is created 
for a project, it cannot be deleted or replaced), you might consider creating a Cost Template in 
the Templates log and copy into the project separately. 

Note: As Project Administrator, you can receive email notification of the 
successful creation of a shell instance, for shells that are created 
manually, through Web Services or a CSV file upload, or through 
auto-creation. This notification can be set up in email notifications in 
uDesigner. Also, you can set your User Preferences to control whether 
you receive these notifications. 

To create a project from a project template or existing project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects in the left Navigator. 

3) If your company is using project categories, click a project category in which to create the 
new project. If you don't wish to categorize the project, or if no categories have been setup, 
click All. Note that not all administrators will have access to all project categories. 

4) From the File menu, click New > Copy From. The Project Cloning window opens. 

5) Click the Copy From drop-down list and choose Project to copy an existing project, or 
Template to copy a project template. 

6) Select a project or template from the list and click OK. To search for a specific project or 
template on the list, click the Filter By field and select Name or Number. In the Filter For
field, enter all or part of the name or number to search for and click Search. 

7) In the Select Modules pane, select the modules to include in the new project. Users and 
Groups are selected by default and copied along with the project properties. 
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Note: If the Schedule Sheet option is selected, the curves relating to the 
schedule sheet will be copied to the new project. If the Schedule Sheet 
is NOT selected, the curves relating to the schedule sheet will be 
created but the name of the schedule sheet selected on the properties 
window will be empty. 

8) Click OK. The Project window opens, displaying the project properties. 

Most properties are copied from the original template with the following exceptions: 

 Project Number: On the General tab, enter a Project Number 

 Project Currency: On the Standards tab, specify the Project Currency 

 Project Image: On the Standards tab, specify the Project Image (optional) 

9) When the window is complete, click OK. 

10) Click Yes to confirm and create the new project. 

Create a New Project Manually 

To manually create a new project:  

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects in the left Navigator. 

3) Click a project category in which to create the new project. If you don't wish to categorize the 
project, or if no categories have been setup, click All. Note that not all administrators will 
have access to all project categories. 

4) Click the New button. The Project window opens. 

5) Complete the information on each of the tabs. 

The tabs contain the same fields as the template window. 

Some notes on the tabs: 

 General tab: Note Project Status: you may set the project status to Active to make it 
available to users immediately, or leave it as Inactive until you have completed setting up 
the new project. This will prevent users from signing in to their company and attempting 
to access the project before it is ready. 

 Location tab: Be sure to enter the complete Project Address and any other project 
related addresses. 

 Standards tab: Use this tab to enter the project image, currencies, email, and 
E-signature type.  

 Progress tab: Enter the project schedule start date, planned completion date, status and 
project phase. 

You can manage a project's progress on a continuing basis by reviewing the project 
properties you define here.  For instance, at any time you can enter a revised completion 
date, enter the percent complete for a design and/or construction project, monitor the 
project status, or change the project phase to ensure information contained in the 
Document Manager is current and available to the project team at the right time. 
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The information that you enter here is also viewable from the Progress pane of the 
Project landing page. This means a project administrator can quickly view the current 
status of a project and make modifications as necessary. 

 Links tab: Use this tab to add any links to be used by your project. 

 Custom tab: Use this tab to add custom attributes. 

 Calendar tab: Use this tab to set up the calendar to be used by your project 

6) Click OK to save your changes and exit the Project window. 

Add Cost Sheet 

The option "Enable P6 sources" is not available in a Cost Sheet created in a Standard Project or 
Standard Project Template. 

The cost sheet that has the option "Enable P6 sources" selected is not included when you want 
to create a new Cost Sheet by copying a cost sheet. 

The template that has the option "Enable P6 sources" selected is not included when you want to 
create a new Cost Sheet using: New > Cost Sheet > Copy from Template. 

Manage Projects 

You can verify the Project properties, make changes as necessary, update status, or activate as 
necessary. It is recommended that you keep the company progress information up to date to 
reflect the ongoing status and progress of the project. 

You can also modify project information in a Project Template and then update one or more 
existing projects by "pushing" the information from the template to the projects. 

To open a project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects in the left Navigator. Select a project name from the 
project log and click Open. The Project home page opens. 

To edit an existing project 

1) Open the project's home page and switch to Admin mode. 

2) Click the Open button. The Project window opens. 

3) Modify the project information as necessary on the tabs. You can modify any of the project 
properties any time during the project duration, except for the project currency. Once a 
project is set up, the project currency is locked. 

4) Click OK to save your changes and exit the Project window. 

Note: The tabs contain the same fields as the Template window. 
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Activate or Deactivate a Project 

To activate/deactivate a project 

1) Go to the Company Workspace and switch to Admin mode. 

2) Click the Open button. The Project window opens. 

3) In the General tab, set the status to Active or Inactive. 

 On-hold: The initial project status. On-Hold projects are listed on the projects log, but you 
cannot work with them. 

 Active: Active, in-progress project. All project actions in User and Administration Mode 
are available. 

 Inactive: Inactivate projects to suspend project usage. Inactive projects are visible from 
the Administration Mode under Sponsored Project log only, but not visible under the 
Projects node (i.e., only Sponsor Company can access the project), or in User Mode logs 
and selections. Only System and Project Administrators (users with Modify Status rights) 
can reactivate the project. 

Note: "Late" tasks in an inactive project may still show up in users' task 
logs. Though they can access the task, no transactions can be 
performed in the inactive project. 

Creating a Program 

To create a new Program: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Click New on the button bar. The Program window opens. 

4) Complete the tabs. This defines the program properties: 

 General: Define general properties 

 Shell/Projects: Add projects and shell to the program 

 Progress: Track progress of the program 

 Links: Add your own web page links, which appear on the Program home page 

See the following section for details. 

5) Click OK to save and exit the window. 

Defining Program Properties 

You can define program properties when you first create a program, or open an existing 
program. 

Define Program General Properties (General tab) 

To access program properties: 
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1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open, or double click. The program properties 
landing page opens. 

4) Click Open to open the Program window. 

5) Use the information in the following table to complete the General tab. 

In this field: Do this: 

Program Number Enter a number for the program. 

Setup Date 
This field is populated with the program creation 
date. 

Program Name Enter a name for the program. 

Description 
(Optional) Enter a description of the program or 
projects or shells within it. 

Administrator 
Click Select and select an administrator from the list. 
Each program must have an administrator. 

Image 
(Optional) You can click Browse and select an 
image file. This image will appear on the Program 
Home Page. 

Program Category 
If a program category data definition has been setup, 
you can select it here. 

Status Select a status. 

Add or Remove Projects or Shells From a Program (Projects tab) 

You can add any Active or On Hold project to a program. Inactive projects are not eligible. 

To add a Projects/Shells to a program 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Program window. 

5) Click the Projects/Shells tab. 

6) Click Add.  

7) Select one or more projects or shells and click the Add button. To select multiple projects or 
shells, hold down the Ctrl or Shift key while selecting.  

8) In the Program window, click OK to save and exit. 

To remove a Project/Shell: 

On the Projects/Shells tab, select the project or shell and click Remove. 
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Setting up Program Progress Tracking (Progress tab) 

You can enter a start date and planned completion dates for a program by manually entering the 
dates, or by linking the program to the project or shell schedule sheet. To use the Schedule 
Manager options, a schedule sheet must be defined in your project or shell. As changes are 
made in the Schedule Manager, they will automatically change the progress indicator in the 
Progress tab. 

Progress indicators linked to the schedule are: 

 Start Date 

 Planned Completion 

 Revised Completion 

To track the progress of a program manually: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Program window. 

5) Click the Progress tab. 

6) Complete the fields. See the following table for details. 

7) Click Apply to save the changes, or OK to save and exit. 

In this field: Do this: 

Start Date 

Choose one of the options: 

Manual: Manually enter the project or shell start date by clicking 
the calendar icon. 

From Schedule Manager: Click the selection list and choose a 
data column from the list (for example, Program Start Date). The 
Program Schedule Sheet must be created and setup before 
selections become available. 

Planned 
Completion 

Choose one of the options: 

Manual: Manually enter the project or shell start date by clicking 
the calendar icon. 

From Schedule Manager: Click the selection list and choose a 
data column from the list (for example, Program Due Date). The 
Program Schedule Sheet must be created and setup before 
selections become available. 

Revised 
Completion 

Choose one of the options: 

Manual: Manually enter the project or shell start date by clicking 
the calendar icon. 

From Schedule Manager: Click the selection list and choose a 
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data column from the list The Program Schedule Sheet must be 
created and setup before selections become available. 

Notes 
Program notes can be anything that the Administrator feels is 
relevant to share with other Project or Shell Administrators. This 
note is not displayed on the Summary or Home Page. 

Add Links to Other Program-Related Web Pages (Links tab) 

Links are displayed on the Program home page. 

To add a link 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Program window. 

5) Click the Links tab. 

6) Enter a name for the link and the link's URL. 

7) To add more links, click the Add Row button and repeat step 6. 

8) When you are finished, click OK. 

Program User Administration 

The User Administration node appears below the new program name in the Navigator once it 
is created and activated. As projects or shells are added to programs, the users and groups are 
not automatically added to the program. By default, the Program Administrator chosen during 
the program setup is added as a program user. The Program Administrator group is 
automatically added as a default group, and the program administrator is added to the group by 
default. You can add additional users and groups to the Program and set permission levels. 

Add Users or Groups to a Program 

To add users or groups to a program via the Company Workspace: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration node for your program in the left Navigator. 

3) Click Users to add users, or Groups to add groups to the program.  

Note: If a User Attribute form has been imported, the program user log 
will reflect the design of any designed Partner Log included in that form. 
See Importing User Attribute Form (on page 98) for details. 

4) Click New on the button bar. The standard User/Group Picker window opens. 
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5) Select a Company from the List Names from: list box and Users or Groups from the Show 
By: list box.  

6) Select the users/groups to include in the Program and click Add. You can also create a new 
group by highlighting the Groups node and selecting File > New or the New button. 

7) When you are done adding users and groups, click OK to return to the Users or Groups log. 

Grant Program Permissions (Access Control) 

Granting program permissions entails granting users access to the modules in the program, 
such as the Schedule Manager or cost sheets. 

To grant user/group permissions to the program 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Open the User Administration grouping node and click Access Control in the left 
Navigator. 

3) On the right pane, select User Mode Access > Programs > [module]. The Permission 
Settings window opens. 

4) Click the Add button. The User/Group Picker opens. 

5) In the picker, specify a user or group and select the Permission Settings. 

6) Click OK, then click OK in the Permission Settings window. 
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Project Administration 

The following topics describe tasks related to project administration which includes Project 
(Standard) (also referred to as: Project) and Templates > Projects.  

In This Section 

Creating and Managing Projects ........................................................................... 197 
Updating Projects .................................................................................................. 213 
Managing Member Companies .............................................................................. 227 
Managing Project Users and Groups ..................................................................... 229 
Setting up Automatic Status Update ...................................................................... 232 
Create an Automatic Project Status Update Setup ................................................ 233 
Choose the Order of Non-active Statuses (Settings Tab) ...................................... 234 
Define Status Change Query and Trigger Conditions (Settings Tab) ..................... 234 
Define Project Status Update Schedule (Schedule Tab) ........................................ 235 
Activate or Deactivate an Auto-update Status Setup ............................................. 236 
Set Permissions for Automatic Update of Project Status ....................................... 236 

Creating and Managing Projects 

Projects can be created from scratch one at a time, or can be created by copying a project 
template. 

It is recommended that you create one or more project templates first, and then create new 
projects based on them. 

Advantages to using a template include ease of individual project setup, consistency between 
projects, and the ability to update project information easily (for example, if you add a new user, 
introduce a new business process, or edit a cost sheet column) by allowing you to make an 
addition or modification directly to the template and then "push" it to existing projects. 

Note: You can migrate standard projects to CBS shells. See Migrating 
standard projects to CBS shells. 

How to create and setup a project 

Be sure you have the proper permission setting to administer projects. If your company has 
chosen to "organize projects" (that is, create projects under different project categories), be sure 
these categories have been set up.  

Note: The categories can also include asset classes. 

Step 1: Create a Project Template
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Most major functionality that is available in a project can be set up in a project template. You 
can set up as few or as many individual features as you like within a template. 

Step 2: Create a new Project

This can be done manually, or by copying a project template. 

Step 3: Set up permissions

Grant permissions to access and work with the new project to project team members. Refer 
to the Unifier Data Reference Guide for project permission settings. 

Step 4: Setup up gates

This is an optional step. The gates feature allows you set up acceptance criteria to use to 
track and control project phases. 

Step 5: Manage projects

This includes updating projects to "push" updated information, set ups, etc., to existing 
projects. The projects do not need to have been created originally from the template. 

The following sections discuss creating and managing projects and project templates. 

Creating a Project Template 

Project (Standard) and project template categories are maintained by the company 
administrator. Asset classes are added as project category nodes when they are created. One 
category ("All") is listed by default. You can create project templates under the All category, or 
other project categories or asset classes as needed. These categories do not appear to users in 
User Mode; they are a way to organize projects or link asset classes to projects. 

Access project templates 

To access project templates 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard)/Projects in the left Navigator. 

3) Expand the Projects (Standard)/Projects node. Like projects, project templates can be 
grouped by categories or by asset classes. 

4) Click one of the category or asset nodes. The Project Templates log opens. The log lists any 
project templates that have been created under the category. 

Create a project template 

The following procedure describes how to create a project template. The procedure is similar to 
creating a new project. 

To create a new project template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard)/Projects in the left Navigator. 

3) Expand the Projects (Standard)/Projects area to display the categories. The default is All. 
The project category that you define here will determine the category to which subsequent 
projects will be assigned. The project category cannot be changed. 
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Use caution when defining a template in a project category. You cannot "re-categorize" a 
project or project template once it is created and saved. 

4) Click one of the category or asset nodes. The Project Templates log opens. The log lists any 
project templates that have been created under the category. 

5) Click the New button. The Template window opens. The Template window is equivalent to 
the Project window; the same properties and tabs are filled out for a project template as for a 
new project. 

6) Complete the Template window. This window will be used for the project Properties when 
creating projects: 

 General tab

Use this tab to define properties. See Define general project properties (General tab)
(on page 203). 

 Location tab

Use this tab to define the project location. See Define project location (Location tab)
(on page 205) and Add a project image (Standards tab) (on page 207). 

 Standards tab

See Add project currencies (Standards tab) (on page 206). 

 Progress tab

See Set up project progress tracking (Progress tab) (on page 209). 

 Links tab

See Add links to other project-related web pages (Links tab) (on page 210). 

 Custom tab

See Select a project custom attribute (Custom tab) (on page 210). 

These tabs are the same for both project templates and projects. 

7) Click Apply to save changes as you enter information, and OK when you are ready to save 
information and exit the Template window. 

Create a project template by copying a template or project 

You can create a Project Template by copying from an existing Project template or an existing 
Project. 

Note: You can choose to copy any existing Custom Calendars from the 
template or from an existing project. 

To create a project template by copying an existing project or project template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Project (Standard)/Projects in the left Navigator, then select a project 
category. The default is All. Use caution when defining a project category. You cannot 
"re-categorize" a project or project template once it is created and saved. 

3) From the File menu, choose New > Copy From. The Template Project Cloning window 
opens. 

4) From the Copy From drop-down list, select one of the following: 
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 Template: The log displays the list of existing project templates 

 Project: The log displays the list of available company-sponsored projects 

5) Select a listed template or project name. 

6) In the Select Modules pane, select the modules to include in the new template. 

7) Click OK. The Template window opens, displaying the project template properties. 

Most properties are copied from the original project or template into the Template properties 
window, with the following exceptions: 

 Project Number: On the General tab, enter a Project Number 

 Project Currency: On the Standards tab, specify the Project Currency 

 Project Image: On the Standards tab, specify the Project Image (optional) 

8) Click OK. Click Yes to confirm. 

Note: Use caution when selecting which modules to copy. When you 
create a project template by copying from an existing project or template, 
you will be copying existing setups already created in the selected 
modules. (For example, if you select Cost Sheet, you will copy not only 
the project cost sheet, but any existing work packages and worksheets 
as well; since cost sheets and work packages cannot be deleted once 
created, you will not be able to delete these from the new template.) 

Set up modules in the project template 

Setting up modules is optional. For example, you can configure a Cost Sheet in your project 
template. When you create a new project using this template, you will have the option of copying 
this Cost Sheet into the new project. 

Project Templates have the same fields as a new Project. 

Note: Some fields are not filled in or not copied over when you copy 
from a template because they are not relevant until a project is created, 
like Project Start Date and Project Image. 

Member Companies

You can select project member companies from your company's list of partner companies. 
See Managing Member Companies (on page 227). 

Access Control

Enables setting up default permission settings for users and groups. See Grant project user 
permissions through Project Access Control (on page 232). 

Users and Groups

As with projects, you must add at least one user to the project template before you can 
activate it. Users and groups added to a project template are always copied by default from 
the template to the project created from it. See Managing Project Users and Groups (on 
page 229). 
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If your groups are going to be similar across all of your projects, you can define them once in 
the template rather than creating them in each project. It is not recommended that you put 
Users into the Project Template unless you know that those users will be on every project. 
The one exception is that a Project Administrator is required to be named in the template. 
Users cannot be deleted once they are in the Template, although Users can be deactivated. 

Projects Templates can include the following modules: 

Business Process Setup

Business Process setups created in the template can be copied over to projects. 

Rules

You can define project level cost or funding rules. 

Project Information

You can define the business process that will be used in the Project Information: General 
node. 

Gates Setup

You can include a gates setup in your project template. See Setting up Gates (on page 
237). 

Cost Manager

You can define any or all of the following in a template: 

 Cost Sheet (includes Worksheets and Work Packages) 

You can create a cost sheet for the project template. This is similar to creating a cost 
sheet for a project. And like projects, you can also include worksheets and work 
packages. 

 Funding Sheets

You can create a project fund sheet, and commitment funding sheet structure. 

 Schedule of values (SOV) (Structures for General Spends, Payment Applications, 
and/or Summary Payment Applications) 

 For General Spends SOV, the SOV structure is copied from an SOV template 
in the Templates log. 

 For Payment Applications SOV and Summary Payment Applications SOV, the 
structure is copied from the line item grid structure of the Payment Application 
Business Process. This means that you must first complete the Business 
Process (BP) setup for the Payment Application BP before you can create the 
structure. 

 Cash Flow Curves

You can create Cash Flow Curves. 
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Note: Since only one Cost Sheet, Funding Sheet, SOV structure (of 
each type) and commitment funding structure can exist in a project, 
make these choices carefully. Once you create these items in the project 
template, you can modify them, but will not be able to delete or replace 
them. 

Document Manager, Project Documents

You can create a folder structure for the document manager that can be used across 
projects. These can be created from Folder Structure Templates, or folders can be added 
manually. Unlike Folder Structure Templates, you can also assign users (if they are in the 
project template) folder-level permissions, and can import folders and folder properties. 

Resource Manager

You can create the setup and resource sheets in the template. 

Schedule Sheet

A Schedule Template will be used to create the Schedule Sheet. Like the Cost Sheet, once 
this is created, it cannot be deleted. 

User-defined Reports (UDRs)

You can create one or more user-defined report templates, which will be used for project 
user-defined reports. You can import user-defined reports into project templates from project 
templates in other companies and Unifier environments. See Importing User-Defined 
Reports into Project or Shell Templates. 

To set up modules in the project template 

1) Open the project template. 

2) Click a module and add the applicable information. This information can be carried over to 
new projects created from the template. 

Manage Project Templates 

Once the Project Template properties have been defined, you can setup any or all of the 
available modules. These will be copied to projects that have been setup using the template. 

Note: You do not have to setup modules here. If you do not setup a 
module in the Project Template, the modules will not be setup in the 
projects. You can setup the projects manually after project creation, or 
by using individual templates, for example, cost sheet templates. 

You have the option to edit project properties and modules and update existing projects with the 
new data. See Updating Projects (on page 213) for more information. 

To open the project template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Project (Standard)/Projects in the left Navigator. 

3) Select a project category (default is All). The Project Templates log opens. 
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4) Select a project template from the log and click Open. 

5) The project template home page opens. The navigator expands to display the modules that 
can be configured in the project template. Select a module to edit or set up. 

To edit project template properties 

1) From the project template home page, click the Open button. The Template window opens. 

2) Click the tabs to view or edit project template properties. 

Defining Project (and Project Template) Properties 

This section describes the Properties window for projects and project templates. 

Define general project properties (General tab) 

To define project locations for a project or project template 

1) Open the General tab of the Project or Template window. 

2) Complete the window as described in the following table. 

In this field: Do this: 

Project 
Number 

For Templates, you might enter a phrase such as Enter project number 
here or information for your Project Administrator regarding how to 
assign a project number, as each project created from the template will 
have its own number. When creating a new project, if the Site 
Administrator enabled automatic project numbering during new 
company setup, this field will be pre-populated each time a new project 
is created. 

Setup Date 
Populates automatically with the current date when the project or 
template is saved. 

Project Name
Enter a project name. For templates, you might enter a generic name or 
instructions such as Enter Project Name here. 

Description 
Explain the purpose or intended uses of the project or template 
(especially if you have multiple templates). 

Administrator 

Click Select to open the User/Group picker and select a Project 
Administrator. For templates, the user will automatically become part of 
the Project Administrator group for any project created from the 
template. (Additional administrators can be selected.) 

Construction 
Type 

Choose New Construction or Retrofit/Remodel. 

Project Status

You can activate the project template immediately, or place it On-Hold 
or make it View-Only and activate later. A template that is On-Hold, 
View-Only, or Inactive cannot be used to create a project. It is good 
practice to leave a project or template On-Hold until you have 
completed the setup. Project Administrators/Users with "modify project 
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status" rights are the only ones who can change the status. 

The project administrator will receive email notification when the status 
of a project changes. The change of project status could occur due to a 
manual change, bulk update, through Web Services or a CSV file, or 
through automatic update. 

Status definitions for projects are: 

 Active: Active, in-progress project. All project actions in User and 
Administration Mode are available. 

 On-Hold: The initial shell status. On-hold shells appear on the 
shells log. Shell administration functionality is available to shell 
administrators for setup and maintenance for users with permissions 
to perform that function. Users cannot create records in a shell that 
is On-Hold. If a user attempts to access a shell that is On-Hold, the 
system displays an alert message stating that the shell is On-Hold. 

 View-Only: For end users, View-Only projects can be viewed, 
printed, exported, and included in reports. They cannot be modified. 
When a shell is View-Only, the status overrides (but does not 
modify) access control permissions, granting only View permissions. 
The project reverts to the access control permissions when the 
project is made Active. View-Only projects can be added to and 
removed from programs, and can roll up to programs, UDRs, and 
dashboards. Business process records cannot be auto-created in 
View-Only projects. Data from View-Only projects does not roll up to 
company-level account codes or cost sheets. Data will roll up from 
View-Only projects to programs, the Planning Manager, and the 
Asset Manager. No updates can occur to View-Only projects 
through Integration, Unifier Mobile, or through reverse 
auto-population. View-Only projects cannot be updated through 
templates. Consolidate line item functionality is disabled for 
View-Only projects. View-Only projects have only view, export, and 
print permissions available. Tasks and Drafts are not available for 
View-Only projects. Messages are available, but users cannot add 
general comments. Mailbox is available for viewing, but users 
cannot send, edit or delete messages for View-Only projects. When 
a project becomes View-only, all scheduled jobs associated with it 
are canceled. When the status of the project changes back to 
Active, you must restart any scheduled jobs. Administrators can 
perform all actions on View-Only projects. 

 Inactive: Used to suspend project usage. Inactive projects are 
visible from the Administration Mode under Sponsored Project log 
only, but not visible under the Projects node (i.e., only Sponsor 
Company can access the project), or in User Mode logs and 
selections. Only System and Project Administrators (users with 
Modify Status rights) can reactivate the project. Late tasks in an 
inactive project may still show up in users' tasks logs. Though they 
can access the task, no transactions can be performed in the 
inactive project. 
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Auto-update 
Status Setup 

The selections on the drop-down list are defined automatic status 
update setups. These setups are defined at the Company level for use 
in specific projects. See Setting up Automatic Status Update (on 
page 232) for details. If you decide not to use the automatic status 
update, you can deactivate it by deselecting a setup (by literally 
selecting the word "Select"). 

Project Type 
The selections on the drop-down list are defined in the data set of the 
Project Type data definition. The default is None. Contact your 
Company Administrator if you need additional Project Types defined. 

Define project location (Location tab) 

You can define up to four addresses (Project, Billing, Shipping, and Billing & Shipping) for a 
project or project template. For each project or project template, you must enter at least one 
address: the Project Address. The Project Address will be used to generate an online location 
map accessed in the Project Home Page in User Mode. 

The following is applicable when creating a project template or new project: 

To define project locations for a project or project template 

1) Open the Location tab of the Project or Template window. 

2) Complete the Location tab as shown in the following table. 

3) Click Apply to save changes, or OK to save and exit. 

In this field: Do this: 

Address 
Type 

Select one of the address types listed (you must complete the Project 
Address fields). 

Address 2 

Enter the main street address 

Note: If the Project Template will be used for different project locations, 
you can enter generic notations for the Project Administrator, such as 
Enter project address here. 

Address 3 

Address 4 
Generally for P.O. Box numbers, suite numbers, etc. 

Country Choose the from the drop-down list. 

Site 
Choose a site from the drop-down list. The selections are generated 
from the Project Site data definition. The default is None. 
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Add project currencies (Standards tab) 

On the Standards tab, you can specify a currency or currencies that will be used on the project. 
The currency you specify here will be used throughout the project, for example for cost business 
processes, the cost sheet, etc. You must define at least one currency. If the project is 
international, you can define multiple currencies in which to display data, although only one can 
be the default project currency. 

Note: The list of available currencies is maintained in Standards & 
Libraries > Exchange Rate. 

To define project currency for a project or project template 

1) Open the Standards tab of the Project or Template window. 

2) In the Currencies section of the window, click the Add button. The Edit Exchange Rate 
window opens. 

Note: The Base Currency shown at the top of the Edit Exchange Rate 
window is the Base Currency set up for your company. For example, if 
yours is a company in the U.S., then the Base Currency will likely be the 
United States Dollar (USD). If your company does business 
internationally, you may make other currencies available for project use. 

3) Use the information in the table below to add a currency. 

4) Click OK to save and exit the Edit Exchange Rate window. 

5) In the Standards tab, select a Project Currency from the drop-down list. This will be used 
as the default project currency. Once you have selected a project currency and saved the 
template or project, it cannot be changed. The selections are generated from the Currencies 
list you defined. 

6) Click Apply to save changes, or OK to save and exit. 

In this field: Do this: 

Currency Name 

Select the currency you want to use for the cost functions in this 
project. 

If the currency you selected is other than the company Base 
Currency, then complete the following fields. 

Rate 

Enter an exchange rate to use for conversion calculations. From 
the drop-down list select one of the following: 

 If Float is selected, the rate is updated automatically from the 
Company Currency Table (Standards & Libraries > 
Exchange Rate). 

 A Peg rate locks in the company rate on the day the rate is 
set. (Only a Project Administrator can manually modify the 
Peg rate to a value other than the company peg rate.). 

Hedge? 
If the Hedge selection is Yes, then the Hedge rate is used for 
conversion calculations. Otherwise, the Float rate will be used. 
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Rate 
If an amount is entered for the Rate, then the hedge rate is used 
until the amount specified is reached (by spends) and then the 
system will revert back to the normal rate. 

Amount 

If Float is specified, Unifier will retrieve the rate, based on today's 
date and time. 

If Peg rate is specified, the field will be editable. 

Comments 
(Optional) Add any comments that might be necessary to explain 
the default currency. 

Note: Once a currency is selected and saved, it cannot be modified. The 
remove option is made available to enable you to remove the additional 
currencies and unsaved changes.  

Add a project image (Standards tab) 

You can add a representative image of the project that will display on the project home page for 
users. 

For templates, it is not necessary to select a project image because it will not be copied to a 
project created from the template. However, you can include one to provide an example to users 
creating projects. 

For best results, the recommended image size is 500 pixels wide by 300 pixels high. Image files 
should be in jpeg or gif format. 

To define a project image 

1) Open the Standards tab of the Project or Template window. 

2) In the Project Image field, click the Browse button. 

3) Browse to the location of the image file, select the file and click OK. 

4) Click Apply to save changes, or OK to save and exit. 

Distribute an External Email Address for the Project (Standards Tab) 

External emails are important communications that need to be included in projects. Such emails 
can come from project members or from external users who do not use Unifier. These email 
communications (and any attachments) can be collected in a central repository, called the 
Project/Shell Mailbox, so that project members can use them in managing and documenting 
the project. Once such emails reside in the project's mailbox, project users can view them, 
forward them to appropriate members, flag them for review, and reply to them. In addition, these 
external emails can be linked to business process records. 

When Unifier is installed on your system, a dedicated email address for your company is 
specified, and whenever you create a project, Unifier assigns it a unique identifier. Unifier 
combines this email address and project identifier to create the Project Mailbox. This email 
address appears on the Standards tab, and from the Standards tab, you can send the email 
address for the Project Mailbox to all project participants, both within and outside of Unifier. 
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Notes: 

 External emails that have been blind carbon-copied (Bcc) are not 
collected by the mailbox. 

 To prevent spam and virus attacks, you will need to create a list of 
approved email addresses that will be accepted by the project. See 
Creating an Approved Email List for Project/Shell Mailboxes (on 
page 141). 

To distribute the external email address 

1) Click the Send Email button. An email message window opens. 

2) In the To field, enter the email addresses of all participants in the project. 

You can also send the address of the dedicated mailbox to external users by adding their 
email addresses in the External Cc field. 

3) Click the Send button. 

Distribute the email address from the landing page 

In addition to the Standard tab, you can distribute the email address from the project's landing 
page. Remember to add the new recipient to the approved email list for this mailbox (Creating 
an Approved Email List for Project/Shell Mailboxes (on page 141)). 

To notify project users whenever the project mailbox receives an external email 

1) In the Send Notification To field, click the Select button. The User Picker opens. 

2) Select the users you want to notify and click OK. 
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Set up project progress tracking (Progress tab) 

The Progress tab of the Project window helps you track the progress of your project. You can 
manage milestones and project phase from this window. This information is displayed on the 
Progress pane of the Project landing page. This means a project administrator can quickly view 
the current status of a project and make modifications as necessary. Project Phase can affect 
other modules such as triggering when certain workflows or documents become available. 

The Progress tab can be linked to the Project Schedule Sheet. By setting up the Project 
properties to integrate with the Schedule Manager, changes in the schedule manager will 
automatically change the progress indicator in the project or program Progress tab. (The 
Schedule Manager is referenced.) 

The Project Phase can be set manually, or can be maintained manually (see Setting up Gates
(on page 237).) 

To set up project progress tracking 

1) Open the Progress tab of the Project or Template window. 

2) Complete the tab as described in the following table. 

3) Click Apply to save changes, or Ok to save and exit. 

In this field: Do this: 

Start Date 

Choose one of the options: 

Manual: Manually enter the project start date by clicking the calendar icon.

From Schedule Manager: Click the selection list and choose a data 
column from the list (for example, Project Start Date). The Project 
Schedule Sheet must be created and setup before selections become 
available. 

Planned 
Completion

Choose one of the options: 

Manual: Manually enter the project start date by clicking the calendar icon.

From Schedule Manager: Click the selection list and choose a data 
column from the list (for example, Project Due Date). The Project 
Schedule Sheet must be created and setup before selections become 
available. 

Revised 
Completion

Choose one of the options: 

Manual: Manually enter the project start date by clicking the calendar icon.

From Schedule Manager: Click the selection list and choose a data 
column from the list The Project Schedule Sheet must be created and 
setup before selections become available. 

Design 
Complete 

This indicates the percentage of the design phase that has been 
completed. Enter a value. 

Constructio
n Complete

This is the percentage of the construction phase that has been completed. 
Enter a value. 
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Notes 
Project notes can be anything that the Project Administrator feels is 
relevant to share with other Project Administrators. This note is not 
displayed on the Summary or Project Home Page. 

Status Chose from one of the three statuses. 

Project 
Phase 

If you are manually managing project phases, you can choose from this 
list for template and projects. 

Note: If you are using Gates, this list may not be applicable. 

Project Phase is a system-defined Data Definition that is pre-filled when 
the company is created. You can update this list by navigating to Data 
Structure Setup > Data Definitions > General and add new values to the 
Data Set list. 

Note: Project Phase is associated with Files and Folders in the Document 
Manager. Files and Folders can be given a Phase Property. Then, the 
only Folders and Files that will show in the DM are those folders without a 
Phase Property or one that matches what is set in Project Setup. 

Add links to other project-related web pages (Links tab) 

Project Links will appear on the Project Home Page. Links entered here in the Project Template 
will be copied over to the Project. 

Project Links will appear on the Project Home Page. They can be used to provide links for users 
to useful websites, your company's website, an intranet, etc. Links entered here in the Project 
Template will be copied over to the Project. 

To add a project link 

1) Open the Links tab of the Project or Template window. 

2) Enter the name and URL for any number of links you want to appear on the project home 
page. The name will display as an interactive link on the project home page. When users 
click on the link, a new browser window opens to the URL. 

For example, to provide a direct link to the government Occupational Health and Safety 
website, you might enter OSHA as the name, and http://www.osha.gov as the URL. 

3) Click Add Row to add additional URL links on the project home page. 

4) Click Apply to save. 

Select a project custom attribute (Custom tab) 

Projects can have Custom Attributes associated with them. Custom Attributes are created as 
company-defined Data Definitions. In the case of Projects and Project Templates, they can be 
used to provide further data not defined elsewhere. In the example below, Regions were defined 
as a custom attribute. 

If no custom attributes have been defined, the tab will be blank. 
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To select a custom attribute 

1) Open the Custom tab of the Project or Template window. 

2) Select the value from the pull-down menu. Click OK. 

Create a Project Calendar (Calendar Tab) 

Each project can have its own calendar. The project calendar that you specify can be used to 
override the company calendar, or you can use the company calendar for the project. 

If there is no project calendar, or a project calendar is not in use, the company-level standard 
calendar marked as the default calendar (Company Calendar (Default)) is the calendar that is 
used by the project. 

The project calendars can be based on: 

a) Standard calendars created at the company level 

b) Custom Calendars created for the specific project 

The project calendar you create applies only to the project for which you create that 
calendar. The calendar selected affects project durations and due dates. For example, 
companies can have multiple projects in different countries that have different working and 
non-working days. These working and non-working days must be considered when 
determining such time-driven factors as business process workflow due dates and activity 
dates in schedule sheets. 

Note: Unless otherwise specified, the default calendar for a project is the 
company calendar that is marked as default at the company level. 

To create a project calendar (Classic View) 

1) Open the Calendar tab of your shell. Alternatively, you can open the Calendar tab of your 
project or Template. The calendar you create in this tab is known as the Project/Shell 
Calendar. 

1. Click Details to open the Details window. 

2. Click the Calendar tab. 

2) Select one of the following calendar options: 

a. Standard Calendar

This allows you to use a standard calendar for your shell, project, or template. Your 
options are Company Calendar (Default) or other calendars listed. 

b. Custom Calendar

This allows you to use a custom calendar for your shell, project, or template. Your options 
are Copy or create a custom calendar. 

The calendar that you select displays in the Calendar tab. 
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Note: You cannot modify a standard calendar. 

To create a project calendar (Standard View) 

1) Go to shell home click My Dashboard ..., and click Details to open the details page 
(overlay).  

2) Click Calendar tab. 

3) Select one of the following calendar options: 

a. Standard Calendar

This allows you to use a standard calendar for your shell, project, or template. You 
options are Company Calendar (Default) or other calendars listed. 

b. Custom Calendar

This allows you to use a custom calendar for your shell, project, or template. You option 
are Copy or create a custom calendar. 

The calendar that you select displays in the Calendar tab. 

Modify a Project Calendar 

You can modify the displayed calendar. You can specify the working and non-working days for 
the calendar. Browse to the month and year using the drop-down lists at the top of the calendar. 
Saturdays and Sundays are set as non-working days by default. Do one of the following:  

To change working and non-working days on a calendar at project level (Classic View) 

1) Open the Calendar tab of your shell. Alternatively, you can open the Calendar tab of your 
project or Template. The calendar you create in this tab is known as the Project/Shell 
Calendar. 

1. Click Details to open the Details window. 

2. Click the Calendar tab. 

a. To change a particular date from a working to a non-working day, click the date cell to 
highlight and click Non Working. You can select multiple dates. This change impacts the 
months individually and does not impact the rest of the calendar or subsequent years. 

b. To change Saturdays and Sundays from non- working days to working days, click the day 
cell for example "Sat," to highlight and click Working. This will make all Saturdays, or 
Sundays, of the calendar working days, including subsequent years. In this scenario, you 
can select individual dates under Saturdays or Sundays and mark them as non-working 
dates. 

A non-working date appears grayed out, and it will not be used in date calculations. 

To change working and non-working days on a calendar at project level (Standard View) 

1) Go to shell home click My Dashboard ..., and click Details to open the details page 
(overlay). 

2) Click Calendar tab. 

a. To change a particular date from a working to a non-working day, click the date cell to 
highlight and click Non Working. You can select multiple dates. This change impacts the 
months individually and does not impact the rest of the calendar or subsequent years. 
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b. To change Saturdays and Sundays from non- working days to working days, click the day 
cell for example "Sat," to highlight and click Working. This will make all Saturdays, or 
Sundays, of the calendar as working days, including subsequent years. In this scenario, 
you can select individual dates under Saturdays or Sundays and mark them as 
non-working dates. 

A non-working date appears grayed out, and it will not be used in date calculations. 

Company Sponsored Projects (Standards Tab) E-Signatures 

If you have configured and activated Company Properties > E-Signatures tab with details about 
the entity that provides electronic signature technology (DocuSign or AdobeSign), then when 
you access your project, Projects (Standard), and open the properties window, you can use the 
Standards tab to select the E-Signatures type.  

By default, the value of the E-Signature Type drop-down list is: Company Default. This means 
that the Project Administrator has selected the Default E-Signature Type in the Company 
Properties > E-Signatures tab as the E-Signature Type for the project. See Edit Company 
(E-Signatures Tab) (on page 82). 

Note: If only one E-Signature provider has been determined in the 
Company Properties > E-Signatures tab, the value of the E-Signature 
Type drop-down list (Standards tab) will be read-only and set as 
Company Default. 

You can select a different value from the E-Signature Type drop-down list. 

The Company Administrator can go to the Company Properties > E-Signatures tab to change 
the default value (Default E-Signature Type). This change does not impact the value of the 
E-Signature Type in the project, and the values will continue to remain as Company Default or 
as chosen by the Project Administrator. 

Updating Projects 

The Update Projects function allows you to quickly add or modify information into a project 
template, and then apply that template to existing projects. This will "push" the new information 
to the projects that you specify. By allowing data to be entered or modified once, this function 
helps to reduce set up time and ensure cross-project uniformity. 

The Update Projects function is available for select modules in Project Templates. The following 
information can be pushed: 

 Users: users, group membership, permissions 

 Groups: group names, permissions 

 Business Processes and BP Setups: Business processes, setups 

 User-defined Reports: Reports, report permissions 

 Access Control: modules, users, groups, permissions 

 Cost Sheet: Cost sheet columns, column access and restrictions 
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 SOV: General and Payment Applications structure 

 Commitment Funding: Commitment funding sheet structure 

 Cash Flow: Curve properties and permissions 

 Rules: Project cost or fund rules 

 Gates Setups: Active or inactive setups 

 Schedule Sheet Properties: title, description, Master Schedule, status, auto-control, 
project start date, and error notification. 

Each project module that can be updated from the template has an Update Project button in the 
toolbar. 

This functionality makes it easy to update information across multiple projects. For example, if 
you add new users, or group of users, to the company and need to add them to multiple 
projects, you can add them to a project template, then use the Update Projects functionality to 
add the users to multiple projects. 

Projects with a status of Active or On-Hold can be updated with this functionality. Inactive or 
View-Only projects cannot. Users with Create permission for the project template modules can 
do this operation. 

Note: You update project information one module at a time. Any Active 
or On-hold projects can be updated in this way. 

General procedure for updating project information 

In general, the Update Project feature works like this: 

Step 1. Open a Project Template. 

Step 2. Navigate to one of the modules listed above. Add or edit data. 

Step 3. Click the Update Project button. Select which information within the module to update, 
and which of your active or on-hold projects to "push" the information to. New information will be 
added to the selected projects. Edited information will overwrite existing data. 

You can also cancel a project update before it reaches the In Process status. 

Detailed instructions for updating specific types of project information is found in the following 
sections. 

Update users 

You can add new users to multiple projects at once by adding them to a project template in the 
User Administration > Users module. When adding new users to a project, you can assign 
individual permissions directly to a new user, or add the user to a group to apply group 
permissions. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Some notes about updating users

 Users are identified by their unique User ID. 

 Any Active, Inactive or On-hold users can be pushed. 

 If the user does not already exist in the project, the user will be added 
to the project with the permission settings and group membership. 

 If the user already exists in the project, the user information is 
updated (replaced) with the user information as entered in the project 
template. This includes permission settings and group membership. 

 If a group that the user was added to doesn't already exist in the 
project, the group will be added, and the user will be added to the 
group. Group permissions are not updated; this is done by updating 
groups. 

 If the group already exists, the user will be added to it. Group 
properties and permissions will not be affected. 

To add or update users using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, go to the User Administration > Users log. 

4) Add a user to the project template, or select a user to edit. Define user parameters and 
assign permissions. 

5) Select one or more users in the Users log. 

6) Click the Update Projects button and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update groups 

You can add new users to projects individually or by adding them to groups, and then adding the 
groups to the projects. You can assign the user individual permissions, or add the user to a 
group and apply group permissions. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes: 

About updating groups: 

 Groups are identified by their unique Group Name. 

 All group properties, including permission settings, will be added or 
updated in the projects that you selected. 

 If the group does not already exist, the group will be created with the 
permission settings. Group membership (user list) will not be 
updated in the project. 

 If a group of that name exists, the properties and permissions of that 
group will be replaced with the new group, but not the list of users. 

 Users will not automatically be added to the group; they need to be 
added by updating users (group membership). 

To add or edit user groups using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Projects (Standard) > All in the left Navigator. Open the project template 
to update. 

3) In the Project Template, navigate to the User Administration>Groups log. 

4) Add a group to the project template, or select group to edit. Define group parameters and 
assign group permissions. 

5) Select one or more groups from the Groups log. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update Business Processes and BP Setups 

You can add and update new business processes, or add additional business process setups to 
existing business processes. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes: 

About updating business processes and setups: 

 BP Setup is identified by the unique combination of BP Name, Setup 
Name and Workflow Name. 

 If the BP Name does not exist, it will be added to project with the BP 
Setup and permissions. 

 If the BP exists, but the BP Setup does not, it will be added to the BP. 

 If the BP and BP Setup exist, the Setup will be replaced with the new 
one. 

 Users and Groups that are part of a BP setup as assignees are 
added/updated, but not permissions. If a group is created, it will be 
empty. Users must be added to the group separately through user 
administration. 

 BP-related permissions are added/updated (for example, discussion 
groups, which are available in Classic View only). 

To add or update business process setups using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Projects (Standard) >All in the left Navigator. Open the project template 
to update. 

3) In the Project Template, navigate to the Setup >Business Process log. 

4) Add any new business processes, if applicable. (The BP must already have been imported 
into Unifier and configured at the company level.) 

5) To add or edit business process setups, select the BP to update in the Business Processes 
log. Click Open. The BP Setup log opens. 

6) Create a new setup or modify an existing setup. You may create as many setups as you 
wish to make available in the project(s). 

7) Select one or more setups from the BP Setup log. 

8) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

9) Click Yes if you want to proceed with the update, or No to cancel. 

Workflow Setup for Workflow Business Processes 
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You have the ability to delete (Delete, or Edit > Delete) inactive Workflow setup for Workflow 
Business Processes in Project Templates. 

Updating Record Properties tab in the BP Setups 

When you push the BP setup to selected shells, or all shells, the users and groups who had 
restrictions to the Audit log and Workflow Progress tabs, the Record Properties tab of the BP 
setup (in shell template) will be pushed into the shells.  

The confirmation message (when pushing BP setup into shells or projects from template) will 
have additional information: "Users and groups permissions, in the Record Properties tab, are 
added to the shell and existing permissions will be updated." 

Update User-Defined Reports 

You can add and update user-defined reports. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Important information about updating reports in Project/Shell:  

 Reports are identified by the combination of Name and Data Type. 

 Report names do not have to be unique. 

 If the report name and data type does not exist, the new one will be added. 

 The original owner of the report is added to the Users or Groups of the report in the receiving 
Project/Shell (Permission tab). 

 The administrator of the receiving Project/Shell becomes the report owner. 

 If a report exists with the same name and data type in the receiving Project/Shell, the 
existing report will be replaced with the new report, and the following information will be 
according to the new report: 

 Report updates 

 Added or changed Users or groups 

 Added or changed permissions 

To add or update user-defined reports using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to the Reports > User-Defined Reports log. 

4) Add a UDR to the project template, or select UDR to edit. Define properties. 

5) Select one or more reports from the User-Defined Reports log. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 
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 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update access control 

You can edit access control parameters and update across projects. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:

 Modules are identified by name. 

 If the module exists in the project, the module is updated, 
users/groups are created or updated, and permissions are updated 
for the module. 

 If the module does not exist, the module is added to the project. 
Users/groups are created and permissions are created for that 
module. 

To update access control using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Projects (Standard) in the left Navigator. Open the project template to 
update. 

3) In the Project Template, open the User Administration grouping node and navigate to 
Access Control and assign user or group permissions to the modules as needed. 

4) Click the Update Projects button. The Update Projects window opens, displaying the list of 
modules for which the access control settings can be updated. 

5) Select the module(s) that you wish to update, click Update Projects and choose one of the 
following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

6) Click Yes if you want to proceed with the update, or No to cancel. 
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Update cost sheet columns in a project 

Cost sheet columns can be updated using this functionality. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes: 

About updating cost sheet columns: 

 A column is identified by a unique data source. 

 If the project cost sheet does not exist in the project, the column is not 
added. 

 If the project cost sheet is present but the column does not exist, the 
column definition is created, and the column is added. Column 
restrictions are added. Users/Groups are created or updated. 

 For formula columns, be sure to first push the columns or data 
sources that make up the formula (if they don't already exist in the 
cost sheet), then push the formula column. 

 Any new column that is created will use the column to its immediate 
left as the reference point for positioning. When a column is added to 
the cost sheet via an update, this means: If the column to the left of 
the column that is being pushed exists in both the template and cost 
sheet, the column will be positioned in the cost sheet according to its 
position in the template. If the column to the left of the column being 
pushed exists in the template but does not exist in the cost sheet, 
then the column will be added to the end (far right) in the cost sheet. 

Cost Column Project Update Rules 

If a project cost sheet column of the same name exists, it will be replaced according to the 
following matrix. 

If this template 
(source): 

Is used for this project (destination): The template will: 

Single Date 
Source 

Column exists Update the column 

Column does not exist 
Create column with the 
same definition 

Logical Data 
source 
(Formula 
entry) 

Logical Data source Column Exists 
(Formula entry) 

Update and replace the 
formula 

Logical Data source column exists 
(Manual entry) 

Not update the column or 
formula 

Column does not exist 
Create column with same 
definition 
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Logical Data 
source 
(Manual entry)

Logical Data source Column Exists 
(Manual entry) 

Update the column 

Logical Data source Column Exists 
(Formula entry) 

Update the column and 
change it to manual entry 

Column does not exist 
Create column with same 
definition 

To add or update cost sheet columns using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Cost Sheet. Create or open the 
Project Cost Sheet. 

4) From the cost sheet, click Columns to open the Columns log. Add or edit cost sheet 
columns as needed. 

5) From the Columns Log window, select the column to push. Only one column can be 
updated at a time. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update Schedule of Values (SOV) Structure 

You can update the SOV structure for General Spends, Payment Applications, or Summary 
Payment Applications. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes: 

 Update Project can be used to create or update the SOV structure. If 
the structure already exists, it will be updated. If not, it will be created 
(restrictions apply for payment applications; see below). 

 When creating or updating the structure of the Payment Applications 
SOV or Summary Payment Applications, the Payment Application 
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business process must be set up in the target project first. If the 
business process has an active setup, then Update Project will 
create or update the structure. 

To update SOV structure using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Schedule of Values. Select one of the 
options: General Spends/Payment Applications/Summary Payment Applications. 

4) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

5) Click Yes if you want to proceed with the update, or No to cancel. 

Update commitment funding structure 

You can update the structure used to create commitment funding sheets. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes: 

About updating the commitment funding sheet structure: 

 Update Project can be used to create or update the commitment 
funding structure in the project. If the structure already exists, it will 
be updated. If not, it will be created. 

 Updating the structure in a project will not affect commitment funding 
sheets that already exist. New sheets will reflect the updated 
structure. 

To update commitment funding structure using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 
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3) In the Project Template, navigate to Cost Manager > Funding > Commitment Funding 
Sheet. 

4) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

5) Click Yes if you want to proceed with the update, or No to cancel. 

Update Cash Flow Curve Properties and Permissions 

You can push cash flow detail curve properties and permissions from a project template to a 
project. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes: 

About updating cash flow curve properties: 

 Both detail curve properties and permissions are pushed from the 
template to the project. 

 Cash flow detail curves are identified by name. 

 If a detail curve with the same name exists in the project, it will be 
replaced. All properties, including detail level and time scale, and 
permission settings will be updated. 

 If a detail curve with the same name does not exist in the project, a 
new one will be created. 

 Users and groups will be added if they do not exist. If a group is 
created, it will be empty. 

 In order to push a curve, the destination project must have a cost 
sheet. 

 Commitment detail level curves will not be pushed. 

 A Summary CBS curve cannot be pushed to a project where the cost 
sheet is flat. 

 After a successful update, the updated destination curves will be 
refreshed. 

To update cash flow properties and permissions using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Cash Flow. 

4) Add a cash flow curve to the project template, or select one to edit. Define properties and 
permissions. 

5) Select a curve from the Cash Flow log. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 
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Update project cost or fund rules 

Project cost or fund rules can be updated using this functionality. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes: 

About updating rules: 

 Both active and inactive rules can be pushed. 

 Rules are identified by the combination of rule name and the source. 

 If the rule does not exist, it will be added. 

 If a rule already exists with the same name and source, that rule will 
be updated. This includes the status: for example, if the rule being 
pushed is active, and the rule in the project is inactive, the system 
will update the existing rule and activate it. 

 It is possible to have more than one rule with the same name and 
source in a project/shell or template. If two or more rules already 
exist with the same name and source as the rule being pushed, the 
update will not occur and will give an error. 

 When the update process begins, the system will first attempt to 
validate each rule (equivalent to clicking the Validate button). This 
will occur whether the rule is active or inactive in the template. If the 
rule is validated successfully, the system will proceed with the 
update. 

 If the rule fails validation, the rule will not be pushed. The attempt will 
be captured in the History. 

To update rules using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Rules. 

4) Select one or more rules from the log. 

5) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 
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An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

6) Click Yes if you want to proceed with the update, or No to cancel. 

Update gates setups 

You can update projects with Active or Inactive Gates setups. The Update Project process runs 
in the background. Depending on the number of records and projects you are updating, it can 
take a considerable amount of time to complete. The process is complete when the End Date 
column in the Update History window shows the complete date. 

Notes: 

About updating Gates setups: 

 The Gates setup update will completely overwrite any existing Gates 
setup, or will be added if it did not previously exist. 

 Previously scheduled Gates runs are overwritten by the new Gates 
setup. If the pushed setup is Active new scheduled Gates runs are 
scheduled according to the schedule in the new setup. 

 Both Inactive and Active Gates setups can be pushed in the update. 

 After update the Gates setup reflects the status of the template. 

 After the update, the Current Phase in the Gates setup is reset to the 
First Phase. 

 After the update, the Gates projects will not run the scheduled refresh 
if the project is On-Hold. Gates scheduling will resume automatically 
when the project becomes Active. 

 If you have permission to create Gates setups, you can update Gates 
setups using Update Project, even if you do not have permission to 
access the individual projects. 

 Users and groups specified in the Email Notification field are added if 
they do not exist. 

 Newly-created groups are empty. 

To update Gates setups using Update Project 

1) Go to the Company Workspace tab and switch to admin mode. 

2) Click Templates > Projects (Standard) in the left Navigator. Open the project template to 
update. 

3) In the project template, click Setup and select Gates. 

4) Select a Gates setup. 

5) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 
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 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

6) Click Yes if you want to proceed with the update, or No to cancel. 

View update history 

You can view details about previously updated project modules. 

To view Update Project History 

1) In the Project Template, navigate to the module to view the update history. 

2) Click the Update Projects button and choose History. The Update Projects: History window 
opens. It lists any previous incidents of using Update Projects. 

3) Select an instance from the list and click Open. The History Details window opens, detailing 
the module information that was updated. History Details displays: 

 Requestor: User who initiated the update process 

 Projects: Either user-selected or all projects 

 Submitted date: When the update request was submitted 

 Start date: When the update process started 

 End date: When the update process ended 

Cancel a project update request 

You can cancel an update request that has not yet started; that is, any request that does not 
have a status of In Process or Finished. 

To cancel a project update request 

1) In the Project Template, navigate to the module in which you want to cancel the update 
request. 

2) Click the Update Projects button and choose History. The Update Projects: History window 
opens. 

3) Select an update that has not yet started. 

4) Click Cancel Request. 

Managing Member Companies 

If your company has set up Partner Companies, those companies can become eligible to be 
added to projects. When added to a project, these companies become Member Companies, and 
their users can participate in projects with any permission level you set for them. 

Note: The list of eligible partner companies is maintained in the Partner 
Companies log. In Administration Mode, navigate to Company > 
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Partner Companies to view the list. 

Add a member company to a project 

Active partner company users (users with a unique Unifier user name, and status of Active or On 
Hold) can be added to projects and assigned permissions, just like sponsor company users. See 
Add a user to a project (on page 229) for more information. 

To add a member company to a project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Member Company in the left Navigator. 
The Member Companies log opens. 

3) Click the Add button. The Add Member Companies window opens. This window lists the 
available partner companies that can be added to the project as a member company. 

You can click the Find button to search for a particular company by Company Name or 
Contact Name. 

4) Select one or more companies from the list and click the Add Member button. 

5) At the confirmation window, click Yes. The company is added to the Member Companies 
log. 

View member company profile 

To view a member company profile 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Member Company in the left Navigator. 
The Member Companies log opens. 

3) Select a company from the list and click Open. The Company Profile window for the 
company opens. This is a view-only window. This information is maintained by the partner 
company's administrator. 

4) Click the General tab to view general information, and the Address tab to view contact 
information. 

Remove a member company from a project 

You can remove a member company from the project's Member Companies list. When a 
member company is removed from a project, users belonging to the member company will be 
automatically inactivated for that project. 

To remove a member company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Member Company in the left Navigator. 
The Member Companies log opens. 

3) Select the company and click the Remove button. 
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4) At the confirmation window, click OK. This will remove the selected company from the list 
and inactivate any users who have been added to the project. 

Managing Project Users and Groups 

This section discusses adding groups and users to projects, managing project groups, and 
managing project permission levels. 

You can use bulk processing to update users in projects. See Managing Users in Bulk (on 
page 137) for details. 

Add a user to a project 

After you have created a project, you will need to add users to the list of approved project users. 
Project users can be from your own sponsor company, or from approved member companies. 

When adding users from your company to the project: 

 To add users from your own (sponsor) company, the user must be either Active or 
On-Hold at the company level. When added, the user will automatically be Active for the 
project. 

 Users who are Inactive at the company level cannot be added to a project. 

When adding users from a partner company to the project: 

 In order to add a user from a partner company, the company must first be added to the 
Member Companies list for the project. The user must be either Active or On-Hold at the 
company level for their own company. When added, the user will automatically be Active 
for the project. 

 The user does not necessarily need to be listed in the Partner Users log at the company 
level in order to be added to a company. If the user is listed in the Partner Users log, the 
user must be Active or On-Hold. If the user is not already in the Partner Users log, they 
will be automatically added to the list of Partner Users with a status of Active.

To add users to a project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company SponsoredProjects > [project] > User Administration > Users in the left 
Navigator. The Users log opens. The log lists all users that are already part of the project. 

3) Click New. The User/Group Picker opens. 

Note: If a User Attribute form has been imported, the project user log will 
reflect the design of any designed Partner Log included in that form. See 
Importing User Attribute Form (on page 98) for details. 

4) Click the List Names from drop-down list at the top of the picker window and choose the 
company from which to add the new project user. 

This drop-down lists your sponsor company plus any member companies that have been 
added to the project. You can click the Member Companies node under the project to view 
the list of available member companies. 
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5) Select one or more users to add to the project. You can press the Shift or Ctrl keys to select 
multiple users at once. 

6) Click the Add button. You can continue to select and add names to the Selected Users 
portion of the picker window. 

7) Click OK to add the users to the project. The new users are listed in the Users log. 

Note: By default, new users will have a status of Active. You can 
change the status or other user detail information selecting the user from 
the list and clicking Open. 

To add a user to a project template 

Open the project template and navigate to User Administration > Users. Follow the steps 
above to add a sponsor company or member company user to the template. 

View or edit a project user's profile 

You can edit a project user's details. These procedures apply to sponsor company users and 
member company users. 

To view or edit a project user profile 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > User Administration > Users in the left 
Navigator. The Users log opens. 

3) Select a user from the list and click Open. The Edit Project User window opens. The window 
has the following tabs: General, Groups, Permissions and Custom. 

4) In the General tab, review the contact information for the user as it will appear in the Project 
Directory. By default, the project address (as defined in the project details) displays as the 
contact address. You can edit this information as necessary. 

You can also modify the user's project status: 

 Active: User is listed in Project Directory, in User/Group Picker, User can log in and 
participate in the project. New users are Active by default. 

 Inactive: If you deactivate a project user, the user's name will not appear anywhere for 
selection on any project-related functions. The user will not be able to access the project. 
Inactivating a user at the project level does not affect their status on other projects. 

 On-Hold: User can be added to a project, or assigned as a participant in a business 
process workflow but cannot sign in. 

5) Select the Show user on the Project Directory option if you want the user's information to 
be viewable in the Project Directory. 

6) In the Groups tab, you can add or remove the project users to a project-level group the 
same way that you add company users to company groups. Click the Add button to add a 
group to the user's list, or select a group and click Remove to remove the user from the 
group. 



Project Administration

231

7) In the Permissions tab, you can assign project-related permissions to the user, by module 
and mode. For more information about assigning permissions, see Company User 
Administration. Permissions are described in the Unifier Data Reference Guide.

8) In the Custom tab, you can view available custom attributes that may have been added to 
the user form. 

Create and Manage Project Groups 

Groups are a way to collect Users together so that adding new team members to the project and 
assigning permissions can be done quickly and efficiently. For example, groups can be 
members of the same project team, and/or they can be users who share the same access 
privileges. At the company level, groups can span projects. At the project level, all members of a 
group are members of a given project. Different members of a project may have different access 
to Unifier functionality, depending on their role on the project. 

For example, a Finance person might require access to cost modules and reports dealing with 
finances, but not RFIs or Transmittals and their associated reports. An Executive might require 
access to Summary financial information, and not the cost BPs. 

As users are added to a Group, they will inherit the Group's permissions. If they are in more than 
one group, then the highest level of permissions granted in any group for a module will prevail. 
Permissions are described in the Unifier Data Reference Guide. 

When adding users to the group, you can choose eligible users from the sponsor company and 
any partner company users. The company short name will be listed in the User Picker window 
next to each user. 

Company level groups cannot be copied into a project. 

To create a new group 

1) Go to the Company workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > User Administration>Groups in the left 
Navigator. The Groups log opens. 

3) Click New. The Groups window opens. 

4) Complete the General tab: 

 Group Name: Enter a name for the group 

 Manager: Click Select and select a user from the User Picker window. This is the person 
who will be responsible for administering the group. 

 Description: Enter an optional description for the group. 

5) Click the Members tab. This is where you add and manage group membership. 

a. Click Add. 

b. From the User/Group Picker, select the users to add to the group and click Add.

c. Click OK. 

6) Click the Permissions tab. In this tab, you manage group permission settings. If a user is a 
member of the group, the user will inherit all group permissions. 
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Granting permissions to the group is similar to granting permissions to individual users. 
Choose the project-related permissions for the group that will apply to all members assigned 
to this group. Choose permissions by module and mode. 

7) In the Custom tab, you can view available custom attributes that may have been added to 
the group form. 

To edit group information 

1) Go to the Company workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > User Administration>Groups in the left 
Navigator. The Groups log opens. 

3) Select a group and click Open, or double-click the selected group. The Groups window 
opens. 

4) Make changes as necessary and click OK. 

Grant project user permissions through Project Access Control 

Once you have created a project, assign permissions to the people who need to access the 
project. You can use Access Control to grant multiple Users or Groups permission 
simultaneously, rather than editing the properties for each User or Group individually. 

To view or change a project's access control 

Click Access Control in the Navigator. Unifier displays a copy of the Navigator menu in the right 
pane of the window. In this right pane, you may click on different modules of the Navigator menu 
to set permissions for those functions. 

Generate and print access information report 

You can generate and print an Access Information summary of user and group access 
(permission settings). The report will display all user and group permissions. 

To generate the Access Information report 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Access Control in the Navigator. 

3) Click the Access Information button. The Access Information window opens. It may take 
several moments to generate the report. 

To print the Access Information report 

1) Generate the Access Information report. 

2) Click the Print button. (When the report is complete, the Print button becomes available.) 

Setting up Automatic Status Update 

At the Company level, you can define the setup of the automatic update of project statuses of 
active projects based on triggering conditions which are defined using various data sources as 
parameters. For example: 
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 A selected activity on the schedule sheet is in the Completed status 

 A single-record business process record is set to a specified status 

 A business process workflow reaches a specified status 

Depending on the setup and the conditions that are set, the status of the project can change 
from Active to a non-active status (On-Hold, View-Only, or Inactive). You can define multiple 
setups for each project. After you define these setups, they can be used on project or shell 
instances, or on templates to enable the automatic update of project status. 

The data sources that you use in the triggering conditions can be either from project or shell 
level, or from the Company level. These data sources can be business processes, sheets or 
attribute forms. You can define the frequency at which Unifier evaluates the conditions to see if a 
particular active project should change its status, and can define a list of users or groups to be 
notified when the project status is changed. The highest frequency is daily. 

This automatic update of project status can be useful for users that have a large number of 
projects and want many of these projects to change their status based on certain triggering 
conditions, and thus the users do not have to search for and modify these projects manually. For 
example, you can define a setup at the Company level that contains a triggering condition that 
changes of the status of an active project to On-Hold if the project funds consumption exceeds 
the funds appropriated for that project. This allows the project manager to review the project and 
take appropriate action. If, in this case, the project manager is able to get additional funding for 
the project, the Administrator can change the project status back to Active to restart the project 
activities. 

Note: An automatic project status update can change the status of a 
project from Active to an inactive status. If you want the inactive project 
status to revert to Active, you must activate the project manually. 

Step 1: Create setups - general information. 

Step 2: Verify the order of project statuses. 

Step 3: Define project status triggering conditions. 

Step 4: Define the schedule for automatic update of project status. 

Step 5: Activate the automatic update of project status. 

Step 6: Define permissions. 

Create an Automatic Project Status Update Setup 

Multiple setups can be defined at the company level and then used to configure individual 
projects. 

To create a new project status update setup 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Workspace > Auto-update Status Setup in the left Navigator. The 
Auto-Update Status Setup log opens. 

3) Click New. The Auto-update Status Setup window opens. There are three tabs: General, 
Settings, Schedule. 



Unifier General Administration Guide

234

4) In the General tab, enter a Setup Name, which displays in the log, and an optional 
Description. 

5) In the Settings tab, define the order of the non-active statuses and the status change query 
and trigger conditions. For details, see Choose the Order of Non-active Statuses 
(Settings Tab) (on page 234) and Define Status Change Query and Trigger Conditions 
(Settings Tab) (on page 234). 

6) In the Schedule tab, you can schedule the shell status update. See Define Project Status 
Update Schedule (Schedule Tab) (on page 235). 

7) Once you have defined the setup, you must activate it to be able to apply it to a project. See 
Activate or Deactivate an Auto-update Status Setup (on page 236). 

Note: You must deactivate a setup to be able to modify it. 

Choose the Order of Non-active Statuses (Settings Tab) 

By default the order of the listed statuses is On-Hold, View-Only, and Inactive. These are listed 
on the left side of the Settings tab in the Status pane. You can change the order using the 
Move Up or Move Down buttons. 

You can change the order of the non-active statuses. 

The order of the statuses is significant because the triggering conditions for the statuses are 
evaluated in the order in which they are listed on this tab, with the verification of the triggering 
conditions occurring for each condition listed in turn. 

For example, if the conditions for the first listed status are not met, then the conditions for the 
next listed status are evaluated. If the conditions for that status are not met, then the triggering 
conditions for the third status conditions are evaluated. As soon as the first match occurs, Unifier 
will automatically change the project status and does not perform further evaluation. 

To reorder non-active project statuses 

1) Open the Auto-update Status Setup window and click the Settings tab. 

2) In the Status pane, select the status you want to move. 

3) Click the Move Up or Move Down button to reposition the selected status. 

4) Click Apply to save changes, or OK to save changes and exit the window. 

Define Status Change Query and Trigger Conditions (Settings Tab) 

The Additional Information section allows you to define condition criteria per element. 
Elements can be selected from all Unifier data sources and modules available at the Company 
level. 

In this field: Do this: 

Notify users and 
groups on Status 
change 

Allows you to define the users and groups who will receive 
status change notification. 
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In this field: Do this: 

Email content 
Enter the content of the email you want to send to notified users 
and groups. This content appears in the Additional Information 
section of the email. 

To define query and trigger conditions 

1) Under Conditions Elements, click Add. 

2) Select a Data Type, and click OK. The Query Condition window opens. 

3) Complete the General tab by entering a name for the query and a brief description. The 
Data type and Element is auto-populated from the selection you make on the Query tab. 

4) Click the Query tab. 

5) Click Add. 

6) Complete the Query tab: 

 Data Element: Click the Select button. The Data Element Picker opens. The list is 
generated from the data type you chose in the General tab.  If the data element is a 
picker, pull-down or radio button, the Value field will display the values entered in the 
data set tab for the data definition associated with the data element. For a full list of data 
elements and data types, Refer to the Unifier Data Reference Guide. 

 Label: The label defaults to the data element name. You can enter a different label. 

 Condition: Define Gate Condition Element Condition. The condition options vary 
dynamically depending on the selected Data Element. Examples include equals, does 
not equal. 

 Values: Specify value. The Values field varies dynamically depending on the selected 
Data Element and Condition. (For example, if the element is a text box, the condition 
might be Contains, and value might be one or more letters to search for. If the element is 
a pull-down or other data definition with a data set, you will select a value from the data 
set.) 

7) Select the trigger conditions. 

8) Click OK. 

Note: The DE of type Rich Text is not available when you define queries 
in the Auto-Update Status Setup window.  

Define Project Status Update Schedule (Schedule Tab) 

You can define a schedule to check the conditions for the automatic update in the Auto-update 
Status Setup window, Schedule tab. 

The maximum frequency that Unifier will verify whether triggering conditions are met is daily. If 
you have a need for greater frequency of verification, you must monitor the project with the 
project manager and then change the project status manually as needed.  For example, if the 
triggering condition verification is performed in the morning, and the project funds are being 
spent during the course of the day, the project could exceed its budget before the condition 
verification occurs the next morning, and the project status is automatically changed. 
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In this field: Do this: 

Enable 
Scheduled 
Runs 

Select this checkbox to enable scheduled evaluating of the automatic 
update status. Deselecting this checkbox will disable the scheduler, and 
any scheduled future runs will be canceled immediately. 

The scheduled evaluation is disabled for the last status in the list, 
provided all conditions are met, and the Enable Scheduled Runs 
checkbox is automatically deselected. 

Frequency 
Choose Frequency of the Scheduled Runs (Daily, weekly, monthly, 
quarterly, yearly) 

Range of 
Recurrence 

You can specify a date on which the Scheduled Runs will end, or no end 
date. 

Activate or Deactivate an Auto-update Status Setup 

You must activate a setup in order to be able to apply it to a project. 

Note: You must deactivate a setup to be able to modify it. 

To activate or deactivate a project status update setup 

1) To activate or deactivate a new setup to use in projects, go to the Company Workspace tab 
and switch to Admin mode. 

2) Click Company Workspace > Auto-update Status Setup. The Auto-Update Status Setup 
log opens. 

3) Select a setup in the log. 

4) Click the Status button. You can choose Active or Inactive. 

Set Permissions for Automatic Update of Project Status 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Open the User Administration grouping node and click Access Control in the left 
Navigator. 

3) On the right pane, select Administration Mode Access > Company Workspace > 
Auto-update Status Setup. The permissions are: 

 Create: Allows the creation of new auto-update status setups, edit existing auto-update 
status setups and activate or deactivate auto-update status setups. 

 Modify: Allows one to edit existing auto-update status setups and activate or deactivate 
auto-update status setups. This permission excludes the ability to create a new 
auto-update status setup. 

 View: Allows viewing of existing auto-update status setups. 
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Setting up Gates 

Before you begin: Verify that the list of project phases resides in the Project Phase data 
definition pull-down data set. This is the same list that is used when selecting a project phase 
manually in the project properties window. You can add or modify the default list as needed. 
This list makes the phases available for any project or project template; for each project or 
template, you select which of the phases to use. Create any business processes that you plan to 
use to drive gates conditions and phase completion. 

Step 1: Define Project Phases. For each project or template, you define the list of project 
phases to include in the setup, choosing from the entire list in the Project Phase data set. 

Step 2: Define Gate Conditions. For each phase, define one or more gates conditions. A gate 
condition is a combination data element and trigger condition that enable transition to the next 
phase. 

Step 3: Schedule Gates runs. The gates runs determine the validation of gate conditions. You 
can schedule runs automatically. This is optional. 

Step 4: Activate the gates setup. 

Step 5: Define permissions. 

Note: If you create a new project by copying a project template or an 
existing project, any existing gates setup in the source project is copied 
into the new project, including the gates status. The gates phases are 
restarted at the first phase in the new project, and the scheduled gates 
run is activated. 

Example of a Gates Setup and Conditions 

You will be setting up phases in gates to represent the actual phases of a project. For the project 
to advance from one phase to another, certain conditions must be met. This example will 
discuss phases, conditions, and using business processes in the context of the conditions to 
advance a project from one phase to another. 

For example, phases for Project Zero could be: 

 Preliminary 

 Investigation 

 Definition 

 Measurement 

 Analysis 

 Start 

 Control 

Previously, you have set up two business processes to use in the conditions for your gates 
setup. These are: 
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 Schedule: A single record business process that is updated manually by a project manager 
by checking checkboxes for the various phases such as Definition Phase Complete? or 
Measurement Phase Complete? 

 Funding: A workflow business process that is automatically updated through the steps of 
the workflow. 

As the project manager checks the checkboxes in the phases as represented in the Schedule 
business process, the gates runs keep checking the statuses of the checkboxes. As they are 
checked off, the project advances to the next phase. 

The exception to this procedure is the transition from the Analysis phase to the Start phase. 
Additional approval is needed for funding in order for the project to advance from Analysis to 
Start. The Funding business process is included in the conditions for the Analysis phase. This 
business process must have the status Construction Approved and have a value of greater than 
zero for the Analysis phase to be exited and the Start phase entered for the project. 

Define the Project Phase List 

To view the project phase list 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Data Structure Setup > Data Definitions in the left Navigator. 

3) Select Basic. 

4) Select the Project Phase data definition and click Open. The Modify Data Definitions window 
opens. 

5) Click the Data Set tab. The active phases on this list will be available for project phase 
setup. 

6) Modify the list as needed. Any changes you make here will be reflected in new gates setups. 
Current setups will not be affected. 

Create a Gates Setup 

You can create a gates setup in project templates and in individual projects. There can be one 
setup per project. 

To create a new gates setup 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) To create the setup in a project, click Company Sponsored Projects in the left Navigator. 
Open the project. 

3) Click Setup > Gates. The Gates Setup log opens. 

4) Click New. The gate setup is created automatically. The Gates Setup window opens. There 
are three tabs: General, Settings, Schedule. 

5) In the General tab, enter a Setup Name, which displays in the log, and an optional 
Description. At this point, Status is Inactive by default. 

6) In the Settings tab, define project phases and gates conditions. For details, see Add 
Project Phases to the Gates Setup (Settings Tab) (on page 239) and Configure Gate 
Elements (on page 240). 



Setting up Gates

239

7) In the Schedule tab, you can schedule regular gates. See Define Gates Runs Schedule 
(Schedule Tab) (on page 241). 

Add Project Phases to the Gates Setup (Settings Tab) 

Select which of the phases to use in the project or template from the available project phase list. 
You can reorder them as necessary for the project or template. 

To add project phases to the new gates setup 

1) Open the Gates Setup window and click the Settings tab. 

2) In the Phases pane, click the Add button. The Select Phases window opens, displaying the 
list of available project phases. 

3) Select one or more project phases to add to the list. To select multiple phases, hold down 
the CTRL or SHIFT keys while selecting. 

4) Click OK. The phases appear in the Phases list. 

The order in which the phases appear on the list is the order in which they will be followed in 
the project. The first phase on the list will be the first phase of the project. 

Configure Gates Conditions 

To access the gate configuration view: 

Select a project phase. The gate configure view opens in the right pane. See the following table 
for more information about the gate configuration view. 

The Phase Gate Configuration section in the navigator lists the Project Phases for the current 
Project. The visual order of the Phases depends on the Order specified in the General tab. 

The Gates Conditions Elements section allows you to define condition criteria per element. 
Gate Elements will be selected from all Unifier data sources and modules available in a 
particular project (for the Sponsoring company). 

In this field: Do this: 

Start Date 

The Start date for a particular Phase can be manually set or auto 
populated from a Schedule Sheet by linking it to a particular 
activity or milestone (activity with zero duration and marked as 
milestone) where it will update dynamically based on the start 
date associated with this activity. If there are multiple Start dates, 
choose the Start date used to set Gantt Charts in Schedule 
Manager. 

The start date must fall within Project date ranges. 

Note: You cannot choose dates from schedule sheets in the 
Schedule Manager for generic shells, because the Schedule 
Manager is not available in generic shells. 

Planned 
Completion 

Can be manually set or auto populated from a Schedule Sheet by 
linking it to a particular activity or milestone (activity with zero 
duration and marked as milestone) where it will update 
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In this field: Do this: 

dynamically based on the start date associated with this activity. If 
there are multiple End dates, choose the End date used to set 
Gantt Charts in Schedule Manager. 

Note: You cannot choose dates from schedule sheets in the 
Schedule Manager for generic shells, because the Schedule 
Manager is not available in generic shells. 

Note: Dates are for reporting only. Phases cannot be date driven.

Advance to Next 
Project Phase... 

This checkbox enables automatic phase advancement. Select the 
checkbox if you want the project to move automatically to the next 
phase once all Gate Elements for a particular Phase have been 
checked. 

Notify users on 
Phase Completion 

Allows you to define users who receive phase completion 
notification. You can configure the body text in the notification 
(similar to the BP Setup on the End Step, where you can specify 
the message text content. 

Reevaluate 
conditions on every 
Gates run 

When selected, this checkbox specifies that processing always 
starts at the First phase during a scheduled Gates Run/Refresh. 
You might have to scroll down to see this checkbox. 

If the checkbox is unchecked for a phase: 

 If the phase is currently incomplete, incomplete conditions are 
evaluated and completed conditions are skipped 

 If the phase is currently complete, phase processing is 
skipped 

 If the checkbox is checked in a phase: 

 Every condition in that phase is reevaluated. Including 
conditions that were met 

 All conditions (except conditions that were marked as "ignore" 
manually) are marked as incomplete at the beginning of every 
Gates run and refresh. 

Saved Gates run (PDF) from prior runs persist. Processing will 
stop at a Phase where first un-met condition is encountered. By 
default this checkbox is deselected. 

Configure Gate Elements 

To add a Gate Condition Element 

1) In the Gates Setup window, gate configuration view, select a project phase and click Add
from the Gate Conditions Elements block. The Data Type window opens. 

2) Select a Data Type from the drop-down. 

3) Click OK. The Edit Gate Condition window opens. 
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4) Complete the General tab: Enter a Name for the Gate Element. This can be the name of the 
data element or any descriptive name. This appears on the Gate Conditions Elements list. 
You can add an optional Description. 

5) Click Apply to save changes, or OK to save changes and exit the window. 

To define query and trigger conditions 

1) In the Edit Gate Condition window, click the Query tab. 

2) Under Query Conditions, click Add. The Query Condition window opens. 

3) Complete the Query tab: 

Data Element: Click the Select button. The Data Element Picker opens. The list is generated 
from the data type you chose in the General tab. If the data element is a picker, pull-down or 
radio button, the Value field will display the values entered in the data set tab of for the data 
definition associated with the data element. For a full list of data elements and data types, 
refer to the Unifier Data Reference Guide. 

 Label: The label defaults to the data element name. You can enter a different label. 

 Condition: Define Gate Condition Element Condition. The condition options vary 
dynamically depending on the selected Data Element. The screen shots below list out the 
various options for different Data Element types. Examples include equals, does not 
equal. 

 Values: Specify value. The Values field varies dynamically depending on the selected 
Data Element and Condition. (For example, if the element is a text box, the condition 
might be Contains, and value might be one or more letters to search for. If the element is 
a pull-down or other data definition with a data set, you will select a value from the data 
set.) 

Change the Order of Project Phases 

To change the order of the phases in a gates setup 

Select a phase and click the Move Up or Move Down button. 

Define Gates Runs Schedule (Schedule Tab) 

You can define a gates run schedule in the Gates Setup window, Schedule tab. This run 
evaluates gates conditions, and marks completed conditions as Complete. The update process 
can also be invoked manually in user mode. The scheduler engine is a background process. 

In this field: Do this: 

Enable 
Scheduled 
Gates Runs 

Select this checkbox to enable scheduled updating of Gate Elements. 
Deselecting this checkbox will disable the scheduler, and any 
scheduled future runs will be canceled immediately. 

The scheduled gates runs are disabled in the last phase provided all 
conditions are met, and the Enable Scheduled Gates Runs checkbox 
is automatically deselected. 
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Frequency 
Choose Frequency of the Scheduled Gates Runs (Daily, weekly, 
monthly, quarterly, yearly) 

Range of 
Recurrence 

You can specify a date on which the Gate Runs will end, or no end 
date. 

Auto-email as 
PDF 
Attachment to 
users and 
groups  

Select this checkbox to enable automatic emailing of the scheduled 
run results as a PDF attachment. The report displays the current 
status of each project phase and gate condition. 

Activate or Deactivate a Gates Setup 

Activating a gates setup will enable the scheduled gates runs. After activation, if you need to edit 
the gates set up, you will need to deactivate it first. 

You can make edits while the setup is inactive, including: adding or removing phases; reordering 
phases; add, modify or remove conditions within a phase. 

Some notes about activating/deactivating gates setup: 

 Reactivating an active project: If you temporarily deactivate a project that is in process, and 
then reactivate it, the gates check will start over at the first phase. This is because the setup 
needs to check all phases for new phase additions or new gate conditions that may have 
been added. You can manually update the project phases by clicking the Refresh button for 
gates in User Mode. This will evaluate all phases starting from the first phase, even if the 
phase has been marked Complete, and mark the first phase as the current phase. 

Note: This may trigger email notifications regarding gates advancement, as set up in the 
Settings tab (where the users who are notified are defined), and those users' email 
subscription settings (User Preferences). 

 While a gates set up is inactive: No scheduled gates run will be done. To manually advance 
phases in User Mode Gates for the project, the gates setup must be active. 

 View-Only and Inactive projects: If a project has View-Only or Inactive status, the gates 
setup is inactivated, and you must manually reactivate the setup. 

Set User Permissions for Gates 

To grant User Mode Gates permissions: 

In Access Control or Permissions window, navigate to User Mode Access > Projects/shells > 
Gates. The permissions are:  

 Change Phase: Allows the user to change gates phases. 

 Modify and Refresh: Allows the user to modify gates and refresh gates. 

 Refresh: Allows the user to refresh gates. 

 View: Allows the user to view gates. 
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Unifier Activity Manager 

Unifier enables you to create, consolidate, and monitor activities that must be completed on a 
schedule by way of the Activity Manager. 

Note: Unifier also enables you to set a series of rate rules that should be 
applied when certain conditions are met in a project by way of the 
Master Rate Sheet.  

Activity Manager Module 

To access the Activity Manager module, go to your project or shell in user mode and from the 
left-hand Navigator click Activity Manager. 

For details about the Activity Manager, Rate Sheet, and Master Rate Sheet, refer to the Unifier 
Managers User Guide. 

In This Section 

Activity Manager Permissions ................................................................................ 245 
Master Rate Sheet Permissions ............................................................................ 246 

Activity Manager Permissions 

You can use the following options to grant permission to Activity Sheet under Activity 
Manager node. 

Access Control 

For Activity Sheet, go to Company Workspace > Admin mode > User Administration > 
Access Control > User Mode Access > Projects/Shells > Activity Manager (or Schedule 
Manager) > Activity Sheet. 

Grant any of the following available permissions: 

 Get Data

If enabled, the user will be able to take action ‘Get Data' for system Activity Sheet which will 
update the system Activity Sheet from P6. 

When enabled, the View permission will be enabled, automatically. If you deselect the View
permission, Unifier deselects the Get Data permission. You cannot assign the Get Data
permission without the View permission, but you can assign the View permission without the 
Get Data permission. 

 Send Data

 View

If enabled, the user will be able to view the Activity Sheet node along with the activity 
sheets present in that node (if any). 
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For Rate Sheet, go to Company Workspace > Admin mode > User Administration > Access 
Control > User Mode Access > Shells / Projects (Standard) > Rate Sheet. 

Grant any of the following available permissions: 

 Full Access

 Create

If enabled, the user can create a Rate Sheet. 

 View

If enabled, the user will be able to view the Rate Sheet node at Company Workspace along 
with the Master Rate Sheet present in that node (if any). 

Permission Templates 

For Activity Sheet, go to Company Workspace > Admin mode > Standards & Libraries > 
Permission Templates. 

Open the template, click the Permissions tab, and assign permissions. 

Under Modules For section, scroll to User Mode Access > Shells / Projects (Standard) > 
Activity Sheet, and assign permissions. See the description of permissions under Access 
Control, above. 

For Rate Sheet, go to Company Workspace > Admin mode > Standards & Libraries > 
Permission Templates. 

Open the template, click the Permissions tab. 

Under Modules For section, scroll to User Mode Access > Shells / Projects (Standard) > 
Rate Sheet, and assign permissions. See the description of permissions under Access Control, 
above. 

Master Rate Sheet Permissions 

You can use the following options to grant permission to Master Rate Sheet under Activity 
Manager node.  

Access Control 

For Master Rate Sheet, go to Company Workspace > Admin mode > User Administration > 
Access Control > User Mode Access > Shells / Projects (Standard) > Master Rate Sheet. 

Grant any of the following available permissions: 

 Create

The Create option will be seen at the same level as 'Get Data'. The 'Get Data' option in the 
Master Rate Sheet log will be enabled based on the permission 'Get Data'. 

If enabled, the user will be able to create a Master Rate Sheet by using the Create option in 
the log. 

With Create permission is granted, if a Master Rate Sheet exists (defined through 
integration), then the user can add resources and roles in the existing Master Rate Sheet. 

 View
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If enabled, the user will be able to view the resources and roles both the ones that have been 
created through integration and the ones created manually within Unifier. 
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About Consent Notices (Administrator) 

Consent notices inform users how personal information (PI) is collected, processed, stored, and 
transmitted along with details related to applicable regulations and policies. Consent notices also 
alert users that the action they are taking may risk exposing PI. Unifier helps you to ensure that 
you have requested the appropriate consent to collect, process, store, and transmit the PI your 
organization holds as part of Unifier data. Consent notices are switched off by default in Unifier. 

Consent notices should: 

 be written in clear language which is easy to understand. 

 provide the right level of detail. 

 identify the purpose and legal basis for your collection, processing, storage, and 
transmission of PI. 

 identify whether data will be transferred to named third parties. 

 identify PI categories and list the data which will be collected, processed, stored, and 
transmitted. 

Note: If an administrator provides consent on behalf of other users, it is 
the administrator's responsibility to ensure the consent has been 
provided by the users through other means. 

In This Section 

About Personal Information ................................................................................... 249 
Cookies in the system ............................................................................................ 250 
Permission Control for Consent Notice .................................................................. 250 
Your Responsibilities ............................................................................................. 251 

About Personal Information 

Personal information (PI) is any piece of data which can be used on its own or with other 
information to identify, contact, or locate an individual or identify an individual in context. This 
information is not limited to a person's name, address, and contact details. For example, a 
person's IP address, phone IMEI number, gender, and location at a particular time could all be 
personal information. Depending on local data protection laws, organizations may be 
responsible for ensuring the privacy of PI wherever it is stored, including in backups, locally 
stored downloads, and data stored in development environments. 

In Unifier, the custom data, which might include personal information, is also stored when a 
customer: 

 Configures the system to store, or collect, data in a business process form (BP form). 

 Configures the system to store, or collect, data in other modules. 
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 Adds additional fields to the forms that collects the users' information, during the user 
creation process. 

 Uploads documents that contain user information. 

Personal information may be visible in multiple areas of the system, including but not limited to: 

 User administration 

 Records in various business processes 

 Tasks 

 Documents 

 Reports 

 Dashboards 

Personal information may be at risk of exposure in multiple areas of the system, including but 
not limited to: 

 Dashboard or custom prints 

 Reports 

 Documents 

 Web Services 

 Unifier Mobile 

Cookies in the system 

When using Unifier, the server may generate cookies and send them to the user's browser. The 
user's machine stores the cookies, either temporarily by the browser, or permanently until they 
expire or are removed manually.  

Each user that signs in to Unifier web will see a notification banner (Cookies in Unifier) that 
notifies the user that Unifier uses cookies. This banner has a link to the Unifier cookie policy 
which explains what information is being tracked by way of cookies. The user must click Got It in 
order to access the rest of the Unifier application.  

Oracle might use cookies for authentication, session management, remembering application 
behavior preferences and performance characteristics, and to provide documentation support. 
Also, Oracle might use cookies to remember your log-in details, collect statistics to optimize site 
functionality, and deliver marketing based on your interests.  

Permission Control for Consent Notice 

You can assign Consent Notice permissions in the following permissions-related modules: 

 Access Control

1. Go to Company Workspace (Admin mode), open the User Administration grouping 
node and click the Access Control node. 

2. Click to expand Administration Mode Access. 

3. Click to expand Consent Notice. 

 User Administration
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1. Go to Company Workspace (Admin mode), open the User Administration grouping 
node and click the Access Control node. 

2. Click to expand the User Administration. 

3. Assign through Company Users, Partner Users, or Groups sub-nodes. 

 Standards & Libraries

1. Go to Company Workspace (Admin mode), open the User Administration grouping 
node and click the Access Control node. 

2. Click to expand Standards & Libraries. 

3. Assign through Permission Templates sub-node. 

Permissions can be given by anyone who has access to the nodes. 

Users who have the Modify permission will be able to modify the setup and other details related 
to Consent Notice, for either user consent or bidder consent. 

If a user has only the View permission for the Consent Notice node, then the user will have 
only permission to view the setup and will not be able to make any edits to the consent notice 
setup or other details. 

Your Responsibilities 

Information security and privacy laws can carry heavy penalties and fines for organizations 
which do not adequately protect PI they gather and store. If these laws apply to your 
organization, it is your responsibility to configure consent notices before they are required. You 
should work with your data security and legal teams to determine the wording of the consent 
notices you will configure in Unifier. 

If a consent notice is declined, it is your responsibility to take any necessary action. For 
example, you may be required to ensure that data is not stored or shared. 

Personal Information (PI) Data in the system 

PI may be visible in multiple areas of Unifier, including but not limited to user administration, 
business process workflows, assignments, work products and documents, reports, user defined 
fields, codes, calendars, project websites, and timesheets. 

PI may be at risk of exposure in multiple areas of Unifier, including but not limited to business 
process workflows, assignments, work products and documents, reports, user defined fields, 
codes, calendars, project websites, and timesheets. 

As part of Unifier Cloud Services, you might be using an identity management domain to 
manage your user access and entitlements across a number of cloud and on-premises 
applications and services. If you are using or accessing an identity management domain, you 
are responsible for deleting your details and data from the identity management domain. You 
are responsible for retrieving your content in the identity management domain during your 
applicable services period.  
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Configuring Consent Notices 

To configure Consent Notices for the system: 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click the General Administration grouping node to expand. 

4) Click Consent Notice to expand the node. 

The Consent Notice node can be seen by the site administrator (on-premises customers 
only and in the system admin mode) and by the default company contact (in the respective 
company). 

You can manage the Consent Notice in all Unifier environments (Development, Test, and 
Production), independently. 

You can see the status of consent acceptance for users. You can also reset consent 
acceptance for all users if there is a need to regain consent after a consent notice has 
changed. 

The Consent Notice node has the following sub-nodes: 

 User Consent

Use this sub-node to set up consent notice for the web, mobile, self-service, portal, and 
Unifier /m sign-ins. 

 Consent Status

Use this sub-node to audit and track the users who have accepted the terms. 

 Bidder Consent

Use this sub-node to set up consent notice for the bidder portal sign-in. 

 Consent Status

Use this sub-node to audit and track the bidders who have accepted the terms. 

If you enable consent notices, you must enter consent notice text. Work with your data security 
and legal teams to determine the wording of the consent notices. If no content is detected, the 
system displays the message: The default consent notice is required if the consent notice option 
is enabled. 

Configuring Consent Notices for User Signing In through Web 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click the General Administration grouping node to expand.  

4) Click Consent Notice and then click User Consent. 
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The Setup window, which is open by default, has the following options: 

Enable Consent Notice

This option is selected by default. You can use this option to enable the consent notice for 
signing in to the system through the web, self-service portal, and mobile device. 

Default Consent Notice

This option lets you enter the default consent notice for the environment when the consent 
notice is enabled. You should work with your data security and legal teams to determine the 
wording of the consent notices you will configure in Unifier. You can enter the consent 
message (text) into the system directly as formatted text or HTML text. 

Note: Oracle does not recommend direct copy-paste of text from 
external sources in the provided editor for consent notices because 
direct copy-paste from external sources impacts the behavior of text 
seen for users. Copy-paste of text from a Word document or a pdf file is 
supported in the provided editor. 

If you click Save without entering the consent notice, the system displays the message: The 
default consent notice is required if the consent notice option is enabled.

Note: When you set the consent notice in this node, the consent notice 
will be applicable to both the web and mobile sign-ins. 

Send notifications when users reject the consent notice

This option enables you to set users or groups to be notified when a user rejects the consent 
notice. 

Cancel

Enables you to undo all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Save

Enables you to save all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Preview

Enables you to preview the content of the consent agreement. 

Other tabs are language-specific consent notices that are supported in the system. If you enter 
content for a specific language then the language specific consent notice will be displayed to the 
users based on the user preferences for language. For example, when the language preference 
(Preferences) is set to Dutch, and the Dutch consent notice is not entered, the user will see the 
default consent notice content when signing in (web or mobile). The Dutch consent notice will be 
seen by the user only when a Dutch consent is entered. 

Auditing Consent Notices for Users Signing In through Web 

To audit consent status for users signing in through web: 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click the General Administration grouping node to expand.  
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4) Click Consent Status sub-node to display the log. 

5) Review the status for each user. 

You can use the Consent Status sub-node to track user acceptance. 

The system tracks users based on the following responses to the consent notice: 

 Accepted 

 Rejected 

 Not Responded 

By default, all users are tracked as Not Responded. When users sign in through web/mobile and 
accept or reject the consent notice, the system tracks their responses and assigns a status 
accordingly. 

If you disable the consent notice option after it was enabled in an environment, the system will 
not reset the tracking status for web/mobile consent and tracking statuses will remain as they 
were. 

The following toolbar options are displayed on the Consent Status log: 

View

Enables you to see the following out-of-the-box (OOTB) views: 

 All 

 Group by Consent Status 

When the view is changed to Group by Consent Status, by default the groups will be 
collapsed and an additional toolbar option of Expand/collapse will be displayed. 

Search

Enables you to find information about any user or group by way of: 

 Name 

 Email Address 

 Title 

 Company 

 Status 

 Record Number 

Find on page

Enables you to filter the contents of the log. 

Print

 Enables you to print the contents of the log.  

Reset Accepted Consent

This option is available when the consent notice option is enabled. This option enables you 
to reset the Accepted consent status to Not Responded when there are changes in the 
agreement. Users who have View permission will not see this option. 

The following columns are displayed on the Consent Status log: 

 Name 

 Email Address 

 Title 
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 Company 

 Record Number 

 Status 

 Time 

Configuring Consent Notices for Bidders Signing In through Web 

The site administrator (in the system admin mode) and the default company contact (in the 
respective company) can enable the consent notice for bidders by using the Bidder Consent
node. If you enable consent notices, you must enter consent notice text. If no content is 
detected, the system displays the message: The default consent notice is required if the consent 
notice option is enabled. 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click the General Administration grouping node to expand.  

4) Click Consent Notice to expand the node. 

5) Click Bidder Consent sub-node to display the log. 

The Setup tab, which is open by default, has the following options: 

Enable Consent Notice

This option is selected by default. You can use this option to enable the consent notice for 
signing in through the Bidder portal. 

Default Consent Notice

This option enables you to enter the default consent notice for the environment when the 
consent notice is enabled. You can enter the consent message (text) into the system directly, 
as formatted text or HTML text. This is a required field and you must enter the consent 
notice. If you click Save without entering the consent notice, the system displays the 
message: The default consent notice is required if the consent notice option is enabled. 

Note: When you set the consent notice it will be applicable to both the 
web and mobile sign-ins. 

Send notifications when users reject the consent notice

This option is selected by default. This option enables you to set users or groups to be 
notified when a user rejects the consent notice. 

Cancel

Enables you to undo all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Save

Enables you to save all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Preview

Enables you to preview the content of the consent agreement. 
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Other tabs are language specific consent notices that are supported in the system. If you enter 
content for a specific language, then the language specific consent notice will be displayed to 
the users, based on the user preferences for language. For example, when the language 
preference (Preferences) is set to Dutch, and the Dutch consent notice is not entered, the user 
will see the default consent notice content when signing in (web or mobile). The Dutch consent 
notice will be seen by the user only when a Dutch consent is entered. 

Auditing Consent Notices for Bidders Signing In through Web 

To audit consent status for bidders signing in through web: 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click the General Administration grouping node to expand.  

4) Click the Consent Status sub-node to display the log. 

5) Review the status for each user. 

You can use the Consent Status sub-node to track the bidders who have accepted the terms 
through signing in by way of bidder sign-in. 

The system tracks bidders based on the following responses to the consent notice: 

 Accepted 

 Rejected 

 Not Responded 

By default all the bidders seen are tracked as Not Responded. The bidders listed have been 
invited to bid by way of invitations. For existing and upgrade users, all bidders who received an 
invitation to bid are listed in the log. 

When users sign in through the bidder portal and accept or reject the consent notice, the system 
tracks their responses and assigns a status accordingly. 

The log shows all bidders with Not Responded status before the web consent is enabled for first 
time. 

The following toolbar options are displayed on the Consent Status log: 

View

Enables you to see the following out-of-the-box (OOTB) views: 

 All 

 Group by Consent Status 

When view is changed to Group by Consent Status, by default the groups will be collapsed 
and an additional toolbar option of Expand/collapse will be displayed. 

Search

Enables you to find information about a user or group by way of: 

 Name 

 Email Address 

 Title 

 Company 
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 Status 

 Record Number 

Find on page

Enables you to filter the contents of the log. 

Print

 Enables you to print the contents of the log. 

Reset Accepted Consent

This option is available when the consent notice option is enabled. This option enables you 
to reset the Accepted consent status to Not Responded, for example if there are changes 
in the agreement. 

The following examples explain how the system administers consent notices in the case of 
an email address or user ID changes: 

Example One 

The email address of vendor record V1 was changed from Email1 to Email2, and the user 
id Email1 was assigned to vendor record V2. 

The system displays a new entry for the user ID (in the Consent Status log) after the 
invitation is sent to the new email address. The system retains the consent agreement 
provided to the previous user ID. 

Example Two 

The email address of vendor record V1 was changed from Email1 to Email2, and the user 
id Email1 has left the organization. 

The system displays a new entry for the user ID (in the Consent Status log) after the 
invitation is sent to the new email address. The system removes the consent 
agreement provided to the previous user ID, and the entry for that user ID is not 
displayed in the Consent Status log. 

The following columns are displayed on the Consent Status log: 

 Name 

 Email Address 

 Title 

 Company 

 Record Number 

 Status 

 Time 





259

Translating Custom Strings (Internationalization) 

The content of the material created by the Users (also known as custom strings) can be 
translated into different languages.  

Examples 

Business Process (BP) name, Data Element (DE) label, drop-down labels, radio button, 
navigation log names, and multi select values 

Note: The user input data in Business Processes (BPs), attribute forms 
of various Managers, and other similar elements, when entered at 
runtime, cannot be translated. 

The Internationalization node (a sub-node of Configuration node) contains the custom strings 
that the users have developed. The custom strings that are listed in the Internationalization Log 
window are set to provide the necessary details for translators. 

Notes:  

 Users can translate custom defined strings into various supported 
languages. The Internationalization module contains a list of custom 
strings developed by the user, which provides the necessary details 
for translators. 

 The numeric fields support international number formats (standards). 

 The system displays all available currencies and their respective 
symbols. 

Oracle provides translations for Arabic, Chinese (Simplified), Chinese (Traditional), Dutch, 
English, French, German, Italian, Japanese, Korean, Portuguese (Brazilian), Russian, and 
Spanish. 
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Internationalization Node Properties 

To access the Internationalization node: 

1) Go to Company Workspace. 

2) Switch to Admin mode. 

3) Click Configuration node to expand. 

4) Click Internationalization to open the Configuration - Internationalization log window. 

Within the log, you can: 

 Determine which log items qualify for custom strings translation. 

 Select to see 100 or 200 items per page. 

Use the Display drop-down list on the top right-hand side of the log window. 

 Change the order of the items in the Source Type column. 

 Change the sequence of the languages displayed in the log as explained in the following 
section. 

 See the list of all Custom Strings available for translation. 

To select which languages must be displayed in the log list: 

1) From the Configuration - Internationalization log window toolbar, click Language Log to 
open the Language log window. This window has the following tabs: 

1. Languages

Displays the following information: 

 Column: Displays the column number (in the Configuration - 
Internationalization log) corresponding to a particular language. 

 Language: Displays the name of the language. 
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 Status: Active (for languages that are available for use) or Inactive (for languages 
that are not available for use). Click on the cell to change the status. The General 
tab in the Modify Translation String window will list languages with Status = 
Active to enable you to modify the translation strings for each of those languages. 

 Default: Enables you to select one language as the default language for the 
system. 

2. Columns

In this tab, only languages that have been marked as Active in the Languages tab will 
be displayed. 

 Column: Displays the column number (in the Configuration - 
Internationalization log) corresponding to a particular language. 

 Language: Displays the name of the language. 

 Show Language: Enables you to select which languages will be displayed in 
Configuration - Internationalization log and elsewhere where the language is 
available for use. 

To change the sequence of the languages displayed in the log: 

1) To rearrange the order of languages displayed on each row in the log list, click to select the 
language, and click Move Up or click Move Down. 

Alternatively, you can double-click the number next to the language, edit the number, and 
click Update Order. 

2) When finished, click Update Order, Apply, and OK. 

3) Use Refresh to update the list in the Internationalization Log window. The following explains 
the refresh options: 

 Strings: Use this option to refresh the Internationalization log with the source strings 
belonging to a particular source type. The system prompts you to select the Source Type 
of the strings that need to be refreshed. 

When you select Strings, the Refresh Strings window opens, which allows you to select, 
or deselect the source types that you want the system to display. Click OK to save your 
changes, Cancel to terminate the change. 

 All Strings: Use this option to refresh the Internationalization log with all custom strings 
from all source types. This operation might take a few minutes. 

When you select All Strings, a Confirmation message window opens explaining the 
system status. Review the message and proceed as desired. 

 History: Use this option to see the history of refresh requests: Requestor, Source Type, 
Submit Date, End Date, and Status. You can view History details after the refresh is 
complete. 

The following explains the function of each toolbar option in the Internationalization Log window: 

 Open: This option allows you to open the translated custom string. 

 Export: This option allows you to export strings for bulk translation. 

 Import: This option allows you to import a file that is ready (translated) into the system, or 
log. 

 Delete: This option allows you to delete translated custom strings. 
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Note: You can delete a custom string only if it has not been used 
elsewhere. 

 Find: This option allows you to filter out the custom strings that are available in the log. 

Note: When you select this option, you must select a source type and 
provide search operator for the string that you want to find. 

 Language Log: This option allows you to set the sequence of log columns. 

 Refresh: This option allows you to refresh the items in the log with new or modified custom 
strings that qualify for custom translation. 

The following explains the function of each menu option in the Internationalization Log window: 

Note: You can perform the functions of menu options using the toolbar. 

 File: This option allows you to perform: Open, Export, Import, and Refresh 

 Edit: This option allows you to perform: Delete, Language Log 

 View: This option allows you to conduct a search: All, Find 

 Help: This option allows you to access: User Help, Admin Help, uDesigner Help, Unifier 
Library, and User Productivity Kit. 

The CBS Code Label and CBS Item Label data elements are available as source strings, for 
Internationalization.  

The following data elements are not available as source strings, for Internationalization: 

 CBS Code 

 CBS Picker 

 CBS Description 

Also, the text "CBS Picker" is a system-defined string and not available as a source string, for 
Internationalization. If you want to change the text "CBS Picker," you can use the label name for 
the "bItemID" data element for the picker title. For example, if Cost Code" is the label name for 
the "bItemID" data element, then the picker title will be "Cost Code Picker." 

Note: After you change the picker name, ensure that you do the same in 
the related column of the CSV, or Excel, import file to prevent import 
failure. 

Internationalizing Environments 

A translated custom string can be used in Unifier Development environment, Test environment, 
and Production environment.  

You can use the "XLIFF" file across the two environments using the export and import functions. 

Workflow 
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First, export the custom string (translated) using the Export option out of one environment. 
Then, using the Import option, import the exported custom string (translated) into the other 
environment. 

Notes: 

 The transfer of translated custom strings can be done one language 
at a time. 

 If a custom string does not exist in the destination environment, then 
that custom string cannot be used; however, the custom string will be 
available in the Internationalization Log window. 

 If you add a source string to your source type in the 
Development/Test environment, but this source string does not exist 
in the Production environment, upon exporting the XLIFF file to the 
Production environment, the source string will carry over. 

Translating Methods 

There are two methods available in the system for translating custom strings: 

 User Interface 

Use this translation method when you add or modify a limited number of custom strings, only. 

 Export/Import 

Use this translation method when you need to translate a large number of custom strings. 
This method is particularly useful to professional product-translators because the system 
provides a file format (.XLIFF) that streamlines the translation efforts (Export). After the 
translations are completed, the Company Administrator, or a User with appropriate 
permissions, can access the node and import the translated file back into the system 
(Import). The translation is done for one language at a time. 

To use the User Interface translation method 

1) Go to the Internationalization node. 

2) Select the custom string that you want to translate. 

3) Click Open from the toolbar to open the Modify Translation String window. The Source Type
and Source String fields are read only. 

4) In the Note field enter a description explaining the context and usage of the custom string 
that you are about to translate. 

5) Modify, or add to, the existing translations. You can enter multiple languages for the custom 
string. 

6) When finished, click Apply and then OK. 

About Source Type and Source String 

Each custom string is unique according to the custom string Source Type and Source String. 
The Source Type displays the Source String category. Data Structure, uDesigner, and Reports 
are some of the options under Source Type. 

Example 
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A designers designs a Data Element (DE) with the label: Vendors. The Business Process is 
also named: Vendors. Since both the DE and BP constitute a design element, the Source 
Type is: uDesigner.  

Language codes 

Use the following information to match the language settings: 

 Chinese (Simplified): zh_CH 

 Chinese (Traditional): zh_TW 

 English: en 

 French: fr 

 German: de 

 Italian: it 

 Japanese: ja 

 Korean: ko 

 Portuguese (Brazil): pt_BR 

 Russian: ru 

 Spanish: es 

To use the Export/Import translation method 

1) Go to the Internationalization node. 

2) Select the custom string that you want to translate. 

3) Click Export from the toolbar to open the Export Options window. 

4) Select values for the following fields: 

 Source Language 

The current language of the custom string. (Example: English) 

 Target Language 

The language that the source custom string has to be translated into. You can select one 
language, only. (Example: German) 

 Source Type 

To allow you to filter the custom string for export base on a particular Source Type. The 
drop-down list contains values such as: Data Structure, Reports, etc. (Example: Business 
Process Setup) 

 Include Translated Strings 

This is an optional parameter. By default, this option is selected. 

- If selected, the custom strings (source strings) that are currently translated into the 
selected language will be exported, also. 

- If deselected, only the custom strings (source strings) that are not translated into the 
selected language will be exported. 

5) Click Export to open the File Download window. The file download operation follows the 
Unifier standard file download process. 
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The exported file is in ".XLIFF" format and the file name contains "Unifier" 
(Unifier+-+<Language Name>.XLIFF). 

The number of characters allowed in the file name is based on Unifier standard. For 
supported version of the "XLIFF" file refer to the Primavera Unifier Tested Configurations in 
the Primavera Unifier Documentation Library. 

The exported file contains the following information: ID, Source String, Target Language, and 
Note. 

The Source String is the base for all translations, the Target Language is the language 
selected, and the Note is a placeholder, which stores notes for the translators. The source 
language attribute for the exported file originates from the Source language selection at the 
time of export. 

6) Save the file in your local folder and open the file using a program such as Notepad or 
WordPad. 

7) Open the saved XLIFF file, review the declaration information, and search for <source>. 
Example: 

<source>Assets</source> 

8) Enter a new line, include the target language information, and save the file. Example: 

<target>Aktiva</target> 

9) Change the value of "approved" to "yes." Example:  

<trans-unit id="l5ZQE6Yw9eD/h+JchexCKco1fHnswOCBQne0aR7L86IugwBoiYsRbBpmz+fhygs3" 
approved="no”> 

If you have exported .XLIFF file prior to 21.8, then your exported file will not be compatible 
after 21.8. For new translations, on or after 21.8, Oracle recommends that you export the 
strings again. 

10) Proceed to import the file back to Unifier. 

When the file is ready, use the Import option to bring the translated file back into the system. 

1) Go to the Internationalization node. 

2) Click Import from the toolbar to open the standard File Upload window. 

3) Click Browse, and import the translated file (Unifier-,Language Name.XLIFF). Basic file 
replacement and override apply. 

At this point, the translated custom strings map to the appropriate language settings and are 
ready to be used. 

Note: The Oracle Database column size must not exceed the storage 
size of 4000 bytes. 

Assigning Permissions 
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The Company Administrator assigns access permissions to the Internationalization node, and 
the permissions can be set for both Users and Groups. 

There are two types of permissions available for the Internationalization node: 

 Configure 

 View 

Users who have Configure permission can translate the custom strings, and Users who have 
View permission can view the translated custom strings, only. 

To assign permissions to a User through the Company Users or Partner Users node: 

1) Open the User Administration grouping node and select either Company Users or Partner 
Users.

2) Select a user from the log. 

3) Go to the Permissions tab. 

4) Go to Administration Mode Access > Configuration > Internationalization. 

5) Assign permissions as necessary. 

To assign permissions to a User with Access Control: 

1) Open the User Administration grouping node and select Access Control. 

2) Go to Administration Mode Access > Configuration > Internationalization. 

3) Click Add. 

4) Click Add Users/Groups.

5) Select all users to assign permissions to and click Add. Click OK when finished. 

6) In the Permission Settings block, assign View or Configure permissions to all selected users. 
Click OK when finished. 

Displaying Custom Strings and System Strings 

The following describes how Custom Strings and System Strings display in Administration mode 
and while defining Sheets and User Define Reports (UDRs). 

The contents that appear in the UI (also known as System Strings) cannot be modified by the 
Users. The System Strings are available in different languages, per user preferences. 

Example 

Sign In and Terms and Condition pages, Menus, Alerts, and Errors 

In contrast, the content of the material created by the Users (also known as Custom Strings) can 
be translated into different languages. 

Example 

Business Process (BP) name, Data Element (DE) label, pull-down values, radio button, text 
in lines, navigation log names, and multi select values 

System Strings are translated according to the user preferences, set in the User Preferences 
window. 
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Custom Strings are translated according to the specifications added to the source string, set in 
the XLIFF file. 

When a combination of System and Custom strings are used (concatenation), for example, in a 
form, the System String portion is translated according to the user preferences, set in the User 
Preferences window, and the Custom String portion is translated according to the specifications 
added to the source string, set in the XLIFF file. As a result, it is possible to see an object having 
one field displayed in one language and another field displayed in another language. 

In general, the translated Custom Strings cannot be displayed, or seen, while in the user is in 
Admin mode, except for: 

 Translated Custom Strings for Attribute forms. 

Example 

If there is a Data Element (DE) called, "Building Name" in an Attribute form (Shell), and if the 
German translation of the DE exists, then the details page displays the German translation in 
Admin mode. 

 Pages that are shared between the User mode and Admin mode. 

Example 

If translated Custom Strings are available, then the pages display the translated Custom 
Strings in Admin mode and are synchronized when switching to the User mode, as is the 
case with: 

 Code-based Configurable Manager- sheet templates 

 Record-based Configurable Manager - sheet templates 

 Asset Class templates 

 Shell Dashboard templates 

 User Define Reports (UDRs) templates 

Administration Mode 

Administration mode 

When in the Administration mode, the contents that appear in the UI (also known as System 
Strings) cannot be modified by the Users. The System Strings are available in different 
languages, per user preferences. 

Example 

Sign In and Terms and Condition pages, Menus, Alerts, and Errors 

In contrast, the content of the material created by the Users (also known as Custom Strings) can 
be translated into different languages. 

Example 
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Business Process (BP) name, Data Element (DE) label, pull-down values, radio button, text 
in lines, navigation log names, and multi select values 

System Strings are translated according to the user preferences, set in the User Preferences 
window. 

Custom Strings are translated according to the specifications added to the source string, set in 
the XLIFF file. 

When a combination of System and Custom strings are used (concatenation), for example, in a 
form, the System String portion is translated according to the user preferences, set in the User 
Preferences window, and the Custom String portion is translated according to the specifications 
added to the source string, set in the XLIFF file. As a result, it is possible to see an object having 
one field displayed in one language and another field displayed in another language. 

In general, the translated Custom Strings cannot be displayed, or seen, while in the user is in 
Admin mode, except for: 

 Translated Custom Strings for Attribute forms. 

Example 

If there is a Data Element (DE) called, "Building Name" in an Attribute form (Shell), and if the 
German translation of the DE exists, then the details page displays the German translation in 
Admin mode. 

 Pages that are shared between the User mode and Admin mode. 

Example 

If translated Custom Strings are available, then the pages display the translated Custom 
Strings in Admin mode and are synchronized when switching to the User mode, as is the 
case with: 

 Code-based Configurable Manager- sheet templates 

 Record-based Configurable Manager - sheet templates 

 Asset Class templates 

 Shell Dashboard templates 

 User Define Reports (UDRs) templates 

Internationalization and CSV Files 

Importing and exporting data can be done by using a Comma-Separated Values (CSV) data file 
or a CSV template file. This section explains how the availability of different languages 
(Internationalization) impact the various CSV files created, used, imported, or exported. 
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Note: Number formatting is not supported for Symbols that are based on 
a right-to-left language such as official languages of Afghanistan or 
Hebrew. 

Generic CSV files 

Language preferences are detected from the Preferences settings (Region Format), for both 
CSV data files and CSV template in: 

 All column headers 

 All informational text 

If importing a CSV file fails, the import error file displays the system generated error messages in 
the preferred language. 

If importing a CSV file fails because of form validation errors, then the custom error message 
displays the message in the preferred language. 

Notes: 

 If translation is not available for a custom error message, then the 
source string is displayed. 

 Before importing a CSV file, always check the Preferences settings 
to see the allowed format and number formatting. 

 When importing, or exporting, a CSV file, the date format follows the 
Preferences window (Region Format) Date Format settings. 

Additional information about exporting and importing CSV files 

When importing and exporting of a CSV file is conducted by users with two different language 
settings (for example, French and German), the data entered into an exported file must match 
the original language set. 

Example 

The CSV template Export has been done in French and the template is being used by a 
German User. If the German User enters data without changing the column structure and 
Imports the file, the Import action will fail and an error message will appear in German, 
indicating the error. 

Internationalization and Web Services 

About Web Services 

New records can be created and line items can be added using Integration through web 
services. Also, the Schedule Manager integrates with Primavera scheduling software by way of 
web services. 
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Note: Integration through web services must be coordinated with an 
Oracle Primavera representative. 

As Project Administrator, you can receive email notification of the successful creation of a shell 
instance, for shells that are created manually, through web services or a CSV file upload, or 
through auto-creation. This notification can be set up in email notifications in uDesigner. Also, 
you can set your Preferences to control whether you receive these notifications.  

Web Services and Internationalization 

The output data generated by web services is always in the source language. 

Note: If a record (Example: Business Process) is created by using web 
services and the Data Definition (DD) label includes a non-ASCII string, 
then the record creation will fail. 

Number formatting of data 

When you enter numeric data in XML, you can use the decimal point (period) and negative 
sign (dash), only. 

Examples 

XML Tag: <Committed_Amount>100.99</Committed_Amount> 

XML Tag: <Credited_Amount>-1423.99</Credited_Amount> 

Sample JSON request 

"data": [ 

        { 

            "uuu_quantity": 6000.258, 

            "amount": -27600.0, 

} 

When you run a Get call, the input content in the response XML or JSON will be in the 
language of the source strings. 

Get Web Services 

You can use the Get Web Services call methods to get various attributes of Shell, CBS, and 
the list of Business Process records, Shells, and User defined data. 

When you run a Get call, the input content in the response XML will be in the language of the 
source strings. 

Number formatting does not apply to the numeric data and the decimal point is a period. The 
negative numbers are displayed with the minus sign before the numeric data, for example, 
-12345.99. 

Note: Number formatting is not supported for Symbols that are based on 
a right-to-left language such as official languages of Afghanistan or 
Hebrew. 
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Internationalization (Email Notifications) 

When the system generates an email notification, the language used for that email is based on 
the recipient's Preferences. 

Email notifications for scheduled User-Defined Reports (UDRs), Gates, and so forth, have two 
components: 

 Text 

 Attachments 

If a Business Process (BP) email notification contains an attachment with the record information, 
then the Custom Strings and number formatting in the attachment is according to the 
Preferences. 

If a scheduled UDR is sent as a part of an email attachment, the language in the PDF 
attachment is according to the Preferences of the UDR owner; however, the email text content 
is according to the recipient's User Preferences. 

When a UDR is generated manually and saved by a User, the language in the PDF attachment 
is according to the Preferences of the User who generated, or ran, the UDR. 

If a scheduled job such as Project Gates, where the "Auto-email as PDF attachment to users 
and groups" option is selected, the language in the PDF attachment is according to the User 
Preferences of the creator of the job (Project Gates creator). 

When a manual refresh of the Gates is requested, the language in the PDF attachment is 
according to the Preferences of the User who requested the refresh. 

Internationalization (Support for Tools) 

When used within the system, the following tools support internationalization: 

 Oracle Map 

 AutoVue Server 

 Flex replacement (O charts) 

Note: The Unifier Plug-ins do not support internationalization. 

Oracle Map viewer supports internationalization for Tier 1 languages. Refer to the Oracle Map 
Viewer User Guide for more details. 

The language displayed in the map, and the following subsequent areas, is according to the 
language selected in the Preferences of the user: 

 View map for BP records from log 

 Shell Landing Page 

 Map Picker in Log Find 

 Map Picker in Bulk Edit 

 View Map when invoked from the BP record 
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Note: eLocation services, which is used for geocoding, does not support 
internationalization. As a result, the map labels are displayed in English. 
If a User enters a label in a different language, the Find feature does not 
provide the desired results. 

Internationalization (BI Publisher Custom Reports) 

The Oracle Business Intelligence Publisher (BI Publisher or BIP) Reports support 
internationalization as follows: 

Custom Report (Report File tab) window

If there are no templates available for the report,the Custom Report window (Report File tab) 
displays according to the default settings. 

To upload the translated XLIFF files and report layout, click Add to open the Add Template and 
Files window, enter data in the required fields, and click OK. 

Notes: 

 The non-RTF templates do not support internationalization. 

 You can change the template type when the template is in Creation 
stage, only. After you create a template, you cannot change the 
template type. Use the report designer to create a new template with 
the desired template type and remove the template that is no longer 
needed. 

In the Custom Report window (Report File tab), the only editable column is the Default column, 
which allows you to set the default template by selecting (check-box) the corresponding 
template. 

Note: The system sets the first template, or XLIFF file, that you upload 
as the default template. 

Use Modify in the Custom Report window (Report File tab) to modify an existing template. After 
you click Modify, the Modify Template and Files window opens, which lets you modify the 
template and the translated XLIFF file for that template. When finished, click OK. 

Use Download in the Custom Report window (Report File tab) to download a template and the 
corresponding translated XLIFF file, in a zip file. 

External Data Model BI Publisher Reports

If you want to download the data model of a template, select the template and click Download in 
the Custom Report window (Report File tab). When the download is complete for an External 
BIP report, the data model is included. 

Non-RTF type template

BIP supports RTF templates and XLIFF files. If the report designer selects a non-RTF type 
template, the Browse option in the Modify Template and Files window (Translated XLIFF files for 
the Template section) will be disabled. 
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Custom Report (Query tab) window

Queries based on Data Definition (DD) support internationalization and number formatting 
associated with internationalization according to the Preferences settings. 

Queries based on Data Views do not support internationalization and formatting because raw 
data is being used. 

Queries based on Ad-Hoc support internationalization and number formatting associated with 
internationalization according to the Preferences settings. 

Internationalization (Dashboards) 

Shell Dashboards 

The Shell Dashboards support Internationalization and number formatting for System Strings as 
well as Custom Strings according to the Preferences settings. 

Internationalization (Help Files) 

Unifier Help files do not support Internationalization and are not translated. 

Note: You can translate the Help files, using a third party translator, and 
display the files based on the your Preferences settings. This includes 
uploading a single PDF with multiple language help information. 

Internationalization (Spell Check) 

The Spell Check feature does not support Internationalization. 

Note: If the language selected in your Preferences is not English, the 
Spell Check option will not be available. 

Internationalization (Date and Time Zone Formats) 

Date formats

The following additional date formats support Internationalization: 

 MM/DD/YYYY 

 DD/MM/YYYY 

 MM/DD/YY 

 DD/MM/YY 

 MM-DD-YYYY 

 DD-MM-YYYY 

 MM-DD-YY 

 DD-MM-YY 

 DD.MM.YYYY 
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 YYYY-MM-DD 

 MMM/DD/YYYY 

 DD/MMM/YYYY 

 YYYY/MMM/DD 

 M/D/YYYY 

 M/D/YY 

 D/M/YYYY 

 D/M/YY 

 YY/M/D 

 YYYY/M/D 

 YY/MM/DD 

 YYYY/MM/DD 

Time Zone formats

The Time Zone setting is based on the Coordinated Universal Time (UTC) and supports 
Internationalization. 

Note: The time format for all dates is: HH:MM AM. 

Internationalization (Audit Log) 

Within the Audit log, the following columns support Internationalization according to the 
Preferences: 

 Event 

 Description 

 Field 

For Event, Description, and Field columns, System Strings are and Custom Strings can be 
translated. 
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Configuring and Publishing BI Publisher Custom 
Templates (Custom Prints and Reports) 

Unifier integrates with BI Publisher to deliver on-demand web-based reporting through Unifier. 

Custom Reports, built in BI Publisher, enable the Company Administrator (or power user) to 
build visually stunning, detailed reports. For example: 

 A report that combines information from multiple (and possibly non-linked) Business 
Processes (BPs) 

 A report that needs professional looking graphics, charts, images, or clip art 

The following sections explain how to create and configure custom prints and custom reports in 
the BI Publisher (Oracle Business Intelligence (BI) Publisher or BIP). 

To publish custom prints and custom reports: 

1) Prepare the custom print or custom report 

2) Click Status

3) Select Publish
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Note: Oracle supports the delivery of BI Publisher reports in PDF format 
by way of email, only. 

In This Section 

Custom Templates (Custom Prints and Reports) Overview ................................... 276 
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Custom Templates (Custom Prints and Reports) Overview 

To access Custom Prints and Reports sub-node: Open Unifier > Company Workspace tab > 
Admin mode > Configuration > Custom Templates. 

Note: To run custom reports, access Reports node: Open Unifier > 
Company Workspace tab > User mode > Reports. Data views are 
required for creating custom reports. 

The New option of the Custom Templates log window (or File > New) enables you to create 
the following: 

Option Description 

Custom Print 
with Internal Data 

When the user clicks New > Custom Print > Custom Print with 
Internal Data Model, the print template window displays the Data 
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Option Description 

Model Model Type set as Internal Multiple. 

Any new custom print templates will be of data model Internal 
Multiple and can be used for bulk printing and single-record 
printing. Existing custom print templates of data model type 
Internal can still be used for single-record printing. 

The tags generated for the XML data in the Sample data tab are 
grouped differently for data model type of Internal Multiple, and 
the template designers must use the new XML data structure and 
create layout templates. 

Custom Print 
with External 
Data Model

External data models can be created outside of the system. They 
can include links to multiple tables and pull data from multiple 
Business Processes. These data models can be used to create 
custom print templates. You can create a Custom Print template 
based on an external data model. The concept of creating a 
Custom Print template based on an external data model is similar 
to the concept of creating a Custom Print template based on an 
internal data model, except that the user creates, uploads, and 
maintains the data model needed for creating Custom Print 
template based on an external data model. 

When the user clicks New > Custom Print > Custom Print with 
External Data Model, the print template window displays the Data 
Model Type set as External Multiple. 

Any new custom print templates will be of data model External 
Multiple and can be used for bulk printing and single-record 
printing. Existing custom print templates of data model type 
External can still be used for single-record printing. 

The external data model must contain parameters that support 
printing of multiple records. The Record IDs pass as comma 
separated value. 

Report with 
Internal Data 
Model

Create a new BI Publisher Custom Report based on the standard 
data model, which is generated and maintained internally by the 
system. When you save the BI Publisher Custom Report, the 
system saves changes applied to the following in the data model: 

 Data views 

 Data links 

 Query parameters 

 Additional parameters 

The Custom Report window contains the following tabs and 
fields: 

General

 Name 

 Description 

 Data Model Type 
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Option Description 

The value for the Data Model Type field in the General tab is set 
to Internal (read-only). 

 Report Level 

 Main View 

Views

Your selected values for the Report Level and Main View fields 
(General tab) determines the fields in the Views tab. 

 Description 

 Data Model Type 

The value for the Data Model Type field in the General tab is set 
to Internal (read-only). 

 Report Level 

 Main View 

- The Main View is no longer a mandatory field while creating the 
Report with External Data Model. 

- Users can add the Main View to a Report with External Data 
Model if they want to add query parameters for the report. 

Query

Parameters

Report with 
External Data 
Model

Create a new BI Publisher Custom Report to upload the custom 
data model file created using BI Publisher. 

The system will not maintain the data model file. 

You can generate sample data for external model based report 
provided that the external model based report is published at least 
once. To do this, you have to externally modify the .XDM file either 
manually or by using the BI Publisher data model editor, then 
re-upload the report. 

This option has the same tabs as the Report with Internal Data 
Model option. 

The value for Data Model Type field in the General tab is set to 
External (read-only). 

The value for Main View depends on the following conditions: 

 If an External Data Model was generated by converting an 
Internal Data Model report, then the value for Main View will 
be set according to the Internal Data Model report. 

 The user will be allowed to deselect the value for Main View
and save the report only if there are no Query parameters 
defined for the converted report. 

 The user will be able to generate sample data as before. 
Generation of sample data will be possible after the report has 
been published at least once. 
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Option Description 

Custom Email 
with Internal Data 
Model

Customize the emails that are sent to bidders who are not a part of 
the system. You can include any of the business process data, 
and the email-related data, in the notification that you want sent to 
the bidder. This option is used to send email notifications for the 
Request for Bid (RFB) business processes. 

The Custom Email window contains the following tab and fields: 

General

 Name 

 Description 

 Data Source 

Lists the Request for Bid (RFB) business processes to enable 
you to create the custom email notification. 

 Data Model Type 

The value for the Data Model Type field in the General tab is 
set to Internal (read-only). 

 Email Type 

 Login Information 

 Bid Invitation 

 Due Date Change 

After you are finished, click Apply to set the values for your 
template and sample data in the following tabs of the updated 
Custom Email window: 

Template File

You can upload multiple Rich Text Format (RTF) templates. You 
can select any template as the default template and change the 
default when required. Click Add to upload a template file that you 
want to use to customize your email. The system uses the 
parameters set in the Add Template window to format the email, 
using the BI Publisher. 

Sample Data

After you add a template, go to the Sample Data tab to select a 
sample data for the custom email. You can generate the sample 
data xml from the Sample Data tab and download the sample data 
xml in order to create the layout files. 

You can export the published Custom Emails using the 
Configuration Packages feature. 

All the fields available in the Custom Print version of a Request for 
Bid (RFB) business processes are available for the Custom Email 
version. In addition, the following email-specific fields are available 
as sample data: 

 From Requestor: The user who has sent across the Bid 
invitation. 
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Option Description 

 Email: Email ID of the requestor. 

 Phone: Phone number of the requestor. 

 Sent for: This field signifies what is the invitation for and has a 
value of ‘Bid'. 

 Username: The user name of the Bidder (Email ID of the 
Bidder) 

 Password: The password that needs to be sent across to the 
Bidder.  

 New Due: The changed value of the Due Date of the Bid. 

 Bid URL: This is the URL which the bidder needs to use to 
login into the Bid portal. 

 Contact First Name(uuu_contact_first_name): This is the 
First Name of the Vendor's Contact. 

 Contact Last Name(uuu_contact_last_name): This is the 
last Name of the Vendor's Contact. 

After you have configured the design of the custom email, you can 
save your changes and publish your design to the BI Publisher 
server. The Notification tab of the Request for Bid (RFB) 
business processes will contain all your added options. You must 
select a notification (Custom Notifications) for: 

 Bid Invitation 

 Login Information 

 Due Date Change 

Each notification has a list of templates that have been published 
at least once.  

When BI Publisher Custom Print templates are created using external data model, the system 
does not generate any additional data models for use in the print template. 

If a custom print template of Internal_Multiple has been converted, then the resulting data 
model will be External_Multiple and will be available for bulk printing. 

Copying a template will copy the data model associated with the source template. 

Use the options in Find to select the data models Internal_Multiple and External_Multiple. 

Assigning Roles and Permissions to BI Publisher User to Publish and Run 
Reports 

If you want to publish and run Unifier reports, the following roles and permissions must be 
assigned to the BI Publisher user (who integrates Unifier and OBIEE):  

 BI Consumer: Open 

 BI Content Author: Traverse 

 BI Service Administrator: Full Control 
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Creating Data Model (.XDM) File 

To create a new .XDM file, you can either: 

a. Create the .XDM file from a local BI Publisher server, or 

b. Copy any existing .XDM file, from an existing report, and create a new .XDM file. 

Note: To create an .XDM file that works with the system, you need to 
make changes in the .XDM file, accordingly. 

Custom Templates Windows Log 

The following applies to all Custom Prints and Reports (Internal Reports and External Reports). 

Users do not need a separate set of permissions to access the External Reports in the Custom 
Prints and Reports log. Users who have permissions to the Custom Templates node are able to 
view the External Reports in the Admin mode. 

In the User mode, since the External Reports appear as a list, the permission settings are the 
same as those for Internal Custom Reports (View). 

The Custom Prints and Reports windows log (Custom Templates - Current View: All) displays 
the following information: 

 Name 

 Description 

 Type 

 Location 

 Data Model Type 

 Key 

 Report Level 

 status 

 Publish/Synch Date 

 Last Modified By 

Name

 Name of Print template or name of Report. 

 For External Reports: This field displays the name of the report populated from the BI 
Publisher server. 

 For Custom Print: The name of the print template, as entered in Unifier. 

 For Internal Reports: The name of the report as entered in Unifier. 

 The maximum character length in Unifier is 255. After 255, the characters will be truncated. 

Description

 Description of Print template or description of Report. 

 For External Reports: This field displays the description of the report populated from the BI 
Publisher server. 

 For Custom Print: The description of the print template, as entered in Unifier. 
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 For Internal Reports: The description of the report, as entered in Unifier. 

Type

 Custom Print 

 External Reports: The reports that are created in the BI Publisher server, and are displayed 
here, will have a Type: External Reports. 

 Internal Reports: The reports that are created in Unifier will have a Type: Internal Reports. 

 Custom Email 

Location

 Location of the report in the BI Publisher server relative to the path specified in the Unifier 
Configurator. 

 For the External Reports, the path is relative to the property value for the BIP External 
Report Folder. 

 For the Internal Reports, the path is relative to the property value for the BIP Report Folder. 

 This column displays the path of the report in the BI Publisher server. The location plays an 
important role when there are two reports with the same name. 

Data Model Type

Internal or External for both Print and Report. 

Key

 System-generated unique ID. 

 For External Reports: The key starts with "uuu_ext" 

 For Print or Internal Report: The key starts with "uuu_" 

Report Level

The value is blank for Print and for both Internal and External reports, it shows Project, 
Program, or Application (for Internal Reports, only). 

Status

 Displays whether the report is in one of the following conditions: 

 Invalid (only applicable for the External Reports) 

 Draft 

 Publish 

Publish Date/Synch Date

 Date the record was last published, or synchronized, in the BI Publisher server and Unifier. 
This field will be blank when status is changed to Draft/Invalid. 

 For External Reports: The date when the report is synchronized in Unifier (from BI Publisher 
server to Unifier). 

 For Custom Print: The date that the print template was published to the BI Publisher server. 

 For Internal Reports: The date the reports was published to the BI Publisher server. 

Last Modified By

Name of the user who last synchronized the record. 
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Note: When transferring Custom Reports by way of configuration 
package, the Custom Reports name and level must match in both 
source environment and destination environment. 

The toolbar contains the following options: 

 New 

 Custom Print with Internal Data Model 

 Custom Print with External Data Model 

 Report with Internal Data Model 

 Report with External Data Model 

 Custom Email with Internal Data Model 

 Open 

 Copy 

 Delete 

 Status 

 Find 

 Synchronize External Reports 

New

The External Reports are created in the BI Publisher server. The New option enables the user to 
create Internal Reports and Custom Print templates. 

Open

The user uses the Open option to open an External Report. 

Copy

This option is disabled if you select a record in the Custom Print, or Reports, logs that is an 
External Report type. 

Delete

For External Reports: The user can use this option to delete External Reports that have "Invalid" 
status. This option is disabled if the selected External Report is in "Published" status. 

For Internal Reports: The user can use this option to delete an Internal Report that has never 
been Published. 

For Custom Prints: The user can use this option to delete a Custom Print that is in "Draft" or 
"Published" status. 

Status

The status for all imported External Reports is "Published." The values for this column are: 

 Draft 

 Published 

 Invalid 

 The "Invalid" status is applicable to External Reports, only. This status does not apply, 
and is not available, for Internal Reports and Custom Print records. 
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 The system assigns the "Invalid" status if a report that has been previously imported to 
the system is no longer in the BI Publisher server. 

 You can delete an External Report that has the status "Invalid" from the log. 

 If the user had the permission to view an External Report at runtime, and the status is 
now set as "Invalid," then the user cannot view the External Report at runtime. 

Find

The Find option, on the toolbar, allows you to search for a particular record in Custom Prints and 
Reports log. The options for finding a report are: 

 Name 

 Type 

 Location 

 Data Model Type 

 Last Modified By 

Synchronize External Reports

The Synchronize External Reports option, on the toolbar, enables you to synchronize data 
between the BI Publisher server and Unifier. 

This option allows you, the Administrator, to update the system with the reports created in the BI 
Publisher server. When you click Synchronize External Reports, the system connects to BI 
Publisher server to retrieve reports through Web Services. 

You can set the level of the report (Report Level) in the Synchronize External Reports window 
that opens after you click Synchronize External Reports. 

After the synchronization is complete, you can set the permissions, per Report Level, in Unifier. 
During the runtime, all changes to the report design, such as data model, layout, translation files, 
and so forth, will be applied. 

The following rules apply when you synchronize external reports: 

 The Synchronize External Reports window displays all the new reports that exist in the BI 
Publisher server. 

 Reports that exist in both BI Publisher server and Unifier (same reports in terms of count, 
name, and location), do not appear in the Synchronize External Reports window. 

 When you click Synchronize External Reports, the system synchronizes all reports. You 
cannot select a particular report to be imported into Unifier. 

 If you have imported a report to Unifier and the report no longer exists in the BIP server, then 
when you click Synchronize External Reports the status of the report will be "Invalid" and you 
cannot see the report at runtime. 

 If you change the name of a report in BI Publisher server, the system treats the report as a 
new report after synchronization. 

 The system sets the original report, in Unifier, as "Invalid" and you cannot see the report 
at runtime. 

 If you change the location of a report in BI Publisher server, the system treats the report as a 
new report, after synchronization 
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 The Synchronize External Reports window displays the report and the report new 
location, after import. 

 The system sets the original report, in Unifier, as "Invalid" and you cannot see the report 
at runtime. 

 If multiple reports, with same names exist in BI Publisher server, after synchronization, all 
reports will be imported into Unifier. 

 After the reports are synchronized, the system updates the descriptions of the reports. There 
will be a small delay for this operation. 

 If the report parameter (external reports) starts with "uuu_hidden_", it will not be available 
for the user to edit in Unifier. 

Synchronize External Reports window

 The Report Name is a read-only field and lists the names in alphabetical order. 

 The Location is a read-only field and lists the location of the report in the BI Publisher server. 

 The Report Level is drop-down field and contains two values to select from: Project and 
Program. The default value is Project, and you can modify the Report Level at the time of 
import, only. After you import the report, you cannot modify the Report Level. If you select an 
incorrect Report Level, then the system sets the status of that report as "Invalid." You can 
select Synchronized External Reports option and set the Report Level in the Edit Report 
Level window. 

 The Description field provides a description for the BI Publisher Report on the BI Publisher 
server. 

BI Publisher Report Levels 

There two major levels for BI Publisher report. 

 Project level which means the report is running in Project/Shell context. 

 Program level which means the report is running in Program context. 

For a Project or Program report, respectively, ensure that the following predefined Unifier 
parameters are applied on the "Where" clause as conditions in the query of the Data Set related 
to the Main view: 

 :uuu_p_context_project_id

 :uuu_p_context_program_id

The following are examples of the parameters used in a "Where" clause: 

 project_id = nvl(:uuu_p_context_project_id,project_id)

 program_id = nvl(:uuu_p_context_program_id,program_id)

Sample XML Data for Custom Templates (Custom Prints and Reports) 

In case of a Custom Print, the sample data contains data elements that will be used in the layout 
files to capture information about a business process. 

Some data elements are specific to the business process selected as they map to the standard 
and custom elements included in the business process forms. 
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If you have an image picker Data Element (DE) on your business process form, then the sample 
data includes the XML element, which provides the data for the ID that corresponds to the image 
as well as the name of the image. 

Example 

If the image picker DE "AE_Image" is placed on the business process form, then the 
generated data XML will have the "AE_Image" DE, which provides value for the uploaded 
image name, and the "k__AE_Image" DE, which provides value for the uploaded image ID. 

You must use the image ID in the BI Publisher template for the custom print of the business 
process. 

There are some data elements present in the sample data for all the business processes since 
they apply to all. These data elements provide information such as record attachments, 
attachment comments, line item attachments, workflow steps, and so forth. 

The following is a list of data elements and their descriptions: 

Notes:

 The top level data set, in the Internal Multiple Data Model Type is the 
project_company_info. This has to be the very first grouping since 
the Internal Multiple Custom Print template can be selected for 
multiple business process records, from the Tasks log, Business 
Processes log, or Master Log pages. These pages display business 
process records from multiple shells that the user has access to 
(permission). This data-set has fields providing information of the 
company and project to which the Business Process record is 
associated with. 

 All other data-sets are children to this data-set. 

 Each XML Data Element Group represents a unique data-set in the 
data model uploaded to the BI Publisher Server and has a field that 
its value uniquely represents the record. 

 The unique field in each data-set is the field to be used as a group-by 
field on the template for rendering the data grouped under the 
business process record. 

 The unique fields are important to the template designers because of 
the layout and the data that needs to be displayed on the BI 
Publisher Custom Print output. 

 The unique field in each data-set can be suffixed by a number. This 
applies to other data-sets as well as a similar field. 

 The number suffix is added automatically to maintain the uniqueness 
of the field across the datasets. This is used by the BI Publisher for 
the correct grouping of the data. For example, for multiple ID fields in 
different datasets, the ID field appears as: <ID_3></ID_3>. 

 The following explains the unique field value for the dataset along 
with a description. 

<li_attachments>
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 Unique Field: <ID_<<no>>>..</ID_<<no>>>

 The sub-elements under this provide information about line item attachments for the 
business process when the business process has line items 

<lic_attachments>

 Unique Field: <ID_<<no>>>..</ID_<<no>>>

 The element is a child of <la_comments> and it's sub-elements provide information about 
attachments linked to the comment of line-item attachment 

<li_ca>

 Unique Field: <ID_<<no>>>..</ID_<<no>>>

 The element is a sub-element that provides information about cost allocation line item 
element for Summary Payment Application of SOV type BP 

<la_comments> 

 Unique Field: <. Unique Field: <COMMENT_ID_<<no>>>..<COMMENT_ID_<<no>>>

 This element is a child of <li_attachments> and it's sub-elements provide information on the 
comments associated with the line-item attachment 

<standard_elements>

 This is applicable to Custom Print of Data Model Type Internal. 

 The sub-elements of this group element provide information about company name, project 
name, project number etc 

<general_comments>

 Unique Field: <. Unique Field: <COMMENT_ID_<<no>>>..<COMMENT_ID_<<no>>>

 The sub-elements of this group element provide information about general comments on the 
business process. 

<gc_attachments>

The element is a child of <general_comments>and its sub-elements provide information 
about attachments linked to the general comment. 

<record_attachments>

 Unique Field: <ID_<<no>>>..</ID_<<no>>>

 The sub-elements under this provide information about record attachments for the business 
process 

<ra_comments>

 Unique Field: <COMMENT_ID_<<no>>>..<COMMENT_ID_<<no>>>
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 This element is a child of <record_attachments> and it's sub-elements provide information 
on the comments associated with the record attachments 

<rac_attachments>

 Unique Field: <ID_<<no>>>..</ID_<<no>>>

 The element is a child of <ra_comments> and it's sub-elements provide information about 
attachments linked to the comment of record attachment 

For workflow business processes, there are additional elements which provide information about 
the workflow process and its details. The following is a list of data elements: 

Unique Field: <ID_<<no>>>..</ID_<<no>>>

<workflow_steps>

 <WF_PROCESS_ID></WF_PROCESS_ID> Process Id

 <SOURCE_ID_1></SOURCE_ID_1> BP record Id

 The sub-element of this element provide information about the workflow steps associated 
with the business process. Details like step name, step assignees 

<task_assignees>

 <WFTEMPLATE_ID></WFTEMPLATE_ID>

 <BIP_SOURCE_ID></BIP_SOURCE_ID>

 <BIP_WF_PROCESS_ID></BIP_WF_PROCESS_ID>

 The sub-element of this element provide information about task and assignee details. 
Information like Task name, Task Status, Assigned From, Assigned To and more 

<workflow_progress>

 <WF_PROCESS_ID></WF_PROCESS_ID> Process Id

 <SOURCE_ID_1></SOURCE_ID_1>

 The sub-elements of this element provide information about status of the workflow 

<group_assignment_notes>

 <PROCESS_ID></PROCESS_ID>

 <STEP_ID></STEP_ID>

 The sub-elements of this element provide information about the notes sent when a task is 
assigned to the group in the workflow process 

Creating BI Publisher Custom Print 

To create a new BI Publisher custom print configuration: 

1) Open Unifier. 

2) Go to Company Workspace tab. 

3) Switch to Admin mode. 

4) Click Configuration to open the node. 

5) Click Custom Templates. 

6) From the log window (Custom Templates - Current View: All) click New. 
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7) Select one of the following options to open the Custom Print window: 

 Custom Print with Internal Data Model, or 

 Custom Print with External Data Model

Note: To view a BI Publisher custom print template, select the template 
and click Open. 

See the Custom Templates (Custom Prints and Reports) Overview (on page 276) section for 
more details. 

Custom Print Window (General tab) 

In the General tab, you can define the general custom print information. 

1) Enter and select values in the following fields: 

Note: Required fields are marked with an asterisk (*), or a star. 

 Name

Enter a unique name for the custom print, up to 50 characters (use alphanumeric 
characters, non-ASCII characters, or spaces). 

 Description

(Optional) Enter a brief description about the custom print up to 250 characters (use 
non-ASCII characters). 

 Data Source

Select one of the values from the drop-down list. The list contains all the design objects 
that support custom print, such as BP names, Space attribute names, CM attribute 
names, and so on. 

 Data Model Type

This is pre-populated read-only field, based on the selected custom print type. The 
values, based on the option selected at the time of creating the custom print, can be one 
of the following: 

Internal 

External 

Internal Multiple 

External Multiple 

Internal or External 

2) Click Apply to continue. 

When you click Apply, the system processes the information that you have provided and 
prepares the custom print for publication. As a result of this process, two additional tabs are 
added to the Custom Print window that require your input: 
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 Template File tab 

The Template File tab allows you to upload: 

 Multiple templates for the custom print (RTF, PDF, Excel, eText) 

 Data model (.XDM) file (for print with external data model) 

 Sample Data tab 

The Sample Data tab allows you to generate the sample XML, which you can use to create 
layouts for the custom print. In the case of an external data model-based report, the report 
must have been published to the BI Publisher server at least once before the sample XML 
data can be generated. 

See the following topics for details: 

 Custom Print Window (Template File tab)

 Custom Print Window (Sample Data tab)

Custom Print Window (Template File tab) 

The Template File tab contains information about the print layout, along with the corresponding 
templates and XLIFF translations. 

You can build a Rich Text Format (RTF) print template and upload the template to your Custom 
Print in the system. 

To create a simple RTF template: 

1) Open Microsoft Word. 

The application must have the Microsoft Word BI Publisher plug-in installed. See Download 
and Install BI Publisher Desktop for Microsoft Office. 

2) Click the Word BI Publisher ribbon. 

3) Click Sample XML to import your sample data and wait until the data is loaded successfully. 

You can use the following option for each template: 

 Add 

 Modify 

 Remove 

 Download 

Add

Use Add to upload the print layout and the translated XLIFF files. The XLIFF files are used for 
translation purposes. When you click Add, the "Add template and Files" window opens. 

The "Add template and Files" window has two sections: 

 Template 

 Translated XLIFF files for the Template 

Note: Required fields are marked with an asterisk (*), or a star. 

Template
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The Template section contains the following fields: 

 Template Name: Enter a unique name for the template (use non-ASCII characters). 

 Template Type: From the drop-down list, select a template type: RTF, PDF, Excel, or eText. 

A Template Type can be changed as long as the template is in Creation stage. After it is 
created, the Template Type cannot be modified, and the custom print designer must create a 
new template (of the desired type) and remove the one that is no longer required. 

 Layout File: Browse to find and upload the layout files, based on the template type. 

Translated XLIFF files for the Template

If you want to internationalize the product, then the translated XLIFF files can be uploaded, 
for the corresponding languages, in the Translated XLIFF filed for template section. 

Note: The languages listed are the active languages selected in the 
Configuration - Internationalization log window, by the administrator. 

Click Apply when finished. 

When you open an existing Custom Print, the Template File tab lists all available templates. The 
first template is always marked as Default, but you can change the default template. 

Modify

Use Modify to modify the existing print template and XLIFF files. You must select an existing file 
before your can proceed. When you click Modify, the "Modify Template and Files" window 
opens. 

The "Modify Template and Files" window has two sections: 

 Template 

 Translated XLIFF files for the Template 

Note: Required fields are marked with an asterisk (*), or a star. 

Template

The Template section contains the following fields: 

 Template Name: The unique name for the template. 

 Template Type: This is pre-populated read-only field, based on the selected Template Type. 

A Template Type can be changed as long as the template is in Creation stage. After it is 
created, the Template Type cannot be modified, and the custom print designer must create a 
new template (of the desired type) and remove the one that is no longer required. 

 Layout File: Browse to find and upload the layout files, based on the template type. The 
original custom print file is displayed. 
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Notes: 

 You can modify a BI Publisher Custom Print template only if the 
status is set as "Draft." 

 You cannot modify a Data Source of a Custom Print template after 
the Custom Print template has been created. 

 You can modify the contents of the Description field at any time. 

Translated XLIFF files for the Template

If you want to internationalize the product, then the translated XLIFF files can be uploaded, 
for the corresponding languages, in the Translated XLIFF filed for template section. 

Click Apply when finished. 

Remove

To remove a Custom Print template, click to select the template, and click Remove. 

Note: To delete a Custom Print template, you can select the Custom 
Print template from the log and click Delete. You can delete a Custom 
Print template regardless of the Custom Print template status. 

Download

The Download option allows you to download the template and the corresponding translated 
XLIFF files. You must select an existing file before your can proceed. 

When you click Download, a zip file is generated. The zip file name format must be: 

Template_<Numeric part of report key>_<File Type>.zip

Example 

Template_483_PDF.zip

You can copy a Custom Print template to use as a base for a new Custom Print template. 

Note: After copying a Custom Print template, the term, "Copy of" 
appears at the beginning of the name of the new Custom Print template. 

Custom Print Window (Sample Data tab) 

You can use the Custom Print window Sample Data tab to download sample data for designing 
the custom print template file. You can use the XML data to design the print template file in the 
BI Publisher. 

The XML tags in the sample data are displayed for all the fields that are relevant to the selected 
data source. The XML tags are grouped according to the XML elements or data sets. The data 
sets displayed in the Sample Data tab are driven by the data source type. For a Workflow BP, 
the various elements are the upper forms, line items, workflow details, comments, and so forth. 

1) In the Sample Data tab click Generate. 

2) When finished, click Download. 
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3) Click Apply. 

4) Click OK. 

Creating Custom Email Template 

To be able to create (or add) a custom email template: 

1) Go to the Company Workspace tab (Admin mode). 

2) From the left-hand Navigator pane, click the Configuration node to expand. 

3) Click the Business Process sub-node to open the Configuration - Business Processes
log. 

4) Click to select your Workflow BP and click Open. 

5) From the left-hand Navigator pane, click the Customize Email sub-node to expand. 

6) Click the Content sub-node to open the Email Content log window. 

7) Click Create to open the Create Template window. 

8) Select your language and enter a name for the template in the Name field. 

9) Compose your email body text and if applicable double-click on the necessary data 
elements, from the right-hand pane (Available Data Elements), to include them in your 
email. You need to enter the title of the DE, manually. Use the elements of rich text editor in 
the body to create a custom email format. The list of DEs can be broadly categorized as: 

 Workspace and Workflow Information (Shell details, Workflow information, and Task 
assignee details) 

 Upper form details 

See the "List of DEs and Categories" table below for details. 

If the DE value is not present a blank value will be updated in the email content. 

Use the Find on Page option to search for a particular DE. 

The active languages appear in separate tabs, according to their order in the language log. 

Select one of the following options, when finished: 

 Save: To save your modified email in the log and keep the Email Content log window open 
to conduct other operations. 

 Save and Close: To save your modified email in the log and close the Email Content log 
window. 

 Use the Cancel option to discard your changes, if any, and return to the Email Content log 
window. 

To be able to modify a custom email template, follow the steps above to access the Email 
Content log window, then open the email that you want to modify and incorporate your changes. 
If there are several email templates in the Email Content log window, you can use the Find on 
Page option to search and find the email template that you need. 

Within the Email Content log window, in the upper-right corner, the system displays the value of 
the maximum size of the outgoing email. 
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Note: Ensure that you keep the size of your emails <20% of the 
maximum size of the outgoing email. 

The Email Content log window displays the size of the email configured under each language 
on the right-hand side of the window. 

The custom email template will be available at the company-level (or global-level) when the 
Business Process Setup is made available at a shell-level template, similar to the setup of the 
custom email subject line. After the Business Process Setup, at the shell-level template, is 
complete, the email content template will become available in the Notifications tab of the 
Business Process Setup. When a task is created during the run-time, for a BP, the email 
generation appears per the custom format that was defined at the customize email content 
node, provided that the format is selected as default format. Email templates for multiple 
languages can be created in the same window. 

If the size of the configured email template, for any language, exceeds the maximum set limit, or 
if the size falls between preferred size-range, an error or a warning message will be displayed 
respectively. 

If you modify a template name, and the email is already in use, then the system changes the 
email name at the selection (BP Setup > Notification tab > any particular task type). 

After you save a custom email, the system displays the record with log containing the following 
fields: 

 Name: Name or title of the template. 

 Last Modified By: Name of the user who last modified the template. 

 Last Modified: Date when the template was last modified. 

 Active Languages: Listed according to the order of the language log. If custom email 
content, for any language type, is defined, then the size of the email configured under each 
language is be displayed in the log. 

List of DEs and Categories

Task 
assignee 

Sent From/Task From 

Sent To 

Task To (All assigned users in the To step of the task) 

Task CC (Where all CC users are fetched from the task assigned) 

Task Status 

Task Due Date 

Workflow 
setup 

Workflow Step Name 

Workflow Email Content 
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Shell Shell Name 

Shell Number 

Administrator 

Hierarchy Path 

Environment Name 

Additional Information

The general comments (any comments that have been added as a part of the record 
modification) are sent out as a part of the system default footer, for the email. 

Also, the line items and attachments that have been added to a record will be included 
through a system-generated footer for the record modification emails. The following DEs are 
not included: 

 <SOURCE_ID></SOURCE_ID> 

 <STEP_ASSIGNEE></STEP_ASSIGNEE> 

 <ASSIGNEE_COMPANY></ASSIGNEE_COMPANY> 

 <STEP_STATUS></STEP_STATUS> 

 <STEP_ACTION></STEP_ACTION> 

 <STEP_COMPLETION_DATE></STEP_COMPLETION_DATE> 

 <WORKFLOW_STATUS></WORKFLOW_STATUS> 

 <WFTEMPLATE_ID></WFTEMPLATE_ID> 

 <PROCESS_ID></PROCESS_ID> 

 <TASK_NAME></TASK_NAME> 

 <ACTION_NAME></ACTION_NAME> 

 <ASSIGNED_FROM></ASSIGNED_FROM> 

 <ASSIGNEE_COMPANY_1></ASSIGNEE_COMPANY_1> 

 <TASK_COMPLETION_DATE></TASK_COMPLETION_DATE> 

 <ASSIGNEE_ID></ASSIGNEE_ID> 

 <TASK_NOTE></TASK_NOTE> 

 <SUBWORKFLOW_NAME></SUBWORKFLOW_NAME> 

 <SUBWORKFLOW_DUEDATE></SUBWORKFLOW_DUEDATE> 

 <TASKNODEID></TASKNODEID> 

 <ACT_STEPTEMP_ID></ACT_STEPTEMP_ID> 

When you click Create, the system opens the first language tab, as listed in the language 
log. You can select any of the languages tabs and paste the content to be translated. You 
can also save an email format in multiple languages. At run-time, the custom email is drafted 
for the selected language, and if the custom email content is not present for the language, 
the system uses the system default format. 
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The user can select any of the created records and click Delete in order to delete the 
selected custom email format. If a selection includes a template which is being used, the 
system will display a confirmation message. The user can delete multiple templates at once. 
After a template is selected for deletion, the system automatically reverts the selected 
template to the system default. 

The header and footer section of the custom email is auto-generated by the system and 
appended to the created custom email. 

Use the Additional Information field that is available as one of the DEs like a note. The 
Additional Information field is configured at the email content section of the BP Setup. 

You (the admin) can select the customized email format under the Notification tab of a BP 
Setup. Go to Notification tab, under Custom Notifications sub-section, click on the 
drop-down option for each email type, and select the desired format. The name of the 
custom template defined is listed in the drop-down list. 

If the user selects "Include both record and line item attachments" or "Include record 
information as attachment," the attachments will be sent as part of custom email. 

The drop-down lists all of the custom email formats defined at the customize mail Content 
node. The same format can be selected for all of the task types. After it is selected, the user 
can click OK or Apply to save the changes. The selected format email is triggered, when the 
user: 

 Creates BP log, by way of create. 

 Creates Project Tasks log, by way of create BP. 

 Goes to the Home Tasks log, by way of create BP, in Project. 

 Goes to the Document Manager, by way of create BP with attachment. 

 Goes to the Query Based Tabs, by way of create 

 Initiates auto create. 

 Wants to use the email for CSV uploads. 

 Creates a task, by way of Unifier Mobile App. 

The subject line for email is either a system-default text, or a customized one which is 
defined under the Customize Subject Line node. 

You (the admin) must assign the right user at each and every step of the workflow, to 
indicate the recipient of the notifications. 

When the user has selected custom email for a particular task and the system does not 
generate a custom email (due to errors), the system sends a default email, automatically. 

DEs of type Rich text are not available to be added in the email subject line configuration, or 
to be added to the custom email content. 

Publishing BI Publisher Custom Print 

You must publish the BI Publisher Custom Prints in the BI Publisher Server. 

To publish a BI Publisher Custom Print: 

1) Prepare the custom print. 

2) Click Status. 
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The status of a BI Publisher Custom Print template is either set as Draft, or the status is set 
as Published. For either case, in order to print the BI Publisher Custom Print template, you 
must select Publish. 

You can delete a Custom Print template regardless of the Custom Print template status. 

3) Select Publish. 

After you publish, the system performs validation and if there are no errors the system 
publishes the Custom Print template and assigns the new Published Date in the log. 

Notes: 

 If you remove the data elements from the design of the data source 
that has been used in the BI Publisher Custom Print template, then 
you must republish the Custom Print template to the BI Publisher 
server. 

 If you add new data elements to the upper form, or detail form, of the 
BP Design, then to be able to see and use these new elements (of 
data schema) in the template you must re-publish the Custom Print 
template and download a new copy of data schema. 

 You can update the Custom Print template layout by regenerating the 
sample data. 

 When the status of a Custom Print changes from "Draft" to 
"Published," the system generates the data model with respect to the 
current BP Design. As a result, if the BP design has changed 
between the time of first download of the Sample Data and the 
publishing of the Custom Print, then the developed report Template 
must be tested again with the new Data XML. 

Parameters for External Multiple Custom Print 

The following is a list of parameters for the External Multiple type custom print that you need to 
use in the data model to ensure that the Bulk Action (in Tasks and Business Processes logs) 
works properly: 

Parameter 
Name 

Description Required Comma-Separate
d Values 

uuu_p_proj
ect_id

Contains the value of the 
Project IDs. 

Yes Yes 

uuu_p_cont
ext_compan
y_id

Contains the value of the 
customer's Company ID. 

Yes No 

uuu_p_proc
ess_id

Contains the value of the 
Workflow Process IDs. 

Yes 

Only for Workflow type 
business processes. 

Yes 

uuu_p_sour
ce_id

Contains the value of the 
Record IDs. 

Yes Yes 
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Parameter 
Name 

Description Required Comma-Separate
d Values 

uuu_p_spac
e_source_i
d

Contains the value of the 
space Record ID. 

Yes 

Only for Space type 
business processes. 

Yes 

uuu_p_obje
ct_type

Contains the value of the 
business process ID in 
uDesigner. 

Yes No 

Creating BI Publisher Custom Report 

To create a new BI Publisher custom report configuration:  

1) Open Unifier.

2) Go to Company Workspace tab. 

3) Switch to Admin mode. 

4) Click Configuration to open the node. 

5) Click Custom Templates.

6) From the log window, click New

7) Select one of the following options to open the Custom Report window: 

 Report with Internal Data Model, or 

 Report with External Data Model

See the Custom Templates (Custom Prints and Reports) Overview (on page 276) section for 
details. 

Note: Oracle supports the delivery of BI Publisher reports from P6 in 
PDF format by way of email, only. 

Custom Report Window (General tab) 

In the General tab, you can define the general custom report information. 

1) Enter and select values in the following fields: 

Note: Required fields are marked with an asterisk (*), or a star. 

 Name

Enter a unique name for the custom report, up to 50 characters (use alphanumeric 
characters or spaces). 

 Description

(Optional) Enter a brief description about the custom report. 
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 Data Model Type

This is pre-populated read-only field, based on the selected custom report type. The 
values can either be Internal or External, based on the option selected at the time of 
creating the custom report. 

 Report Level

A drop-down list that allows you to select Project for a project-level custom report, 
Program for a program-level custom report, or Application for an application-level custom 
report. 

 Main View

A drop-down list that allows you to select a data view to use as the main view of the 
custom report. The items in the drop-down list are populated with the data views that 
have been published. 

Note: When you are selecting a Main View, ensure that you select a 
view that has the level-appropriate ID, as a column, in the view 
definition. For example, if you are selecting a Main View for a Program 
(report level), the view must have "program_id", as a column, in the view 
definition. 

2) Click Apply to continue. 

When you click Apply, the system processes the information that you have provided and 
prepares the custom report for publication. As a result of this process, two additional tabs are 
added to the Custom Report window that require your input: 

 Template File tab 

The Template File tab allows you to upload: 

 Multiple templates for the custom report (RTF, PDF, Excel, eText) 

 Data model (.XDM) file (for report with external data model) 

 Sample Data tab 

The Sample Data tab allows you to generate the sample XML data which you can use to 
create layouts for the custom report. 

See the following topics for details: 

 Custom Print Window (Template File tab)

 Custom Report Window (Sample Data tab)

Custom Report Window (Views tab) 

On the Views tab, you can: 

 Set the views used as data sets (Views used as data sets) 

 Determine data links (Data links) 

To set additional views, used as data sets, follow these steps: 

1) On the Custom Reports window, click the Views tab. 

2) In the "Views used as data sets" section click Add to add a new row to the Views list. 
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3) In the "View Name" column, from the drop-down list, select a view. The drop-down list 
displays the available published data views. 

In the "View Type" column, double-click the entry to make the cell editable, and select a view 
type from the drop-down list. You can select one view as the main view, only. The other 
views are sub-report views. 

4) In the "Data Set Name" column, double-click the cell to make it editable, and enter the name 
of the data set to which this view should belong. 

5) In the "Data Set" Tag column, double-click the cell to make it editable, and enter the tag for 
the data set. 

6) To add another view, repeat steps 1 to 5. 

You can enter any number of data views for a custom report and group them into data sets. 

After you have specified the data views and grouped them into data sets, you can link one data 
set to another in order to extract related information from multiple sources. 

For translation-related information about Oracle Business Intelligence Publisher (BI Publisher or 
BIP) Reports, see the Unifier General Administration Guide. 

Note: For External Data Model based reports, you cannot add or remove 
views. 

You can create only one link level; that is, you can create one "sub-link." You cannot create 
another link under a sub-link. 

To determine data links, follow these steps: 

1) In the Data links section of the window, click Add to open the Add Link window. 

2) In the Source Data Set field, select the name of the data set you want to link to another set. 
The selection list shows the data sets you created in the upper section of the Views tab. 

3) In the Source Element Name field, select the name of the field on the source data set that 
you want to map to the target data set. 

The element data type must match the data type of the target element; for example, you 
must match an integer to an integer, a string to a string. 

4) In the Target Data Set field, select the name of the data set the source data set should link 
to. 

5) In the Target Element field, select the name of the field on the target set that the source 
element field should map to. 

6) To add another link, click the Add button and repeat steps 2 to 5, or click OK to save the 
links the exit the Add Link window. 

7) Click Apply, and click OK to exit the Custom Report window. 

Example for creating a data link: 

Row View Name View Type Data Set Name Data Set Tag 

0 Invoices Main View inv inv 

1 InvoicesLI Sub Report View LineItem LineItem 
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At this point, set the relationship between the Main View and the Sub Report View that you have 
added. 

1) Go to the Data Links section and click Add. 

2) Link the ID field, from the Invoices Data View, to the RECORD_ID field, from the Invoices 
Line Item Data View. 

Example 

Source Data Set: inv

Source Element Name: INV_ID

Target Data Set: LineItem

Target Element: INV_LI_RECORD_NO

3) Click OK to add to add the link. 

4) Click Apply. 

Custom Report Window (Query tab) 

When creating, you can specify two types of parameters before running a report: 

 Search Parameters 

Use these to filter the SQL results. Data View result rows that do not match the filter will not 
be sent from Unifier to BI Publisher. 

 Additional Parameters 

Use these to pass additional parameters for BI Publisher to consume at runtime. All values 
are sent from Unifier to BI Publisher for further operation. See Parameters tab below. 

Search Parameters 

Search parameters allow the report runner to filter the data that gets sent to BI Publisher. For 
example, a Contract Report may need to be filtered by Vendor or Contract Type. A Ball-in-court 
report may be filtered for a specific task assignee, or task type. 

At runtime, the report runner can select or multi-select from a list of values based on the search 
parameters specified in the report configuration. This means that Unifier basically runs the Data 
View before the report is run to give the report runner a list of the SQL results. He can then 
select or multi-select values from this initial run to filter what will appear in the report output. 

On this tab, you can add query parameters to the configuration. The query parameters are 
created on the columns of the main view, selected for the Custom Report. At runtime, these 
parameters appear in the Search Parameters block. 

To add query parameters to the custom report 

1) On the Custom Reports window, click the Query tab. 

2) Click the Add button. The Add Query window opens. Complete the window: 

 Element Name: Click the drop-down list and choose from the elements (all columns from 
the main view). 

 Label: Enter a label to use for the Element Name. This label appears to the user 
at runtime. 
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 Operator: Select the appropriate operator to use for the query. The operators will 
depend on the data type of the element chosen. 

 Source Type: This is the source of the value. Choose one of the following: 

 Data Definition: Allows you to choose a data definition. The following field 
becomes available: 

 Select Definition: Select from the drop-down list. The list displays data definitions 
defined in the company that apply to the type of element chosen. (For example, if 
you choose a pull-down or radio button, the data set values defined for the data 
definition will be displayed to the user at runtime.) This allows you to use existing 
data definition values, rather than entering them manually (see Ad Hoc below). 

 View: Allows you to compare columns in your current view against another view chosen 
here. The following fields become available: 

 Select View: Lists all published data views. Choose the view to compare. 

 Value Column: Lists the columns for view chosen in Select View. This is the 
column that will be compared. 

 Label Column: What you choose here will be displayed to the user at runtime. 

 Context Sensitive: If this checkbox is selected, the results will automatically apply 
the filter for project_id at runtime (results will be for the current project only). 

 Ad Hoc: Allows user to select values in User Mode from selection list. If you choose this 
option, you must specify the list of values here. This is similar to defining a data definition 
data set. 

 Click the Add button. The Ad Hoc window opens. 

 Click Add. A new row is added. 

 Enter a Value and Label. 

3) You can modify the query parameters by doing the following: 

 Delete a row by selecting it and clicking Remove. 

 Modify parameter by selecting a row and clicking Modify. 

 Change the order of the query parameters (as they appear in User Mode), by selecting a 
row and clicking Move Up or Move Down. 

4) When done, click Apply to save changes. You can click OK to save and exit, or click another 
tab to continue to define the configuration. 

Custom Report Window (Parameters tab) 

If the report designer has defined a formula using parameters with the same name that was 
used in the Parameters tab, then it will be displayed on the report at runtime. In User Mode, 
these parameters appear in the Additional Parameters block. 

Additional Parameters 

Additional parameters allow the report runner to specify parameters that can be used at 
report runtime to alter how the data is displayed. 

Unlike Search Parameters: 

 Additional Parameters only support entering text. You cannot select or multi-select values 
from Unifier. 
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 Additional Parameters allow us to specify a default value so that the user only needs to 
change the value if needed. 

A good example of where to use Additional Parameters is for calculations, for example, when 
you enter a target future exchange rate. You can also use Additional Parameters for 
conditional highlighting so that only rows over/under a certain value are highlighted. 

Note: In the section Conditional Formatting, You need to hard-code a value (for example, 
10,000). 

To add additional parameters to the custom report: 

1) On the Custom Reports window, click the Parameters tab. 

2) Click Add to add a new row. Enter the following information. 

 Editable: If this checkbox is selected, the field will be editable in User Mode. If not, the 
field is read-only. 

 Hidden: If selected, the field will be hidden in User Mode. The report may still use the 
parameter at runtime, depending on the design. 

 Name: Double-click in the field to make it editable. The Name entered here must match 
the parameter name used in the BIP report. The behavior and default values for the 
parameters specified here can be applied automatically to the report at run time. 

 Label: Defines the label of the parameter field in User Mode. 

 Default: You can enter a default value that will be used in User Mode. 

3) To delete a row, select it and click Remove. 

4) Click Apply to save changes. You can click OK to save and exit, or click another tab to 
continue to define the configuration. 

Predefined BI Publisher Parameter Examples 

The name for a Parameter is mapped to a BIP parameter based on the format: 
:uuu_p_{Parameter Name}

Note: Ensure the length of {Parameter Name} is less than 24 characters. 

Any parameters created on the Parameters tab also need to be appropriately added into the 
Parameters tag in the .XDM file. 

Predefined Unifier Parameters 

Predefined parameters are reserved for Unifier to pass the runtime values to BI Publisher 
runtime context. 

Here is example from a XDM file. 

<parameters xmlns="http://xmlns.oracle.com/oxp/xmlp">

  …

   <parameter name="uuu_p_context_project_id" dataType="xsd:string" 
rowPlacement="7">

     <input label="context project id" size="10"/>

   </parameter>
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   <parameter name="uuu_p_context_program_id" dataType="xsd:string" 
rowPlacement="8">

     <input label="context program id" size="10"/>

   </parameter>

   <parameter name="uuu_p_reportByF" dataType="xsd:string" 
rowPlacement="9">

     <input label="uuu_p_reportByF" size="20"/>

   </parameter>

   <parameter name="uuu_p_timeZoneF" dataType="xsd:string" 
rowPlacement="10">

     <input label="uuu_p_timeZoneF" size="20"/>

   </parameter>

   <parameter name="uuu_p_diffMinutesF" defaultValue="0" 
dataType="xsd:string" rowPlacement="11">

     <input label="uuu_p_diffMinutesF" size="20"/>

   </parameter>

   <parameter name="uuu_p_sysyTimeZoneID" dataType="xsd:string" 
rowPlacement="12">

     <input label="uuu_p_sysyTimeZoneID" size="20"/>

   </parameter>

   <parameter name="uuu_p_searchConditionF" dataType="xsd:string" 
rowPlacement="13">

     <input label="uuu_p_searchConditionF" size="50"/>

   </parameter>

   <parameter name="uuu_p_urlF" dataType="xsd:string" rowPlacement="14">

     <input label="uuu_p_urlF" size="40"/>

   </parameter>

   <parameter name="uuu_p_sessionIdF" dataType="xsd:string" 
rowPlacement="15">

     <input label="uuu_p_sessionIdF" size="50"/>

   </parameter>

   <parameter name="uuu_p_companyRegistryF" dataType="xsd:string" 
rowPlacement="16">

     <input label="uuu_p_companyRegistryF" size="50"/>

   </parameter>
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The following is an example for how to use the predefined BI Publisher Parameters to display an 
image in the Report layout: 

1) Create Form fields in the .rtf. 

2) In the HelpText of the form field, define variable matching the parameter names used in the 
image URL. 

3) Right-click the dummy image and select Size (and its AltText), then enter the following 
content: 

url:{concat($uuu_p_urlF,'companyRegistry=',$uuu_p_companyRegistryF,'
&sessionId=',$uuu_p_sessionIdF,'&id=',PROJECTIMAGE)}

Note: The uuu_p_* are the predefined parameters in the data model. 
They are also the variable names defined in the RTF form fields. The 
PROJECTIMAGE is the element for image file ID from Unifier. 

In the HelpText of the form field enter: 

<?variable@begin:uuu_p_urlF;(.//uuu_p_urlF)[1]?>

Custom Report Window (Template File tab) 

The Template File tab allows you to upload: 

 Multiple templates for the custom report (RTF, PDF, Excel, eText). 

 Data model (.XDM) file (for report with external data model) 

 XLIFF translation files 

Use this tab to add, modify, remove, or download files and click Apply when finished. 

You can build a Rich Text Format (RTF) report template and upload the template to your 
Custom Report in Unifier. 

To create a simple RTF template: 

1) Open Microsoft Word. 

The application must have the Microsoft Word BI Publisher plug-in installed. See Download 
and Install BI Publisher Desktop for Microsoft Office. 

2) Click the Word BI Publisher ribbon. 

3) Click Sample XML to import your sample data and wait until the data is loaded successfully. 

Note: You may need to complete the General tab first and click Apply
before this tab appears. 

Custom Report Window (Sample Data tab) 

The Sample Data tab allows you to generate the sample XML data, which you can use to create 
layouts for the custom report. In the case of an external data model-based report, the report 
must have been published to the BI Publisher server at least once before the sample XML data 
can be generated. 
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Note: Depending on the Report Level that you have selected in the 
General tab, the fields and selections in this tab changes. 

1) In the Sample Data tab select a sample, determine the number of rows that you want to see, 
and click Generate. 

2) When finished, click Download. 

3) Click Apply. 

4) Click OK. 

Download and Install BI Publisher Desktop for Microsoft Office 

To download and install BI Publisher desktop for Microsoft Office: 

1) Download Oracle BI Publisher Desktop for Microsoft Office from: 
http://www.oracle.com/technetwork/middleware/bi-publisher/downloads/index.html 

Ensure that you choose the BI Publisher Desktop version (32bit vs. 64bit) based on your 
version of Microsoft Office 32 bit or 64 bit. 

Note: If your Microsoft Word executable is found at C:\Program Files 
(x86)\Microsoft Office\Office12\WINWORD.EXE, then you 
have the 32 bit version). 

2) Run the installer. 

No additional setup is required after running the installer. To ensure that the installation was 
successful, check to see that the plug-in has been added to your Microsoft Word user 
interface. The BI Publisher ribbon appears after launching Microsoft Word. 

(Optional) SQL Text Editor 

When you start to write more complex reports, having a text editor that highlights SQL keywords 
can make a big difference. For your needs, a simple editor such as Notepad++ would suffice. 
Ensure that you set the Language to SQL. You can copy the queries developed through the text 
editor and paste them into the Data View window. 

(Optional) SQL Developer 

You can download Oracle SQL Developer from: 
http://www.oracle.com/technetwork/developer-tools/sql-developer/downloads/index.html 

1) Download the first option in the list: Windows 64-bit - zip file includes the JDK 7 

2) Extract the file onto your computer (for example, C:\Oracle\sqldeveloper\). 

3) Run sqldeveloper.exe. 

Building Report Template (RTF) 

You can build a Rich Text Format (RTF) template and upload the template to your Custom 
Report in Unifier, and generate live reports. 
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Using Invoice as an example, the following explains how to build a simple RTF template 
(non-tabular report). 

To create a simple RTF template: 

1) Open Microsoft Word. 

The application must have the Microsoft Word BI Publisher plug-in installed. See Download 
and Install BI Publisher Desktop for Microsoft Office. 

2) Click the Word BI Publisher ribbon. 

3) Click Sample XML to import your sample data and wait until the data is loaded successfully. 

Note: Alternatively, you can use a template file (for example, A Word 
template file from your customer). 

4) Click Repeating Group to generate a loop on each Invoice. The Repeating Group window 
opens. 

5) In the For Each field, enter a value in the Data Set Name for each of the Invoices that you 
chose, when defining your Custom Report (for example, inv). This does not apply to the 
Invoices Line Items. 

6) In the Group By field, select a field for your Invoice loop. Use the INV_ID because it is a 
unique identifier for each Invoice. 

7) (Optional) Insert a page break after each Invoice to keep your report formatted. 

8) (Optional) Select the Data already sorted option. You can select this option because you 
have already sorted your data in your SQL statement, using: ORDER BY. 

9) Click OK. 

The BI Publisher plug-in application adds a code to the document which includes: a start 
(for-each), a page break (page break), and an end (end) for your Invoice loop. 

10) Add a blank line after "for-each" operator to make room for your Invoice information. 

11) Click the field icon (ab|Field) to open the field browser. 

The field browser window enables you to add fields from your XML sample data file. 

1) After each "for-each" operator, double-click Inv_Record_No in the field browser. 

2) Add a hyphen ( - ) [n-dash] after the record number. 

3) Double-click Inv_Title to add the Invoice title. 

Example 

for-eachINV_RECORD_NO-INV_TITLE

page breakend

4) (Optional) Run the report by clicking PDF on the Word BI Publisher Ribbon (Word will 
prompt you to save your RTF file if you have not, already). 

The first report is now ready. 

The report only has the Invoice record number and title for each Invoice in your sample XML (the 
approved and pending ones because: WHERE inv.STATUS = 'Approved' OR inv.STATUS 
= 'Pending' in our SQL statement). 
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You can continue to build on the generated report by adding additional fields from the Upper 
Form of the Invoices BP, as well as headers, footers, formatting, and so forth. 

Creating a Report with Line Items 

You can use the Table Wizard to create a report with all the Line Items. 

Using Invoice as an example, the following explains how to create a report with Line Items: 

1) Add a blank line after for-eachINV_RECORD_NO - INV_TITLE operator and leave your 
cursor. 

2) Click Table Wizard on the Word BI Publisher Ribbon. 

3) Select Table as your Report Format and click Next. 

4) Select /DATA_DS/Inv/LineItem as your Data Set (or the name that you had given your Line 
Item data set). 

5) Select the fields that you want to add to the table. Since this is for the Invoice line items, you 
must only add fields that are specific to the line items. 

If you need to add a field for "group on" (for example, Inv_Li_Record_No), the grouping 
process is similar to the process explained in the preceding section. Since you have grouped 
the records by Invoice in the preceding section, you can leave the value blank. 

The order of the selected columns must match the order that you want in your table, except 
for the column that you use for grouping, which is outside the table. In the "Which fields do 
you want to show in your report" window, match the order as shown here: 

Inv Li Record No --> In Li Record 

Inv Li No -->Inv Li No 

Inv Li Desc --> Inv Li Desc 

Inv Li Unit Price --> Inv Li Unit Price 

Inv Li Quality --> Inv Li Quality 

Inv Li Amount --> Inv Li Amount 

Inv Li Uom --> Li Uom 

Code --> CodeInv 

Item --> Item 

6) In the "How would you like to group your report" window, leave every option as is because 
you have already grouped your data by Invoice in the preceding section. 

7) In the "Which fields would you like the user to sort the data" window, within each table, sort 
the lines by Inv_Li_No (Invoice Line Item Number). Specify that this is a Number so that it is 
sorted correctly. 

8) Click Finish. 

The Table Wizard inserts the table and the necessary code: 

for-eachINV_RECORD_No - INV_TITLE
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Inv Li No 
Inv Li 
Desc 

Code Item 
Inv Li 
Quantity 

Inv Li 
Uom 

Inv Li Unit 
Price 

Inv Li 
Amount 

F 
INV_LI_
NO 

INV_LI_D
E SC 

CODE ITEM INV_LI_QU
ANTITY 

INV_LI_
UOM 

INV_LI_UNI
T_PRICE 

INV_LI_AM
OUNT E 

page breakend

You must run the report to see what information is generated. While the data is correct, you 
need to work on formatting the data. See Formatting Data for details. 

Formatting Data 

To format the data generated: 

 Provide a descriptive text (not SQL column names) for Column titles. 

 Adjust the Column widths. 

 Apply general table coloring (borders and shading, font sizes, cell alignment, etc.). 

 Ensure that the "dollar" format is used for the two price columns (for example, $110.00). See 
the details that follow. 

 Add useful information, from the Upper Form of the Invoice, above the table. See the details 
that follow. 

 Provide a "Total" for the amount column. See the details that follow. 

When you are finished, generate a PDF and repeat the process if necessary. 

To change the formatting of the Price & Amount columns (for example, 110.0 > $110.00): 

1) Double-click on INV_LI_UNIT_PRICE (the code under the Unit Price field) to launch its BI 
Publisher properties. 

2) Change the Formatting Type to Number. 

3) Set the Formatting Format to $#,##0.00;($#,##0.00) (paste in the blue text). 

4) Repeat the preceding steps for the Amount column. 

To add useful information, from the Upper Form of the Invoice, above the table: 

Note: Tables are an efficient formatting tool for organizing data from the 
Upper Form. Include separate columns for the field name (align right) 
and the field value (align left). You can also hide the borders if you 
prefer. 

1) Create a 4-row and 2-column table and add field names. 

2) Place your cursor where the first inserted field value must be entered. 

3) Click the field icon (ab|Field) to open the field browser and add fields from your XML sample 
data. 

4) Add useful information such as Creator, Email, and Status (or other fields you added to your 
SQL statement) above your Line Item Table. 
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5) Double-click on the correct field value from the Field window to add the Title to the report (for 
example, add Invoice title in the Title field). 

To provide a "Total" for the amount column, using Invoice as an example: 

1) Right-Click somewhere in the last row of your Invoice Line Item table and select Insert > 
Insert Rows Below. 

2) Highlight all the columns in the new row, except for the last one, and Merge the cells (from 
the right-click menu). 

3) Click in the newly created cell and enter: Total 

4) Right-align the cell. 

5) Place your cursor into your last column of the new row. 

6) Click the field icon (ab|Field) to open the field browser and add fields from your XML sample 
data. 

7) Click Inv_Li_Amount column to highlight. 

8) Set the calculation (at the bottom) to Sum. 

9) Click Insert to add the calculation into the table. 

10) (Optional) Select the Total row and make the text bold. 

Adding Summary Page to Report 

Your report lists details. The Summary page contains a table with a summary of all the details 
(for example, Invoices) as well as charts to add graphical information. 

To add a summary page to your report, using Invoice as an example: 

1) Add Project information. 

In preceding sections, you have set your template to loop through each Invoice. In order to 
create a summary page, you need to include the following information: 

a. Using Word, insert a page break before the "for-each code" at the top of the document. 
Do not use the page break command in BI Publisher. 

b. Add a title to the Summary page (for example, Invoice Report). 

c. Click the field icon (ab|Field) to open the field browser and add information about the 
project, if you have not done so in your SQL statement. 

d. Add additional information about the Project below the title (in a table) such as the Project 
number, Project name, Start/End dates and Initial/Revised budgets. 

e. Format dollar values as numbers with the formatting $#,##0.00;($#,##0.00). You can 
format dates as type Date using date formatting options such as: MM/dd/yyyy 

2) Add Summary table. 

A summary table contains the Invoice data that goes in the report. You can use the Table 
Wizard, similar to the process in the "Creating a Report with Line Items" section. 

a. Place the cursor on a new line under the table on the title page, where you want your 
table of Invoices to appear. 

b. Click Table Wizard on the Word BI Publisher Ribbon. 

c. Select Table as your Report Format and click Next. 

d. Select /DATA_DS/Inv as your Data Set (or the name you used in your Invoice data set). 
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e. Select the fields that you want to add to the table. Since this is for the Invoice, you must 
only add fields that are specific to the Invoices and not the Invoices Line Items. 

You do not need to group because your SQL statement provides one line per Invoice. 

f. Sort by Invoice Record Number, in the "Which fields would you like to use to sort the 
data?" window. 

g. Click Finish. The Table Wizard inserts the table and the necessary code. 

h. Format the data. See Formatting Data for details on how to format the data. 

Adding a Chart 

Using Invoice as an example, you can include a chart in the summary page to demonstrate how 
the Invoices are split. 

There are several chart types available in BI Publisher. The following is for creating a Pie-chart. 

To add a pie chart: 

1) Place the cursor above the summary table. The goal is to include the chart between the 
Project summary table and Invoice summary table because the table can get long and 
expand to the next page. 

2) Click Chart on the Word BI Publisher Ribbon. 

3) Set the Chart Type (on the right) to Pie Chart. 

4) (Optional) Select one of the Chart Styles. 

5) Drag Inv_Amount from the Data tree to the Values box to ensure that the size of each pie 
slice is determined by the dollar amount of the Invoice. 

6) Drag Inv_Title from the Data tree to the Labels box to ensure that the: 

 Pie slices are determined by Invoice 

 Invoice Title appears in the legend 

7) (Optional) Click Preview (top right corner) to see a preview of the chart and make changes if 
necessary. 

8) (Optional) Use the Properties table on the right side to set Chart Title, Legend properties, 
and so on. 

9) Click OK. You change the chart settings by double-clicking the chart in the template. 

10) (Optional) Add spacing between the chart and the two tables and center-align the chart. 

Adding Headers and Footers 

Use a 3-column table in the header and footer of your template to allow for a uniform adjustment 
of items such as titles, logos, and page numbers. Use Microsoft Help to learn how to add the first 
page to your document that does not include Header or Footer. 
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Adding Images from Unifier 

Note: Microsoft Word does not support form fields in the header and 
footer. If need to add an image to the header or footer of your Custom 
Report and you want the image to repeat on each page, see the "Adding 
BI Fields to the RTF Header or Footer" section. 

To add an image (examples: Company logo, Shell image, or image picker from a BP record: jpg, 
gif, or png) from Unifier into your Custom reports, use the Sample XML file (Sample Data) that 
you have created and exported into Unifier. 

Note: Company logo cannot be displayed in Unifier interface. Create a 
company-level business process to place your Company logo. 

The following shows the procedure by using an example: 

1) Open the XML file. 

2) On top, identify the XML elements that are blank (shown in bold in the following code). 

<?xml version="1.0" encoding="UTF-8"?>

<DATA_DS>

<uuu_p_reportByF></uuu_p_reportByF>

<uuu_p_timeZoneF></uuu_p_timeZoneF>

<uuu_p_diffMinutesF>0</uuu_p_diffMinutesF>

<uuu_p_sysyTimeZoneID></uuu_p_sysyTimeZoneID>

<uuu_p_searchConditionF></uuu_p_searchConditionF>

<uuu_p_urlF></uuu_p_urlF>

<uuu_p_sessionIdF></uuu_p_sessionIdF>

<uuu_p_companyRegistryF></uuu_p_companyRegistryF>

<inv>

<PROJECT_ID>1012</PROJECT_ID>

<INV_ID>1</INV_ID>

<INV_RECORD_NO>INV-001</INV_RECORD_NO>

<INV_TITLE>Lumber Contract - Initial Invoice</INV_TITLE>

<INV_STATUS>Approved</INV_STATUS>

Note: At runtime, these blank elements are fully populated with 
information about the Unifier server base URL, the User's session ID, 
and the Unifier company registry. 

3) Using the included parameters, plus the ID of a specific image (the image that you want), 
construct a URL of the format: 

<uuu_p_urlF>CompanyRegistry=<uuu_p_companyRegistryF>&sessionId=<uuu_
p_sessionIdF>&id=<image_ID>

Note: To build a similar URL in your BI Publisher report, ensure that you 
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have the Image ID because the other three parameters have already 
been identified. 

4) Access the Image ID of the image that you want and: 

Note: If applicable, you can find the Company logo Image ID in the 
companylogo column of the table sys_company_info. 

a.  JOIN the information into your existing Data Views. 

or 

b. Add the information as a new Data View, which you can add as a Sub-Report View to any 
Custom Report. The SQL to create a new Data View: 

SELECT companylogo

FROM sys_company_info

WHERE companyregistry = 'unifier';

5) Define the variables: 

After you have an Image ID, you must define the variables needed to build the image URL by 
hiding the variables in a Data Field: 

a. Add a data field somewhere at the top of your report. This can be any field. You only 
need a placeholder for your variables. 

b. Double-click on the newly added data field and click the Advanced tab. Delete the text in 
the code box, if any. 

c. Add the following text into the code box: 

<?variable@begin:uuu_p_urlF;(.//uuu_p_urlF)[1]?> 
<?variable@begin:uuu_p_companyRegistryF;(.//uuu_p_companyRegistryF
)[1]?>

<?variable@begin:uuu_p_sessionIdF;(.//uuu_p_sessionIdF)[1]?>

<?variable@begin: image;(/DATA_DS/co/COMPANYLOGO)?>

Notes: 

 If you are adding a Shell image or Image Picker Data Element, you do 
not need that last line. Add the last line only if you have created a 
Company log Data View (If applicable, you can find the Company 
logo Image ID in the companylogo column of the table 
sys_company_info). 

 The example code presumes that you added an unlinked Sub Report 
View with the Data Set Tag "co" (for Company). You can change the 
Data Set Tag "co" (for Company) to the value that you have in the 
last column of Company Logo row in the Views used as data sets 
table on the Views tab of the Custom Report dialog. 

 If you want to insert the Project Shell ID, you must access that 
variable. Depending on where you are in your grouping, the variable 
can be: <?variable@begin:image;(SHELLIMAGE)[1]?>

To access the Project or Shell Image ID: 
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1) Go to table: unifier_shell_info. 

2) Identify the shellimage column of the table. The Project or Shell Image ID is in the 
shellimage column. 

You can JOIN this table to your main report view based on the unifier_shell_info.pid column, 
which contains the project ID. 

After you defined your variables, you can add an image. The BI Publisher leverages the 
Alternative Text of an image to dynamically set the image source. For more information, refer to 
the BI Publisher Report Designer's Guide. 

To add a dummy image: 

1) Create an image (for example, Dummy_Image.jpg) and size it appropriately (for example, 
300 x 200 px). 

2) Right-click on the image and select Size… 

3) Click the Alt Text tab of the Size dialog 

4) Paste the following into the Alternative Text box: 
url:{concat($uuu_p_urlF,'companyRegistry=',$uuu_p_companyRegistryF,'
&sessionId=',$uuu_p_sessionIdF,'&id=',$image)}

Note: The last parameter ($image) was set as a variable to either the 
Company logo or the Project or Shell image. You must adjust the 
parameter if you want to include both images. Ensure that you use 
separate variable names for each. 

To test an image: 

The three parameters that you used to build your URL to the image are not downloaded as part 
of the sample data: 

uuu_p_urlF

uuu_p_sessionIdF

uuu_p_companyRegistry

You must upload your RTF template to Unifier, publish the Custom Report, and then run the 
report to ensure that your image was inserted successfully. 

Adding BI Fields to RTF File Header or Footer 

Microsoft Word does not support form fields in the header and footer. As a result, you need to 
populate the headers and footers with text or images from Unifier. Refer to the BI Publisher 
Report Designer's Guide for more details. 

To populate the headers and footers with text or images from Unifier, follow these steps: 

1) At the top of our RTF template (in the body, not the header), place the following tags: 

<?template:header?>

<?end header?>

2) These tags form the start and end of your header. In between them, place the text and 
images you want to include in the report header. 
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3) Double-click into the header of the document. Ensure that none of the BI Publisher fields are 
highlighted. 

4) Add the text: <? call@:header?> to place everything in the tags added above into the header 
at report runtime. 

Importing a Template 

After you have created your template, you can upload it into Unifier. 

To upload your template: 

Note: Invoices is used as an example. 

1) Sign in as a Company Administrator, and go to the Company Workspace tab; ensure that 
you are in Administration mode > Configuration > Custom Reports. 

2) Open your Invoices Custom Report. 

3) In the Report File tab (consisting of Add, Modify, Remove, and Download options) 

a. Click Add to open the template window. 

b. Enter information in the following fields: Template Name, Template Type, and Report 
Layout File. 

 To localize the Custom Report output for different languages, you can provide 
XLIFF files for RTF-type templates here. 

 The Template Name field accepts spaces and other characters. 

c. Click Browse to select the template file for uploading. 

d. Click OK to confirm the upload. 

4) Click Browse and upload the RTF file. 

5) Click OK to close the window. 

6) Publish your report by selecting your report from the log and selecting Status > Published 
from the toolbar. 

Your report is added to the list and Users can access the report from Projects, if they have the 
appropriate permissions. 

Adding a Report to Navigator 

To add your report to the Navigator: 

1) Sign in as a Company Administrator, and go to the Company Workspace tab; ensure that 
you are in Administration mode > Configuration > Navigator (User mode). 

2) Open your Project or Shell Navigator. You must be able to see your Custom Report on the 
right-hand side. If you do not see your Custom Report, ensure that you have published the 
report. See Importing a Template. 

3) Add your Custom Report to the Reports section on the left-hand side (in the Navigator, you 
can create a new subfolder under Reports called Advanced Reports). 

4) Click OK to close the window. 

5) Deploy the Navigator by highlighting it and clicking Deploy from the toolbar. 
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Setting Permissions on Report 

You must give permissions to users so that they can run the new, custom report. 

You can give permissions using a Project template (to distribute the permission to all projects), 
or do it on case-by-case bases, one project at a time. 

To set permissions: 

1) Sign in as a Company Administrator, and go to the Company Workspace tab; ensure that 
you are in Administration mode > Company Sponsored Shells > Projects. 

2) Find your Project (the project that you want to add the Custom Report to) and open. 

3) Open the User Administration grouping node and click Access Control. 

4) Go to the Custom Report, click the report to open the Permission Settings window. 

5) Add View access for any Users or Groups that you want to be able to run the Custom Report 
in your Project. 

Repeat the preceding steps if you want to add your Custom Report to other Projects. 

Running the Report 

To run your Custom Report: 

1) Navigate to your Project that has your Custom Report (for example, The Project with Invoice 
BPs created and in an approved or pending state) 

2) Run the report. 

Advanced BI Publisher Functions 

The following topics explain the advanced functions of the BI Publisher. 

Conditional Formatting 

With BI Publisher, it is easy to use conditional formatting to highlight table cells or entire table 
rows using conditional formatting. 

Example 

Highlight invoices with an amount over $10,000. 

Highlighting a Table Cell 

1) After you create a table, place the cursor in the cell where want to apply conditional 
formatting. 

Note: The cell must be either text or a Data Field. 

2) Click Conditional Format. The BI Publisher Properties window open on the Properties tab. 

3) From the Data field drop-down list select the data element that you want to evaluate to 
determine the conditional highlighting. This does not need to be the same data field in the 
cell that you are trying to highlight. 

4) Specify whether that Data Field is a Number or Date/Text Field. 
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5) Enter the conditions for this Data Field using the pertinent drop-down list. 

6) For each condition, specify the formatting that you want to be applied when that condition is 
met. 

Only two conditions can be entered by using this window. If you have more than two conditions, 
you can click on the Advanced tab and copy/paste the conditions already entered to create 
additional conditions. Ensure that you copy an entire "if" statement, up to and including the 
"<?end if?>" 

Example 

<?if:number(INV_AMOUNT)>10000?><?attribute@incontext:background-colo
r;'#FFB9B9'?><?end if?>

Highlighting an Entire Table Row 

To highlight an entire table row, follow the preceding instructions; however, ensure that you 
select Apply to Entire Table Row. 

Publishing BI Publisher Custom Report 

To publish a BI Publisher Custom Report: 

1) Prepare the custom report 

2) Click Status

3) Select Publish

Making a New Custom Report Appear in Navigation 

If you need to change the location of BI Publisher custom reports, follow these steps to make 
newly defined reports appear:  

1) Go to the Company Workspace tab, and switch to the Admin mode. 

2) Navigate to Configuration > User Mode Navigator. 

Note: If the company uses the default User Mode Navigator (that is, the 
company has not defined a custom User Mode Navigator), you will be 
able to see the report name under Access Control of the project or 
program.  

3) Open the project/shell User Mode Navigator. 

4) In the dialog box, find the newly created BIP reports on the right side and move them to a 
desired location in the navigator. 

5) Save the changes and close the window. 

6) Select the project/shell User Mode Navigator and click the Deploy button to ensure the 
changes take effect. 

7) After deploying the navigator, sign out and then sign in, go to Access Control, and assign 
permissions for the new custom report. 
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Note: BI Publisher User Group requirement: To be able to create 
reports, users must be added to BI Publisher Author user group in the 
Primavera Administration Application.  

Setting Permissions for Custom Reports 

To set permissions for Custom Reports: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Open the User Administration grouping node and click Access Control in the left 
Navigator. In the Access Control log window, there are two modules: 

 Administration Mode Access

 User Mode Access

If the reports are at the Program level, in the right pane, select User Mode Access > 
Programs > Reports > Custom > <report name>. 

If the reports are at the Project level, in the right pane, select User Mode Access >
Projects/Shells > Reports > Custom > <Report Name>.

3) Select the access for the appropriate user. 

4) Click OK. 

Notes: 

 A user with the configure permission to the Custom Report node, 
can configure custom print templates. There are no separate 
permissions for performing actions on the custom print templates. 

 If you have a User Mode Navigator, you must include the Custom 
Report in the navigator and redeploy before the user can assign 
permission through Access Control. 

Running a Report 

To run the BI Publisher Report in Unifier: 

1) Sign in to your Unifier environment. 

2) Select a Project or Shell. 

3) Ensure you are in User mode. 

4) Under the Project/shell navigation tree, select Reports, [Custom node]. 

5) Select a report and a dialog box will open. 

6) In the dialog box, enter the Template and Format, enter the Search Parameters, and click 
Run Report to run the report. 

Uploading a Template for External Data Model Type Custom Report 

To upload a template for External data model type custom report: 
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1) In the Report file tab, click the Add/Modify button. 

2) Click the Browse button, navigate to the .XDM file you want to use for the data model, and 
click the Upload button. 

The system uploads the data model for the report to the BI server. 

3) (Optional) To modify the data model, you can download it to your local drive by clicking the 
Download button. 

4) Click OK. 

You need to upload the Data Model file (.XDM) from the custom report Template File tab, using 
the following parameters: 

 uuu_p_project_id

Project ID 

 uuu_p_context_company_id

Company ID 

 uuu_p_process_id

Workflow process ID 

 uuu_p_source_id

Business process record ID 

 uuu_p_object_type

Business process ID as in uDesigner 

 uuu_p_hide_task_details

To hide the task status if the user does not have permission. The value of 0 is passed if the 
user does not have permission to view the task statuses. 

 uuu_p_hidden_comments

To view the hidden comments, if the user has the permission. The value of 1 is passed if the 
user has the permission to view hidden comments. 

These parameters are used to pass information from the Unifier runtime to the BI Publisher 
server (integration at runtime). 

Downloading Sample XML Data for Designing New Templates 

This part of the Sample Data tab is for downloading sample data to use in designing a new 
report template file. You can download data from a specific project. 

To download sample XML data for designing new templates: 

1) (Optional) In the Sample Project field, select the project or shell data you want to generate. 

If you do not specify a sample project or shell, the system will use data from the main view 
that was specified on the Views tab. 

2) In the Number of rows to return field, specify the number of rows of data you want to use 
for designing the template. 
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3) Click the Generate button. This button is disabled in case of external data model report until 
the report has been published at least once. 

The system generates a random sample of the XML from the Sample Project, or the main 
view of data. 

4) Click OK. 

You can then use this XML data in BI Publisher to design the template file. 

Modifying Existing XDM for Custom Report or Custom Print Configuration 

Changes to the Data view, Data Set, Query and Parameters are not applied to the XDM file by 
the system. Users need to apply those changes manually to the XDM file. 

Data View 

If a data view is changed, it may require a modification in the XDM file. For instance, if a new 
column is added and it is required in the layout of the report, then the column must be added 
into the query in the data set in the XDM file. 

Main View for Data set 

If a main view is changed for the data set, it requires a modification in the XDM file to reflect the 
change in the From clause of the query of the main data set. 

Query Parameter 

The Element name for a Query is mapped to a BI Publisher parameter based on the format: 

:uuu_p_{Element Name}

Note: Ensure the length of {Element Name} is less than 24 characters. 

Any query parameters created on the elements of the main view on the query tab also need to 
be appropriately mapped in the Where clause of the main view query in the XDM. 

To modify an existing custom report configuration: 

1) Go to the Company Workspace tab and switch to Administration mode. 

2) Click Configuration > Custom Templates in the left Navigator to open the log. 

3) Select a custom report and click Open to open the custom report window. 

Note: The custom report must be in Draft status for modification. 

4) Modify the fields as necessary. All fields except the "Report Level" can be modified, as long 
as the custom report has not yet been published. After the report has been published, the 
"Report Name" field also becomes un-editable. 

Adding a Dynamic Image in the Custom Print Template 

To add images from within Unifier to the Custom Print template: 

1) Create form fields in the .rtf file, corresponding to the following parameters: 
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 <?variable@begin:uuu_p_urlF;(.//uuu_p_urlF)[1]?>

 <?variable@begin:uuu_p_sessionIdF;(.//uuu_p_sessionIdF)[1]?>

 <?variable@begin:uuu_p_companyRegistryF;(.//uuu_p_companyRegistry
F)[1]?>

Note: The uuu_p_* is a predefined parameter in the data model. 

2) Right-click the dummy image and select Size and provide the following value in the 
Description field of the AltText information for the image: 

Description: 
url:{concat($uuu_p_urlF,'companyRegistry=',$uuu_p_companyRegistryF,'&sessionId=',$uuu
_p_sessionIdF,'&id=',BPIMAGE)} 

For example, you must replace the <BPIMAGE> data element, in the above URL value, with 
the image file ID "k__<image element>" from the sample XML. See Sample XML Data for 
Custom Templates (Custom Prints and Reports) (on page 285). 

Adding a Dynamic Image in the Custom Report Template 

To add images, from within Unifier, to the Custom Report template: 

1) Create form fields in the .rtf file, corresponding to the following parameters: 

 <?variable@begin:uuu_p_urlF;(.//uuu_p_urlF)[1]?>

 <?variable@begin:uuu_p_sessionIdF;(.//uuu_p_sessionIdF)[1]?>

 <?variable@begin:uuu_p_companyRegistryF;(.//uuu_p_companyRegistry
F)[1]?>

Note: The uuu_p_* is a predefined parameter in the data model. 

2) Right-click the dummy image and select Size and provide the following value in the 
Description field of the AltText information for the image: 

Description: 
url:{concat($uuu_p_urlF,'companyRegistry=',$uuu_p_companyRegistryF,'&sessionId=',$uuu
_p_sessionIdF,'&id=',PROJECTIMAGE)} 

For example, you must replace the <PROJECTIMAGE> data element, in the above URL 
value, with the image element taken from your sample data XML. See Sample XML Data for 
Custom Templates (Custom Prints and Reports) (on page 285). 

Adding a Dynamic Image in BI Publisher Report 

To add a dynamic Unifier image in BI Publisher report, we need to create a new data set in the 
Data Model (XDM) file, as explained below. 

Note: The following instructions apply to reports that run directly on BI 
Publisher server. The BI Publisher reports run via Unifier do not need to 
make these changes. 

In the .XDM file: 
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<dataSet name="security_token" type="complex">

         <sql>

            <![CDATA[SELECT token_value sec_token from ( SELECT 
token_value,expired,ROW_NUMBER() OVER (ORDER BY expired desc) rn FROM 
sys_server_token WHERE token_type = 'img') where rn = 1]]>

         </sql>

</dataSet>

<group name="security_token" label="security_token" 
source="security_token">

      <element name="SEC_TOKEN" value="SEC_TOKEN" label="SEC_TOKEN" 
dataType="xsd:string" breakOrder="" fieldOrder="1"/>

</group>

Note: The purpose is to get the server token from database where 
"expired" is the maximum from all the rows. 

In the report template that requires to have the image to be inserted, change the "Alt text" of the 
image to point to image retrieval URL. 

To retrieve a Unifier image, use the URL: https://unifier-server-address 
/bluedoor/rest/image/<image_id>/<server_token>

The report parameter uuu_p_urlF can be created in Data Model (XDM) file with a default 
value, so at the runtime the Unifier server address-part of the URL can be changed 
appropriately: 

  <parameter name="uuu_p_urlF" 
defaultValue="https://unifier-server-address/bluedoor/rest/image" 
dataType="xsd:string" rowPlacement="8">

            <input label="uuu_p_urlF" size="100"/>

        </parameter>

The report template uses this URL in the "Alt text" of the image, as in: 
url:{concat($uuu_p_urlF,'/',DATA_IMAGE_ID,'/',//security_token/SEC_TOKE
N[1])}

Where: uuu_p_urlF can be the template variable, for example: 
<?variable@begin:uuu_p_urlF;(.//uuu_p_urlF)[1]?>

The security token, retrieved from DB by the dataset is: //security_token/SEC_TOKEN[1]

The runtime data (image ID) is: DATA_IMAGE_ID

Adding Rich Text Data Element in BI Publisher Report and Custom Print 

Unifier supports custom print, and custom report, for the “Rich Text” data element. You can use 
the “Rich Text” data element (of your BP form) in your data model. Furthermore, the HTML 
version of the “Rich Text” data element can be rendered as HTML, in the report, if the HTML 
version needs to be seen in BI Publisher template. 
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To include the “Rich Text” data element: 

1) Go to the report template file, for “Rich Text” data element. 

The Rich Text fields in the BI Publisher template file are prefixed with: ?html2fo. For 
example, if the DE name is RTECODE, then the DE name must be wrapped as it was in the 
template file as: <?html2fo: RTECODE?>. This will allow the template processor to treat the 
element as HTML. 

2) To view the Rich Text type DE in correct format, in the BI Publisher reports (in the BI 
Publisher server), go to the data model editor for the report and set the data type of the 
RTECODE data element column to XML. 

In the BI Publisher, the Rich Text type DEs can be found in the <model>_richtext data model. In 
addition, when defining queries and Data Links in Custom Templates: 

 The Rich Text type DE from the BP richtext views (model_richtext) must be restricted. 

 The plain Rich Text type DE content, from the BP model, must be allowed. 

When you add a Rich Text type DE to the custom print template:  

The following HTML elements will not work in the PDF output format: 

 Table 

The borders will not display. 

 Alignment 

The left, right, and indent will not work. 

 Image 

Will not display. 

 Code block 

Will not work. 

The following HTML elements will not work in the RTF output format: 

 Table 

The borders will not display. 

 Alignment 

The left, right, and indent will not work. 

 Code block 

Will not work. 

 Block Quote 

Will not work. 

Note: The Rich Text Data Element does not support indentation, bullets, 
or numbering, when configured in Custom Print or Custom Report.  

Connect to the Database 

A direct connection to the Unifier database using SQL Developer is not possible. The creation of 
SQL queries must be done in Data Views, or by pulling rows down from Unifier into a local 
database. 
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If you need to pull the data into a local database for the purpose of SQL development, Oracle 
offers Oracle Database 11g Express Edition (XE) free of charge. You can install this lightweight 
DB on your computer and use it for development purposes. 

Download Oracle Database Express Edition (XE). Refer to the XE documentation for instructions 
on how to install the software and create a local database. 

(Optional) Pulling Down the Data 

In Unifier, after you know the table names, you can export 200 lines so it can be inserted into 
your local Database (DB). To pull down the data: 

1) Sign in as a Company Administrator, and go to the Company Workspace tab; ensure that 
you are in Administration mode > Data Structure Setup > Data Views. 

2) Click New to create a new Data View. 

3) Enter a name (for example, Export DV) and a Label (for example, Export Data View). 

4) In the SQL Definition field, enter the following for a particular table: SELECT * FROM 
<tablename>

5) Click OK. 

6) Click the Status drop-down list and set the newly created Data View to Published. 

7) Highlight the Data View you just created and click Data on the toolbar. 

8) In the window, click Export as SQL on the toolbar to save the .sql file locally. This SQL file 
includes the CREATE and INSERT commands required to get your data into your local XE 
database. 

At this point, you can create the table and insert the exported rows into your local XE database 
using tools like SQL Developer. 

Repeat the steps above for any tables that you like to access offline. 

Note: You can reuse the same Data View multiple times; however, you 
need to do find and replace in the downloaded SQL to ensure that the 
table names match the names that are in Unifier. 

Since you have a subset of the database locally, you can use SQL Developer to write complex 
queries, offline, before bringing them into Unifier. 
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Configuring Project Numbering, Cost Codes, and 
Status 

To configure project numbering, cost codes, and status: 

1) Go to the Company Workspace tab and click Configuration > Shell Manager in the left 
Navigator. 

2) Select Projects (Standard) and click the Open button. The Configuration - Projects 
(Standard) window opens. 

3) Complete the General tab as described in the table below. 

4) Click Apply to save your changes, or OK to save and exit the window. 

In this field Do this 

Enable 
automatic 
numbering 

Select to allow automatic numbering of projects based on the specified 
Format and Start values. You can deselect this checkbox to disable 
automatic numbering. This checkbox is selected by default. 

Format/Start 

Specify the format and starting number for projects if automatic 
numbering is enabled. Format determines the format of the numbering 
schema. Start determines the starting number of the numeric schema. 
By default, Format is blank and Start is 0001. The numbering schema 
format cannot be changed after a user creates projects using the 
originally specified format. 

Cost Codes: 
CBS/Generic 

Displays the type of cost code specified in uDesigner for the project. 
The type available for Projects (Standard) is CBS. 

Status 
Status can be Active or Inactive. Users cannot access projects with the 
status Inactive. The default is Inactive. 

In This Section 

Create and Manage Project Categories (Organize Projects) ................................. 325 

Create and Manage Project Categories (Organize Projects) 

You may create project categories to help organize multiple projects. Project categories have no 
effect in User Mode and are invisible. Users who are assigned to a project, regardless of the 
category, will see the project listed in their Projects log. 

Once a project has been created under one category, it cannot be moved to another. New 
projects may be created under the new categories. Once you create a category, you cannot edit 
or delete it, but you can deactivate it to prevent it from being displayed in the Navigator. 
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Tip: Project Administration permissions can be set based on category. 
For example, you might create a category called Large Construction 
Projects, another called Small Construction Projects, and another called 
Maintenance and Facilities. You can grant project administration 
permissions to one set of project administrators for the All category, to 
another group for the construction categories, and to a third group to 
handle project administration of the maintenance/facilities projects. Once 
you create a category, you cannot edit or delete it, but you can 
deactivate it to prevent it from being displayed in the Navigator. 
Remember to grant permissions to yourself or others to view the new 
categories and to create/edit projects in the category. 

To create a project category 

1) Go to the Company Workspace tab and switch to User mode. 

2) In the left Navigator, click Configuration > Shell Manager. 

3) Select Projects (Standard) and click the Open button. The Configuration - Projects 
(Standard) window opens. 

4) In the Organize tab, click Add. The Add Project Category window opens. 

5) Type a name for the new category. The status for the newly-added category is Active: 

 Active: projects can be created in the category, which appears in the Navigator 

 Inactive: the category will not appear in the Navigator until it is activated 

6) Click OK to add the category. 

7) After all categories have been added, click OK to save and exit the Configuration - Projects 
(Standard) window. 

To rename a project category 

1) In the Configuration - Projects (Standard) window, select a category. 

2) Edit the project category Name and click OK. 

3) Click OK to close the Configuration - Projects (Standard) window. 

To activate/deactivate a project category 

1) Open the Configuration - Projects (Standard) window and do one of the following: 

 To deactivate an active category, deselect the Activate checkbox. Deactivating a 
category will cause it to not be displayed under Company Sponsored Projects, but this 
does not affect any projects organized within it. Any projects in a deactivated category 
are still accessible to administrators under Administration Mode > Projects, and to 
users in User Mode. 

 To activate an inactive category, select the category and select the Activate checkbox. 

2) Click OK to close the Configuration - Projects (Standard) window. 

To grant permission to access the new project category 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, do one of the following: 
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a. Click User Administration > Company Users or Partner Users (to grant permissions to 
company or partner users), or 

b. Click User Administration > Groups (to grant permissions to a group or individual 
users.) 

3) Select a company, partner, group, or user from the log and click Open. 

4) Click the Permissions tab. 

5) In the upper portion of the window, under Administration Mode Access, do one of the 
following: 

a. Click User Administration > Company Users, 

b. Click User Administration > Partner Users, 

c. Click User Administration > Groups, 

d. Click User Administration > Task Reassignment, or 

e. Click Company Sponsored Projects (Standard). 

6) Select the new categories to which you want the user to have administration access, and 
click OK. The user may already have access to All which allows them to administer (create 
or edit) projects in the All category. 

Note: Having "Administer All" permission does not automatically grant 
administration access to other custom categories. This permission 
setting allows the user access to the project category only, and does not 
set specific permissions regarding project administration. 

To access the categories 

New categories appear under the Company Sponsored Projects (Standard) node in the 
Company Workspace tab (Admin mode). You may need to refresh the page (reopen the 
company record, or press the F5 key) before you can see the new categories. 
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Configuring the User Mode Navigator 

You (Company administrator) can configure the User mode Navigator (Company Workspace 
tab > Admin mode > Configuration > User Mode Navigator) to better suit the company 
business needs. The User Mode Navigator enables you to modify the appearance and 
organization of the modules and business processes that are available in the left-hand Navigator 
for all company users. 

This functionality of the User Mode Navigator is limited to the collaborative portions of the User 
mode Navigator in the Home Workspace, Company Workspace, Programs, Shells, and Projects. 

Note: This configuration will affect the User mode Navigation for all 
users in your company. Oracle strongly recommends that you fully test 
your configurations in the Development/Test environment. 

Within the User Mode Navigator, you can create new grouping nodes, rename existing ones, 
reorder items within the nodes, and even remove unused modules from the Navigator, in order 
to provide increased flexibility to organize and view modules and business processes. The 
configured view will appear for all users. 

As always, access to any module or business process is strictly controlled by permission 
settings. The User Mode Navigator feature does not override permission settings in any way; it 
simply allows you to customize the look and organization of navigator modules that a user has 
permissions to access. Any changes you make to the User mode navigation tree will be 
reflected in the Access Control view. 

Example 

 If a user has permission to access at least one leaf node under a grouping node, then the 
grouping node will appear in the user's view of the navigator. 

 If the user does not have permission to any leaf nodes under a grouping node, then the 
grouping node will not appear in the user's Navigator. 

The following terminology is used with User Mode Navigator: 

 Grouping node: This is a container "parent" node. Grouping nodes are easy to identify 
because they have a (+) next to them in the navigation tree. Clicking a grouping node, in the 
left-hand Navigator, expands the node to display any child nodes below it; the child nodes 
can be leaf nodes, or another grouping node, for example, Project Logs, Cost Manager, and 
so forth. 

 Actionable grouping node: This type of grouping node not only expands to display child 
nodes underneath it, but also refreshes the right pane and displays an associated log or 
page, for example, Projects node, which expands to display the project nodes in the 
Navigator and opens the Project home page, also. 
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 Leaf node: This is a child node that cannot become a grouping node. In the last node of the 
navigation "tree," no further branching can take place. Clicking a child node refreshes the 
right pane to display the associated module or log, for example, Cost Sheet within the Cost 
Manager, or the individual business process logs under Project Logs. 

The configurable navigator allows you to: 

 Configure navigation trees for: 

 Company Workspace Navigator 

 Home Navigator 

 Program Navigator 

 Project / Shell Navigator 

Note: The settings do not take effect in your users' navigators until you 
deploy them. 

The User Mode Navigator enables you to: 

 Create new grouping nodes (New) for: 

 Company Workspace 

 Home Workspace 

 Program 

 Project/Shell 

 Copy an existing navigator setup (Copy) 

 Deploy a navigator (Deploy) 

The system performs a check to see if there are any other navigators of the same type 
currently active, or not. If yes, then the system notifies you that the currently deployed 
navigator will be set to "Inactive" status. 

 Undeploy a navigator (Undeploy) 

When selecting this option for an Active navigator, the navigator (for the type selected) 
displays system defaults during the runtime. 

 Include a navigator for your configuration package 

 To be able to define multiple navigators per object and create configuration packages to 
suit various out of the box (OOTB) solutions. Each OOTB solution has its own 
configuration of business processes, reports, and so forth along with the User mode. 

 You can include multiple navigators in the component list and create your configuration 
package. 

 The status of a navigator does not impact export. 

 When you package a User Mode Navigator setup for the first time, you must include all 
the designs (on the left-hand side of the navigator) in the package. If you do not include 
the designs, the configuration package creation will result in an error. 

 For Active navigator setups, the Last Deployed Date must be greater than the Last 
Saved Date. 

 If the navigator status is set to Active, then the system deploys that navigator to the 
destination environment. If the status is Inactive, then the system adds the navigator to 
the User Mode Navigator list. 
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 If a navigator with the same name exists in both the package and the destination server, 
then the system updates the content at the destination server. 

 If the status of the navigator in the destination server is Inactive and the status of the 
navigator in the package is Active, then the system deploys the navigator and changes 
the status to Active in the destination server. 

 If the status of the navigator in the destination server is Active and the status of the 
navigator in the package is Inactive, upon import of the configuration package, the 
system updates the content of the navigator, but the navigator will not be deployed. 

 Custom BI Publisher reports can be a part of the User Mode Navigation setup. 

 Internal BI Publisher reports, included in the setup, must be either a part of the package 
or exist in the destination server. If the Internal BI Publisher report is in Draft status, the 
import will succeed if the Internal BI Publisher report has been published, in the 
destination server, at least once. 

 External BI Publisher reports, included in the setup, must be either a part of the package 
or exist in the destination server. The External BI Publisher report name, location, and 
report level that exists in the destination server must match the attributes existing in the 
package. 

 Rename new and existing grouping nodes 

 Change the icons associated with the nodes 

 Move nodes up and down the navigation tree, or from one grouping node to another 

 Remove unused modules from the navigator without deleting the modules themselves 

 Move business process logs or other modules between new or existing grouping nodes 

 Store the following versions of the navigator: 

 Last saved version 

 Last deployed version 

 System default version, 

 Restore the navigator to any of the above versions at any time 

Note: Configuring navigator is a separate setup. As a result, the new 
business processes do not appear in the log selected in the 
configuration. Instead, the new business processes appear in the right 
pane of the user's configurable navigator window. To place the new 
business processes inside the corresponding node in the left pane 
Navigator, and make it available to the users, you must transfer the new 
business processes manually. 
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Create a New User Mode Navigator Configuration 

You can create one configuration for user mode Project, Shell, Program or Company 
Workspace.  

To create a new project, program or company workspace navigator configuration 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log lists all previously created configurations. 

3) Click New and choose one of the following: 

 Home: configures the navigation node for the Master Log - Business Processes node. 

Note: You cannot hide the Tasks, Notifications, Drafts, and Mailbox 
nodes in the Home workspace. 

 Company Workspace: configures the navigation nodes within the Company Workspace 
portion of the User Mode navigator 

 Program: configures the program level navigation 

 Project/Shell: configures the project/shell level navigation 

The Create New Navigator window opens. The left portion of the window displays the 
navigation as it would appear for users. In the example below, the default navigation is 
displayed, since a new configuration has not been deployed. The right pane of the window 
displays available modules or business process logs that can be added to the navigation on 
the left. 

4) Configure the new navigator configuration as described below. 

5) To save the configuration, click OK. 

The configuration will be displayed in the log. There can be one configuration each for 
Project, Shell, Program or Company Workspace. After saving, you must deploy the 
configuration for it to take effect. See Deploying a Navigator Configuration (on page 336). 

You can configure the new project, program or company workspace navigation. After 
deploying, the configuration will appear in the user mode navigator for all users in your 
company. 



Configuring the User Mode Navigator

333

Use the toolbar to configure the navigation: 

 New: Creates a new grouping node. 

 Rename: Allows you to rename the selected grouping node. 

 Expand All: Expands all grouping nodes to reveal their functional sub-nodes. 

 Move Up / Move Down: Moves selected nodes up or down in the navigator. 

 Cut / Paste: Allows you to cut and paste nodes from one grouping node to another. 

 Restore: Restores the configuration to the system default, or the last deployed version. 

 Change Icon: Allows you to change the icon of the selected node. 

To expand all navigator nodes 

In the navigator window, click the Expand All button. This expands all grouping nodes and 
allows you to view all of the nodes currently present in the navigation. You can contract a 
grouping node to hide the leaf nodes by clicking the (-) next to the grouping node name. 

Create a New Grouping Node 

You can create a grouping node to use to organize modules or business process logs.  

To create a new grouping node 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) Open a configuration from the log. In the left box, select a valid parent node. This can be the 
root node (Company Workspace, Program, Shell, or Project), or any other grouping node in 
the navigator tree (for example, Cost Manager or Project Logs). 

4) Click New. The newly created node is created under the selected node. The default name is 
New Grouping Node, and uses the default icon of a file folder. Grouping nodes can be 
renamed, moved and given a new icon. 

Rename a Grouping Node 

You can rename any new or existing grouping node in the navigator, with the exception of the 
root node (Project, Shell, Program or Company Workspace). You cannot rename leaf nodes.  

To rename a grouping node 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) Open a configuration from the log. In the left box, double-click the grouping node, or select 
the node and click the Rename button. The field becomes editable. 

4) Enter a new name for the field, up to 32 characters. Grouping nodes under same parent 
node cannot have same name. 
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Change the Icon of a Grouping Node 

You can change the icon of any grouping node except the root node (Projects, Shells, 
Programs, Company Workspace).  

To change the icon of a grouping node 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) Open a configuration from the log. In the left box, select the grouping node and click the 
Change Icon button. The available icons are displayed. 

4) Click the new icon. The icon immediately appears on the selected grouping node. 

Move Nodes within the Navigator 

You can move any grouping node or leaf node up or down the navigator, either within the 
original grouping node, or from one grouping node to another. There are three ways to move 
nodes within the navigator:  

 Move a node up and down the navigation tree within its parent grouping node 

 Move a node from one grouping node to another 

See the following procedures for more details. 

To move a node up or down the navigator 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) In the navigator window, select the node to move. 

4) Click the Move Up or Move Down button to move the node up or down within the parent 
grouping node. If you move a grouping node, all child nodes move with it. 

To move a leaf node from one grouping node to another 

1) In the navigator window, select the node to move. 

2) Click the > (right arrow) button to move the node to the right pane. Continue with each node 
that you want to move. 

Only leaf nodes will be moved. If you select a grouping node, only the leaf nodes underneath 
it will move to the right pane. The grouping node itself will be deleted. 

3) In the left pane, select the destination grouping node into which you want to move the leaf 
nodes. 

4) In the right pane, select the leaf node to move and click the < (left arrow) button. The leaf 
node moves to the grouping node on the left. Repeat as needed with any other leaf nodes to 
move. 

Note: If you leave a leaf node in the right pane and deploy the 
configuration, that module or business process will not appear on the 
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user mode navigator for users. 

To move a node from one grouping node to another by cut and paste 

1) In the navigator window, select the node to move. You can select a grouping node or leaf 
node. 

2) Click the Cut button. (The selected node will not yet be removed). 

3) In the left pane, select the destination grouping node in which to move the selection. 

4) Click the Paste button. The node will be moved the new location. If you have selected a 
grouping node, the grouping node and all leaf nodes will be moved. 

Remove Unused Modules from the Navigator 

If there are modules that your company never uses, and that cannot be hidden by use of 
permission settings (for example, the Mailbox module), you can remove them from the User 
Mode Navigator. The modules themselves will not be deleted, and can be restored to the 
Navigator at any time.  

To remove a module from the User Mode Navigator 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) In the navigator window, select the node to remove. 

4) Click the > (right arrow) button to move the node to the right pane. Continue with each node 
that you want to remove. 

Only leaf nodes will be moved. If you select a grouping node, only the leaf nodes underneath 
it will move to the right pane. The grouping node itself will be deleted. 

5) Save and deploy the configuration. The nodes that remain in the right pane will not appear in 
the user mode navigator. 

Delete a Grouping Node 

Any grouping node can be deleted. Leaf nodes cannot be deleted; however, you can remove 
them from the user mode navigator that appears to all users. See Remove Unused Modules 
from the Navigator (on page 335). 

To delete a grouping node 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) In the left pane of the navigator window, select a grouping node. 

4) Click the > (right arrow) button. The grouping node is deleted. If the grouping node contains 
leaf nodes, the leaf nodes are moved to the right pane, and the grouping node is deleted. 
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Deploying a Navigator Configuration 

After you have created a navigator configuration, it must be deployed for changes to take effect 
in the user mode. After you deploy the navigation, the view will be displayed to all users. 

To deploy a new navigator 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) In the User Mode Navigator log, select the configuration to deploy. 

4) Click the Deploy button. When the navigation configuration is deployed, a confirmation 
window opens. Click OK. 

The navigator change takes effect immediately for all users. 

Delete a Navigator Configuration 

If you delete a configuration from the User Mode Navigator log, the system defaults for the 
applicable portion of the User Mode Navigator (Project, Shell, Program or Company Workspace) 
will be restored back to the system defaults automatically. 

To delete a configuration and restore the navigator to system defaults 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Configuration > User Mode Navigator. The User Mode 
Navigator log opens. The log lists any previously created configurations. 

3) In the User Mode Navigator log, select the configuration to delete. 

4) Click the Delete button. At the confirmation window, click Yes. The user mode navigator will 
be restored to system defaults immediately. 

Restore the Navigator to Previous or Default Configuration 

You can restore the navigator configuration to a previously saved version, the last deployed 
version, or to original system default at any time. You must still deploy the restored navigator in 
order for it to take effect. 

To restore the navigator to a previous or default version 

In the configurable navigator window, click the Restore button and choose one of the following 
options: 

 Last Saved: Restores the navigation tree to the last saved version, regardless of 
deployment 

 Last Deployment: Restores the navigator to the version that was last deployed (not 
applicable for new configurations that have not yet been deployed) 

 System Default: Restores the navigator to the original system defaults 
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Unifier Mobile Application 

The Oracle Primavera Unifier Mobile Application is built specifically for installation and use on 
mobile devices that use iOS or Android operating systems. To get the Unifier Mobile App, you 
have the following options: 

 Download it from the App Store or Play Store, or 

 Launch Unifier, click your user name in the upper-right corner, click Get Unifier Mobile App, 
and follow the prompts. 

After download, you can scan the QR code to set up the Unifier Server URL and user name on 
your Unifier Mobile App. 

Note: If you are in a region without access to the Google Play Store, 
Apple App Store, or your organization is using a Content Security 
Service or Mobile Device Management solution and requires that users 
do not download from the Apple Store or Play Store, submit a Service 
Request in My Oracle Support to request versions of the Oracle 
Primavera Unifier Mobile Application for those scenarios. 

Important sign-in information for on-premises users on non-SSO servers 

For on-premises customers on non-SSO server (prior to 19.12.2): 

Unifier Mobile App uses the Basic Authentication for login while connecting to the Unifier web 
application deployed on a non-SSO server. 

For on-premises customers on non-SSO server (on or after 19.12.2): 

Unifier Mobile App uses Form-based Authentication while connecting to the Unifier web 
application deployed on a non-SSO server. As a result, you must use the latest version of the 
mobile app to access data on your device.   

Note: The user preferences, in the Unifier web application, will be 
effective when you sign in to the mobile app. 
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Unifier and Other Oracle Applications 

Unifier objects can be integrated with other Oracle applications by way of: 

 Web Services 

Client and server applications that communicate over the World Wide Web's (WWW) 
HyperText Transfer Protocol (HTTP) and provide a standard means for operation between 
software applications running on a variety of platforms and frameworks, using XML. For more 
information about Web Services integration, refer to the Unifier Integration Interface Guide. 

 Oracle Database Gateways 

Addressing the needs of disparate data access and making it possible to integrate with any 
number of non-Oracle systems from an Oracle application. Oracle Database Gateways 
enable integration with data stores such as IBM DB2, Microsoft SQL Server, Excel and 
transaction managers like IBM CICS. 

Unifier is integrated with the following enterprise applications via Primavera Gateway: 

 Oracle Primavera Analytics 

 Oracle Primavera P6 

 Oracle E-Business Suite (also known as Applications/Apps or EB-Suite/EBS) 
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As shown below, once all the objects are created and linked to each other, data flows to Unifier 
(business flows/synchronizations) in this formation: Oracle application/external application > 
Oracle application/external Provider > Gateway > Unifier Provider > Unifier 
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The following sections describe the process in details. 

In This Section 

Unifier and Primavera Analytics ............................................................................. 343 
Unifier and Primavera P6 ...................................................................................... 381 
Unifier and Primavera Gateway ............................................................................. 388 
Unifier and Primavera Cloud ................................................................................. 430 
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Unifier and Primavera Analytics 

Analytics provides an in-depth and comprehensive method for analyzing and evaluating: 

 Shells 

 Project performance 

 Project history 

 Business Processes (including Vendor analysis) 

 Cost Sheet 

 Cash Flow 

 P6 Summary Sheets 

 Generic Cost Sheet 

 Space Utilization (from Space Manager) 

Configure this section in Unifier for users to ensure they are able to see data within Analytics. 

If the Analytics module is enabled, the Company administrator can access the Analytics 
module by signing into Unifier and navigating to the System Modules node (Data Structure > 
Administration mode > System Modules). 

Note: The System Administrator has to load the Analytics module. 

Users can use the Analytics for data input and must have permission in order to be able to 
access the Analytics node. Permissions set in Unifier (Access Control) enable users to view 
the data in Oracle Business Intelligence (OBI) server. Users ability to access OBI server is also 
set in Unifier. 
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Analytics Node 

The Analytics node is located under the Integrations grouping node. In Analytics node, you can 
select publication of Unifier data to Unifier staging tables, map data, and set schedule for 
periodic publication of Unifier data into Analytics.  

Note: A separate ETL process pushes the staging data into STAR which 
then becomes available in Analytics. 

When you click the Analytics node, the log displays predefined set of Unifier modules such as:  

 Business Processes 

 Cash Flow 

 Cost Sheet 

 Generic Cost Sheet 

 P6 Summary Sheets 

 Shells 

 Space Manager 

 Vendors 
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Analytics Log Properties 

The Analytics log has two columns which display the Name and the Last Modified Date of the 
records. 

The Analytics log toolbar has the following options: 

 Open 

 Schedule 

 Run Now 

 Run History 

The Open, Run Now, and Run History options can be accessed from the File menu. The 
Schedule option can be accessed from the Edit menu. 

Analytics Log (Business Process) Setup 

You can set up Dashboards and Analyses, for Unifier Business Processes, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and select the Business Process data that you want to 
use for analyses. 

When you open a Business Process in the Analytics node, you will see the Analytics - 
Business Process Setup window with the following tabs: 

 Business Processes tab 

 Custom Fields tab  

 Data Mapping tab 

Business Processes tab 

Select Business Processes for Analytics

The Business Processes tab allows you to select the Business Process that you want to 
use in Analytics. 

Use the Add or Remove buttons to add or remove the Business Processes for Analytics. To 
add a new Business Process for use in Analytics: 

1. Click Add to open the Select Business Processes for Analytics window that lists all the 
company-level, Shell-level, and Project-level Business Processes, in alphabetical order. 

Note: This list includes Active and Inactive Business Processes. 

2. Select one Business Process, or select as many as you need, and click OK to add the 
Business Process to the log. 
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Note: After you added the Business Process, that Business Process will 
no longer be available in the Select Business Processes for Analytics 
list. 

You can remove a Business Process that is published for Analytics. To remove a Business 
Process for use in Analytics, select the Business Process from the Select Business 
Processes for Analytics list and click Remove. You can delete multiple Business Processes 
from the list. You can add a removed Business Process for Analytics reporting. Click Add if 
you want to add a removed Business Process to the list. 

If a Company Administrator inactivates a Business Process that has been used for Analytics, 
then this Business Process continues to remain in the Business Processes tab. If you 
remove a Business Process from the Business Processes tab, data that exists in Analytics, 
for the removed Business process, remains as is; however, the new data will not be 
published. 

To save space, you can decide not to track the history of facts and dimensions, on a 
Business Process.  

In the Analytics - Business Processes Setup window (Business Processes tab) you can 
select a business process and mark to not track the history of the business process data 
elements (Track History of Data Elements? column). By default, all BPs in this tab are 
selected to have their history tracked. After your initial selection in the Track History of Data 
Elements? column for a BP, if you open the Analytics - Business Processes Setup
window and go to the Business Processes tab and deselect the track history option for a 
BP, then Unifier will notify you that the BP will no longer maintain the historical data in 
Analytics. 

For a BP with track history option selected, all data mapping changes for the elements of the 
BP will be recorded as errors in the historical data in Analytics. 

Note: The Track History of Data Elements? column values will be 
included in the Configuration Package during export or import. 

Custom Fields tab 

The Custom Fields tab is available after you add your Business Processes in the Business 
Processes tab. The Custom Fields tab has two sections:  

 Main Form Elements 

 Line Item Elements 

You can specify values in each field to set the number of user-defined fields for Data 
Mapping. The default values displayed are based on the existing user-defined fields limit that 
is currently set in Unifier. 

The total number of Main Form custom fields cannot exceed 900. Similarly the total number 
of Line Item custom fields cannot exceed 900.  

When entering values in the fields:  

 Use numeric values. 

 Do not use decimal points. 

 Use numbers greater than the default values. 
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Note: The number of fields specified are bundled as a part of 
configuration package, if the component has been tagged. 

Data Mapping tab 

The Data Mapping tab allows you to map the predefined Analytic Business Process fields to a 
corresponding Unifier Data Element (DE) in the Business Process. 

Notes: 

 The Data Mapping tab is available after you have added a Business 
Process, in the Business Processes tab, and clicked Apply or OK. 

 The Data Mapping is done per DE and not per Business Process. All 
Business Processes added in the Business Processes list tab are 
included and you do not need to select a specific Business Process 
for mapping. 

 The fields from both Upper and Detail forms can be mapped in the 
Data Mapping tab, and you can change mapping of the fields. 

 The workflow data (Steps and tasks), related to any Workflow BP, is 
also sent to Analytics. 

 The DE of type Rich Text is not available to be mapped to the UDFs 
from Analytics.  

The Data Mapping tab displays the following information: 

 Name 

 Source 

 Data Source 

 User Defined Attributes 

 Name 

 Data Type 

 Source 

 Data Source 

 Label 

Note: In addition to the system defined fields for Analytics, you can 
define additional custom fields for Analytics in the User Defined Attribute 
section. 

Name

The Name column is pre-populated and displays the following names: 

 Specification Section 

 Vendor ID 

 Contract Type 

 Reason 

 Unit of Measure 
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 Spend Category 

 Quantity 

 Unit Cost 

The names above represent the fields used in OBI. These are read-only fields and you cannot 
modify them. 

All the "Main Form" fields are listed first and are sorted alphabetically within the source. 

All the "Line Item" fields are listed after the Main form fields and are sorted alphabetically within 
the source. 

Source

The Source column displays the location of the Data Element (DE) seen in the Data Source. For 
Business Processes, the DEs can either be from the "Main Form" or the "Line Item." 

Data Source

The Data Source column contains a consolidated list of all DEs for all of the selected Business 
Processes in the Business Processes tab. In addition: 

 The list of values displayed upon clicking the Data Source drop-down will be those that have 
a matching data definition as the Name field. When you click, the Data Source drop-down list 
contains a list of values that have a matching Data Definition (DD) as the Name field. 

 The drop-down list, which requires the Upper form mapping, contains a consolidated list of 
all Upper form DEs. For example, if there are ten Upper forms from all the Business 
Processes, and each Upper form has 10 DEs, then the list of DEs displayed in the 
drop-down list will be a consolidated and unique list of DEs from all the Business Processes. 

 The drop-down list, which requires the Detail form mapping, contains a consolidated list of all 
Detail form DEs. For example, if there are twenty Detail forms, and each Detail form has 10 
DEs, then the list of DEs displayed in the drop-down list will be a consolidated and unique list 
of DEs from the Detail forms of all the Business Processes. 

 The fields displayed in the Data Source drop-down list is a concatenation of DE Label and 
DE Name, and the DE Name is displayed within parentheses. For example, 
Department(contract_department)

User Defined Attributes

The User Defined Attributes section of the Data Mapping tab lists the following columns: 

 Name 

 Data Type 

 Source 

 Data Source 

 Label 

The Label will be based on the selected DE label, but you can change it. 

Use the Add, Modify, and Remove to add, modify, or remove user defined attributes. 

To modify a user-defined attribute, click to select the attribute, click Modify, and modify the 
fields. 
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To remove a user-defined attribute, click to select the attribute, click Remove, and modify the 
fields. 

To add a user-defined attribute, read the following information: 

When you click Add, the Add User Defined Attribute window opens. This window allows you to 
select the following mandatory fields: 

 Data Type

 Source

 Name

 Data Source

 Label

Notes: 

 A value for the mandatory Label field will be selected by the system. 

 The Label field is populated based on the Data Element that you have 
selected from the Data Source drop-down list. 

 The Label field is editable and required. You will receive an error 
message if you leave the Label field blank. 

 If you notice that the value in the Label field has changed, it means 
that other fields have been updated at one point. 

 Analytics displays the value, if the label is absent. 

 Analytics displays the label, which has the Value/Label pair, in the 
case of Data Elements (DEs). 

The Data Type that you select impacts the Name and the Data Source of the user-defined 
attribute. The Data Type field allows you to select the following attributes, only: 

 String (default) 

 Date 

 Numeric 

For example, if you select String as your Data Type, you can: 

 Select from a predefined set of sources from Source drop-down list (Main Form or Line 
Item). 

 Add up to 30 names (User Defined String Fields 1 - 30) as the Name. 

 Select from a predefined set of data sources from Data Source drop-down list. 

 The content of the Label field will be selected by the system and according to your other 
selections. 

Analytics Dimension and Fact 

The Data Type that you select corresponds to the Analytics fields as follows: 

 If the Data Type that you select is String/Date, then your selection corresponds to a 
Dimension object in Analytics. 

 If the Data Type that you select is Numeric, then your selection corresponds to a Fact object 
in Analytics and is available in the Primavera - Project User Defined, only.  
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Additional information 

 If the same DE exists in both Upper form and Detail form, then the DE is displayed for the 
Upper form fields, as well as the Line Item fields. 

 If you map a DE for one field, you can map the same DE to another field. You can choose 
the DEs, per your Company business needs, when setting up the mapping. 

 If you change the mapping of the fields, for the new records, then the next time the data is 
published to OBI, the values will be as per the updated fields. If you need to refresh, for all 
the records, then you need to click the checkbox option in the Schedule tab. 

 If you delete a DE mapped to an Analytic field, then the Data Source field displays the DE 
name, only. 

 If there are any un-mapped fields in the Data Mapping tab, the un-mapped fields appear in 
the DE list, based on the updated design. 

 If you delete a Business Process, and click Apply, then the Data Source field displays the DE 
name, only. 

 The allowed user-defined attributes is driven by the number that is set in the Custom Fields 
tab.  

 Pickers are available for String field mappings for both canned and user defined attributes 
and are as follows:  

 BP Data Picker 

 Shell Data Picker 

 Space Data Picker 

 User Data Picker 

 BP Picker 

 User Picker 

 Shell Picker 

 Space Picker 

 BP Creator  

 P6 Activity Picker  

Summary Payment Application (SPA) SOV type BPs 

You can perform data reporting in Analytics for Base Commit, Change Commit, and Payment 
Application Business Processes of SPA SOV type. The system sends the following Cost 
allocation Line Item details to Analytics: 

 Cost Code 

 Cost Name 

 Short Description 

 Quantity 

 Unit Price 

 Amount 

If you need to transfer data from any field (at the Summary level) to Analytics, then you must 
map the field to a User Defined Field in Line Items of the Business Process. The system sends 
the mapped field to Analytics as a part of Cost allocation Line Item. 
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Note: Users can map any field that exists in the Detail form. 

The values of the fields in the existing Cost allocation Line Items are retained for the fields that 
are common to both the Summary and Cost allocation Line Items. The following explains the 
details: 

 Cost Code

The value of the field in the Cost allocation Line Item is retained. The CBS Picker field does 
not exist in the Detail Form design. 

 Cost Name

The value of the field in the Cost allocation Line Item is retained. The bi_item field does not 
exist in the Detail Form design. 

 Short Description

The value of the field in the Cost allocation Line Item is retained. 

 Quantity

The value of the field in the Cost allocation Line Item is retained. 

 Unit Price

The value of the field in the Cost allocation Line Item is retained. The Unit price is 
auto-populated from the value of the field in the Detail Form and is a read-only field in the 
Cost allocation Line Item. The value of the field in the Cost allocation Line Item will match the 
value of the field in the Detail Form. 

 Amount

The value of the field in the Cost allocation Line Item is retained. 

Analytics Log (Cash Flow) Setup 

You can set up Dashboards and Analyses, for Unifier Cash Flow data, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and: 

 Select the Cash Flow names that you want to use for analyses. 

 Set up the data for the fields related to Cash Flow in the Cash Flow record. 

When you open a Cash Flow record in the Analytics node, you will see the Cash Flow Setup 
window that contains the Cash Flow names defined in Shells. In this window, you can add a 
Cash Flow record and click Apply to see the Data Mapping tab. 

In addition to the system-generated Cash Flow Curves, you can add additional user-defined 
Cash Flow Curves (total of 10). The User Defined Curves section, in Data Mapping tab of the 
Cash Flow Setup, displays the additional 5 Cash Flow Curves (User Defined Curves from 6 to 
10). 

Cash Flow tab 

Use the Cash Flow tab to select the Cash Flow names that you want to use in Analytics. Once 
selected, you can use Add to add the name or Remove to remove a Cash Flow. 

To add a new Cash Flow: 
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1) In the Analytics - Cash Flow Setup window, Cash Flow tab, click Add to open the Cash Flow 
window, Select Cash Flow for Analytics. 

Note: This list includes the available Cash Flow items, from all CBS 
Shells with Detail Levels of CBS, Summary CBS, and Commitment in 
alphabetical order.  

2) Select one Cash Flow, or select as many as you need, and click OK to add the Cash Flow to 
the log. 

Note: After you add a Cash Flow, that Cash Flow will no longer be 
available in the Select Cash Flow for Analytics list. 

You can remove a Cash Flow item that is published for Analytics. To remove a Cash Flow item 
for use in Analytics, select the Cash Flow item from the Select Cash Flow item for Analytics list 
and click Remove. You can delete multiple Cash Flow items from the list. You can add a 
removed Cash Flow item for Analytics reporting. Click Add if you want to add a removed Cash 
Flow item to the list. 

Data Mapping tab (Cash Flow) 

The Data Mapping tab allows you to map the predefined Analytic Cash Flow fields to a 
corresponding Unifier Cash Flow Curve type. 

Note: The Data Mapping tab is available after you have added a Cash 
Flow item, in the Cash Flow tab, and clicked Apply or OK. 

The Data Mapping tab displays the following information: 

 Name: Predefined and represents the fields used in OBI. 

 The names are grouped logically and sorted based on Initial Baseline, Current Baseline, 
Actuals, Forecast, and User Defined Curves (1 through 10). 

 The drop-down list for the Initial Baseline and Current Baseline includes the items that 
are based on the Baseline Cash Flow curve type, defined under the Cash Flow data 
sources (Cashflow Datasources window) in the Standard & Libraries. 

 The drop-down list for the Actuals includes the items that are based on the Spends curve 
type. 

 The drop-down list for the Forecast includes the items that are based on the Forecast 
curve type. 

 The drop-down list for the User Defined Curves (1 through 10) includes all the Cash Flow 
data sources. The items listed are based on the Cash Flow curve type and sorted in 
alphabetical order. 

 Data Source: The Cash Flow data sources defined under the Cash Flow > Data Sources 
node of the Standards & Libraries. 

 The fields displayed in the Data Source drop-down list is a concatenation of the Cash 
Flow data source name and Cash Flow curve type. 

The Analytic field name can be the same as the Data Source name. For example, you can map 
a User Defined Curve to data source named, "Initial Baseline." 



Unifier and Other Oracle Applications

353

The following is a list of fields that need mapping for Cash Flow: 

 Initial Baseline 

 Current Baseline 

 Actuals (Spends) 

 Forecast 

 User Defined Curves (labeled 1 through 10) 

Note: Cash Flow Derive curve is not supported. 

Analytics Log (Cost Sheet) Setup 

You can set up Dashboards and Analyses, for Unifier Cost Sheet data, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and select the Cost Sheet column data that you want to 
use for analyses.  

This section explains the following topics: 

 Data Mapping - Columns

 Data Mapping - Cost Attributes

When you open a Cost Sheet record in the Analytics node, the Analytics - Cost Sheet Setup 
window opens with the following tabs: 

 Data Mapping - Columns

 Data Mapping - Cost Attributes

The following explains each tab and their respective fields. 

Data Mapping - Columns 

The Data Mapping - Columns tab is divided in two sections: 

 System-defined columns: Listed on top of the window. 

 User-defined Columns: Listed under User Define Columns section of the window. 

The system-defined columns of the Data Mapping - Columns tab allows you to map the Cost 
Sheet Analytic fields to a corresponding Cost Sheet Data Source defined in Unifier. 

In addition to the system-defined Cost Sheet columns, you can add additional user-defined 
columns (total of 20). The User Defined Columns section, in Data Mapping - Columns tab of 
the Cost Sheet Setup, displays the additional 10 columns (User Defined Columns from 11 to 20). 

The top section of Data Mapping - Columns tab (system-defined columns) has the following 
columns: 

 Name

 Data Source

The following explains each column. 

Name

Lists a series of predefined fields which correspond to the fields used in OBI. 
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Note: Since the fields under Name are grouped logically, the order 
displayed is according to the list of fields that need mapping for Cost 
Sheet. 

This is a list of predefined fields: 

 Estimate 

 Original Budget 

 Pending Budget Revisions 

 Approved Budget Revisions 

 Revised Budget 

 Contracts 

 Purchase Orders 

 Original Commitments 

 Forecast 

 Pending Change Orders 

 Pending PO Amendments 

 Pending Commitment Changes 

 Approved Change Orders 

 Approved PO Amendments 

 Approved Commitment Changes 

 Revised Commitments 

 Pending Payment Applications 

 Pending Invoices 

 Pending Spends 

 Approved Payment Applications 

 Approved Invoices 

 Approved Spends 

 Actuals Received 

 Journal Entries 

 Risks & Issues 

 Forecast Adjustments 

 Budget Variance 

 Remaining Budget 

 Budget Percent 

 Commitment Percent 

Data Source

Lists the corresponding data source to each field that is listed in the Name column. The values 
in the Data Source fields: 

 Are divided into two sources (Single Sources and the Logical Sources). 

 Are sorted in alphabetic order. 

 Exist in the Cost Sheet for all CBS type Shells. 
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The lower section of Data Mapping - Columns tab (under the User Defined Columns section) 
has the following columns: 

 Name

 Data Source

 Label

The following explains each column. 

Name

 This is a list of predefined columns, each column titled User Defined Column and numbered 
from 1 to 20. 

The Analytic field name can be the same as the Data Source name. For example, you can map 
a User Defined Curve to data source named, "Initial Baseline." 

Data Source

 The P6 data sources are included under the Single Sources, and the element is included 
within the parenthesis of the P6 Data Source. For example, Current Baseline (Planned 
Cost).

 In addition to the predefined list displayed, you can add up to 10 additional mappings for the 
Cost Sheet data sources. 

 You can pick the same data source for multiple fields. 

Label

 Labels are required for the User Defined Columns. A red-color asterisk (*/star symbol) 
appears for the columns that have been mapped to a data source. 

Note: Asterisk (*/star symbol) does not appear for a column that has not 
been mapped to a data source. 

 For existing mappings of user-defined Cost Sheet columns, the labels are populated based 
on the data source name. 

 Labels support non-ISO characters (UTF-8 characters). 

 If there are no labels, then the data source names will be sent to OBIEE. 

Note: Custom String translation is not applied. 

 When you select a data source for the first time, the label is populated based on the data 
source name. You can modify the label according to your business need. 

 The maximum characters allowed in the label field is 50, same as the Cost Sheet Data 
Source Name. 

Note: The system does not perform Label Uniqueness test. 

Data Mapping - Cost Attributes 

The Data Mapping - Cost Attributes tab contains user-defined Attributes, listed under the User 
Defined Attributes section. 
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To add a new field, click Add to open the Add User Defined Attribute window. Enter name, 
source, and label in the following fields: 

 Name

 Data Source

 Label

The Data Type field is read-only and set as "String" by default. The value in the Data Type field 
determines if the selected field is a Dimension object or a Fact object in Analytics. If the Data 
Type field is "String," then the field is a Dimension object in Analytics. 

Note: Only the "String" type field is supported for Cost Code Attributes 
data mapping in Analytics. 

You can add up to 20 String type Data Elements (DEs) from the Cost Code Attributes Detail 
Form as User Defined Attributes. 

The Name field is a required field and lists User Defined String Field 1 through 20. 

 If a name has been selected, for example, User Defined String Field 1, then the list does not 
include User Defined String Field 1 and starts with User Defined String Field 2. 

 If an existing name has been deleted, the name will appear in the list. 

The Data Source field lists Data Elements (DEs) in the Cost Code Attributes Detail Form. 

Only DEs with the "String" type Data Definitions (DDs) are displayed in the Data Source field. 
The "String" type DDs in the list are: 

 Text Box 

 Multiple Text Lines 

 Pull-Down Menu 

 Radio Buttons 

 Multi-select Input 

The DDs in the Data Source field include the DEs. For example, Description 
(uuu_cost_description). If a DE that has already been added is deleted from the deployed 
design, then the DE name will be seen, only. 

Unifier populates the Label field based on the DE that has been selected in the Data Source
drop-down list. The Label field is a required and editable field, and it will accept non-ISO 
characters (UTF-8), to support internationalization. 

The maximum allowed length is the same as the DE label, and Unifier does not check for label 
name uniqueness. 

Analytics Log (Generic Cost Sheet) Setup 

Analytics supports reporting and analyses of data from the various cost attributes in the Generic 
Cost Sheet of Shells with Generic Cost Codes. 

Note: You work with a Generic Cost Sheet in the same way that you 
work with Cost Sheet (CBS Shells); however, the difference is that the 
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data in the Generic Cost Sheet comes from Generic Shells and 
sub-shells, but the data for Cost Sheet comes from the CBS Shells. 

You can access your Generic Cost Sheet from the Analytics node in Unifier (Shell > Admin 
mode > Analytics > Generic Cost Sheet) and map your Analytics fields to the corresponding 
Generic Cost Sheet columns. 

Double click Generic Cost Sheet to open the Analytics - Generic Cost Sheet Setup window. 

The Data Mapping tab (in the Analytics - Generic Cost Sheet Setup window) enables you to 
map the Generic Cost sheet Analytic fields to the corresponding Generic Cost Sheet columns, 
defined in Unifier. The Data Mapping tab has the following fields: 

 Name 

 Data Source 

 Label 

The Data Source values are the Single Sources and Logical Sources existing in the Generic 
Cost Sheets of all the Generic type Shells. You can pick the same data source for multiple fields. 

The Label field is required field for the user-defined columns. The system supports a total of 40 
user-defined columns, for the Generic Cost Sheet. 

Note: An asterisk (*) appears for columns where mapping has been 
completed. The asterisk (*) does not appear if the column is not mapped 
to any data source. 

The system populates the Label column with the Name column for the data source, as set in the 
Generic Cost sheet column definition. You can modify the values in the Label column, based on 
your business needs. The Label column supports non-ISO and UTF-8 characters. 

The maximum number of characters allowed for this field is 50, same as the maximum number 
of characters in the Generic Cost Sheet Data Source Name. 

Notes: 

 The system does not support Custom String translation. 

 The system does not perform label uniqueness verification. 

Analytics Log (P6 Summary Sheets) 

You can set up Dashboards and Analyses, for P6 Summary Sheets, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and select the P6 Summary Sheets data that you want 
to use for analyses. 

When you open P6 Summary Sheets in the Analytics node, you will see the Analytics - P6 
Summary Sheets Setup window with the following tab: P6 Data Sources. 
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P6 Data Sources tab 

The P6 Data Sources tab allows you to select the P6 Data Sources that you want to use in 
Analytics (P6 Data Sources for Analytics). 

Use the Add or Remove buttons to add or remove the P6 Data Sources that you want to use in 
Analytics. 

To add P6 Data Sources for Analytics: 

Click Add to open the Select P6 Data Sources for Analytics window and select a P6 data source 
for Analytics. The following data sources are available to select: 

Note: The P6 Data Sources that need to send data to OBIEE are set up 
here. 

 Current Schedule 

 Customer Sign-Off Baseline 

 Initial Planning Baseline 

 Management Sign-Off Baseline 

 New P6 Data Source for Analytics Testing 

 P6 Testing datasource 

These are all the published P6 data sources defined under Standards & Libraries. 

When finished, click Apply and then OK. 

You can select more than one data source. To select more than one data source, click one 
source, click OK, and click to add additional data sources. 

Note: Once you add a data source, that data source will not be shown in 
the Select P6 Data Sources for Analytics window. 

Additional information

 You can use the P6 Summary Sheets that are included in the following types of Unifier CBS 
Shells for Analytics: 

 Duration 

 Resource loaded 

 Cost loaded 

Note: The P6 Summary Sheets for the above data sources will send 
data to Analytics. 

 If fields overlap between the CBS Shells and the existing P6 Summary Sheets, then the 
system-defined fields in the P6 Summary Sheets will be used. 

Example: 

Planned Start and Planned Finish are mapped fields in Unifier CBS Shells; however, 
these fields will be replaced by the system-defined fields in the P6 Summary Sheets. 
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 Data analysis can be performed on P6-Unifier integrated data. Since there is no user 
interface (UI) component for the P6 Summary Sheets in Unifier, when Unifier sends data to 
OBIEE, the details of the P6 Summary Sheets of the selected P6 data source is sent to 
Analytics. In Analytics, views are created based on the details of the P6 Summary Sheets 
and the user can see the daily-level data. 

Analytics Log (Shells) 

You can set up Dashboards and Analyses, for Unifier Shells, in Oracle Business Intelligence 
Enterprise (OBIE) analyses and select the Shell data that you want to use for analyses. 

When you open a Shell in the Analytics node, you will see the Analytics - Shells Setup window 
with one tab: 

Data Mapping. 

The Data Mapping tab is divided into two sections: 

 System defined and User defined attributes 

 User Defined Columns 

The system defined columns of the Data Mapping tab allows you to map the Shells (called 
"Projects" in Analytics) Analytic fields to a corresponding Shell attribute Data Element (DE) 
defined in Unifier. 

The top section of the Data Mapping tab displays all the system defined fields in the following 
columns: 

 Name 

 Data Source 

Name

Lists a series of predefined, read-only fields, which represent the fields used in OBI. 

Note: When the user adds a new user-defined field on a Shell mapping 
page, the "Name" field displays fields up to 100 (minus the ones used 
already).  

 Shell Phase 

 Anticipated Start 

 Anticipated Finish 

 Start 

 Finish 

 Forecast Start Date 

 Forecast Finish Date 

 Planned Start 

 Planned Finish 

 Scheduled Finish 

 Current Budget 

 Original Budget 
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 Proposed Budget 

 Address 1 

 Address 2 

 City 

 State 

 State Code 

 Country 

 Country Code 

 Postal code 

Data Source

 Lists all of the Data Elements (DEs), in the Shell attributes, with matching Data Definitions 
(DDs). 

 The DEs are listed in alphabetical order. 

 The values listed in the drop-down list have a matching DD as in the Name field and includes 
a consolidated list of all the DEs across all Shell attribute forms. For example, when you 
select the "Project Start Date," the drop-down list will include all the date fields in all of the 
Shell attribute forms. 

The bottom section of the Analytics - Shells Setup window includes the User Defined 
attributes/fields presented in the following columns: 

 Name 

 Data Type 

 Data Source 

 Label 

Use the Add, Modify, and Remove to add, modify, or remove user defined attributes. 

To modify a user-defined attribute, click to select the attribute, click Modify, and modify the 
fields. 

To remove a user-defined attribute, click to select the attribute, click Remove, and modify the 
fields. 

Note: If you remove a user-defined attribute, the DE name will remain in 
the list for future use. 

To add a user-defined attribute, read the following information: 

When you click Add, the Add User Defined Attribute window opens. This window allows you to 
select the following mandatory fields: 

 Data Type 

 Name 

 Data Source 

 Label 

Notes: 

 The Label field is populated based on the Data Element that you have 
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selected from the Data Source drop-down list. 

 The Label field is editable and required. You will receive an error 
message if you leave the Label field blank. 

 If you notice that the value in the Label field has changed, it means 
that other fields have been updated at one point. 

The Data Type that you select impacts the Name and the Data Source of the user-defined 
attribute. The Data Type field allows you to select the following attributes, only: 

 String (default) 

 Date 

 Numeric 

For example, if you select String as your Data Type, you can: 

 Add up to 20 names (User Defined String Fields 1 - 20) as the Name. 

 Select from a predefined set of data sources from Data Source drop-down list. 

 The content of the Label filed will be selected by the system and according to your other 
selections. 

Dimension and Fact

The Data Type that you select corresponds to the Analytics fields as follows: 

 If the Data Type that you select is String/Date, then your selection corresponds to a 
Dimension object in Analytics. 

 If the Data Type that you select is Numeric, then your selection corresponds to a Fact object 
in Analytics. 

Additional Information 

Pickers are available for String field mappings for both canned and user defined attributes are as 
follows:  

 BP Data Picker 

 User Data Picker 

 Planning Data Picker 

 User Picker 

 Location Picker 

 P6 Activity Picker 

 Auto-update Status Setup Picker 

Analytics Log (Space Manager) 

You can set up Dashboards and Analyses, for Space Manager, in Oracle Business Intelligence 
Enterprise (OBIE) analyses and select the Space Manager data that you want to use for 
analyses. 

When you open the Space Manager in the Analytics node, you will see the Analytics - Space 
Manager Setup window with one tab: Space Types. 
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The Space Types tab contains a list of space type names under the Space Types for Analysis
section. You can add and remove a Space type using the Add and Remove buttons on this tab 
and below the Space Types for Analysis section. When finished, click Apply and Ok to 
complete the operation. 

Adding Space Types 

To add new Space Types click Add to open the Select Space Types for Analytics window. If 
available, a list of available Space Types that have been deployed in the Company appear in the 
window, in alphabetical order. The list contains all Active and Inactive Space Types. 

Click to select one, or more, Space Types. 

Click OK to add the selected Space Types to the Space Types log. 

Once added: 

 The selected Space Types do not appear in the Select Space Types for Analytics window. 

 The Data Mapping - Space Types tab appear. 

Click Apply to complete the adding operation. 

Removing Space Types 

You can remove the Space Types that have been published for Analytics. To remove the Space 
Types, click to select one, or more, Space Types and click Remove. Once removed: 

The selected Space Types do not appear in the Select Space Types for Analytics window. 

If you want to add removed Space Types, read the instructions in the Adding Space Types topic. 

Working with Space Types 

If you (Company Administrator) inactivate a space type, and the inactivated space type was 
used for Analytics, then the inactivated space type remains in the Space Types tab. 

If a published space type is removed from the Space Types tab, the data that exists in Analytics 
(for the removed space type) remains as is. 

Note: Added new data will not be published. 

If an unpublished space type is removed from the Space Types tab, then no information related 
to the space type, and Level, is sent to Analytics. 

The following sections explain the following tabs that appear after you add Space Types: 

 Data Mapping - Space Types tab 

 Data Mapping - Level tab 
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Data Mapping - Space Types Tab 

The Data Mapping - Space Types tab appears after you add Space Types, and it enables you 
to add custom fields, from various Space Types, to use in Analytics. You can use this tab to map 
the Analytics field to the corresponding Space Types field. The Data Mapping - Space Types
tab contains a list of user-defined attributes under the User Defined Attributes section. The 
User Defined Attributes section is a log that lists the following fields for each user-defined 
attributes: 

 Name

 Data Type

 Data Source

 Label

All the fields mentioned above are read-only fields. You can add, modify, and remove 
user-defined attributes using the Add, Modify and Remove buttons on this tab. 

Adding new user-defined fields 

To add new user-defined fields, click Add to open the Add User Defined Attribute window and 
enter values in the following required fields: 

 Data Type

 Name

 Data Source

 Label

About Data Type 

The values for Data Type field are: 

 String

 Date

 Numeric

When you select a Data Type, you set the value of the of the field as either a Dimension or a 
Fact. If you select the Data Type as String, or Timestamp, then the field will be a Dimension 
object in Analytics. If you select the Data Type as Numeric, then the field will be a Fact object in 
Analytics. 

Data Type Analytics 

String Dimension 

Date Dimension 

Numeric Fact 

Adding new user-defined fields (custom fields) for Data Type: String 

If you select the Data Type as String, then up to 20 String type Data Elements can be added 
from the Space Detail Form, as user-defined attributes. 
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To add new user-defined fields (custom fields) for String Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined String Field 1" to "User Defined 
String Field 20.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. 

Example 

If the "Department" field has been added as a “User Defined String Field 1," then the “Name” 
drop-down list does not display the “User Defined String Field 1." 

If a previously added field has been deleted, then that Name is displayed in the Name 
drop-down list. 

Data Source

The Data Source drop-down list contains a list of Data Elements from the Space Detail Form. 

If you select the Data Type as String, the Data Elements in the Data Source drop-down list are: 

 Strings and Integer Pull Downs 

 Integer and String Radio Buttons 

 Check Boxes 

 Test Data Elements 

There are no Pickers listed/available. The Data Source field displays a series of interconnected 
Data Element names and Data Element labels in the following format: DE Label(DE name). For 
example, Project Type(prjt_type). If a previously added Data Element is deleted from the 
Deployed design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Date 

If you select the Data Type as Date, then up to 10 "Date" Data Elements can be added from the 
Space Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for Date Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 20.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. 

Example 

If the "Project Commission Date" field has been added as a “User Defined Date Field 1," 
then the "Name" drop-down list does not display the “User Defined Date Field 1." 
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If a previously added field has been deleted, then that Name is displayed in the Name 
drop-down list. 

Data Source

If you select the Data Type as Date, the Data Elements in the Data Source drop-down list are: 

 Date 

 Date only Picker 

The Data Source field displays a series of interconnected Data Element names and Data 
Element labels in the following format: DE Label(DE name). For example, Project Archive 
Date(prjt_arc_date). If a previously added Data Element is deleted from the Deployed 
design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Numeric 

If you select the Data Type as Numeric, then up to 40 numeric data elements can be added 
from the Level Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for Numeric Data Type, click Add to open the 
User Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 40.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "Total Count" field has been added as a “User Defined Date 
Field 1," then the Name drop-down list does not display “User Defined Date Field 1." If a 
previously added field has been deleted, then that Name is displayed in the Name drop-down 
list. 

Data Source

If you select the Data Type as Numeric, the Data Elements in the Data Source drop-down list 
are the Data Elements found on the Space Detail Forms and are: 

 Integer 

 Currency 

 Decimal Amount 

There a no Integer Pull Downs, Integer Radio Buttons, and Integer Check Boxes. The Data 
Source field displays a series of interconnected Data Element names and Data Element labels 
in the following format: DE Label(DE name). For example, Contract Amount(con_amt). If a 
previously added Data Element is deleted from the Deployed design, then the Data Element 
name is displayed, only. 

Label
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The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Data Mapping - Level Tab 

The Data Mapping - Level tab appears after you add Space Types, and it enables you to add 
custom level/floor fields, from various Levels, to use in Analytics. You can use this tab to map 
the Analytics field to the corresponding Levels field. 

The Data Mapping - Level tab contains a list of user-defined attributes under the User Defined 
Attributes section. The User Defined Attributes section is a log that lists the following fields for 
each user-defined attributes: 

 Name

 Data Type

 Data Source

 Label

All the fields mentioned above are read-only fields. You can add, modify, and remove 
user-defined attributes using the Add, Modify and Remove buttons on this tab. 

Adding new user-defined fields 

To add new user-defined fields, click Add to open the Add User Defined Attribute window and 
enter values in the following required fields: 

 Data Type

 Name

 Data Source

 Label

About Data Type 

The values for Data Type field are: 

 String

 Date

 Numeric

When you select a Data Type, you set the value of the of the field as either a Dimension or a 
Fact. If you select the Data Type as String, or Timestamp, then the field will be a Dimension 
object in Analytics. If you select the Data Type as Numeric, then the field will be a Fact object in 
Analytics. 

Data Type Analytics 

String Dimension 

Date Dimension 
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Data Type Analytics 

Numeric Fact 

Adding new user-defined fields (custom fields) for Data Type: String 

If you select the Data Type as String, then up to 20 String type Data Elements can be added 
from the Level Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for String Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined String Field 1" to "User Defined 
String Field 15.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "Department" field has been added as a “User Defined String 
Field 1," then the Name drop-down list does not display “User Defined String Field 1." If a 
previously added field has been deleted, then that Name is displayed in the Name drop-down 
list. 

Data Source

The Data Source drop-down list contains a list of Data Elements from the Level Detail Form. 

If you select the Data Type as String, the Data Elements in the Data Source drop-down list are: 

 Strings and Integer Pull Downs 

 Integer and String Radio Buttons 

 Check Boxes 

 Test Data Elements 

There are no Pickers listed/available. The Data Source field displays a series of interconnected 
Data Element names and Data Element labels in the following format: DE Label(DE name). For 
example, Project Type(prjt_type). If a previously added Data Element is deleted from the 
Deployed design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Date 

If you select the Data Type as Date, then up to 10 "Date" Data Elements can be added from the 
Level Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for Date Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name
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The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 10.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "Project Commission Date" field has been added as a “User 
Defined Date Field 1," then the Name drop-down list does not display “User Defined Date Field 
1." If a previously added field has been deleted, then that Name is displayed in the Name 
drop-down list. 

Data Source

The Data Source drop-down list contains a list of Data Elements from the Level Detail Form. 

If you select the Data Type as Date, the Data Elements in the Data Source drop-down list are: 

 Date 

 Date only Picker 

The Data Source field displays a series of interconnected Data Element names and Data 
Element labels in the following format: DE Label(DE name). For example, Project Archive 
Date(prjt_arc_date). If a previously added Data Element is deleted from the Deployed 
design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Numeric 

If you select the Data Type as Numeric, then up to 30 numeric data elements can be added 
from the Space Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for Numeric Data Type, click Add to open the 
User Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 30.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "# of Spaces" field has been added as a “User Defined Date 
Field 1," then the Name drop-down list does not display “User Defined Date Field 1." If a 
previously added field has been deleted, then that Name is displayed in the Name drop-down 
list. 

Data Source

If you select the Data Type as Numeric, the Data Elements in the Data Source drop-down list 
are the Data Elements found on the Level Detail Forms and are: 

 Integer 

 Currency 

 Decimal Amount 
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There a no Integer Pull Downs, Integer Radio Buttons, and Integer Check Boxes. The Data 
Source field displays a series of interconnected Data Element names and Data Element labels 
in the following format: DE Label(DE name). For example, Contract Amount(con_amt). If a 
previously added Data Element is deleted from the Deployed design, then the Data Element 
name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Analytics Log (Vendors) 

You can set up Dashboards and Analyses, for Unifier Vendors data, in Oracle Business 
Intelligence Enterprise (OBIE) analyses. 

When you open a Vendors record in the Analytics node, you will see the Analytics - Vendors 
Setup window that contains the following tabs, after you add a Vendor record and click Apply: 

 Vendors tab 

 Data Mapping tab 

Vendors tab 

Note: You need to first select the Business Processes that you want to 
set as Vendor Business Processes for use in Analytics. 

In the Vendors tab, click Add to open the Select a Business Process as Vendor for Analytics 
window. The list of Business Processes in this window is in alphabetical order. 

Note: Only one Business Process can be marked as Vendor, so the Add 
option is disabled after your selection. 

Select a Business Process (Company and Shell level - Active and Inactive), then click OK. You 
can select one Business Process, only. 

You can remove a Vendor Business Process by selecting the item and clicking Remove. 

Use the Vendors tab to select the Vendors names that you want to use in Analytics. Once 
selected, you can use Add to add the name or Remove to remove a Vendor. 

You can remove a Vendor Business Process that is published for Analytics. To remove an item 
for use in Analytics, select the item from the list in the Select a Business Process as Vendor for 
Analytics window and click Remove. You can add a removed item for Analytics reporting. Click 
Add if you want to add a removed item to the list. 

If the Company Administrator inactivates a Business Process marked as Vendor, and if the item 
is used for Analytics, then this Vendor Business Process remains in the Vendors tab. 

If a Vendor is removed from the Vendors tab, data that exists in Analytics (for the removed 
Vendor Business Process) remains as is; however, the new data will not be published. 
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Data Mapping tab 

The Data Mapping tab allows you to map the predefined Analytic Vendor related fields to a 
corresponding Unifier Data Element (DE) in the Business Process. As mentioned earlier, this tab 
is available after you have added a Business Process in the Vendors tab and clicked Apply or 
OK. 

In the Data Mapping tab, the following columns, or fields, are present: 

 Name 

 Source 

 Data Source 

Name

Pre-populated and represents the fields used in OBI. These are read-only fields and you cannot 
modify them. 

Source

Displays the location of the Data Element (DE) seen in the Data Source. The DEs for Vendor 
mapping are the Upper form DEs. 

Data Source

Allows you to select from a list of all Upper form DEs, for the selected Vendor Business Process 
in the Vendors tab. The list is filtered based on the Data Definition (DD) match. You can change 
the mapping of the fields. 

The following is a list of fields that need mapping for Vendors: 

 Vendor ID 

 Name 

 Type 

The fields displayed in the Data Source drop-down list is a concatenation of DE Label and DE 
Name, and the DE Name is displayed within parentheses. For example, 
Department(contract_department)

Rules for Data Mapping 

 If the Analytic field is of a String type, then all pull-downs (Integer and String), Radio Boxes 
(Integer and String), check boxes, and text DEs are displayed. No pickers will be seen. 

 If the Analytic field is of a Pull-down type, then the list of DEs displayed in the Data Source 
drop-down list are filtered and only the DEs of Pull-down type are displayed. This list 
includes both Integer and String Pull-downs. 

 If the Analytic field is of a Numeric type, then the list of values displayed is a consolidated list 
of all numeric data elements, which include DEs of type Integer Amount, Currency Amount, 
and Decimal Amount. No integer pull-downs or Radio boxes will be seen. 

Scheduling Setup 

Unifier sends data from all Shells, regardless of the Shell status. If you need to filter the data, 
based on the Shell status, you (the Administrator responsible for setting up the Analytics 
Schedule) must set up filter condition on the data and set up a schedule to send the data to OBI. 
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You can set up Scheduling by clicking the Schedule (on the log toolbar). The Schedule Setup 
window allows you to set the following: 

 Frequency

 Filters

Note: If you change the filter setup, the change only applies to the 
subsequent runs. Since the scheduled runs sends incremental data 
(Data that has changed between runs) only, the filter change is 
applicable to the sent incremental data. 

The default option is: Include data from all Shells. 

If you select to set up a filter to include data from Shells with a particular status (Include data 
from Shells with Statuses), the system provides the following Shell statuses: 

 Active 

 On-Hold 

 View Only 

 Inactive 

You can exclude data, also. Include the Shell that you want its data to be excluded (Exclude 
data from selected Shells) to prevent the data in that Shell from being sent to OBI. 

 Data Refresh

Select the Refresh all data button if you made changes to data mappings and data 
definitions, and want the system to apply your filtering to the existing data in OBI. 

 Additional Information

In the Send error notification to field, specify who must receive the error notifications. 
Notifications are emails that contain failure of data exchange between Unifier and Analytics 
server.The Administrator can set up Users and Groups to receive these notifications. 

Unifier sends data to Analytics periodically. To accommodate your business needs, the following 
additional granularity, for sending the data, is available.  

A user can send Unifier data to OBIE every 4, 6, 8, or 12 hours so that the dashboards and 
reports in Analytics get the latest data. You can set up Scheduling by clicking the Schedule (on 
the log toolbar). The Schedule Setup window allows you to set the Frequency. Furthermore, 
you can update the Publish at values according to the frequency. 

In addition, since the Company-level data that is seen in Analytics is determined by permissions 
(see Granting Permissions for Analytics), user permissions impact the data that is being 
available to the users. An administrator can set permissions in terms of who can view the 
Company-level information from the respective level Business Processes that are enabled for 
Analytics. 

The Run Now option (toolbar), in the Analytics setup page, enables the admin to run the data 
publish at-will, for Analytics.  

Upon selecting the Run Now option, Unifier displays the following message: "This action will 
only publish the Unifier data for Analytics and will not update the data seen in Dashboards and 
Analyses. You must run Analytics ETL to update them. Do you want to proceed?" 

This option is available for the users only if the Modify permission has been granted. 
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When Unifier is already running a job of data publish based on the schedule setup, an alert is 
displayed to inform the user that the job for data publish is already in progress: "Unifier data is 
already being published based on the schedule. You must wait for this to be complete before 
performing this action." 

Access Control Changes for Analytics Node in User Mode Access 

Use this access control to: 

 Give permission to view or visit analytics or OBIEE at the company or shell levels 

 Provide data level access for analytics or OBIEE dashboards 

User Mode Access > Company Workspace 

The root node "Non-navigational Nodes" (under Company Workspace section of the Access 
Control), contains the Analytics node, and the administrator can assign permissions to the root 
node "Non-navigational Nodes." The View option is the only permission option available for 
Analytics node. 

When users have view permissions at Company Workspace level, the users can see the 
executive dashboard tab and the “Analytics” link, after opening the tab. 

User Mode Access > Shells/Projects (Standard) 

The Analytics node is available under the "Non-navigational Nodes." The administrator can 
assign permissions to both users and groups. 

Analytics Subject Areas and Unifier Data 

Analytics subject areas use the following Unifier data: 

 Generic cost sheet 

 P6 Summary Sheets 

 Shells 

 Space Manager 

 Vendors 

 Business Processes 

Analytics uses this subject area to analyze cost and non-cost line items in business 
processes. 

 Business Process History 

Analytics uses this subject area to analyze weekly historical business process facts to better 
understand changes over time. Note that dimensional business process history is not 
supported. 

 Cash Flow 

Analytics uses this subject area to analyze CBS-level cash flows. You can map columns to 
predefined company-level cash flow curves. Five generic columns are included to support 
custom labels from Primavera Unifier. Any Cash Flow families will be designated in 
Primavera Unifier (based on Cash Flow 'Name' value). 
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 Cash Flow History 

Analytics uses this subject area to analyze weekly historical cash flow facts to better 
understand changes over time. Note that dimensional cash flow history is not supported. 

 Cost Sheet 

Analytics uses this subject area to analyze cost sheets. You can map your data source to a 
predefined list of cost sheet columns. Ten generic columns are included to support custom 
labels from Primavera Unifier. 

 Cost Sheet History 

Analytics uses this subject area to analyze weekly historical cost sheet facts to better 
understand changes over time. 

Note: Dimensional cost sheet history is not supported. 

Granting Permissions to Setup Analytics 

To initially setup the Analytics node within Unifier, permissions must be enabled in the 
Administration mode and User mode.  

To grant permission for Analytics (Administration Mode Access) 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration grouping node to expand. 

3) Click Access Control in the left Navigator. 

4) On the right pane, select Administration Mode Access > Integrations > Analytics. The 
Permission Settings for: Analytics window opens. Here you can add, modify, or remove 
permission settings. 

5) Click Add to open a new Permission Settings for: Analytics window. 

6) Click Add Users/Groups. The Users/Group Picker window opens. 

7) Select the intended users and/or groups and click Add. 

8) Click OK to return to the Permission Settings window. 

9) Select the users or groups in Select Users/Groups, located in the upper portion of the 
window, and select the appropriate level of access for the user or group in Permissions 
Settings, located in the lower portion of the window. 

View: This option allows users and groups to open and view the contents in Analytics node. 
Users with View permission cannot make any changes. 

Modify: This option allows users and groups to configure and modify the data required for 
Analytics. This setting includes View permission. Users are also able to set schedule for 
publishing data, for various areas in Unifier, to the Oracle Business Intelligence (OBI) server. 

10) Click OK. 

11) Click Apply to save changes and keep the window open, or click OK to save changes and 
close the window. 

To grant permission for Unifier data in Analytics (User Mode Access) 

1) Go to the Company Workspace tab and switch to Admin mode.  
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2) Click the User Administration grouping node to expand. 

3) Click Access Control in the left Navigator. 

4) In the Access Control log, click User Mode Access to expand. 

5) Click Company Workspace to expand. 

6) Click Non-navigational Nodes to expand. 

7) Click Analytics to open the Permission Settings for: Analytics window. 

8) Click Add to open a new Permission Settings for: Analytics window. 

9) Click Add Users/Groups. The Users/Group Picker window opens. 

10) Select the intended users and/or groups and click Add. 

11) Click OK to return to the Permission Settings window. 

12) Select the users or groups in Select Users/Groups, located in the upper portion of the 
window, and select the appropriate level of access for the user or group in Permissions 
Settings, located in the lower portion of the window. 

View All Records: This option allows users and groups to open and view Company level 
Business process data and all the available project level data in Analytics . Users with View 
All Records permission cannot make any changes. 

View All Company Records: This option allows users and groups to open and view only the 
Company-level information from the respective level Business Processes that are enabled 
for Analytics. Users with View All Company Records permission cannot make any 
changes. 

View All Shell Records: This option allows users and groups to open and view all the 
available/mapped shell level data in Analytics, like Cost, Cashflow etc. Users with View All 
Shell Records permission cannot make any changes. 

Note: For existing users, the first checkbox option (View All Records) is 
automatically selected, after upgrade. 

Analytics and Dashboards 

Each of the following dashboards has filter selections, or prompts, to help you narrow the results 
in the sections by the date, project, location, and so on. You can access the Analytics node in 
Company Workspace > Admin mode > Integrations > Analytics. 

 Business Process 

The Business Processes dashboard enables you to view business process data, including 
business process overview analyses, business process data by geographic location, and 
business process history analyses. 

 Cash Flow 

The Cash Flow dashboard enables you to view cash flow data, including comparisons of 
actuals vs. forecast and forecast vs. baseline, cash flow data by geographic location, and 
cash flow history analyses. 

 Cost Sheet 

The Cost Sheet dashboard enables you to view cost data, including a comparison of original 
and revised budget details, and cost history analyses. 
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Accessing the Unifier Analytics Dashboard in OBI 

Users can access the Unifier Analytics dashboard designed in Oracle Business Intelligence 
(OBI) platform by using the link provided in Unifier. 

With Single Sign On (SSO) 

When accessing the Unifier Analytics dashboard with Single Sign On (SSO) enabled, you 
navigate from Unifier to the OBI, directly. 

If a user goes to the OBI landing page, the accessibility of the landing page, dashboards, 
analyses, and so forth are controlled by the settings for the user that is logged in OBI. 

If a Shell analytics user cannot go to the corresponding dashboard, the system will take the user 
to the default landing page set in OBI. 

Without Single Sign On (SSO) 

To access the Unifier Analytics dashboard without Single Sign On (SSO) enabled, you need to 
login to the OBI server. 

Accessing Unifier from OBI server 

You can access Unifier from OBI server by way of Action Links. Action Links are a way of 
providing easy and seamless navigation from an Analysis to other local content (such as other 
Analyses or Dashboards) or external content (such as websites). The Action Links in Analytics 
allows you to view the data in Unifier. 

Action Links (from OBI to Unifier) 

The following is a list of available Action Links: 

 Link to BP Log 

 Link to BP Record 

 Link to Cash Flow log 

 Link to Cost Sheet log 

 Link to Shell landing page 

 Link to P6 Summary Sheet log 

 Link to Spaces log (Space Manager) 

 Link to Level log (Space Manager) 

With Single Sign On (SSO) 

When accessing from OBI server with Single Sign On (SSO) enabled, you must have 
appropriate permission to access a particular page, and pertinent navigation, in Unifier. For 
example, if you want to access a Cost Sheet using the Cost Sheet Action Link, you must have 
permission to access that particular Cost Sheet, for the selected project (Project Cost Sheet). 

If you do not have permission to a Unifier page that is linked to an Action Link, then the system 
will take you to the default landing page. 



Unifier General Administration Guide

376

Without Single Sign On (SSO) 

To access the Unifier Analytics dashboard without Single Sign On (SSO) enabled, when using 
an Action Link, you need to login to the OBI server and enter your credentials. 

If a Unifier session is already in progress and you click an Action Link, the system will take you 
to the Unifier page, directly. 

Users must have appropriate permission to access a particular page, and pertinent navigation, 
in Unifier. For example, if you want to access a Cost Sheet using the Cost Sheet Action Link, 
you must have permission to access that particular Cost Sheet, for the selected project (Project 
Cost Sheet). 

If you do not have permission to a Unifier page that is linked to an Action Link, then the system 
will take you to the default landing page. 

About Link to BP Record 

With Single Sign On (SSO) enabled, if you click the Link to BP Record (Action Link), you can 
launch Unifier application and open the Business Process Record, provided that you have the 
appropriate permissions to the Business Process record. If you do not have the required 
permissions to the Business Process record, then the system will take you to the Business 
Process Log. 

Without Single Sign On (SSO) enabled, if you click the Link to BP Record (Action Link), the 
system displays the Sign In page or Unifier landing page (depending on whether the session is 
expired or not). If you click the Link to BP Record (Action Link), you can launch Unifier 
application and open the Business Process Record, provided that you have the appropriate 
permissions to the Business Process record. If you do not have the required permissions to the 
Business Process record, then the system will take you to the Business Process Log. 

Accessing Analytics from Unifier 

You can access Analytics from the following places in Unifier:  

Company level Dashboards 

The company level access is typically provided to executive level users who want to view the 
Analytics dashboards at a Company level. These users will be able to access data from all 
Shells. 

Dashboards 

You can access the executive Analytics Dashboards by clicking the Analytic Dashboards icon. 
Clicking the Analytic Dashboards icon, on the top left-hand corner of the screen, allows you to 
open the Analytic Dashboards in OBIE. 

The Analytic Dashboards icon can be seen by users who have access to Company level 
Analytics (Company Workspace > Non Navigational Nodes: View access). 

Shell-level Dashboards 

The Shell members can configure Shell dashboards. 



Unifier and Other Oracle Applications

377

In the Source Details section of the Edit Dashboard window, the Analytics option for the Block 
Type supports Analytics for Shell details. 

Any user with the Edit Dashboard permissions can add the Analytics option for the Block Type. 

Publishing Unifier Data to Analytics 

You must send Unifier data to Analytics periodically on an incremental basis. To send data to 
analytics, you will need to:  

1) Publish Unifier data to staging tables 

2) Run ETL Using the Primavera Analytics Administration Web Application to send data to the 
STAR schema of Primavera Data Warehouse. 

For more details on how to use the Primavera Analytics Administration Web Application, see 
Primavera Analytics Cloud Service Administration Guide. 

You can set the frequency of sending data to Analytics to Oracle Business Intelligence (OBI), by 
using the Schedule option in the toolbar. 

Note: If you need location-specific details for Spatial Data in Analytics, 
ensure that the values for Country and State Data Elements (DEs) are 
according to the ISO standards. These values can be pulldowns or plain 
text fields. 

Schedule Setup 

The frequency for the data publication can be Daily, Weekly or None. The default value is Daily. 

You can set the frequency to Every __ hours, Daily, Weekly, or None. 

The default frequency is Daily. 

If you select Weekly, the system sets the day to Sunday. You can change the day. 

If you select None, there will be no periodic publication of Unifier data to Analytics. 

You can set the time for the publication of data. 

You must set the time format to 24-hour notation in the form hh:mm, for the publication of data. 
The Hour drop-down lists hours from 0 to 23 for hour and 0 to 59 for minute. The default option 
for time is set to 00:00. The system displays the server time zone after the minute. 

You must select the checkbox for the Data Refresh option if you made changes to the DD value 
or labels. By default, the checkbox is unchecked. 

You must select the checkbox for the Data Refresh option if you made changes to the data 
mapping fields. After the run is complete, the system resets the checkbox for the Data Refresh
option and the checkbox will be unchecked. 
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Mapping Linked Elements 

The linked elements can be mapped to Analytics fields. The values of linked elements from the 
source are rendered at run-time in the destination record. However, if there are any changes to 
the value of the linked elements in the source record, then you need to conduct a full refresh of 
data in order for Analytics to display these values. As a result, you must select Refresh All data
for this purpose. 

Run History 

The Run History option allows you to see the status of the scheduled runs of the Unifier data 
publication to the Analytics server. When you select the Run History option, by clicking Run 
History on the toolbar, the Run History window opens and displays the following information: 

 Requestor: Is always "System" 

 Submit Date: The date entered by user 

 Start Date: The date entered by user 

 End Date: The date entered by user 

 Status: The run status 

You can view the Run History details by opening a record in the Run History log. 

The history details window includes the Start Date, End Date, and a message. 

 Success message: Data was sent to Analytics, successfully. 

 Failure message: For example, An error occurred and data was not published to Analytics 
successfully. Contact System Administrator. The system then displays the actual error after 
the generic failure message. 

Unifier Configurator and OBI Server for On-Premises 

The Unifier Configurator has an additional option for users to enter the URL to the OBI server. 
Refer to the Unifier Installation Guide (WebLogic) for details. 

Analytics Block 

The following provides detailed information about the Analytics Block window: 

 Block Title: This field contains the title of the Analytics Block. 

 Name: This field contains the name (as a hyperlink) of the Analytics Block. 

 URL: This field contains the URL, entered by the user, and it must match the URL specified 
in the Configurator. 

Note: The URL protocol, server path, and port must all match; otherwise, 
the validation fails. 

Example 

If the URL is: http://slc44.us.oracle.com:7001/analytics, then the Analytics 
URL must be: http://slc44.us.oracle.com:7001/analytics. 
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Note: The system does not validate the other URL parameters, for 
example, the Dashboard name. 

When you post the Analytics Block, it appears in the Source Details log and provides the 
following information: 

 Block Title: Title entered by the user. 

 Source Name: Same as the name entered in the Name field. 

 Block Type: Analytics 

 Result Type: Blank 

 Display Type: Blank 

The Analytics Block is also displayed in the Shell landing page. In the Unifier Analytics pane, 
you can click Analytics Dashboards to go to the shell dashboard in the Analytics server. 

If a user does not have permissions to access the Shell dashboards defined in OBIEE server, 
then the link is disabled and displays as plain text. 

You can add Analytics block to “My Dashboards”. However, the link connecting Unifier to the 
Analytics server, from this "My Dashboards" is completely driven by the Access Control > Mode 
Access > Shells/Projects (Standard) > Non-Navigation Nodes > Analytics. 

Analytics Block and Shell Templates 

The Analytics Block that is defined in the Shell dashboard of the Shell templates can be pushed 
to Shell instances. 
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Unifier and Primavera P6 

Unifier receives the integrated data, from P6, and uses the data for the following Cost modules: 

 Cost Sheet 

 Cash Flow 

 Earned Value (EV) 

As a part of integration, you can capture the "summarized" P6 data within the Cost modules and 
view the information in a columnar and comparative format, for example, Cost Sheet columns, 
Cash Flow Curves, and Earned Value Curves). In addition, the Reporting functionality within 
Unifier enables you to create "User-Defined" or "Custom" reports using the "summarized" P6 
data. 

Prerequisites for a Successful Integration 

 Use CBS type Shells to use Unifier cost modules with data integrated from P6. 

 Use the system Data Element uuu_int_schedule_type within the Integration -> Detail 
section of Shell attribute form definition. 

 Create and Publish P6 Data Sources to pull P6 data into Cost Sheet. 

 Create Shell instances corresponding to each P6 Schedule that needs to be integrated with 
Unifier by following these instructions: 

 Each Shell instance must have the same ‘Shell Number' as the corresponding P6 Project 
ID. 

 To bring the P6 internal Project id to Unifier, you need to add the P6 Internal Project ID 
field (uuu_int_internal_proj_id) to the Attribute form and the Integration Detail 
form (Company Workspace > Admin mode > uDesigner > Shell Manager > Integration > 
Detail) 

 Create or use separate Shell Templates for Duration Based and Resource or Cost 
Loaded integrated Shells in Unifier because the Cost Sheet for Duration Based 
schedules will not contain columns rolling up from P6 Summary Sheets (when the other 
two types of schedules will have columns rolling up from P6 Summary Sheets) 

 Include the following in the Role attribute form, if the integration will be Resource or Cost 
Loaded: 

 uuu_role_imported_from_p6

 uuu_role_type, uuu_role_id

 uuu_role_uom

 For correct cost calculations in Resource Loaded schedules, update all imported roles with 
Rate values. 

 If you create Unifier Roles via integration, include the Roles above the Data Elements (DEs) 
in the integration detail section in uDesigner Role attribute design. 

 For Resource Loaded or Cost Loaded schedules: 

 (Recommended) Do not change or update the ID of Roles created via integration 
manually because when you create Roles via integration the Role ID is used as the 
identifier by means of which the integration interface maps the P6 Resource to Unifier 
Role. 
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 If you want to integrate the CBS codes with P6, do the following: 

 Include uuu_cost_imported_from_p6 and uuu_int_hidden_from_p6 in the CBS 
attribute form 

 Define the default CBS segment values within Data Structure Setup -> Data Definitions 
-> Cost Codes 

 If you want to create Cost Codes for a Shell using the P6 CBS structure, ensure that the 
Cost Sheet structure in P6 is Tree. 

 Do not include Unifier Cost Code separators (“-”, “.”,) in P6 CBS Codes if you are creating 
Cost Codes in Unifier using P6 data. 

 When working with P6 data sources or Cost Sheet columns: 

 You can create or publish P6 data sources via integration and when the "Send Summary 
data" integration is used. 

 You can add published P6 data sources, as columns, in Cost Sheet Templates, only. 

 If you create P6 data sources via integration, and not manually, then you can add 
columns to Cost Sheet after the "Send Summary data to Unifier" is used, only. 

 If you create P6 data sources manually, and not via integration, then create or publish P6 
data sources by: 

 Creating or publishing one P6 Data Source called "Current Schedule." This 
datasource is used by the system to define the "Type" of all Master Summary 
sheets (Summary sheets which contain summary data from the main P6 project 
which is integrated with Unifier). 

 Creating or publishing all "Baseline Type" values defined within P6 Enterprise 
Data as P6 Data Sources in Unifier. 

 Once you created or published the P6 data sources, you can use the P6 data 
sources to create columns in the Cost Sheet Template and push the information to 
the Shell instances. 

In This Section 

P6 Data Sources Node .......................................................................................... 382 
P6 Activity Data ..................................................................................................... 385 
P6 Activity Picker Query Configuration .................................................................. 385 
P6 Data and Cash Flow Templates ....................................................................... 387 

P6 Data Sources Node 

The P6 Data Sources node is located under the Standards &Libraries node. The P6 Data 
Sources node enables you to access the following information, based on your permissions:  

 Data source 

Captured from P6 Summary Sheets, for use in Cost Sheets or Cost Sheets Templates. 

Examples of P6 Data Sources: Current Schedule Summary, Original Baseline Summary, 
Sanctioned Baseline Summary 

 Dataset for the attribute "Type" for P6 Summary Sheets 
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Note: Unifier allows a maximum of 12 P6 Data Sources to be integrated, 
with "Current Schedule" as one of the 12 P6 Data Sources must be 
named. 

P6 Data Sources Permissions 

The P6 Data Sources node appears under the Standards &Libraries node, when in 
Administration mode. The following permissions are available for the P6 Data Sources: 

 Create 

Users with Create permission have full access to the P6 Data Sources node and is allowed 
to create new data sources, modify existing data sources, and delete and view all data 
sources. 

If a user has "Create" permission, the remaining two permissions are enabled automatically. 

 Delete/Modify 

User with Delete/Modify permission will not be able to Create new data sources. 

If a user has "Delete/Modify" permission, the "View" permission is enabled automatically. 

 View 

User having View Permission will not be able to Create, Modify or Delete, but will only be 
able to View the different data sources. 

P6 Data Sources Log Window (Main menu) 

File

New: To create a new Data Source 

Open: To open a Data Source 

Note: Data Sources must have unique names. 

Edit

Delete: To delete a P6 Data Source 

If the P6 Data Source has been published already, you cannot delete it. 

Publish: To publish Data Source properties 

Note: You cannot edit the name of a Data Source. 

View

To find a Data Source. 

Help

To access online help and documents. 

P6 Data Sources Log Window (Toolbar menu) 

New
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To define a new P6 Data Source, using the New window. 

Open

To open a defined P6 Data Source. 

Delete

To delete an existing Data Source, one record at a time. 

Publish

To make the P6 Data Source available to be added as Cost Sheet columns. You can select and 
Publish more than one Data Source at a time. 

Note: Once a Data source is published, it appears as a "single" Data 
Source within a Cost Sheet or Cost Sheet Template that have the option 
of "Enable P6 Sources" selected in the properties. Unpublished Data 
Sources are not available as Cost Sheet "Single" Data Sources. 

Find

To find a Data Source 

P6 Data Sources Properties Window 

 Name

Text (maximum 120 characters). This content of this field is from P6 and maps to the P6 
Project Name. 

 Description

Editable field allowing you to enter a description (maximum 500 characters). 
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P6 Activity Data 

If you are using both Unifier and P6, you can link the two applications using Primavera Gateway 
and send data from a P6 Schedule to Unifier Projects. You can "pick" activities and 
Auto-populate (AP) or Reverse Auto-populate (RAP) from the corresponding P6 project. 

Corresponding P6 Project 

The term “Corresponding P6 project” refers to that P6 project which has the: 

 Same ID as Unifier Project 

or 

 Same ID as captured in a system element in Unifier project attributes 

Maintaining Projects (Unifier and P6) 

Maintain projects between the two applications by ensuring that the: 

 ID of the projects match in both applications 

or 

 System Data Element (DE) (uuu_int_p6_project_id) is present on the Shell Attribute 
form, and the value is the same as the corresponding P6 project ID. 

If only one of the conditions above is met, then the Gateway - Unifier Provider can determine 
which P6 project corresponds to which Unifier project. 

Note: Integration with P6 application applies to Unifier CBS type Shell 
only. The integration does not apply to the Unifier Project (Standard). 

P6 Activity Picker Query Configuration 

You can query the P6 Activity Picker elements by using the fields associated with the P6 Activity 
Attribute form. 

To define query conditions for P6 Activity Picker elements, from the same place as Data Picker 
query conditions in Unifier, switch to the Admin mode > uDesigner > Business Processes > 
Open > Data picker. 

In the Query Condition window, you can add query conditions under the Add Query Condition
section: 

 Data Element

A drop-down list that contains all the elements (pre-defined or custom) from the P6 Activity 
Attribute form. You can use the Data Element to create any query to filter out P6 Schedule 
activities from the P6 Activity Picker. 

 Condition

To set conditions for the query. 
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P6 Data and Cash Flow Templates 

You can use a Cash Flow Shell template (Shell instances and Shell templates) to select the 
Summary Sheets by selecting the associated P6 data sources. As a result, when you use a 
Cash Flow Shell template to push the Cash Flow settings, the system updates the Shell instance 
with the Cash Flow settings of the template. 

Note: The following applies to both Distribution, Cost, and Schedule 
sections. 

At runtime, the system uses the data from Summary Sheets, associated with the P6 data 
source, to render the Cash Flow curves. 

Distribution and Schedule 

Admin mode > Templates > Shells > Building > Template > Cost Manager > Cash Flow

In the Distribution or Schedule sections of the Cash Flow templates (with Detail level CBS), click 
Select from the Use data from P6 Sources option to open the Select Data sources window. This 
window displays all the data sources listed in the Standards & Libraries. 

Note: The Data Type option (under the P6 Source selection option) is a 
required field, if you select Use data from P6 Sources option. Use the 
drop-down list in the Data Type field to see a list of all the data types 
available for the selected P6 data source. 

Since the Schedule type will be blank, the Cash Flow template displays all the options available 
regardless of the Schedule type. 

The P6 sources in Distribution, Cost (only for Actuals), and Schedule sections are always 
enabled in the Cash Flow templates. 

The P6 Sources window (source selection) lists all the Published data sources, in alphabetical 
order. You can click on a source name to select that source. To find a source, go to Find, click 
the drop-down list, and follow the prompts. Depending on the type of the Cash Flow curve, this 
option is available only if you select the Distribution/Schedule/cost option as Use data/dates 
from P6 Sources. 

The Data type options for the Baseline curves are: 

 At Completion 

 Planned 

The Data type options for the Forecast curves are: 

 At Completion 

 Remaining 

You can copy the Cash Flow curve properties that exist in a Shell template to the Cash Flow 
curves that exist in instances if: 

 The Shell template push is done 

 The Shell template is used to create new instances 
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Unifier and Primavera Gateway 

Gateway allows data to be moved between two applications (at least one of them is a Primavera 
application) on schedule or on demand. It is a single integration hub where all the data 
integration happens with Primavera applications. 

For a Unifier object to exchange data with an object in another application via Gateway, the 
object must be pre-defined within: 

 Unifier Provider 

 Gateway 

 Oracle application/external application Provider 

Additionally, objects within each Provider must have a hard-coded (Java code) link to the 
corresponding object (with which it exchanges data) in Gateway. 

Example 

To expose Unifier Project object for integration with another application via Gateway, there 
must be a: 

 Project object defined in Unifier Provider 

 Project object defined in Gateway 

 Project object defined in Unifier Provider must be hard-coded (Java code) to link to 
Gateway Project object 

Correspondingly, to exchange data with Unifier Project object, the Oracle application/external 
application Provider must have a Project object within it and that object must be hard coded (via 
java coding) to link to Gateway Project object. 

Unifier Objects and Gateway 

Unifier sends data to the Oracle application through Gateway. The following Unifier objects can 
be integrated with Oracle applications via Gateway: 

 Projects/Shells

You can create and update Projects in Unifier using project data from an external application 
via Gateway. The exchange of information is bi-directional, from the Oracle application to 
Unifier and from Unifier to the Oracle application. 

Note: Integration with an Oracle application/external application does not 
apply to the Unifier Project (Standard). 

 Business Processes

You can create and update Business Process records using data from external applications 
sent to Unifier via Gateway. The exchange of information is bi-directional, from the Oracle 
application to Unifier and from Unifier to the Oracle application. 

 Roles

You can create and update Unifier Roles using data sent over from Gateway. The exchange 
of information is bi-directional, from Oracle application to Unifier and from Unifier to the 
Oracle application.  
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 CBS Codes

You can create CBS codes, within a Cost Sheet, using data sent over from Gateway. The 
exchange of information is one-directional, from the Oracle application to Unifier. 

Note: Integration with P6 application applies to Unifier CBS Shell-type 
only. 

Document exchange support through Gateway 

Unifier supports exchanging documents attached to BP records, or Line Items, through 
Gateway. In particular, through integration between Unifier and Gateway, Gateway performs as 
an intermediary and supports: 

Attaching documents to the respective BP records, or Line Items, while importing the documents 
into Unifier. 

Exporting documents (attached to BP records, or Line Items,) out of Unifier and to any Oracle 
application which is receiving the BP records, or Line Items. 

Notes: 

 The Oracle application must support receiving and exporting 
documents. 

 Once the documents are sent across to the Oracle application, the 
system deletes the documents from Gateway. 

Gateway Objects and Unifier Provider Objects 

Business Processes 

When you deploy a BP design to Gateway, the system maps to the BP design, in Gateway, in 
two ways: 

 Mapping to the existing, predefined, objects in Gateway. 

 Mapping to a newly created object in Gateway, under Unifier Provider. 

Mapping to a newly created object in Gateway requires that you: 

 Use the dynamic object mapping, in Gateway, to map the newly created objects from Unifier 
Provider to an existing object in Gateway. 

or 

 Create a new object in Gateway and map the Unifier Provider object to newly created object 
in Gateway. 

The new objects created in Unifier Provider contain the following default information: 

 Object name. 

 Description that is added in the Unifier. 

 Fields (including respective properties) associated with the design 

Before you can use the object, you must configure the remaining information for the newly 
created object: 
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 Data related to Flow Type 

 Cross-reference to the Gateway object 

Once you complete mapping the object in Gateway, you can use the object for creating business 
flows in Gateway and use the data. 

Configuring Unifier Objects on Gateway 

By default, the mapping of data involves the following applications in order: 

1) Unifier 

2) Unifier Provider on Gateway 

3) Gateway Provider on Gateway 

Mapping to a newly created object in Gateway requires that you match the information of that 
object in Gateway to the information of the object that you deployed from Unifier. In Gateway, 
once you find and select an object that you can use (i.e., an object that has matching 
information), you can proceed by cross-referencing the object in Unifier to the selected object in 
Gateway. 

Default Gateway Objects 

The following table lists the object names that are available for mapping in Gateway, by default, 
and provides a description: 

 Item Object Name Description 

1 BlanketPurchaseOrder

A company level purchase order, which 
enables agreements with vendors to 
provide services across multiple projects, 
released on a per-project/per-period 
basis with work authorizations against a 
previously determined maximum. 

2 
BlanketPurchaseOrderDetai
l Line Items for Blanket Purchase Orders 

3 Contract
Base Commit for EPC Activities (SOV = 
Payment Application) 

4 ContractDetail Line Items for Contracts 

5 PurchaseOrder
To track money committed to be spent 
(General Spends type Base Commit) 

6 PurchaseOrderDetail Line Items for Purchase Orders 

7 WorkRelease

Process that is connected to Blanket 
Purchase Order Business Process that is 
deployed at company level. This process 
can be used to write against the blanket 
purchase order  

8 WorkReleaseDetail Line Items for Work Releases 



Unifier and Other Oracle Applications

391

 Item Object Name Description 

9 ChangeOrder A formal commit change to the contract. 

10 ChangeOrderDetail Line Items for Change Orders 

11 POAmendment
Approval process for purchase order 
changes.  

12 POAmendmentDetail Line Items for PO Amendments 

13 Invoice

A general process for requesting and 
approving payments against 
commitments (invoice at the CBS or 
breakdown level, do not calculate 
retainage or stored materials) 

14 InvoiceDetail Line Items for Invoices 

15 PaymentApplication

A process to track your payment 
information using a standard payment 
application method (for example, tracking 
retainage, stored materials, past 
payments, etc.) 

16 PaymentApplicationDetail Line Items for Payment Applications 

17 Estimate
Used to create multiple project estimates 
and identify the preferred scenario. 

18 EstimateDetail Line Items for Estimates 

19 BudgetApproval Used to approve project budget  

20 BudgetApprovalDetail Line Items for Budget Approval 

21 BudgetChange
For requesting additional (or reduced) 
budget beyond the existing budget.  

22 BudgetChangeDetail Line Items for Budget Changes 

23 BudgetTransfer

For transferring budget from one CBS 
code to another. Most typically used to 
release budget contingency to other cost 
items.  

24 BudgetTransferDetail Line Items for Budget Transfers 

25 PotentialChangeOrder
Contractor initiated potential change 
order.  

26 
PotentialChangeOrderDetai
l Line Items for Potential Change Orders 
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 Item Object Name Description 

27 JournalEntry

A process for adjusting spends line items. 
Most commonly used to reassign costs to 
alternate cost centers or GL codes; 
Generic spend to transfer across cost 
codes 

28 JournalEntryDetail Line Items for Journal Entries 

29 Payment
BP to hold Checks Processed Information 
from Financial System.  

30 PaymentDetail Line Items for Payments 

31 RiskAndIssue

A log for documenting, tracking, and 
estimating impacts of open issues and 
risks; Log of items that may impact 
schedule/scope/cost 

32 RiskAndIssueDetail Line Items for Risks & Issues 

33 FundAppropriation Fund accounts as assigned to projects  

34 FundAppropriationDetail Line Items for Fund Appropriations 

35 ProjectInformation Project attribute information 

36 VendorEvaluation
Document vendor performance for 
consideration for future work (Simple) 

37 Vendor Company vendor directory 

38 Vendor Detail Line Items for Vendors 

39 Timesheet
Used to capture Employee Timesheets 
(project / non-project hrs) 

40 TimesheetDetail Line Items for Timesheets 

41 RequestforSubstitution
A change of identical material or 
equipment  

42 
RequestforSubstitutionDet
ail Line Items for Request for Substitution 

43 BudgetChangeOrder

 A change to a budget that is typically 
created for a contractor that is based on 
changes to a contract between the 
contractor and owner. 

44 BudgetChangeOrderDetail Line Items for Budget Change Orders 

45 BudgetItem
 A budget that is typically created for a 
contractor that is based on a contract 
they have with an owner for a project. 
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 Item Object Name Description 

46 BudgetItemDetail Line Items for Budget Items 

47 PaymentApplicationtoOwner
 A payment application that is raised by a 
contractor to the owner in order for the 
contractor to receive payment. 

48 
PaymentApplicationtoOwner
Detail

Line Items for Payment Applications to 
Owner 

49 PaymentFromOwner

 A record of the actual payments a 
contractor will have received from the 
owner based on the payment application 
they presented to the owner. 

50 PaymentFromOwnerDetail Line Items for Payments From Owner 

User-Defined Report (UDR) 

Unifier displays a project-level/company-level UDR that is enabled for integration in the log page 
of the Business Objects node (Company Workspace > Admin mode > Integrations > 
Gateway > Business Objects). 

You can export data, generated out of a project-level/company-level UDR that is enabled for 
integration, to an Oracle/external application Provider through Gateway. 

To export, you can select the listed UDR and click Deploy to send the data in the UDR to 
Gateway and use the data for integration with an Oracle/external application Provider. 

Gateway Node in Unifier 

To access the Gateway node go to  Company Workspace > Admin mode > Integrations > 
Gateway > Business Objects

The Gateway node provides the following information on the Gateway Integration landing 
page:  

 API URL

 This element captures the Gateway API URL that Unifier goes to in order to establish 
connection with Gateway. 

 Data Definition: SYS Description Text 250 

 User Name

 This element contains the user's name who logs into Gateway URL. 

 Data Definition: SYS Long Name 

 Unifier Deployment

 Allows you to enter the name of the Unifier Deployment, which needs to be accessed to 
exchange data with external applications 

 Data Definition: SYS Short Description Text 250 

 Integration Parameters block 
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 Source Base Currency

 Activity Sheet Synchronization

 Import Synchronization (The import synchronization that is selected for Activity 
and Assignment data for customers with EVM license and import synchronization 
that is selected for Activity data for customers without EVM license.) 

 Export Synchronization

 Rate Sheet Synchronization

To see the Integration Settings, click Open from the toolbar to open the Integration Settings
window. In the Integration Settings window, you can edit fields and run tests. The Integration 
Settings window contains the following blocks and fields: 

Gateway block 

 API URL

 User Name

 Password

 Contains the password required to log into the Gateway URL. 

 Data Definition: Short Description Text 

 Test Connection

 Enables you to run a test to verify that the Gateway URL and other credentials are 
valid. See the "Testing Connection" topic below. 

 Unifier Deployment

 Allows you to enter the name of the Unifier Deployment, which needs to be 
accessed to exchange data with external applications 

 Data Definition: SYS Short Description Text 250 

Integration Parameters block 

Select Source Base Currency for Rate Conversion

 Currency

 Select Synchronizations to exchange Activity data

 Import Synchronization (editable drop-down (size 250 chars)) 

 Contains the name of the Gateway Synchronization, which will be used to Import Activity 
data from Unifier to P6 

 Using the Gateway URL and the Unifier Deployment details captured within the 
Integration tab of "Company Properties," this field lists all the "Import" synchronizations 
from the URL, which are applicable to the mentioned Unifier Deployment. 

 The synchronizations shown in the drop-down will be the ones that match the Unifier 
Deployment. It lists the OOTB synchronizations provided for Oracle Primavera Cloud. 
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Note: For Unifier, this is an "Import" synchronization (to import data into 
Unifier). From P6 perspective, this is an "Export." 

For customers with or without EVM licenses, the import synchronization that is selected in 
Select Synchronizations to exchange Activity data will be the import synchronization 
that is selected for EVM data, provided customer selected that prior to upgrade to 20.7; 
otherwise, the synchronization selected will be from Select Synchronizations to 
exchange Activity data. 

For all customers, the activity import synchronization that is selected in Select 
Synchronization to exchange Activity and Assignment data prior to upgrade to 20.7 
is shown as selected under import synchronization Select Synchronization to 
exchange Activity data. If there is no synchronization selected in Select 
Synchronization to exchange Activity and Assignment data, then the synchronization 
selected in Select Synchronization to exchange Activity data must be selected. If 
none of them are selected prior to upgrade to 20.7, then the import synchronization will 
be empty. 

Starting from 20.7, customers with or without EVM licenses can get data from P6, and the 
existing export synchronization and Import Synchronization selected from Role and 
Resources synchronization will not have any impact. 

 Export Synchronization (editable drop-down (size 250 chars)) 

Contains the name of the Gateway Synchronization which will be used to Export Activity 
data from P6 to Unifier 

Using the Gateway URL and the Unifier Deployment details captured within the 
‘Integration' tab of Company Properties, this field lists all the "Export" synchronizations 
from the URL which are applicable to the mentioned Unifier Deployment. 

The export synchronization shows additional OOTB synchronizations "Send Activity 
data from Unifier to Primavera Cloud" defined for Oracle Primavera Cloud. You will be 
able to push the updated activity data to Primavera Cloud, using the export 
synchronization. 

The Export Synchronization option "Update Activity data from Unifier to Primavera Cloud" 
enable you to send updated activity data from Unifier to the Oracle Primavera Cloud. 
When you are using Oracle Primavera Cloud data for scheduling a project, you can bring 
the activities, schedules, and the associated WBS to the Unifier Activity Sheet. From the 
Activity Sheet, Unifier pulls the activity attributes into the business processes. In the 
business processes, you can update the schedules and reverse auto-populate (RAP) 
data back to the Activity Sheet. In the Unifier Activity Sheet log of the projects that are 
synchronized with Oracle Primavera Cloud, the Send Data option enables you to send 
the updated schedules back to the Oracle Primavera Cloud. The business flow updates 
the activity data in Oracle Primavera Cloud according to the activity data in Unifier.  

Note: For Unifier, this is an "Export" synchronization (to export data from 
Unifier), from P6 perspective, this is an "Import." 

 Import Synchronization (editable drop-down (size 250 chars))  

Contains the name of the Resource and Role Rates from P6 for EVM Copy. 
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When you make changes in the Integration Settings window, you must click OK to save your 
changes. Click Cancel to close the Integration Settings window. 

Testing Connection

To run a test to verify that the Gateway URL and other credentials are valid use the Test 
Connection option, in the Gateway block. If the system is unable to establish connection, you 
will receive an error message. If the system is able to establish connection, you will receive a 
confirmation message. 

Business Objects Node in Unifier 

You can expand the Gateway node to see the Business Objects node (Company Workspace
> Admin mode > Integrations > Gateway > Business Objects). When you click the Business 
Objects node the Business Objects log window appears on the right-hand side. 

The Business Objects log window in Unifier provides the following information: 

 List of Unifier objects that have been deployed from uDesigner. The Unifier objects are: 

 Projects/Shells (Attribute form) 

 Business Processes 

Note: The following types of BPs are not supported for integration: 
Project/Shell Creation BP - Resource BP - RFB BP - Text BP. 

 Roles (Attribute form)  

 CBS Codes (Unifier CBS Shell-type only) 

 Detailed information about each Unifier object that has been deployed: 

 Name 

 Category 

 Type 

 Last Updated 

 Last Deployed to Gateway 

 A mean to deploy a Unifier Business object that is ready to Gateway 

 Deploy to Gateway 

In the Business Objects log window, the columns provide detailed information about each Unifier 
object that has been deployed. 

Column name Description 

Name The name of the Unifier object. 

Category 
The category of the Unifier object: 
Business Processes, Shell Manager, and 
so forth 
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Column name Description 

Type 

The type of the Unifier object: Activity 
Sheet Attributes (from P6 and not defined 
in uDesigner), Resource Attributes, Roles 
Attributes, Cost, Simple, Shell Type, 
Document, Line Item, and so forth. 

Last Updated 
The date when the Unifier object was last 
updated, which is the Unifier object 
"Deploy" date from uDesigner. 

Last Deployed to Gateway 
The date when the Unifier object was last 
deployed to Gateway. 

In the Business Objects log window, the menu enables you to: 

 Deploy a Unifier object to Gateway 

 Edit 

 Find a Unifier object by applying filters 

 View 

 Review the history of a Unifier object 

 View 

 Access Unifier Help, documentation library, and productivity kit 

 Help 

In the Business Objects log window, the toolbar enables you to: 

 Deploy a Unifier object to Gateway 

 Deploy to Gateway

 Review the history of a Unifier object 

 History

 Find a Unifier object by applying filters 

 Find

Deploy to Gateway 

When deployed to Gateway, the system appends the attributes of the objects in Unifier to the 
corresponding object in Unifier Provider. You can select multiple items and deploy the selected 
items to Gateway. For the selected objects, the user can create the following and synchronize 
the data exchange: 

 Data Mapping templates 

 Business Process flows 

If the "Integration" form of the following is set in uDesigner, you can use this option to deploy: 

 Activity Sheet Attributes (as captured in Unifier > Unifier Provider > Gateway) 

The deploy action only sends the values that you had manually entered in the Activity 
Attribute form to Gateway. 
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The "Activity Sheet" object in Gateway contains all the pre-defined Activity Attributes fields by 
default. 

If you have added bitemID field in the Activity Sheet, then the P6 CBS code (P6) can then be 
mapped to the bitemID (Unifier) in the field mappings on Gateway.  

 Projects/Shells (Attribute form) 

 Business Processes 

Data Elements of type SYS Rich Text must not be sent to Gateway, when deployed.  

 Roles (Attribute form)  

 CBS Codes (Unifier CBS Shell-type only) 

 Project-level/Shell-level User-Defined Reports (UDRs) 

 Company-level UDRs 

How to exchange data through UDR with an Oracle application Provider 

You can export the data generated out of a UDR through Gateway and out to an external 
system. UDRs that are enabled for integration (i.e., the "Enable for Integration" option is 
selected) appear in the Business Objects node log, under Gateway in Company Workspace. 
You can deploy these UDRs and integrate them with Oracle integrators. 

Note: For a UDR to be eligible for deploying to Gateway, you must 
select the "Enable for Integration" option. 

All the UDRs, which have been enabled for integration (i.e., the "Enable for Integration" option is 
selected), are listed in in the Business Objects node, and you can choose to deploy those UDRs 
to Gateway to configure them for Data Exchange. 

The Business Objects node log displays UDR types and categories. 

All Project-level/Shell-level UDRs have Project-level/Shell-level as their type and User Defined 
Report as their category. 

All company-level UDRs have company-level as their type and User Defined Report as their 
category. You can search for and find a UDR Business Object by type or category. 

If you deselect the "Enable for Integration" option of a UDR after it has been deployed to, and 
configured in (for a Business Flow), Gateway, the system generates an error when 
synchronizing. 

If you delete a UDR that you have recently deployed to, and configured in (for a Business Flow), 
Gateway, the system generates an error when synchronizing. 

When a Line Item Type BP is deployed to Gateway, from Unifier, the system creates two objects 
for that BP. 

You can create different field mapping templates, according to the template requirements, and 
use the templates in different Business Flows to transfer the data. 

If you share documents between Unifier and any Oracle application, and the Oracle application 
does not support document integration, the system completes the Business Flow but without 
transferring the documents. 
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History 

The system logs all the deployed Unifier objects in History. The History option allows you to 
view the status of a deploy action, informing you whether the deployment was successful, or not, 
in addition to the following information: 

 Requestor 

The name of the user who has deployed the record. 

 Source 

If you select Unifier objects of same type and deploy, then the system provides all selected 
objects (including names of all objects which were chosen by you for deploy) in alphabetical 
order. 

If you select Unifier objects of multiple types and deploy, then the system provides separate 
history entries for each of the objects that are getting deployed to Gateway. 

 Start Date 

The date when the deployment action started (Unifier started to prepare the xml file for 
Gateway). 

 End Date 

The date when the deployment action ended. 

 Status 

The status of deployment action (Finished, In Progress, Finished with Errors). 

In the History window toolbar, you can: 

 Open 

To open an item in the History log. 

- Similar to the Open option in other "History" windows in Unifier, this action opens the 
"History Details" window. 

- Similar to other places in Unifier, you can take this action on one selected row only. 

 Find 

To allow you to search the History records. You can search on all columns (Requestor, 
Attribute Form, Submit Date, Start Date, End Date, Status). 

 Close Window 

To close the History window. 

History Details 

 If you select a row in the History window and click Open, the History Details window opens. 
This window includes information about: 

 Business Processes 

The name of the attribute form that was deployed. 

 Gateway URL 

The Gateway API URL through which link to the 3rd party applications is established, as 
defined by the user within Unifier Company Properties > Integration tab. 

 Unifier Deployment Name 
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The name of the Unifier Deployment as defined within the Unifier Company Properties > 
Integration tab. 

 Deploy action status details 

The details of the status of the deploy action, successful or not. 

Find 

The Find option allows you to search for records in all of the Business Objects window columns. 

Configuring Permissions for Business Objects 

To configure the permissions for Business Objects go to: Company Workspace > Admin mode 
> User Administration > Access Control. The Access Control node includes the Gateway
node. 

To set permission for Gateway node: 

 Configure

If you check this permission, the user can update the "Integration Settings" at "Gateway 
Integration" landing page. 

 Get / Set Activity Sheet Data

If you check this permission, the user can do the following from the Shell log File menu 
(Unifier CBS type Shell): 

 Get Activity Sheet Data (from the Shell toolbar): 

- All Shells 

- Selected Shells 

- Filtered Shells 

- History 

 Send Activity Sheet Data (from the Shell toolbar): 

- All Shells 

- Selected Shells 

- Filtered Shells 

- History 

Permission for "Get / Set Activity Sheet Data" from Shell log are configured in Unifier Admin 
Mode while permissions to take these action from within a Shell (User mode) are given at 
Unifier User mode level. 

To set permission for Business Objects node: 

Deploy

If you check this permission, you will enable the Deploy option, in the right-hand pane of the 
Business Objects page. 

You can grant permissions, for Business Objects, by way of the User Mode Access in Access 
Control node: Company Workspace > Admin mode > User Administration > Access Control
> User Mode Access > Shells / Projects (Standard) > Schedule Manager > Activity Sheet. 
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Note: You can move the Activity Sheet module under other nodes. 

The following permissions are available for Activity Sheet: 

 Get Data

If you check this permission, the user can go in the Activity Sheet (Shell > User mode > 
Schedule Manager > Activity Sheet) and perform "Get Activity Sheet Data" or view 
"History." 

If you select the "Get Data" permission, the "View" permission will be selected automatically. 
In addition to the "Get Data" permission, the user needs the "View" permission in order to be 
able to have the "Get Activity Sheet Data" permission. You can grant "View" permission 
without granting the "Get Data" permission. 

 Send Data

If you check this permission, the user can go in the Activity Sheet (Shell > User mode > 
Schedule Manager > Activity Sheet) and perform "Send Data" or view "History." 

If you select the "Send Data" permission, the "View" permission will be selected 
automatically. In addition to the "Send Data" permission, the user needs the "View" 
permission in order to be able to have the "Send Activity Sheet Data" permission. You can 
grant "View" permission without granting the "Send Data" permission. 

 View

If you check this permission, the user can view Activity Sheet data (Shell > User mode > 
Schedule Manager > Activity Sheet) and perform "Open." 

The permissions above are also available: 

 When granting permissions through User Administration (Company Workspace > Admin
mode > User Administration). 

 Within a Shell Template or Shell Instance Access Controls. 

 When granting permissions within a Shell Template or Shell Instance Access Control 
through User Administration. 

 Where all nodes are listed in Unifier Navigator (User mode), when appropriate. 

Unifier Provider, Unifier, and Gateway 

The following Unifier objects are available in Unifier Provider: 

 Project

Includes attributes that support the creation of projects in Unifier by way of Gateway. The 
Project object in Unifier Provider includes the following information: 

 Status 

 Location 

 Template Number 

 Business Processes (BPs) 
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Enables you to create/update different types of BPs such as Cost, Line Item, Document, and 
so forth, in Unifier. To correspond to the Gateway infrastructure, separate objects are 
available to capture the information in the BP Upper Form and Detail tab. To support the 
creation of BPs in Unifier, the Business Processes object in Unifier Provider includes the 
following information: 

 Name 

 Status 

 Detail tab Name 

 Roles

Enables you to create/update Roles in Unifier (Resource Manager > Roles). 

 Resources

Enables you to create/update Roles in Unifier (Resource Manager > Roles). You can use the 
Resources object to identify whether data from Unifier Provider can create a Role, or not. 

 CBS Codes (Unifier CBS Shell-type only) 

 Enables you to use the CBS object in Unifier Provider to import/export the CBS code data 
from Unifier. 

 Enables you to use the CBS object in Unifier Provider to import the CBS code data into 
Unifier. 

The following provides more details. 

Project/Shell 

To create/update Project/Shell in Unifier you can use the following attributes: 

 Data Dictionary 

 Business Flow 

 Synchronization 

 End-to-end solution 

The following sections provide more details. 

Project/Shell Data Dictionary 

The following table describes the Data Dictionary for Unifier Provider (Project/Shell): 

Attribute Name Description 

Status To capture the status of Unifier projects. 

Since Unifier projects must have one of following 
statuses, the user must define the data value mapping 
XML to map status of source project and to a project 
status value in Unifier. 

 Active 

 On-Hold 

 View-Only 

 Inactive 
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Attribute Name Description 

Location The location of the destination Unifier Project. 

Example 

All Regions > Sites > Properties 

Template The "Number" of the template which must be used to 
create the new project in Unifier. 

 Unifier Shell Template Numbers are enforced to be 
unique across all shell template types. 

 Unifier determines the "Type" of the shell that must 
be created, using the template number. 

Project/Shell Business Flow 

When defining a Business Flow in Unifier Provider (Project/Shell), the destination application 
parameters for Unifier Provider, Project object, enable you to define the location (Location) and 
template (Template) as parameters. The attributes are specific to Unifier and eliminate the need 
for the source application to send the values for Unifier fields. 

If the source application sends value for either of the parameters mentioned below via data 
mapping and you define the parameter value in the business flow, then the value sent by way of 
mapping takes precedence. 

The following parameters are required for successful project creation in Unifier. 
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Note: Oracle recommends that you set these parameters as "Required" 
in the Business Flow definition. 

Object Value Description 

Project Location This is a Text field. You must 
enter one location, only. 

Example 

All Regions > Sites > 
Properties 

If you enter multiple locations, 
Unifier Provider will not be 
able to resolve the location in 
Unifier and project creation 
will fail. 

Use this parameter to identify the 
location (Location): Where the 
Unifier project must be created in 
Unifier. 

You can also add the location as 
"Shell Attribute" (uuu_location) when 
defining the "Project" object filters. 

If you define the location parameter 
as a shell attribute (uuu_location = 
<xyz>), and use the available 
drop-down field (Location) for the 
Project object, then project creation 
will fail. 

If you add a filter row by selecting 
the fields as Shell Attribute Form 
and provide a value of the Shell 
Location, for Project object, then 
project creation will fail. 

Project Template 
Number 

This is a Text field. You must 
enter one number, only. 

If you enter multiple numbers, 
Unifier Provider will not be 
able to resolve the template 
in Unifier and project creation 
will fail. 

Use this parameter to identify the 
templates which must be used to 
create the new Project in Unifier. 

Project/Shell Synchronization 

Synchronization in Unifier Provider (Project/Shell) occurs when you set the parameters (Project 
Location and Project Template Number) as "Required" or "Optional" in the Business Flow 
definition. 

Project/Shell End-to-End Solution 

The following explains the end-to-end solution for Unifier Provider (Project/Shell). The 
configuration settings are for: 

 Unifier 

 Unifier Provider 
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To configure the creation of projects in Unifier via Gateway 

Note: This is an optional step. You can skip deploying the objects from 
Unifier and add relevant fields in Gateway Data Mapping Templates 
directly, manually. 

In Unifier, go to Company Workspace > Admin mode > Gateway > Business Objects. 

Deploy the Shell Attribute Forms of the shells that you want to create in Unifier, via Gateway 
Integration. 

All fields from the deployed Shell Attribute Forms appear as attributes of Project object in Unifier 
Provider Data Dictionary. 

To configure the creation of projects in Unifier Provider via Gateway 

You must: 

 Create Data Mapping Templates 

 Define Business Flow 

 Define Synchronizations 

 Synchronize 

The following provides the details for each step: 

Create Data Mapping Templates

Create Data Mapping Templates to map attributes of the Shell that needs to integrate with the 
Oracle application. All attributes of the Unifier Data Dictionary Project object are available to be 
added to the Data Mapping Template. 

Note: Ensure that you create one Data Mapping Template per Shell 
type. 

If you do not want to deploy from Unifier and want to create the Data Mapping Templates in 
Gateway directly, then add each Shell Attribute Form Data Element that needs to receive data 
from the Oracle application Project object, manually. 

If you want to deploy from Unifier, after adding the Shell Attribute Form Data Element, then: 

 If the manually added field is same as one of the fields that were deployed from Unifier, then 
there will be no adverse impact on the existing fields. 

 If the manually added field does not exist as a Data Element in Unifier, then there will be no 
adverse impact on the existing fields. 

The fields remain as they are when the Oracle application sends values for the fields that were 
added to Unifier Provider and those values are not sent to Unifier. 

Define Business Flow

Define Business Flow using the appropriate Data Mapping Template. 

Create one Business Flow per Shell type in Unifier. 

Add the appropriate source (Source) application parameters to filter the projects that you want to 
create in Unifier. 
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Add the values of relevant destination (Destination) application parameters (Location and 
Template). 

Configure the Business Flow to be used for creating (Create) and updating (Update) the project 
in Unifier. 

Define Synchronizations

Define Synchronizations by using the appropriate Business Flow. 

Define the appropriate parameter values for data exchange. 

Define the schedule frequency so that the synchronization does not have to be run manually for 
the project creation or update. 

Synchronization

When a synchronization is run, Unifier Provider sends data to Unifier to: 

 Create or update a Shell instance (as per Business Flow configuration). 

 Populate the Data Element with the name of the application that is integrating with Unifier, if 
the destination Shell Attribute Form contains the "uuu_integrated_with" Data Element. 

Note: The application name value is sent by Gateway. The name is not 
hard-coded by Unifier. 

Gateway maintains a cross-reference table between objects of the two applications to monitor 
whether to create or update the records of an object. The cross-reference table has IDs of 
projects in Unifier and P6. If the cross-reference table has and entry for a Unifier project against 
a P6 project, then Gateway will update the Unifier project; otherwise, Gateway will create a 
Unifier project. 

Note: If a project exists in Unifier and does not have an entry in the 
Gateway cross-reference table, then when Gateway proceeds to create 
a project in Unifier, to prevent creating a duplicate project in Unifier, 
Unifier converts the create request to update request and proceeds to 
update the existing project, instead of creating a new project. 

Business Processes 

To create/update Business Process records in Unifier you can use the following attributes: 

 Data Dictionary 

 Business Flow 

 Synchronization 

 End-to-end solution 

The following sections provide more details. 



Unifier and Other Oracle Applications

407

Business Processes Data Dictionary 

Data Dictionary (Unifier Provider Business Processes) 

Notes: 

 The remaining attributes are deployed from Unifier, as Data 
Elements, and will be added to relevant business processes, per 
business need. 

 If available, the Object IDs in Gateway are noted in the corresponding 
field. 

 The Parent Element ID is the tag in the Line Item which connects the 
Line Item with the parent record in which the Line Item has to exist 
in. 

 Create separate templates for importing data into different BPs. 

Item Object Name Description Object Attributes 

1 Company Costs Unifier business processes that 
hold company level costs. 

When deployed from Unifier, the 
Upper forms of the Business 
Processes of the following 
category provide data for this 
object: 

Type = Cost 

AND 

Sub-type = Commit at Company 
Level 

AND 

Classification = <Null> OR Generic

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Amount (amount) 
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Item Object Name Description Object Attributes 

2 Company Costs 
Detail 

Detail tabs of Company Cost 
business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Company 
Costs category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Short Description 
(short_desc) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 
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Item Object Name Description Object Attributes 

3 Project 
Commits 

Unifier Project level business 
processes related to money 
committed to be spent. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Cost 

AND 

Sub-type = Line Items with CBS 
Code OR Line Items with Multiple 
Codes 

AND 

Classification = Base Commit OR 
Change Commit 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Due date (due_date) 

 Effective Date 
(uuu_effective_date) 

 Transaction Currency 
(currencyid) 

 Rate in Project 
Currency 
(currencyrate) 

 Status (status) 

 Description 
(description) 

 Amount (amount) 

 Publish Path 
(uuu_dm_publish_path
) 

 Reference BPO 
(ref_bpo) 

 Contract/PO (refid) 
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Item Object Name Description Object Attributes 

4 Project 
Commits Detail 

Detail tabs of the Project commits 
type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Project 
Commits category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Cost Code (bitemID) 

 Short_Description 
(short_desc) 

 Description 
(description) 

 Work Package (wpid) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 

 Reference BPO 
Lineitem 
(ref_bpo_lineitem) 

 Reference 
(uuu_sovlinum) 

 Parent Detail Id 
(ParentDetailId) 
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Item Object Name Description Object Attributes 

5 Project Invoices Unifier invoice related Project level 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Cost 

AND 

Sub-type = Line Items with CBS 
Code OR Line Items with Multiple 
Codes 

AND  

Classification = General Spends 
OR Payment Applications 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Due date (due_date) 

 Effective Date 
(uuu_effective_date) 

 Contract/PO (refid) 

 Transaction Currency 
(currencyid)  

 Amount (amount) 

 Status (status) 

 Publish Path 
(uuu_dm_publish_path
) 



Unifier General Administration Guide

412

Item Object Name Description Object Attributes 

6 Project Invoices 
Detail 

Detail tabs of the Project invoices 
type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Project 
Invoices category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Cost Code (bitemID) 

 Short_Description 
(short_desc) 

 Description 
(description) 

 Work Package (wpid) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 

 Effective Date 
(uuu_effective_date) 

 Scheduled Value 
(scheduled_value) 

 Parent Detail Id 
(ParentDetailId) 
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Item Object Name Description Object Attributes 

7 Other Project 
Costs 

Unifier Project level business 
processes that captures costs 
other than commits or invoices. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Cost 

AND 

Sub-type = Line Items with CBS 
Code OR Line Items with Fund 
Code OR 

AND 

Classification = Generic OR 
Transfer OR 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Amount (amount) 

 Publish Path 
(uuu_dm_publish_path
) 
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Item Object Name Description Object Attributes 

8 Other Project 
Costs Detail 

Detail tabs of the Other Project 
costs type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Other Project 
Costs category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Cost Code (bitemID) 

 Fund Code 
(uuu_fund_code) 

 Short_Description 
(short_desc) 

 Description 
(description) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 

 Effective Date 
(uuu_effective_date) 
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Item Object Name Description Object Attributes 

9 Project Simple Unifier project level Simple 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Simple 

AND 

Level = Project/Shell 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Publish Path 
(uuu_dm_publish_path
) 

10 Company 
Simple 

Unifier company level Simple 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Simple 

AND 

Level = Company 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Due Date (due_date) 

 Publish Path 
(uuu_dm_publish_path
) 
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Item Object Name Description Object Attributes 

11 Company Line 
Item 

Unifier company level Line Item 
type business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Line Item 

AND 

Sub-Type = Any 

AND 

Level = Company 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Due Date (due_date) 

 Publish Path 
(uuu_dm_publish_path
) 

12 Company Line 
Item Detail 

Detail tabs of the company Line 
Item type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Company 
Line Item category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Short Description 
(short_desc) 
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Item Object Name Description Object Attributes 

13 Project 
Document 

Unifier Project level Document type 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Document 

AND 

Sub-Type = Any 

AND 

Level = Project/Shell 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Short Description 
(short_desc) 

 Status (status) 

 Publish Path 
(uuu_dm_publish_path
) 

14 Project 
Document 
Detail 

Detail tabs of Project Document 
type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Project 
Invoices category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Name (uuu_Name) 

 Short Description 
(short_desc) 

 Line Item Status 
(uuu_line_item_status)

 Issue Date 
(uuu_issue_date) 

Summary Payment Application (SPA) SOV type BPs 

The creation and update of the Line Items in the Summary Payment Application (SPA) SOV type 
BPs requires three fields in Unifier Provider. These fields are designed to identify and separate 
the SPA SOV type BPs in Unifier Provider from the existing SPA SOV type BPs in Unifier. 
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Note: Line Item update is not supported for Project Invoice (Payment Applications) Type of BP's 
through Gateway Integration. As a result, every Update from Gateway to Unifier will result in the 
creation of a new Line Item. 

Depending on which Line Item is referenced, the Line Items coming from Gateway follow a 
certain structure as described in the examples below: 

Base Commit Type BP Line Item

Example 

<_bp_lineitems>  <!—Summary Line -- >

<ElementId>Summary1</ElementId>

<ParentDetailId></ParentDetailId>

<short_desc>desc 1</short_desc>

</_bp_lineitems>

<_bp_lineitems>  <!—Costed line -- >

<ElementId>costed line 1</ElementId>

<ParentDetailId>Summary1</ParentDetailId>

<short_desc>desc 1</short_desc>

</_bp_lineitems>

Note: The parentdetailid connects the BP Line Item to its parent 
Summary Line Item in the SOV. 

Change Commit Type BP Line Item

Example 

<_bp_lineitems> <!—Summary Line -- >

<ElementId>Summary1</ElementId>

<ParentDetailId></ParentDetailId>

<short_desc>desc 1</short_desc>

<uuu_sovlinum>1</uuu_sovlinum>

</_bp_lineitems>

<_bp_lineitems> <!—Costed line -- >

<ElementId>costed line 1</ElementId>

<ParentDetailId>Summary1</ParentDetailId>

<short_desc>desc 1</short_desc>

<uuu_sovlinum>1.1</uuu_sovlinum>

<bItemID>Code 1</bItemID>

</_bp_lineitems>
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Notes: 

 The parentdetailid connects the BP Line Item to its parent 
Summary Line Item in the SOV. 

 The Data Element uuu_sovlinum is an optional field. If the value is 
received by Unifier for the same field, then Unifier will try to update 
an existing row; otherwise, the update will create a new Line Item in 
the SOV (based on the settings of the SOV). 

Invoice Type BP Line Item

Example 

<_bp_lineitems> <!—Summary Line -- >

<ElementId>Summary1</ElementId>

<ParentDetailId></ParentDetailId>

<short_desc>desc 1</short_desc>

<bItemID></bItemID>

<_refnum>1</_refnum>

</_bp_lineitems>

<_bp_lineitems> <!—Costed line -- >

<ElementId>costed line 1</ElementId>

<ParentDetailId>Summary1</ParentDetailId>

<short_desc>desc 1</short_desc>

<bItemID>Code 1</bItemID>

<_refnum>1.1</_refnum>

</_bp_lineitems>

Notes: 

 The parentdetailid connects the BP Line Item to its parent 
Summary Line Item in the SOV. 

 The refnum is for Unifier and is used when creating the structure 
within the SOV for the incoming Line Items and the Summary lines. 

Unifier Provider BP Objects and Gateway Objects 

To correspond to the Unifier Provider objects (explained in the preceding Data Dictionary 
section), Gateway will introduce new objects to support the various business processes. 

You can use the mapping information in the following table to see how data is sent from Unifier 
to an Oracle application and flows from object to object (Unifier Provider > Gateway). 
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Item Unifier Provider Object Name Corresponding Gateway Object Name 

1 Company Costs BlanketPurchaseOrder 

2 Company Costs Detail BlanketPurchaseOrderDetail 

3 Project Commits 

BudgetChangeOrder 

BudgetItem 

Contract 

PurchaseOrder 

WorkRelease 

ChangeOrder 

POAmendment 

4 Project Commits Detail 

BudgetChangeOrderDetail 

BudgetItemDetail 

ContractDetail 

PurchaseOrderDetail 

WorkReleaseDetail 

ChangeOrderDetail 

POAmendmentDetail 

5 Project Invoices 

Invoice 

PaymentApplication 

PaymentApplicationtoOwner 

6 Project Invoices Detail 

InvoiceDetail 

PaymentApplicationDetail 

PaymentApplicationtoOwnerDetail 

7 Other Project Costs 

Estimate 

BudgetApproval 

BudgetChange 

BudgetTransfer 

PotentialChangeOrder 

JournalEntry 

Payment 

PaymentFromOwner 

RiskAndIssue 

FundAppropriation 
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Item Unifier Provider Object Name Corresponding Gateway Object Name 

8 Other Project Costs Detail 

EstimateDetail 

BudgetApprovalDetail 

BudgetChangeDetail 

BudgetTransferDetail 

PotentialChangeOrderDetail 

JournalEntryDetail 

PaymentDetail 

PaymentFromOwnerDetail 

RiskAndIssueDetail 

FundAppropriationDetail 

9 Project Simple ProjectInformation 

10 Company Simple VendorEvaluation 

11 Company Line Item 
Vendor 

Timesheet 

12 Company Line Item Detail 
VendorDetail 

TimesheetDetail 

13 Project Document  RequestforSubstitution 

14 Project Document Detail RequestforSubstitutionDetail 

Business Processes Business Flow 

When defining a Business Flow in Unifier Provider (Business Processes), the destination 
application parameters for Unifier Provider, BP object, enable you to define which BP needs to 
receive data by way of the Business Flow configuration. The attributes are specific to Unifier and 
eliminate the need for the source application to send the values for Unifier fields. 

Notes: 

 To avoid duplicating records, create separate Business Flows (for two 
BPs of the same type) when importing data into Unifier. 

 Do not use a single Business Flow in Gateway to import into two 
Company Costs type BPs. Instead, use different Business Flows for 
setting up the data flow. 

If the source application sends value for either of the parameters mentioned below via data 
mapping and you define the parameter value in the business flow, then the value sent by way of 
mapping takes precedence. 

The following parameters are required for successful project creation in Unifier. 
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Object Value Description 

Business Process Name Text field 

If you enter more than one 
value, then the integration 
will fail. 

Use this parameter to 
identify the Name of the 
business process that 
requires the data from the 
Oracle application. The 
value that you enter in this 
parameter is used by Unifier 
Provider to identify which 
BP requires data. 

Example 

Creating Data Mapping 
Template 

 Unifier Provider object: 
Project Commits 

 Gateway object: 
Contracts 

 Oracle Application 
object: xyz 
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Object Value Description 

Business Process Detail 
Tab Name 

Text field 

If you enter more than one 
value, then the integration 
will fail. 

Use this parameter to 
identify the Detail tab of the 
business process that 
requires the data from the 
Oracle application. The 
value that you enter in this 
parameter is used by Unifier 
Provider to identify which 
BP requires data. 

Example 

Creating Data Mapping 
Template 

 Unifier Provider object: 
Project Commits Detail 

 Gateway object: 
Contracts Detail 

 Oracle Application 
object: xyz 

Note: The tab Name is also 
an attribute for all Line Item 
objects in Unifier Provider. If 
the Oracle Application 
sends value for tab name 
by way of mapping, then the 
mapped value will override 
the parameter value defined 
in Business Flow. 
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Object Value Description 

Line Item Identifier Text field 

Note: Oracle recommends 
that you use the Data 
Element name. 

If you enter more than one 
value, then the integration 
will fail. 

This parameter is used by 
Unifier during an update of 
an existing Line Item (in 
Unifier), only. The value that 
you enter in the Data 
Element of this parameter is 
used by Unifier to identify 
which Line Item requires 
update. 

Note: Within this parameter 
text box, enter the name 
(not label) of the Data 
Element on the Detail tab 
that must be used as the 
identifier for Line Item 
update. Unifier Provider 
identifies the value entered 
in this text box as the DE 
name (not label). 

Business Processes Synchronization 

Synchronization in Unifier Provider (Business Processes) occurs when you set the parameters 
(Business Process Name, Status, and Detail Tab Name) as "Required" or "Optional" in the 
Business Flow definition. 

Business Processes End-to-End Solution 

The following explains the end-to-end solution for Unifier Provider (Business Processes). The 
configuration settings are for: 

 Unifier 

 Unifier Provider 

To configure the creation of Business Processes in Unifier via Gateway 

Note: This is an optional step. You can skip deploying the objects from 
Unifier and add relevant fields in Gateway Data Mapping Templates 
directly, manually. 

Go to Company Workspace > Admin mode > Integrations > Gateway > Business Objects. 

Deploy the business process record that you want to create in Unifier, via Gateway Integration. 

All Data Elements from the deployed business process record appear as attributes of Business 
Process object (Company Costs, Project Commits, Project Invoices, etc.) in Unifier Provider 
Data Dictionary. 
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To configure the creation of Business Processes in Unifier Provider via Gateway 

You must: 

 Create Data Mapping Templates 

 Define Business Flow 

 Define Synchronizations 

 Synchronize 

The following provides the details for each step: 

Create Data Mapping Templates

Create Data Mapping Templates to map attributes of the BPs Upper Form data that needs to 
integrate with Gateway > Oracle application. 

Notes: 

Ensure that you create one Data Mapping Template per BP. 

If the BP that needs to integrate has Detail tab, then create additional 
Data Mapping Template, one template per Detail tab, to ensure that the 
map the Detail Form elements to Gateway > Oracle application. 

Once you deploy the BP from Unifier to Gateway, all the attributes of the Business Process 
object Unifier Provider (Company Costs, Project Commits, Project Invoices, etc.) will be 
available for you to add to the Data Mapping Template. 

If you do not want to deploy from Unifier and want to create the Data Mapping Templates in 
Gateway directly, then you must add each BP Data Element that needs to receive data from a 
Oracle application object in Gateway, manually (use the Add New Field in the Add Template 
window). After you add each BP Data Element in Gateway, you must deploy the BP from Unifier. 
Note the following conditions: 

 If the manually added field is the same as one of the fields that you deployed from Unifier, 
there will be no impact on the existing field. This is similar as if you deployed the manually 
added field from Unifier. 

 If the manually added field does not exist as a Data Element in Unifier, there will be no 
impact on the existing field. When the Oracle application sends value for this field to Unifier 
Provider, the value remains as is and it is not sent to Unifier. 

Define Business Flow

Define Business Flow using the appropriate Data Mapping Template. 

Create one Business Flow per BP Upper Form and one Business Flow per BP Detail tab in 
Unifier. 

Add the appropriate source (Source) application parameters to filter the BP records that you 
want to extract for the Oracle application and create in Unifier. 

Add the values of the following relevant destination (Destination) application parameters in order 
for the BP Records/Line Items to be created in Unifier: 

 Project ID 

 Business Process Name 
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 Business Process Detail Tab Name 

Configure the Business Flow to be used for creating (Create) and updating (Update) the BP 
Records/Line Items in Unifier. 

Define Synchronizations

Define Synchronizations by using the appropriate Business Flow. 

Define the appropriate parameter values for data exchange. 

Define the schedule frequency so that the synchronization does not have to be run manually for 
the BP Records/Line Items creation or update. 

Synchronize

When a synchronization is run, Unifier Provider sends data to Unifier to create or update BP 
Records/Line Items instance (as per Business Flow configuration). 

Example 

To create BP records of Base Commits type in Unifier: 

1) In Unifier, deploy the Base Commits BP to map to Unifier Provider object (Project Commits). 

2) Log in to Gateway instance and create the following two Data Mapping Templates: 

a. Using the Gateway object "Project Commits" to map the Base Commits BP "Upper Form" 
information to the Oracle application. 

b. Using the Gateway object "Project Commits Detail" to map the Base Commits BP "Detail" 
tab information to the Oracle application. 

3) Using the appropriate Gateway objects, create the following two Business Flows: 

a. Using Gateway object "Purchase Orders" and selecting the corresponding Data Mapping 
Template that you created (sub-step "a" above). 

b. Using Gateway object "Purchase Orders Detail" and selecting the corresponding Data 
Mapping Template that you created (sub-step "b" above). 

4) Add the appropriate source (Source App Parameters) to filter records from the source 
application and set the destination application parameters (Destination App Parameters) to: 

a. Business Process Name = Base Commit 

b. Business Process Detail Tab = <detail tab name> 

5) Create two synchronizations: 

a. For Base Commit BP in Unifier 

b. For Base Commit Line Item in Unifier 

6) Define the schedule frequency so that the synchronization does not have to be run manually 
for the BP Records/Line Items creation or update. 

Roles 

You can create a Role in Unifier by using both Role and Resource data from a Oracle 
application. The Role object in Unifier Provider can be used to create and update Roles in 
Unifier. The following sections provide details about: 

 Roles Data Dictionary 
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 Roles Business Flow 

 Roles Business Flow (Destination App Parameters) 

 Roles Synchronization 

 Roles End-to-End Solution 

Roles Data Dictionary 

The Role object in Unifier Provider has the following default attributes which are the mandatory 
fields needed to create a Role object in Unifier: 

Attribute Name Description 

Role Name The name of the Role object in Unifier. 

Role Status The Role status is either Active or Inactive.

 If the Oracle application Role Status 
values do not match the Unifier Role 
Status values, then use Data Mapping 
values. 

 If the Oracle application does not send 
any values for this attribute, then 
Unifier creates a Role with a default 
status of "Active." 

Role Currency The currency for the Role. 

This attribute is mandatory/required for 
creating a Role object in Unifier. 

If the Oracle application does not send any 
values for this attribute, then Unifier 
creates a Role with a default currency of 
company base currency. 

As a result of the Summary Sheet integration that creates Roles in Unifier (by pulling data from 
P6 Schedule Summary data, the Role ID (uuu_role_id) is a mandatory/required field for creating 
a Role object in Unifier. 

Creating a Role object in Unifier by pulling data from Gateway (Role/Resource object) does not 
require the Role ID (uuu_role_id) field for creating a Role object in Unifier. 

Creating a Role object in Unifier via Gateway integration (by pulling data from Gateway 
Role/Resource object) requires the values of the following fields, mentioned in the table above: 

 Role Name 

 Role Status 

 Role Currency 

Roles Business Flow 

Role, or Resource, mapping in Unifier (from an Oracle application) is achieved by way of the 
"Dynamic Object Mapping" field in Gateway. 

The "Create Template" window in Gateway enables you to select "Provider 1" as a Oracle 
application and "Provider 2" as Unifier. 
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In the section available for mapping objects, you can select "Resource" as the object in the 
Oracle application and "Role" as the object in Unifier (Provider 2). 

You can choose a criteria to bring the "Resource" data from the Oracle application by selecting 
the "Use Criteria Step" checkbox. You can then proceed to the next step and add the required 
mappings. 

Roles Business Flow (Destination App Parameters) 

You can create the Roles object in Unifier from both Resources and Roles objects in Unifier 
Provider. As a result, when defining a Business Flow, you need to identify the parameters 
(Destination App Parameters) within Unifier Provider. The following explains the Roles Business 
Flow: 

Roles Synchronization 

You can create synchronization using the appropriate Business Flow. 

Roles End-to-End Solution 

Follow these steps to create Roles objects in Unifier, via Gateway integration: 

1) From Unifier, deploy the Roles attribute form to Gateway. 

 This is an optional step. You can use this step to add additional Data Elements (required 
for Role creation or to receive values from the Oracle application) to the Roles attribute 
form. 

 You can create the Role object in Unifier from Role, or Resource, object in Unifier 
Provider by using the destination parameter (see the Roles Business Flow (Destination 
App Parameters) above); however, when a Roles object is deployed from Unifier, it only 
provides attributes for the Role object in Unifier Provider, only. 

2) Create Data Mapping Template. 

Unifier Provider "Role" object > Gateway "Role" object > Oracle Application "xyz" object 

3) Create Business Flow. 

Use the Gateway "Role" object and Data Mapping Template. 

4) Create Synchronization. 

Use the Business Flow. 

5) Create Schedule. 
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Enable the scheduled creation/update of roles. 

Resources 

You can use the Resources object to identify whether a data from Unifier Provider can create a 
Role/Resource, or not. When you map a Unifier "Resource" object to a Gateway "Resource" 
object, you can create/update both the Resources and Roles object in Unifier. The following 
sections provide details about: 

 Resources Data Dictionary 

 Resources Business Flow 

 Resources Synchronization 

 Resources End-to-End Solution 

Resources Data Dictionary 

The Resources object in Unifier Provider has the following default attributes which are the 
mandatory fields needed to create a Resources object in Unifier: 

Attribute Name Description 

Resource Name Unifier Resource Name. 

Resource Status The Resource status is either Active or 
Inactive. 

If the third-party application Role Status 
values do not match the Unifier Resource 
Status values, then use Data Mapping 
values. 

If the third-party application does not send 
any values for this attribute, then Unifier 
creates a Resource with a default status of 
"Active." 

Resource Code Resource Code. 

Resource Capacity Resource Capacity. 

User First Name First name of the Unifier user who is being 
added as a resource. 

User Last Name Last name of the Unifier user who is being 
added as a resource. 

User E-mail ID E-mail ID of the Unifier user who is being 
added as a resource. 

Default Role Name The role that the resource is allocated to. 
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Resources Business Flow 

You can create the Business Flow by using the appropriate Resource-to-Resource Data 
Mapping Template. 

Resources Synchronization 

You can create the Synchronization by using the appropriate Business Flow. 

Resources End-to-end Solution 

Follow these steps to create Resources objects in Unifier, via Gateway integration: 

1) From Unifier, deploy the Resource attribute form to Gateway. 

 This is an optional step. You can use this step to add additional Data Elements to the 
Resources attribute form that are required for: 

Resource, or Role, creation. 

Receiving value from the third-party application. 

When a Resource object is deployed from Unifier, it only provides attributes for the Resource 
object in Unifier Provider, only. 

2) Create Data Mapping Template. 

Unifier Provider "Resource" object > Gateway "Resource" object > Third-party Application 
"xyz" object 

3) Create Business Flow. 

Use the Gateway "Resource" object and Data Mapping Template. 

4) Create Synchronization. 

Use the Business Flow. 

5) Create Schedule. 

Enable the scheduled creation/update of resources. 

CBS Codes 

You can create and update the CBS Codes in Unifier Cost Sheet via Gateway integration with 
any Oracle application. 

Unifier and Primavera Cloud 

When Unifier Single-tenant and Oracle Primavera Cloud are integrated, you can configure 
Unifier Single-tenant to connect:  

 A single Unifier projects to a single Primavera Cloud project. 

 A single Unifier projects (in multiple shells) to multiple Primavera Cloud projects. 

Note: Oracle recommends that you inspect what you expect from 
connecting Unifier projects to Primavera Cloud projects because you 
may experience unexpected data and results. 

The Unifier Multi-tenant connection to Primavera Cloud is through Lobby. 
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Primavera Cloud Integration 

To access the Primavera Cloud Integration page: 

1) Go to your company workspace (Admin mode). 

2) From the left Navigator, click Integrations grouping node to expand. 

3) Click Primavera Cloud functional node to open the Primavera Cloud Integration page. 

Recommended Integration Settings for Unifier Single-tenant and Oracle Primavera Cloud  

If the OAuth client ID is not configured in Primavera Cloud, then the system cannot generate the 
access token. In such cases, contact the System Administrator for support. 

Connecting Unifier Single-tenant and Oracle Primavera Cloud  

There are no direct connections between Unifier Single-tenant and Primavera Cloud. The Unifier 
Single-tenant can access primavera Cloud Application Programming Interface (API) through 
access token generated from Lobby. 

The only way that you can connect Unifier Single-tenant to Primavera Cloud, and to be able to 
generate the needed access token, is through sending a request to the System Administrator 
and ask the System Administrator to enter the URL for Lobby in the custom.properties file 
(Unifier Configurator Settings > Advanced tab). 

If the server name and the host & scope name are different, then the Primavera Cloud 
connection will not be established.  

The following diagram shows the integration elements: 
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Sending Cash Flow values from Unifier Single-Tenant to Primavera Cloud 

To be able to send cash flow values from Unifier Single-Tenant to Primavera Cloud, you must 
ensure that the destination application (Primavera Cloud) is up and running.  

Once you receive the access token, you can send cash flow values from Unifier Single-Tenant to 
Primavera Cloud as needed; however, if the destination application (Primavera Cloud) is down, 
or not running for a reason, then your export will not take place. 

The Unifier Single-tenant connects to Primavera Cloud through an Application Programming 
Interface (API)—not to its server. Since this type of connection (through API) does not allow the 
system to check for the availability of the destination application (Primavera Cloud), the system 
will not be able to notify you, if the destination application (Primavera Cloud) is not up and 
running. 

Connect 

In the Connect tab, the Company Administrator can enter the Oracle Primavera Cloud URL and 
the user's information. 

The OPC URL that you enter in the connection details must be same as the one used for the 
host name of the OPC.  

This tab is selected by default and contains the following fields: 

Primavera Cloud URL

This field must contain a valid Oracle Primavera Cloud URL, where: 

a. Data from Unifier must be sent to, and 

b. Data from Primavera Cloud must be received from. 

You must enter a valid URL that enables Unifier to connect to Primavera Cloud. 

Username

This field must contain a valid email address. 

You must enter the Primavera Cloud Administrator's username in this field. 

Password

This field must contain a valid password. 

For security-related reasons, the system uses the values in the Username and Password fields 
only to generate an access token. 

When finished, the Company Administrator clicks Save & Generate Access Token to connect 
Unifier to the Primavera Cloud. 

Unifier uses the Lobby identity application token request by sending the URL, username, and 
password values to get the access token and refresh token. 

After entering the URL and credentials and clicking Save & Generate Access Token, the 
system will save the Primavera Cloud End Point URL and generate the access token. The 
system then uses the Lobby identity API by sending the username and password values to get 
the access token and refresh token. 
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Notes: 

 The refresh token will be generated before the access token expires. 

 If the server name and the host and scope name are different, the 
Primavera Cloud connection will not be established. 

The system will use the access token (which will be generated based on the username and 
password) to authenticate the Primavera Cloud public API to send (push) and receive (pull) cash 
flow data for selected projects. 

 If the values of the URL or credentials have been entered correctly, you will see this 
message: "The access token has been generated successfully." 

 If for any other reason the system cannot generate the access token, you will see this 
message: "The access token cannot be generated. Contact your Administrator for additional 
details." 
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